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EndNote X9 

1 Giriş 

EndNote, online uygulaması ile ortak çalışmalar yürütülmesine imkan sağlayan özel bir 

veri tabanı uygulamasıdır. EndNote, Microsoft Word’ün Windows ve Mac OS X 

sürümleri ile uyumludur. Kütüphaneler her iki platform arasında kolaylıkla 

paylaşılabilir. 

EndNote, kişisel bilgi veri tabanlarınızı oluşturarak, bibliyografik bilgileri (örneğin; 

kitaplar, dergiler, kataloglar, görsel veriler vb.) saklamanıza, düzenlemenize, 

taramanıza ve paylaşmanıza olanak sağlamaktadır. 

 EndNote, referans ve imaj veri tabanıdır—kişisel referans kütüphanelerinizdeki, 

bibliyografik referansları depolama, yönetme ve arama işlemlerinde uzmandır. 

Grafik, tablo, şekil ve formül içeren imajları düzenleyebilir, her imaj için caption 

(altyazı) ve keywords (anahtar kelimeler) atayabilirsiniz. 

 EndNote, online arama aracıdır—online bibliyografik veri tabanlarında arama 

yapma, referansları doğrudan kütüphanenize import etme ve yeniden düzenleme 

konusunda en kolay yolları sunar. Ayrıca, çeşitli online servislerden, CD’lerden ve 

kütüphane veri tabanlarından, veri dosyaları import işlemi gerçekleştirebilir. 

 EndNote, makale ve bibliyografya oluşturma aracıdır—Cite While You Write 

özelliği ile, Microsoft Word’de atıfları, şekilleri ve tabloları biçimlendirebilir. 

Makalenize referans, şekil ve tablo eklediğinizde listeler otomatik olarak 

oluşturulur. Microsoft Word şablonları ile, yayımcılar tarafından istenen makale 

formatları konusunda size kolaylık sunar. 

EndNote X9 ile, referanslar, PDF'ler ve PDF'lere eklenmiş notlarınızı (annotations) 

içeren EndNote kütüphanenizi, 99 kişiyle paylaşabilirsiniz. Herkes, paylaşılan 

kütüphaneyi, yeni referans kayıtları ve mevcut kayıtlara notlar ekleyerek, aynı anda 

kullanabilir. Değişiklikler, ‘Activity Feed’ butonu kullanılarak görüntülenebilmektedir. 

EndNote Online, EndNote desktop, Web of Science Core Collection ve 

ResearcherID’de bulunan bir özelliktir. EndNote Online, Web’de çeşitli bibliyografik 

yönetim araçları sunar. Referansları kişisel EndNote online hesabı ile import edebilir, 

düzenleyebilir, makalenize atıf işlemleri gerçekleştirebilir ve bibliyografyalar 

oluşturabilirsiniz. Bkz. 12 EndNote Online 

Network edition (network sürümü), birden fazla sayıda kullanıcı için EndNote 

network sürümü mevcuttur. Aynı anda kullanım için EndNote’u, network’te paylaşımlı 

bir şekilde kurabilir veya her bir kullanıcı için lokal kurulum yapabilirsiniz. Her iki 

konfigürasyonda da kullanıcılar ‘server’ üzerindeki ortak kütüphanelere ve kendi kişisel 

kütüphanelerine erişebilir. Ayrıca, stillerini, filtrelerini veya bağlantı dosyalarını 

düzenleyebilir ve EndNote seçeneklerini, gereksinimleri doğrultusunda 

yapılandırabilirler. EndNote ‘Network Edition’, EndNote’un, uygulamasını, 

kütüphanelerini veya referanslarını aynı anda birden fazla kullanıcının kullanacağı, 

laboratuvar ve departmanlar için uygun bir bibliyografik lisans paketidir. 

EndNote network paketi kullanıcılarının dikkat etmesi gereken bazı hususlar: 

 EndNote’da, aynı anda birden fazla kullanıcının, bir kütüphaneyi düzenlemesini 

sağlayan ‘Record Locking’ (kayıt kilitleme) fonksiyonu mevcut değildir. Kullanıcılar, 

EndNote kütüphanelerini (veri tabanlarını) aynı anda kullanım için ‘read-only’ (salt-

okunur) veya ‘locked’ (kilitli) durumda paylaşıma açabilir. Birden fazla kullanıcı, 

arama yapmak, dokümanlarına referansları kopyalamak ve bibliyografyalarını 

biçimlendirmak için aynı EndNote kütüphanesine erişebilir (referans düzenleme 

yalnızca read-write (okuma-yazma) hakkı olması durumunda mümkündür). 
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 Ortak kullanılan bir EndNote kütüphanesinin bakım ve güncelleme işlemleri farklı 

bir lokasyondan yapılıyor ise yalnızca bir kişi tarafından gerçekleştirilmelidir; ve bu 

kullanıcının kütüphanenin bulunduğu klasöre ‘full access’ (sınırsız erişim) izni 

olmalıdır. Kütüphaneye network üzerinden ‘read-only’ (salt okunur) olarak erişen 

diğer tüm kullanıcılar için, güncellenen kütüphane periyodik olarak gönderilmelidir. 

 Kullanıcılar, kişisel ‘Preferences’ (Seçenekler) dosyalarını lokal olarak kendi 

sürücülerinde tutabilirler. 

 EndNote kütüphaneleri Windows ve Macintosh network platformları ile uyumludur. 

Bu sayede, Macintosh ve Windows kullanıcıları, network üzerinden bir EndNote veri 

tabanına aynı anda erişebilirler. Herhangi bir dönüşüme ihtiyaç yoktur! 

 EndNote, belirli bir zamanda yazılıma erişebilen eş zamanlı kullanıcı sayısını 

(EndNote Network Concurrent) sınırlandırmak için, lisans anahtar sunucusu 

yazılımıyla birlikte kullanılabilir. 

 EndNote'un kullanılacağı ortam, uzun dosya adlarını desteklemelidir. 

EndNote kurulumu ile gelen birkaç önemli bileşen: 

 Connection Files (Bağlantı Dosyaları): online veri tabanlarındaki referanslara 

doğrudan erişim için kullanılan dosyalar 

 Filters (Filtreler): referans verilerini içeren tekst-dosyalarını import için kullanılan 

dosyalar 

 Spelling Dictionaries: yazım denetimi için kullanılabilir sözlükler 

 Styles (Stiller): atıflar ve bibliyografyalar oluştururken kullanılan formatlar 

 Kelime İşlemci Dosyaları: Word veya WordPerfect dosyaları, ve ayrıca Word için 

‘EndNote Manuscript Templates’ dosyaları. 

 Term Lists: ilgili alanlara girilen adların veya kelimelerin bir listesi, terim 

listelerinde tutulmaktadır. Yazarken terimler önererek veri girişine yardımcı olurlar. 

EndNote dünya çapında akademik enstitülerde ve araştırma kuruluşlarında çalışan 

araştırmacılar, kütüphaneciler ve öğrenciler tarafından kullanılmaktadır. 

Amaç 

 ‘Author’ (yazar), ‘keyword’ (anahtar kelime), ‘journal’ (dergi), ‘book’ (kitap), ‘year 

of publication’ (yayınlanma yılı) vb. bilgiler ile ilgili hızlı bir şekilde arama, erişim ve 

depolama; 

 Farklı kaynaklardan veri import; (örneğin Internet, veri diski vb.) 

 Referansları kolaylıkla düzenleme ve biçimlendirme; 

 Makaleleriniz için anında bibliyograyalar oluşturma ve yazdırma; 

 Cite while You Write. 

Araçlar 

 Menü çubuğu komutları; 

 Araç çubuğu komutları; 

 Klavye komutları (menülerde yer alan kısayol tuş komutları); 

 Sağ-tuş menüleri. 

1.1 Windows/Mac Sistem Gereksinimleri 

EndNote Windows ve Macintosh® platformları ile uyumludur. Mevcut platform ve 

programlarınızın EndNote ile uyumlu olup olmadığını kontrol etmek için sistem 

gereksinimleri linkine tıklayın: 

https://researchsoftware.com/tr/software/bibliography/endnote/sistem-gereksinimleri 

https://researchsoftware.com/tr/software/bibliography/endnote/sistem-gereksinimleri
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1.2 Terimler Sözlüğü 

1.2.1 Add-in (Eklenti) 

Eklenti, mevcut bir bilgisayar programına, belirli özellik ekleyen yazılım bileşenidir. 

EndNote Desktop ve EndNote Online'da, dokümanlarınıza atıf işlemi gerçekleştirmek 

için kullandığınız Cite While You Write eklentisidir. 

1.2.2 Connection Files (Bağlantı Dosyaları) 

EndNote bağlantı dosyası, online veri tabanı ya da online kütüphane kataloğunda 

arama yapmak ve referansları import etmek için gerekli bilgileri içermektedir. Her 

bağlantı dosyası farklı bir veri tabanını ifade etmektedir (örneğin; Library of Congress 

veya National Library of Medicine’dan PubMed). 

Kurulum ile gelen bağlantı dosyaları default olarak;  

‘C:\Program Files\EndNote X9\Connections’ (32-bit Windows versiyonları için) 

‘C:\Program Files (x86)\EndNote X9\Connections’ (64-bit Windows versiyonları için) 

klasöründe bulunmaktadır. Bunun dışında düzenlediğiniz ya da yeni oluşturacağınız 

bağlantı dosyaları kendi kişisel klasörünüzde tutulacaktır (default olarak, 

C:\Users\UserName\Documents\EndNote\Connections). 

Online veri tabanlarına bağlanmak için EndNote içerisinden;  

 ‘Edit>Connection Files>Open Connection Manager...’ menüsü 

 ‘Tools>Online Search...’ menüsü 

 ‘Groups Paneli’nde yer alan  ‘Online Search>more…’ 

kullanılarak açılan ‘Connection File Manager’ ekranından bağlanmak istenen veri tabanı 

seçilerek eklenebilir. Online veri tabanlarına erişim için Internet bağlantısı gereklidir. 

 Not 

 EndNote X9 kurulumu, en sık kullanılan bağlantı dosyaları ile birlikte 

gerçekleşmektedir. Tüm bağlantı dosyalarını ya da ihtiyaç duyduğunuz dosyaları 

http://endnote.com/downloads/connections adresinden download edebilirsiniz. 

Ayrıca bu sayfaya, EndNote içerisinde ‘Edit>Connection Files>Open Connection 

Manager...’ menüsünü kullandığınızda açılan, ‘Connection File Manager’ ekranında, 

‘Get More on the Web...’ butonuna basarak da ulaşabilirsiniz.  

1.2.3 Doi (Digital Object Identifier) 

Digital Object Identifier / DOI, Uluslararası Standardizasyon Örgütü (ISO) tarafından 

standartlaştırılan nesneleri benzersiz bir şekilde tanımlamak için kullanılan, kalıcı bir 

tanımlayıcı veya tanıtıcıdır. Handle System’in implementasyonu olan DOI, genellikle 

dergi makaleleri, araştırma raporları, veri setleri ve resmi yayınlar gibi akademik, 

mesleki ve siyasal bilgileri tanımlamak için yaygın olarak kullanılsa da mesleki videolar 

gibi diğer bilgi kaynaklarını tanımlamak için de kullanılmıştır. Ayrıntılı bilgi: 

http://dx.doi.org ve www.doi.org. 

1.2.4 Field (Alan) 

Alanlar, bir EndNote referansını oluşturan ‘author’, ‘year’ veya ‘title’ gibi bilgilerin 

tutulduğu bölümlerdir. EndNote referans penceresinde, yazar adları ya da anahtar 

kelimeler gibi her bir alana ait bilgiler, ayrı bölümlerde görüntülenir. Alanlarda bulunan 

bilgilerin nasıl görüntüleneceği EndNote stillerine göre belirlenir. Veriler import 

edilirken kullanılan EndNote import filtreleri, hangi bilginin hangi alana 

yerleştirileceğini, bu alan adlarına ve etiketlerine göre belirler. EndNote ile, her 

referans kaydı için 54 alana kadar veri girişi yapılabilmektedir. 

http://endnote.com/downloads/connections
http://dx.doi.org/
http://www.doi.org/
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1.2.5 Library (Kütüphane) 

Kütüphane, referans kayıtlarınızın saklandığı EndNote veri tabanınız için kullanılan 

terimdir. Kütüphane, referans materyali kayıtlar koleksiyonudur. 

1.2.6 Output Style (Çıktı Stili) 

EndNote bibliyografya stilleri, bir makalede yer alan referans ve atıfların nasıl 

biçimlendirileceğini belirlemek için kullanılan dosyalardır. Stiller, noktalama işaretleri, 

atıf ve referans sıralaması, referans listesi ve metin içi atıf görünümü için gerekli olan 

alanlar hakkında bilgiler içerir. EndNote’da 7000‘in üzerinde yeniden biçimlendirilebilir 

stil bulunmaktadır. 

Kurulum ile gelen stil dosyaları default olarak; 

‘C:\Program Files\EndNote X9\Styles’ (32-bit Windows versiyonları için) 

‘C:\Program Files (x86)\EndNote X9\Styles’ (64-bit Windows versiyonları için) 

klasöründe bulunmaktadır. Bunun dışında düzenlediğiniz ya da yeni oluşturacağınız stil 

dosyaları kendi kişisel klasörünüzde tutulacaktır (default olarak, 

C:\Users\UserName\Documents\EndNote\Styles). 

Stiller, ‘Format Bibliography, Format, Print, Export, ve Copy Formatted’ komutlarını 

kullanırken, kütüphane penceresi tab panelindeki, ‘Preview’ (Önizleme) tabında, seçilen 

referans kayıtlarının nasıl biçimlendirileceğinin görüntülenmesini de sağlamaktadır. 

1.2.7 PubMed 

PubMed, öncelikli olarak yaşam bilimleri ve biyomedikal konularla ilgili referanslar ve 

özetlerden oluşan MEDLINE veri tabanına erişen ücretsiz bir arama motorudur. Ulusal 

Sağlık Enstitüleri’ndeki Amerika Birleşik Devletleri Ulusal Tıp Kütüphanesi (NLM), veri 

tabanını, Entrez bilgi alma sisteminin bir parçası olarak tutmaktadır (Kaynak: 

Wikipedia). 

1.2.8 Record Number (Kayıt Numarası) 

EndNote, kütüphanenize her referans eklediğinizde, o kayda eşsiz bir kayıt numarası 

atamaktadır. Kayıt numaraları, makale formatı belirlendiğinde, doğru referansın 

kullanılmasını sağlamak için geçici atıfda (Temporary Citations) görüntülenir: 

{Argus, 1991#14} 

Ayrıca bu bilgi, bir referans kaydına çift tıklanarak ulaşılan ‘Referans Penceresi’ başlık 

çubuğunda da görüntülenir. Bkz. 4.1.4 Record Numbers (Kayıt numarası) Hakkında 

1.2.9 Reference (Referans) 

Kütüphane, referans olarak adlandırılan kayıtlar kolleksiyonunu içerir. EndNote 

kütüphanesinde oluşturacağınız referans kayıt sayısı için sınır bulunmamaktadır. Veri 

tabanı performası için 50.000 referans kaydının aşılmaması önerilmektedir. 

1.2.10 Reference Type (Referans Tipi) 

EndNote kütüphaneleri, ‘books’ (kitaplar), ‘journal articles’ (dergi makaleleri) ve 

‘newspaper articles’ (gazete makaleleri) gibi farklı kaynaklardan referanslar içerebilir. 

Bu farklı kaynaklara ‘Reference Types’ diyoruz. EndNote ‘Reference Type’ listesinde, 

yaygın olarak kullanılan referans tipleri yer almaktadır. 

1.2.11 Web of Science 

Web of Science (WoS), Clarivate Analytics tarafından ödeme karşılığında sunulan, atıf 

indekslerinden oluşan bir kolleksiyondur. Atıf indeksleri 11.000'den fazla akademik 
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dergiyi kapsamaktadır. Her yıl, yaklaşık 12.000 bilimsel konferans bildirisi 

eklenmektedir. Toplamda, 46 milyondan fazla veri içermektedir. Bu veritabanlarına 

erişim, ISI Web of Knowledge (WoK) ile edinilebilir. Bu ücretli bir hizmettir ve 

genellikle üniversitelerin aboneliği bulunmaktadır, bu sayede üniversitelerdeki 

bilgisayarlardan bu bilgilere erişilebilmektedir (Kaynak: Wikipedia). 

1.2.12 Z39.50 

Z39.50, uzak veri tabanlarındaki bilgiye erişim ve arama yapma olarak tanımlanan bir 

‘NISO’ (National Information Standards Organization) protokolüdür ve öncelikli olarak 

bibliyografik veri tabanlarındaki verileri almak için kullanılır. 

1.3 EndNote’u Başlatmak 

Aşağıdaki örneklerle ilgili, kurulum ile gelen ‘Sample_Library_X9.enl’ kütüphanesini 

default olarak; 

‘C:\Users\Public\Public Documents\EndNote\Examples’ 

ya da 

‘C:\Program Files\EndNote X9\Examples’ (32-bit Windows versiyonları için) 

‘C:\Program Files (x86)\EndNote X9\ Examples’ (64-bit Windows versiyonları için) 

klasörünün altındaki ‘Sample_Library_X9.enlx’ sıkıştırılmış kütüphanesine çift 

tıklayarak ya da EndNote’u çalıştırdıktan sonra, ‘File/Open/Open Library...’ menüsünü 

kullandığınızda açılan ekranda ‘Sample_Library_X9.enlx’ dosyasının yerini göstererek 

açabilirsiniz. 

1.3.1 Microsoft Word ile Başlatmak 

1. Microsoft Word’ü açın. 

2. EndNote tabında  butonuna basın. En son kullanılan EndNote 

kütüphanesi default olarak açılacak ve aşağıdaki ‘Kütüphane (Library) Penceresi’ 

görüntülenecektir. 

   

1.3.2 Başlat (Start) Menüsünü Kullanarak Başlatmak 

1. ‘Başlat’ menüsüne tıklayın. 

2. Menüden ‘Programlar/EndNote/EndNote Program’a tıkladığınızda en son kullanılan 

EndNote kütüphanesi varsayılan olarak açılacak ve aşağıdaki ‘Kütüphane Penceresi’ 

görüntülenecektir. 

Başlık Çubuğu Menu Çubuğu 

Kütüphane Penceresi 

Durum Çubuğu 

Tab Paneli 

Groups Paneli 

Layout Paneli 

Araç Çubuğu 
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 Not 

 ‘Registration Number’ (Kayıt Numarası) ve EndNote sürümünüzü ‘Help/About 

EndNote X9’ menüsünü kullanarak öğrenebilirsiniz. 

 ‘Edit/Preferences/Libraries’ menüsünde, ‘When EndNote starts’ listesinde bulunan 

seçenekler ile kütüphane açılma ayarlarını belirleyebilirsiniz. 

 Open the most recently used library 

 Open the specified libraries 

 Prompt to select a library 

 Do nothing 

Listeden Open the specified libraries seçildiğinde ‘Add Open Libraries’ butonu ile 

varsayılan kütüphane seçimini yapabilirsiniz. Bkz. 8.8 Libraries (Kütüphaneler) 

1.4 Ekran Yapısı 

1.4.1 Kütüphane (Library) Penceresi 

EndNote kütüphanesini açtığınızda, farklı panellerin bulunduğu ‘Kütüphane Penceresi’ 

görüntülenecektir. 

 Groups (Grup) paneli 

 Search (Arama) Paneli 

 Referans listesi paneli 

 Tab paneli 

Kütüphane penceresinin sağ alt köşesindeki ‘Layout’ butonunu kullanarak kütüphane 

görüntü düzenlemesini gerçekleştirebilirsiniz. Yedi farklı şekilde görünüm 

sağlayabilirsiniz: 

- Groups Panel: Left, Off 

- Reference Panel: Right, Right-Split, Bottom, Bottom-Split, Off  

Bir paneli etkin hale getirmek için mouse ile tıklayabilir ya da bir panelden diğerine 

geçmek için ‘F6’ tuşunu kullanabilirsiniz. 
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1.4.1.1 Groups (Grup) paneli 

Gruplar, referans kayıtlarına daha kolay erişim için kullanılmaktadır. Kütüphane 

penceresi listesinin solundaki panel, çeşitli grup tiplerini içeren grup setlerinden 

oluşmaktadır. Bkz. 5.8 Groups Paneli. Grupların seçimi ve menü komutları seçtiğiniz 

kütüphane görüntüleme moduna göre değişmektedir. 

 

 Local Library Mode: Online gruplar haricindeki otomatik gruplar, kişisel gruplar ve 

akıllı grupların görüntülendiği kütüphane modudur. Bu mod, online aramalar 

sırasında bulduğunuz referans kayıtlarını yanlışlıkla açık olan kütüphanenize 

eklemenize engel olur. Varsayılan kütüphane modudur. 

 Online Search Mode: Online veri tabanlarından referans kayıtları aranarak, 

download edilebilir. Bu modda sadece ‘Online Search’ grubu yer almaktadır. 

Referanslar geçici bir kütüphaneye download edilecektir. EndNote’u kapattığınızda 

ya da diğer kütüphane seçeneklerine geçiş yaptığınızda referanslar silinecektir. 

Bkz. 4.2 ‘Online Search’ import işlemi 

 Integrated Library & Online Search Mode: Tüm grup ve komutlar bu modda yer 

almaktadır. Online veri tabanından referansları download ettiğinizde, EndNote bu 

kayıtları ‘Online Search’ grup setinin altındaki gruba ve açık olan kütüphanenize 

kaydetmektedir. 

Bulunan referans kayıtlarını saklamak istemediğinize karar verirseniz, kayıtları seçin ve 

‘Trash’ klasörüne taşıyın. 

1.4.1.2 Search (Arama) Paneli 

Arama paneli EndNote penceresinin en üstünde görüntülenmektedir. Pencerenin sağ 

üst köşesindeki  geçiş düğmesi arama panelinin görüntülenmesini 

ya da gizlenmesini sağlamaktadır. Bkz. 5.5 EndNote Kütüphanelerinde Arama 

 

1.4.1.3 Referans Listesi (Reference List) Paneli 

Referans listesi seçili olan grubun tüm referanslarını görüntülemektedir. Seçenekler 

araç çubuğunda da yer almaktadır. 

Groups paneli 

Referanslar 

Tab paneli 

Layout 

Bibliyografik  Output Stili 

 Kütüphane adı 

Kolon başlıkları 
Search (Arama) tabı 

Preview (Önizleme) tabı 

PDF tabı Reference tabı 

Local Library Mode 

Online Search Mode 
Integrated Library&Online 

Search Mode 
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 Sıralama (Sort Order) 

Sıralama düzenini kolon başlığına tıklayarak ya da Tools > Sort Library’den 

değiştirebilirsiniz. Bir kütüphaneyi sıraladığınızda, bu sıralama düzeni kütüphaneyi 

kapatıp açtığınızda korunacaktır. Bkz. 8.12 Sorting (Sıralama) 

 Kolon genişliği ayarı 

- Mouse’u kolon başlıklarının arasına koyun. 

- Kolon ayracını sürükleyerek genişliği ayarlayın. 

 Görüntüleme Alanları (Display fields) 

Default olarak kütüphane penceresinde ilk alan ‘Read/Unread’ alanıdır. Takip eden 

diğer alanlar: 

 File Attachments (paperclip). 

 Author 

 Year 

 Title 

 Rating 

 Journal / Secondary Title 

 Last Updated 

 Reference Type 

 URL 

Kolon başlıklarını sürükleyerek görüntü sırasını değiştirebilirsiniz. Edit > Preferences 

> Display Fields kullanılarak alan ekleyebilir, kaldırabilir ya da ismini 

değiştirebilirsiniz. Sadece ilk yazar adı yerine tüm yazar adlarının ‘Author’ başlığı 

altında görüntülenmesini istiyorsanız, ‘Display all authors in the Authors field’ onay 

kutusunu işaretleyin. Bkz. 8.2 Display Fields (Alanların Görüntülenmesi) 

 Referans Listesinde Gezinme 

Referans kayıtlarını taramanın farklı yolları bulunmaktadır. Bkz. 5.2.1 Library 

(Kütüphane) Penceresinde Gezinti  

 Display Font 

Yazı tipi değişiklikleri için, ‘Edit > Preferences > Display Fonts’u kullanabilirsiniz. 

Bkz. 8.3 Display Fonts (Görüntülenen Yazı Tipleri) 

1.4.1.4 Tabs panel 

Reference, Preview ve PDF Viewer sekmelerini aşağıdaki gibi kullanabilirsiniz: 

 Display Button (Görüntüleme butonu) kullanımı 

Kütüphanenin sağ üst köşesindeki görüntüleme butonuna tıklayarak istediğiniz tabı 

aktif hale getirebilirsiniz. 

 

 Tab kullanımı 

Seçilen bir referansın içeriğini düzenlemek için ‘Reference’ tabını kullanabilirsiniz. 

Görüntüleme butonu 
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Seçilen referansı geçerli stilde görüntülemek için ‘Preview’ tabını kullanabilirsiniz. 

 

 Eklenen PDF dosyalarını ‘PDF Viewer’ panelinde görüntülemek ve not eklemek 

için ‘Attached PDF’s’ tabını seçin. 

 

 Not 

 Kütüphane ‘Tab Paneli’nde bulunan ‘Reference’ sekmesi ile, seçilen referansa ait 

detayları kolaylıkla görüntüleyebilir ve değişiklik yapabilirsiniz. 

 

Open PDF Email PDF 
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 EndNote kütüphanenizde herhangi bir referans kaydı arama işlemi için ‘Search’ 

panelini kullanabilirsiniz. 

 

 Online veri tabanlarında arama yapmak için, arama yapılmak istenen veri tabanı 

‘Kütüphane Penceresi/Groups Paneli/Online Search’ grubunun altında bulunan 

listede yer alıyorsa listeden seçilebilir. Eğer, listede bulunmayan bir veri tabanında 

arama yapılacaksa ‘more…’ seçeneği ya da menülerden ‘Tools/Online Search...’ 

komutu kullanılabilir. Açılan ‘Choose a Connections’ ekranında, arama yapılmak 

istenen veri tabanı seçildiğinde, veri tabanı bağlantısı kurulur ve ‘Search’ paneli 

otomatik olarak aktif duruma gelir. ‘Search’ paneli aktif hale geldikten sonra arama 

kriterleri girilerek arama işlemi gerçekleştirilebilir. 

 

1.4.2 Referans Penceresi 

‘Kütüphane Penceresi’nde, bir referans kaydına çift tıklayarak, referans detaylarının 

görüntüleneceği ‘Referans Penceresi’ne erişilebilir. Bu pencerede, referansa ait alan 

bilgileri düzenlenebilir. Referansa ait tüm bilgiler, kendi alanlarında 

görüntülenmektedir. Referans tipi başlık çubuğunun altında görüntülenir. Açılan 

referansın başlık çubuğunda görüntülenen ‘Author’, ‘year’ ve ‘record number’ atıf 

bilgisidir. örnek: [Yovel, 2008 #59]. 

Daha önce arama yapılan veri tabanları listesi 

Search paneli 
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 Not 

 Referans penceresinde bulunan ‘Options’  butonunu altındaki  

komutu ile veri içermeyen alanları görüntüleyebilir/gizleyebilirsiniz.  

komutu ile ‘Rating’ alanını görüntüleyebilir/gizleyebilirsiniz. Default olarak 

referanslardaki tüm alanlar görüntülenmektedir. 

 PDF dosya içeriğini görüntüleyebilirsiniz. PDF dosyası ve URL adresi örnek olması 

için sonradan eklenmiştir. 

 Attach File… butonu ile dosya ekleyebilirsiniz. 

 Sol üst köşedeki gezinme tuşlarını, kütüphanenizdeki referansları sıra ile 

görüntülemek için kullanabilirsiniz. Bkz. 5.2.2 Referans Penceresinde Gezinti. 

1.5 Araç Çubukları 

En çok kullanılan komutlara kolay erişim için EndNote araç çubuklarını kullanabilirsiniz. 

‘Library’, ‘Reference’, ‘CWYW’, ‘PowerPoint  ve ‘PDF’ olmak üzere beş farklı araç 

çubuğu bulunmaktadır. Araç çubuklarının içeriği aşağıda ayrıntılı olarak 

açıklanmaktadır. 

1.5.1 Kütüphane Araç Çubuğu 

  

 Local Library Mode lokal kütüphane işlemleri için kullanılır; 

 Online Search Mode online arama işlemleri için kullanılır; 

 Integrated Library& lokal kütüphane ve online arama işlemlerinin birlikte  

 Online Search Mode görüntülenmesi için kullanılır;  

 Bibliographic Output Style Output Style seçmek için kullanılır; 

 Copy to Local Library Online Search Mode’da istenilen arama sonuçlarını Local 

Library’e eklemek için kullanılır; 

Alan adları kalın olarak görüntülenir 

Veri alanı 

Referans Tipi 

İleri/Geri butonları 

Kayıt Numarası 

Rating alanı 

Tam Metin (Fulltext) Pdf Dosyası 

Boş alanları 

görüntüle/gizle 

görüntüle/gizle 
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 New Reference yeni bir kayıt eklemek istendiğinde, ‘New Reference’ 

penceresini açmak için kullanılır; 

 Online Search online arama işlemleri için bağlantı dosyası seçim 

ekranına ulaşmak için kullanılan butondur; 

 Import referans import penceresine ulaşmak için kullanılır; 

 Export referansları RTF, HTML, XML ve TXT formatlarında 

export etmek için kullanılır; 

 Find Full Text tam metinleri download etmek için kullanılır; 

 Open Link referans kaydına ait URL adresine ulaşmak için 

kullanılan butondur; 

 Open File referans kaydına eklenen dosyaları açmak için 

kullanılan butondur; 

 Insert Citation atıf eklemek için kullanılan butondur; 

 Format Bibliography atıf ve referans formatı belirlemek için kullanılır; 

 Go To Word Processor Word dokümanına dönmek için kullanılır; 

 Sync Library Desktop ve Web kütüphanelerizin senkronizasyonu için 

kullanılır; 

 Share Library Diğer EndNote kullanıcılarını, senkronize edilen 

kütüphanenize erişime davet etmek için kullanılır; 

 Activity Feed Paylaşılan kütüphanenizdeki son işlem kayıtlarını takip 

etmek için kullanılır; 

 Help ‘Help’ menüsüne ulaşmak için kullanılır; 

 Quick Search hızlı arama yapmak için kullanılır;  

 Show/Hide Search Panel Arama panelini görüntülemek ya da gizlemek için 

kullanılır; 

1.5.2 Referans Araç Çubuğu 

  

 Previous Reference önceki referans kaydına gitmek için kullanılır; 

 Next Reference sonraki referans kaydına gitmek için kullanılır; 

 Reference referans kaydının içeriğini görüntülemek için 

kullanılır; 

 Attached PDFs ekli PDF’i görüntülemek için kullanılır; 

 Attached File... dosya eklemek için kullanılır; 

 Find References Updates... referans kaydına ait güncellemelerin bulunup 

bulunmadığını kontrol etmek için kullanılır; 

 Open Link referans kaydına ait URL adresine ulaşmak için 

kullanılan butondur; 

 Open File referans kaydına eklenen dosyalara ulaşmak için 

kullanılan butondur; 

 Spell Check ‘Spell Check’ penceresine ulaşmak için kullanılır; 

 Mark as Read/Unread referans kaydını okundu/okunmadı olarak 

işaretlemek için kullanılır; 

 Attach Figure referans kaydına resim veya şekil eklemek için 

kullanılan butondur; 

 Format Bibliography atıf ve referans formatı belirlemek çin kullanılır; 

 Return To WordProcessor word dokümanına dönmek için kullanılır; 

 Font yazı tipini belirlemek için kullanıllır; 

 Size yazı tipi boyutunu belirlemek için kullanıllır; 

 Bold teksti kalın yapmak için kullanılır; 

 Italics teksti italik yapmak için kullanılır; 
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 Underline tekstin altını çizmek için kullanılır; 

 Plain teksti düz yapmak için kullanılır 

 Superscript üst simge yapmak için kullanılır; 

 Subscript alt simge yapmak için kullanılır; 

 Symbol Font sembol eklemek için kullanılır; 

 Change Case harf değişimi için kullanılır; 

 View Source Record referans kaydına ait Web of Science kimlik 

numarası bulunuyorsa, Web of Science kaynak 

kaydına erişmek için kullanılır; 

 View Related Records referans kaydına ait Web of Science kimlik 

numarası bulunuyorsa, Web of Science ilgili kayıt 

listesine erişmek için kullanılır. 

1.5.3 Cite While You Write Tab 

   

Citations Grubu 

 Insert Citation veri tabanınızdan, bir veya birden fazla referans  

kaydını seçmek ve atıf yapmak için, arama kriteri 

girilen ekrana erişim amaçlı kullanılır; 

 Insert Citation  

- Insert Citation... veri tabanınızdan, bir veya birden fazla referans  

kaydını seçmek ve atıf yapmak için, arama kriteri 

girilen ekrana erişim amaçlı kullanılır; 

- Insert Selected Citation(s) EndNote ekranında seçilen, referans(ları) 

 eklemek için kullanılır; 

- Insert Note... yeni bir not eklemek için kullanılır; 

- Insert Figure... EndNote ‘Figure’ alanında bulunan, imaj/grafik  

dosyasını eklemek için kullanılır;  

 Go to EndNote EndNote programına, Word içerisinden erişmek 

için kullanılır; 

 Edit & Manage Citation(s) seçilen atıf(ları) düzenlemek için kullanılır; 

 Edit Library Reference(s) seçilen atıfa ait, EndNote referans kayıt ekranını 

açmak için kullanılır; 

Bibliography Grubu 

 Style atıf ve bibliyografya stilini seçmek için kullanılır; 

 Update Citations  yapılan stil değişikliklerini güncellemek için  

 and Bibliography kullanılır;  

 Convert Citations and Bibliography 

- Convert to Unformatted biçimlendirilmiş atıfları, ‘geçici atıflara’,   

Citations dönüştürmek için kullanılır; 

- Convert to Plain Text dokümandan EndNote kodunu kaldırarak, 

 düz metne dönüştürmek için kullanılır; 
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- Convert Reference Manager Reference Manager ile oluşturulmuş atıfları,   

Citations to EndNote EndNote formatına dönüştürmek için kullanılır; 

- Convert Word  Word özellikleri ile oluşturulmuş atıfları, EndNote   

Citations to EndNote formatına dönüştürmek için kullanılır; 

 Categorize References  

- Group References by Bibliyografyadaki referansların, oluşturulan kişisel 

Custom Categories kategorilere göre gösterilmesi için kullanılır;  

- Configure Categories  Bibliyografyadaki referansların, kategorilere 

 ayrılması için kullanılır; 

 Instant Formatting is On/Off  

- Turn Instant Formatting Metin için referanslarda, anında biçimlendirme 

On/Off özelliğinin açılıp/kapatılması için kullanılır; 

- Configure Instant Anında biçimlendirme özelliğinin yapılandırılması 

Formatting için kullanılır; 

 Bibliography Preferences ( ) atıf ve bibliyografya biçim ayarları için kullanılır; 

Tools Grubu 

 Export to EndNote 

- Export Travelling Library bir Word dokümanında bulunan referansları   

 EndNote kütüphanesine export etmek için  

 kullanılır; 

- Export Word  Word özellikleri ile oluşturulmuş atıfları export 

 Citations etmek için kullanılır; 

- Export Word  Word özellikleri ile oluşturulmuş atıfları Master 

Master List List olarak export etmek için kullanılır; 

 Manuscript Matcher Çalışmanın yayınlanabileceği dergi önerilerini 

görüntülemek için kullanılır;  

 Preferences ‘Cite While You Write’ seçeneklerini düzenlemek 

için kullanılır; 

 EndNote Help ‘Cite While You Write’ yardımı görüntülemek için 

kullanılır. 

1.5.4 PowerPoint Araç Çubuğu 

  

Citations Grubu 

 Insert Citation veri tabanınızdan, bir veya birden fazla referans 

kaydını seçmek ve atıf yapmak için, arama kriteri 

girilen ekrana erişim amaçlı kullanılır; 

 Insert Selected Citation(s) EndNote ekranında seçilen referans(ları)   

 eklemek için kullanılır; 
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References Grubu  

 Insert Reference veri tabanınızdan, bir veya birden fazla referans 

kaydını seçmek ve referans listesini oluşturmak 

için, arama kriteri girilen ekrana erişim amaçlı 

kullanılır; 

 Insert Selected Reference(s) EndNote ekranında seçilen referanslara ait, 

referans listesini oluşturmak için kullanılır; 

Formatting Grubu 

 Style atıf ve bibliyografya stilini seçmek için kullanılır; 

 

Tools Grubu 

 Go to EndNote EndNote programına Power Point içerisinden 

 erişmek için kullanılır; 

 EndNote Help Atıf ve referans yardımı görüntülemek için  

 kullanılır; 

1.5.5 PDF Araç Çubuğu 

 

 Open/Close PDF PDF’i referans penceresinde açıp kapatmak için 

kullanılır; 

 Save PDF PDF’i kaydetmek için kullanılır; 

 Print PDF’i yazdırmak için kullanılır; 

 E-mail PDF PDF’i e-mail ile göndermek için kullanılır; 

 Previous Page / Next Page önceki / sonraki sayfaya ulaşmak için kullanılır; 

 Go to belirli bir sayfaya gitmek için kullanılır; 

 Zoom Out / Zoom in / Zoom sayfayı yakınlaştırmak / uzaklaştırmak / görüntü 

yüzdesi için kullanılır; 

 Rotate Counterclockwise /  sayfayı saat yönü tersine / saat yönüne  

 Rotate Clockwise döndürmek için kullanılır;   

 Sticky Note belirlenen yere not girmek için kullanılır; 

 Highlight Text belirlenen metni vurgulamak için kullanılır; 

 Underline Text belirlenen metnin altını çizmek için kullanılır; 

 Strikeout Text belirlenen metnin üstünü çizmek için kullanılır; 

 Find PDF içinde arama yapmak için kullanılır; 

 Find Previous / Find Next önceki / sonraki arama kaydını bulmak için 

kullanılır. 
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1.6 Sağ-Tuş Menüleri 

Tıklama Yeri Alanı Sağ-tuş menüsü 

Library (Kütüphane) 

Listesi  

 

 

Group (Grup) Listesi 

 

 

 

Edit (Düzen) Listesi 
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1.7 Kısayol Tuş Komutları 

Komutlar Eylem 

Ctrl + O Kütüphane Aç 

Ctrl + W Kütüphane Kapat (aktif) 

Ctrl + S Kaydet 

Ctrl + P Yazdır 

Ctrl + Q Çıkış 

Ctrl + Z Geri Al (yalnızca en son yapılan eylem) 

Ctrl + X Kes 

Ctrl + C Kopyala 

Ctrl + V Yapıştır 

Ctrl + A Tümünü Seç / Tümünü Seç İptal 

Ctrl + K Copy Formatted 

Ctrl + R Change Text … 

Ctrl + N New Reference (Yeni Referans) 

Ctrl + E Edit Reference (Referans Düzenle) 

Ctrl + D Delete Reference (Referans Sil) 

Ctrl + M Show All References (Tüm Referansları Göster) 

Ctrl + Y Spell Check (Yazım Denetimi) 

Ctrl + 1 Açılan referans kaydında seçilen alana ait terimler listesini 

(Term List) açmak için kullanılır 

  

İleri/Geri komutları Eylem 

Ctrl + Page Down Sonraki Referans (Edit penceresinde) 

Ctrl + Page Up Önceki Referans (Edit penceresinde) 

Home İlk referansa git 

End Son referansa git 

Ctrl + F Referans Ara (Referans Listesinde) 

Ctrl + J Go To … (Edit penceresinde) 

  

Biçim komutları Eylem 

Ctrl + T Seçilen metnin düz yazı (plain size) boyutuna getirir 

Ctrl + L Seçilen metnin düz yazı (plain font) tipine getirir 

Ctrl + B Kalın 

Ctrl + I İtalik 

Ctrl + U Altını Çiz 

Ctrl + Shift + Üst Karakter 

Ctrl + = Alt Karakter 

Ctrl + 2; Ctrl + 5 Çift satır aralığı; 1.5 satır aralığı 
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CWYW komutları Eylem 

Alt + 0 Insert Note (Not Ekle) 

Alt + 1 Return to Word / Go to EndNote (Word’e Dön / EndNote’a 

Git) 

Alt + 2 Insert Selected Citation(s) (Seçilen atıf(lar)ı ekle) 

Alt + 3 Format Bibliography (Bibliyografya Biçimi) 

Alt + 4 Unformat Citations 

Alt + 5 Edit Library References (Kütüphanedeki referansları 

düzenle) 

Alt + 6 Edit Citation(s) (Atıf(lar)ı Düzenle) 

Alt + 7 Insert Citation(s) (Atıf(lar)ı Bul) 

Alt + 8 Export Traveling Library 

Alt + 9 Cite While You Write Preferences (Cite While You Write 

Seçenekleri) 
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2 Kütüphane (Library) Oluşturma, 

Açma, Kapatma 

Kütüphaneler, referans kayıtlarını, her bir referans kaydıda, 54 alana kadar bilgi 

içerebilir. 

2.1 Kütüphane Oluşturma 

Referans kayıtlarının ekleneceği boş bir kütüphane oluşturmak için, aşağıdaki işlem 

sırası izlenmelidir. 

1. ‘File/New’ menüsünü seçin. 

‘New Reference Library’ penceresi görüntülenecektir. 

2. ‘Dosya adı’ alanına yeni kütüphane adını girin ve kütüphanenizi kaydetmek 

istediğiniz yeri belirleyin. 

3. ‘Kaydet’ butonuna basın. 

Artık, EndNote kütüphanenize referans kayıtlarınızı ekleyebilirsiniz. Bkz. 4 Referans 

Kaydı Girme 

  

 Not 

 Veri tabanı adı 255 karakterden uzun olmamalıdır. Boşluk kullanılabilir. Fakat, veri 

tabanları server üzerinde saklanıyor ise, bu karakter sayısında uzun dosya adları 

kullanılamamaktadır. DOS standartlarına göre maksimum karakter sayısı 8, dosya 

uzantısı olarak da 3 karaktere izin verilmektedir. 

 Oluşturulacak kütüphane sayısında bir sınır yoktur. Kütüphanelerinizin boyut limiti, 

onları depolayacağınız disk alanı ile sınırlıdır. 

 Aynı anda birden fazla kütüphane ile çalışılabilmektedir. Ancak, birden fazla küçük 

kütüphane yerine, çalışmanız için atıf işlemi gerçekleştireceğiniz referansların 

bulunduğu, büyük bir kütüphane ile çalışmanız önerilmektedir. 

2.2 Kütüphane Kapatma 

EndNote kütüphanelerini kapatmak için aşağıdaki seçenekleri kullanabilirsiniz: 

  butonu kullanılabilir; 

 ‘File/Close Library’ menüsü kullanılabilir; 

 ‘Ctrl+W’ tuş kombinasyonu kullanılabilir; 

 Görev çubuğunda sağ-tuş yaparak açılan menüden ‘Close’ (Kapat) seçilebilir. 
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2.3 Kütüphane Açma 

2.3.1 EndNote Kütüphaneleri Açma 

2.3.1.1 ‘Başlat’ menüsünü kullanarak  

1. ‘Başlat (Start)’a tıklayın 

2. ‘EndNote Program’ menüsünü seçin. 

Windows en son açılan 15 dosyayı bu listede tutar. 

3. Açmak istediğiniz kütüphaneyi seçin  

(dosya EndNote ikonu  ile listede yer alacaktır). 

2.3.1.2 Menü Çubuğu / Kısayol Tuşları ile açma 

1. EndNote’u başlattıktan sonra ‘File/Open/Open Library...’ menüsünü seçin veya 

‘Ctrl-O’ kısayol tuş kombinasyonunu kullanın. 

2. Görüntülenen ekrandan: 

- veri tabanı (kütüphanelerinizin bulunduğu) klasörünü belirleyin. 

- açmak istediğiniz kütüphane adını seçin; 

 (birden fazla dosyayı aynı anda açmak için ‘Ctrl’ tuşunu kullanın). 

3. ‘Aç’ (Open) butonuna basın. 

 Not 

 Eğer, bir kütüphaneyi açamıyorsanız dosya zarar görmüş olabilir, sorunu gidermek 

için ‘Tools/Recover Library’ menüsünden veri tabanını onarmayı deneyin. Bkz. 3.3 

Kurtarma (Recovering) 

 EndNote son kullanılanlar listesinde oniki dosyayı tutar. Son kullanılan dosyalardan 

birini açmak istediğinizde, ‘File/Open Recent’ menüsünü kullanabilirsiniz. 

 EndNote ile aynı anda birden fazla kütüphane ile çalışabilirsiniz. Açık olan 

kütüphane listesine ‘Window’ menüsünden ulaşabilirsiniz. 

 EndNote default olarak, en son kullanılan EndNote kütüphanesini otomatik olarak 

açmaktadır. Bu seçenek, ‘Edit/Preferences/Libraries’ menüsü kullanılarak 

değiştirilebilir. 

2.3.2 Eski Versiyonlar ile Oluşturulan EndNote Kütüphanelerini Açma 

EndNote X9 ile, EndNote 8’den X8 versiyonuna kadar oluşturulmuş kütüphaneleri 

herhangi bir işlem yapmadan doğrudan açabilirsiniz. Ancak, EndNote 8 öncesi (5, 6 ve 

7) versiyonlar için aşağıdaki işlem sırasını takip edebilirsiniz: 

1. ‘File/Open/Open Library...’ menüsünü seçin. 

2. Açılan ekranda, EndNote 8 versiyonu öncesi hazırlanmış kütüphaneyi bulun. ‘Aç’ 

butonuna basın. 

3. Seçilen kütüphanenin eski bir versiyonla hazırlandığı ve bu kütüphanenin 

dönüştürülmesini isteyip istemediğinizi belirten bir uyarı mesajı alacaksınız. 

‘Tamam’ butonuna basın. 

4. Yeni oluşturulan kütüphanenin adını girdikten sonra ‘Kaydet’ butonuna bastığınızda 

eski versiyonla oluşturulmuş kütüphane yeni versiyona dönüştürülecektir. 

2.3.3 Üst Versiyonlar ile Oluşturulan Endnote Kütüphanelerini Açma 

EndNote X, X1, X2, X3, X4, X5, X6, X7 ve X8 ile tamamen uyumludur, bu nedenle 

kütüphanelerinizi bu versiyonlar arasında düzgün bir şekilde paylaşabilirsiniz. 

EndNote X9 kütüphaneleri, EndNote X6'dan önceki versiyonlar ile geriye dönük olarak 

uyumlu değildir. Eğer, EndNote X9 ile oluşturulmuş bir kütüphaneyi önceki bir 

versiyonda açmak istiyorsanız, iki farklı seçenek bulunmaktadır: 

 RIS-filtresi kullanılarak, EndNote’un yeni versiyonlarından eski versiyonlarına 

kütüphane export işlemi gerçekleştirilebilir. 

 EndNote kütüphanelerini, eski versiyonlarda yeniden oluşturmak için ‘Recover’ 

(Kurtarma) özelliği kullanılabilir. 
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2.3.4 ProCite veya Reference Manager Veri Tabanlarını Açma 

2.3.4.1 ProCite Veri Tabanlarını Dönüştürme 

EndNote ile ProCite veri tabanlarınızı, kolaylıkla EndNote kütüphanelerine 

dönüştürebilirsiniz. Orjinal ProCite veri tabanlarınız eksiksiz EndNote kütüphanelerine 

dönüştürülür ve kopyalanır. 

ProCite veri tabanlarınızı dönüştürmek için, aşağıdaki işlem sırasını izleyin: 

1. ‘File/Open/Open Library...’ menüsünü seçin. 

2. Açılan ekranda ‘Dosya türü’ listesinden ProCite database (*pdt) dosya türünü 

seçin. 

3. Dönüştürmek istediğiniz ProCite veri tabanını seçin ve ‘Aç’ butonuna basın. 

Aşağıdaki mesaj ekranı görüntülenecektir. 

  

4. Bu ekrandan: 

- ‘Convert’ butonuna basarak dönüştürme işlemini gerçekleştirebilir veya 

- ‘Customize’ butonuna basarak ProCite çalışma formlarında ve EndNote-ProCite 

alan eşleştirmelerinde değişiklik yapabilirsiniz. 

5. ‘Convert’ butonuna bastığınızda ‘Save Converted Library as’ penceresi 

görüntülenecektir, ‘Dosya adı’ alanına yeni bir kütüphane adı girin veya ProCite 

adını doğrudan kullanılarak ‘Kaydet’ butonuna basın. 

Dönüştürme işlemi tamamlanacak ve sonrasında kütüphane EndNote ile açılacaktır. 

2.3.4.2 Reference Manager Veri Tabanlarından (Database) Export İşlemi 

Reference Manager ile export için, aşağıdaki işlem sırasını izleyin: 

1. EndNote veri tabanına dönüştürmek istediğiniz Reference Manager veri tabanını 

açın. 

2. ‘File/Export’ menüsünü seçin. 

3. ‘Export References’ penceresi açılacaktır 

-  butonuna basarak dosya adını girin ve kayıt yerini belirleyin. 

- Export formatı olarak RIS’i seçin ve 

- ‘All references in list’i seçin 

4. ‘Export’ butonuna basın. EndNote ile tekst dosyası import işlemi için Bkz. ‘4.4 

Tekst Dosyası Import İşlemi’ 

  

Kayıt yerini seçin ve 

bir dosya adı girin 
RIS’i Seçin 

Bir seçenek belirleyin 
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3 Yedekleme (Backing up), Silme 

(Deleting), Kurtarma (Recovering), 

Sıkıştırma (Compressing) 

3.1 Yedekleme (Backing Up) 

Birçok nedenle dosyalarınız zarar görebilir: CD’ler veya hard diskler bozulabilir, virüsler 

nedeniyle dosyalarınız silinebilir veya bozulabilir. Bu durum teziniz veya çalışmalarınız 

ile ilgili sürenin uzamasına neden olacaktır. Eğer dokümanlarınız herhangi bir şekilde 

zarar görmüş ise (bu büyük veya küçük bir zarar olabilir); yedek kopyalarınız size 

saatler belki günler kazandırabilir. 

EndNote kütüphanenize, referanslar eklendikçe kütüphanenizin değeri ve önemi 

artacaktır. Bu nedenle, EndNote kütüphaneniz ile birlikte diğer önemli dosyalarınızın da 

yedeğini almanız önerilmektedir. Yedeğini alacağınız önemli dosyalar aşağıda yer 

almaktadır: 

 EndNote kütüphanesi ve kütüphanenizin bir parçası olan grafikleri, imajları, 

tabloları vb. bilgileri içeren .DATA klasörü 

 Kişisel Reference Types dosyası 

 Değiştirilen Styles, Filters ve Connection Files 

 Kelime işlemci dokümanları 

Yedeklerinizi veri tabanınızın default lokasyonundan farklı bir lokasyonda saklayın. 

3.1.1 EndNote kütüphaneleri 

1. ‘File/Save a Copy’ menüsünü seçin. 

2. ‘Save a Copy’ ekranı görüntülenecektir. 

3. ‘Konum’ (Save in) listesinden dosya kayıt yerini seçin (default lokasyondan farklı 

bir lokasyon seçin). ‘Dosya adı’ (File name) kutusunda kütüphane adı önceden 

girilmiş olacaktır (orjinal adına Copy eklenmiş şekilde), isterseniz yeni bir dosya adı 

girebilirsiniz. 

   

4. ‘Kaydet’ (Save) butonuna bastığınızda yedeklediğiniz EndNote kütüphaneniz 

oluşturulacaktır. 

Gerekli olan tüm kütüphane dosyalarını ve klasörlerini kopyalamak isterseniz, 

sıkıştırılmış filename.enlx dosyası oluşturabilirsiniz. Bkz. Error! Reference source 

not found. Sıkıştırma (Compressing) 
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3.1.2 Kişisel Reference Types 

Kişisel referans tiplerini yedeklemek için; 

1. Edit > Preferences’ı seçin. 

2. ‘Preferences’ ekranından ‘Reference Types’ı seçin. 

3. Dosya ekranını görüntülemek için Export butonuna tıklayın. 

4. Dosyanızın adını verin ve kaydetmek istediğiniz klasörü seçin. ‘Save’ butonuna 

tıklayın. 

Referans tiplerini yüklemek için; 

1. Edit > Preferences’ı seçin. 

2. ‘Preferences’ ekranından ‘Reference Types’ı seçin. 

3. Dosya ekranını görüntülemek için ‘Import’  butonuna tıklayın. 

4. Export ettiğiniz .xml dosyasını seçin ve açın. 

Referans tipleri hakkında ayrıntılı bilgi için; Bkz. 7 6.5 

3.1.3 Output Styles, Filters ve Connection Files 

Değiştirilen stillerin de yedeği alınmalıdır, böylece kişiselleştirilmiş stilinize bir şey 

olursa bibliyografik formatı yeniden oluşturmak zorunda kalmazsınız. Benzer şekilde, 

kişiselleştirilmiş filtreleri ve bağlantı dosyaları da yedeklenmelidir, böylece 

referanslarınızı istediğiniz gibi import etmek için yapılan değişiklikleri yeniden 

oluşturmanız gerekmez. 

Kurulum ile, Styles, Connections ve Filter klasörleri default olarak, EndNote program 

klasörüne yüklenmektedir: 

C:\Program Files\EndNote X9 

Bu dosyaları değiştirmediyseniz yedeğini almanıza gerek yoktur. Çünkü, bu dosyalar 

her zaman kurulum paketi ile default olarak gelmektedir. 

Bu dosyalardan birinde değişiklik yaptıktan veya yeni bir dosya oluşturduğunuzda 

kişisel Styles, Filters veya Connections klasörüne kaydedilir. Bu klasörler, default 

olarak aşağıdaki dizinde yer almaktadır:  

C:\Users\Username\Documents\EndNote\Styles 

3.1.4 Kelime işlemci dokümanları 

EndNote atıflarını içeren yazdığınız makaleler, EndNote yedek dosyalarınız ile birlikte 

saklanmalıdır. 

3.2 Silme (Deleting) 

EndNote, istenmeyen bir kütüphane silme işlevi içermemektedir. Silmek istediğiniz 

kütüphaneyi kapattıktan sonra kütüphane dosyasını ve ilişkili .DATA klasörünü ‘Delete’ 

butonunu kullanarak silebilirsiniz. 

1. Silmek istediğiniz veri tabanının kapalı olduğundan emin olun. 

2. Kütüphanenin bulunduğu klasörü açın 

- libraryname.enl dosyasını seçin 

- libraryname.DATA klasörünü seçin 

3. Sağ tuş menüsünden Delete komutuna ya da klavyeden Delete butonuna basın. 

4. ‘Dosya Silinmesini Onayla’ (Confirm File Delete) ekranındaki uyarı mesajını kabul 

etmek için ‘Evet’ (Yes) butonuna basın. 

EndNote içerisinden de bir kütüphaneyi silebilirsiniz:  
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1. Silmek istediğiniz veri tabanının kapalı olduğundan emin olun. 

2. Menülerden ‘File>Open Library…’ seçin. 

3. ‘Select a Reference Library’ ekranında: 

- libraryname.enl dosyasını seçin 

- libraryname.DATA klasörünü seçin 

4. Sağ tuş menüsünden Delete komutuna ya da klavyeden Delete butonuna basın. 

5. ‘Select a Reference Library’ ekranını kapatmak için ‘Cancel’ butonuna basın. 

 Not 

 Eğer, açık bir kütüphaneyi silmeye çalışırsanız, hata mesajı görüntülenecektir. 

‘Tamam’ (OK) butonuna basın ve kütüphaneyi kapatıktan sonra silme işlemini 

gerçekleştirin. 

 Bir Word dokümanında, bibliyografya oluşturmak için kullanacağınız EndNote 

kütüphanesini silmeyin. 

 Eğer, bir kütüphaneyi yanlışlıkla sildiyseniz ve .DATA  klasörünüz hala duruyorsa 

aşağıda bulunan işlem sırasını uygulayarak kütüphanenizi .DATA klasörü ile aynı 

yerde yeniden oluşturabilirsiniz:  

1. Bir tekst-editör açın, örneğin ‘Not Defteri’ (NotePad). 

2. ‘Dosya/Farklı Kaydet...’ (File/Save as...) menüsünü kullanarak boş bir 

doküman olarak kaydedin. 

3. Yanlışlıkla silinen orjinal kütüphane ile aynı yerde ve aynı dosya adını kullanın 

(dosya uzantısı .enl olarak değiştirilmelidir). 

4. EndNote programını açın. 

5. ‘Dosya/Aç’ (File/Open) menüsünden ‘Not Defteri’ ile oluşturduğunuz dosyayı 

seçin. Kütüphane anında oluşturulacaktır. 

3.3 Kurtarma (Recovering) 

Bazen bilgisayarınızdaki dosyalar zarar görebilir. Eğer, EndNote kütüphaneleriniz zarar 

görmüşse, açmaya çalıştığınızda veya referanslarla çalışırken hata mesajı alabilirsiniz. 

Böyle bir durumda, çalışmalarınızın aksamaması için, önemli dokümanlarınızı düzenli 

olarak yedekleyin. Şayet, zarar gören EndNote kütüphanelerinizin yedeği yoksa, 

kütüphanelerinizi onarmak için, ‘Recover Library’ komutunu kullanabilirsiniz. 

Zarar gören EndNote kütüphanelerinizi onarmak için, aşağıdaki işlemleri takip edin: 

1. Onarmak istediğiniz EndNote kütüphaneniz açık ise kapatın. 

2. ‘Tools/Recover Library...’ menüsünü seçin. 

3. Uyarı mesajını kabul etmek için ‘Tamam’ (OK) butonuna basın. 

  

4. ‘Select Library to Recover’ penceresi görüntülenecektir, onarmak istediğiniz 

EndNote kütüphanenizi seçin ve ‘Aç’ (Open) butonuna basın. 
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5. ‘Save Recovered Library as’ penceresi görüntülenecektir. 

‘Dosya adı (File name)’ alanında onarılan kütüphane adı olarak dosya adına –

Saved eklenmiş olarak görüntülenir.  

   

6. ‘Kaydet’ (Save) butonuna basıldığında kaç tane referans kaydının onarıldığına dair 

bilgi mesajı görüntülenecektir. 
  

  

7.  ‘Tamam’ (OK) butonuna bastığınızda işlem tamamlanacaktır. 

 Not 

 Onarma işlemini yapmadan önce kütüphanenizin yedeğini alın. 

 Kurtarılan kütüphanenin bir yedeğini alın. 

 Açık kütüphaneler onarılamaz. 

 Büyük kütüphanelerin onarım işlemi daha uzun sürmektedir. 

 ‘Term Lists’ (Terimler Listeleri), kütüphane ile birlikte onarılmaz. Bu nedenle, her 

terim listesini yeniden oluşturmak için ‘Tools/Define Term Lists...’ menüsünden, 

listeyi seçin ve kütüphanenizde kullanılan terimler için, ‘Update List...’ butonuna 

basın. Bkz. 6.5 Term Lists (Terimler Listesi) 

 ‘Recover Library...’ komutu, üst versiyonlar kullanılarak oluşturulmuş EndNote 

kütüphanelerini, alt versiyonlar ile açmak için de kullanılabilir. 

3.4 Sıkıştırma (Compressing) 

Bir EndNote kütüphanesi; dosyaadı.enl dosyası ve dosyaadı.DATA klasörü olmak 

üzere iki dosyadan oluşur. Kütüphane dosyalarınızı (dosyaadı.enl ve ilişkili 

dosyaadı.DATA klasörünü tüm içeriği (şekiller, gruplar, terimler vb.) ile), sıkıştırarak 
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dosyaadı.enlx şeklinde kaydedebilirsiniz. Bu işlem sayesinde, kolaylıkla kütüphanenizi 

yedekleyebilir veya meslektaşlarınıza bir kopyasını gönderebilirsiniz. Daha sonra, 

EndNote kütüphanenizi kolaylıkla geri yükleyebilirsiniz (unzip). Kütüphane sıkıştırma 

işlemi için aşağıdaki işlem sırasını izleyin: 

3.4.1 Sıkıştırılmış Kütüphane Oluşturma (Compressing a Library) 

1. EndNote kütüphanenizi açın. 

2. ‘File/Compressed Library (.enlx)...’i seçin. ‘Compressed Library (.enlx)’ ekranı 

görüntülenecektir.  

   

3. Bu ekranda, ‘Create’ seçeneği ile belirleyeceğiniz kriterlere bağlı olarak tüm 

kütüphaneyi, bir grup setini, bir grubu  ya da  kütüphanenizde seçili olan referans 

kayıtlarını, dosya ekleriyle veya ekli dosyaları olmadan sıkıştırabilir ve ‘Create & 

Email’ seçeneği ile sıkıştırılmış kütüphanenizi e-mail olarak gönderebilirsiniz.  

4. Kütüphanenizi sıkıştırmak için ‘Next’ butonuna basın. 

5. ‘Save Compressed Library (.enlx)’ ekranında dosya adını (dosyaadı.enlx) girdikten 

sonra ‘Kaydet’ butonuna basarak sıkıştırılmış kütüphanenizi oluşturabilirsiniz. 
  

  

3.4.2 Sıkıştırılmış Bir EndNote Kütüphanesini Geri Yükleme 

1. Sıkıştırılmış.enlx dosyasının üzerine gelin mouse ile çift tıklayın ya da EndNote 

X9’u açın ve ‘File/Open/Open Library...’ menüsünü kullanarak sıkıştrılmış .enlx 

dosyasını seçin. 

2. .enlx uzantılı dosyanızı açtığınızda, bu dosyanızın bulunduğu dizinde, .enl uzantılı 

EndNote kütüphaneniz ve .DATA uzantılı veri klasörünüz oluşturulacaktır. 

 Not 

 EndNote ‘Compressed Library’ komutu ile 4 gigabyte’tan büyük kütüphaneler 

sıkıştırılamamaktadır. 

 Sıkıştırılmış bir kütüphaneyi adlandırırken, aşağıdaki karakterler alt çizgi ile 

değiştirilmelidir: 

\ (back slash) 

/ (forward slash) 

: (colon) 

* (asterisk) 

? (question mark) 

“ (quotation mark) 

< (less than) 

> (greater than) 

| (vertical bar)
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4 Referans Kaydı Girme 

EndNote kütüphanenize, birkaç farklı şekilde veri (yeni kayıt) ekleyebilirsiniz: 

 Manuel giriş. 

Bkz. 4.1 Manuel Referans Ekleme 

 Import etme 

 Online Arama, Bkz. 4.2 ‘Online Search’ import işlemi 

 Direct import, Bkz. 4.3 Online Veri Tabanlarından Bibliyografik Veri Import 

İşlemi  

 Tekst dosyası import, Bkz. 4.4 Tekst Dosyası Import İşlemi 

 PDF dosyası import, Bkz. 4.5 PDF Import  

 Kopyalama 

Bkz. 6.4 Kütüphaneleri Birleştirme 

4.1 Manuel Referans Ekleme  

4.1.1 Farklı Bibliyografya Formatlarının Oluşturulabilmesi İçin Minimum 

Girilmesi Gerekli Alanlar 

Bibliyografik bilgiler, her EndNote referansında ayrı alanlara girilir. EndNote, 

bibliyografik verilerin ayrı alanlarda depolanması sayesinde, daha sonra bu verileri 

birbirinden farklı bibliyografik formatlara dönüştürebilmek için kullanır. Eğer, bu 

bilgileri, uygun formatlarda atıf yapmak için kullanmak istiyorsanız, referans tipine 

göre minimum bilgiler ilgili alanlara girilmelidir. Referans tipine göre, minimum 

girilmesi gerekli alanlar listesi aşağıda yer almaktadır: 

 Journal Article: Author, Year, Title, Journal, Volume, Issue, Pages. 

 Book: Author , Year , Title , City, Publisher. 

 Book Section: Author, Year, Title, Edition, Book Title, City, Publisher, Volume, 

Pages, Series Editor, Series Title , Edition. 

 Edited Book: Editor, Year, Title, Series Edition, Series Title, City, Publisher, 

Volume, Number of Volumes, Edition. 

 Magazine Article: Author, Year, Title, Magazine, Volume, Issue Number, Pages, 

Date. 

 Newspaper Article: Reporter, Year, Title, Newspaper, City, Pages, Issue Date. 

 Conference Proceedings: Author, Year of Conference, Title, Editor, Conference 

Name, Conference Location, Publisher, Volume, Number of Volumes, Pages, Series 

Editor, Series Title, Edition Date. 

 Electronic Source: Author, Year, Title, Access Year, Access Date, Edition, Last 

Update Date, Type of Medium, Label, URL. 

4.1.2 Manuel Olarak Referans Girişi ile İlgili Püf Noktalar 

Manuel veri girişi yaparken, aşağıdaki püf noktalar işinizi kolaylaştıracaktır: 

 Bilgiler doğru bir şekilde girilmelidir. 

 Referans kaydınız ile, belirlediğiniz anahtar kelimeler birbiriyle tutarlı olmalıdır. 

 EndNote referans verilerinizi girerken özel bibliyografik format ve noktalama 

işaretleri kullanılmamalıdır. Örneğin, başlıklar için çift tırnak kullanmaya, dergi 

adlarını italik yapmaya veya kısaltmalar (volume number “Vol.”) kullanmaya gerek 

yoktur. Yalnızca ham veri girmeniz yeterlidir, format oluşturma işlemini EndNote ile 
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gerçekleştirin. EndNote, bibliyografya oluşturulurken, referanslara gerekli 

noktalama işaretlerini ekler ve metin stilini olması gerektiği gibi düzenler. 

 Yazar ya da anahtar kelime gibi alanlara veri girişi yaparken alan ayracı (default 

olarak ‘Enter’ kullanılır) kullanmayı unutmayın. 

 Bir alan içinde gezinmek için yön tuşlarını kullanabilirsiniz. 

 Sonraki alana geçmek için Tab butonunu kullanabilirsiniz. 

Bir önceki alana geçmek için Shift+Tab tuş kombinasyonunu kullanabilirsiniz. 

 Manuel olarak çok fazla referans kaydı girecekseniz, publisher (yayıncı), city 

names (şehir adları) gibi alanlar için yeni Term Lists oluşturmak veri girişinizi 

hızlandırmanızda oldukça faydalı olacaktır. Bkz. 6.5 Term Lists (Terimler Listesi) 

4.1.3 Manuel Referans Kaydı Giriş İşlemi 

Bu alıştırmada, ‘Sample_Library_X9.enl’ kütüphanesine yeni bir referans kaydı girişi 

yapacağız. ‘Sample_Library_X9.enl’ kütüphanesine default olarak; 

‘C:\Users\Public\Public Documents\EndNote\Examples’ 

ya da 

‘C:\Program Files\EndNote X9\Examples’ (32-bit Windows versiyonları için) 

‘C:\Program Files (x86)\EndNote X9\ Examples’ (64-bit Windows versiyonları için) 

klasörünün altında ‘Sample_Library_X9.enlx’ sıkıştırılmış kütüphanesine çift 

tıklarayarak ya da EndNote’u çalıştırdıktan sonra ‘File/Open/Open Library...’ menüsünü 

kullanarak ‘Sample_Library_X9.enlx’ dosyasının yerini göstererek ulaşabilirsiniz. 

1. ‘New Reference’ ekranına, ‘Library’ araç çubuğunda ‘New Reference  ’ butonunu, 

menülerden ‘References/New Reference’ komutunu veya klavyeden ‘Ctrl+N’ tuş 

kombinasyonu seçeneklerinden birisini kullanarak ulaşabilirsiniz. 

2. Boş ‘New Reference’ penceresi görüntülenecektir. 
  

  

3. ‘Reference Type’ alanında Journal Article default seçili olarak gelmektedir. 

Gerekli ise pencerenin üst tarafında yer alan ‘Reference Type’ listesinden farklı bir 

referans tipi seçilebilir (‘Reference Type’ listesi alfabetik olarak sıralanmaktadır). 

4. Referansta bulunan her bir alana bibliyografik verileri girin. Veri girişi ile ilgili 

olarak, yardım ve detaylı bilgi için aşağıda bulunan tabloda yer alan açıklamalara 

gözatın. 

Girmeniz gereken zorunlu veriler ‘Alıştırmalar’ kolonunda yer almaktadır. 

5. Veri girişini bitirdiğinizde,  butonunu, menülerden ‘File/Close Reference’ 

komutunu ya da klavyeden ‘Ctrl+W’ tuş kombinasyonu seçeneklerinden birisini 

kullanın. 

Önceki & Sonraki Referans 

Referans Type seçin 

Alan Adı (Fieldname) 
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6. Girmiş oldunuz referans bilgilerini kaydetmek isteyip istemediğinizi soran EndNote 

uyarı mesajı ekranında ‘Yes’ butonuna basın (Eğer, uyarı mesaj ekranının her kayıt 

değişikliğinde açılmasını istemiyorsanız, ‘Do not display message again’ onay 

kutusunu işaretleyin. Ancak, kütüphanenizdeki referans kayıtları üzerinde hatalı bir 

değişiklik yapılmaması için bu onay kutusunun işaretlenmemesi önerilmektedir). 

  

7. Girmiş olduğunuz referans kaydı kütüphanenize eklenecektir. 

Sonuç 

    

Bir Önceki & Sonraki Referans 

Alan adı kalın olarak görüntülenir 



 

3
8
 

 

Alanlar (Fields) Bilgi Alıştırmalar 

Rating  Referanslarınızı değerlendirmek için Rating alanını kullanabilirsiniz. 

 Alan görüntülenmezse sağ üst köşedeki  ikonuna tıklayın ve ‘Show Rating Field’ı seçin.  

 

Author (Yazar), 

Secondary Author, 

Tertiary Author, 

Subsidiary Author 

(Term List) 

 İki farklı yazım şekli mümkündür 

1) Soyadı,İlk Adı İkinci Adı 

EndNote virgül işareti sayesinde ad ve soyad ayrımını yapmaktadır. Yazarın birden fazla 

ismi varsa hepsini girmek mümkündür. İlk adının baş harfini girdikten nokta koyup ikinci 

adının baş harfini girebilir veya ilk adını girdikten sonra bir boşluk bırakıp sonra ikinci 

adını girebilirsiniz. 

Soyadı virgül İlk Ad İkinci Ad veya İlk 

adının baş harfi nokta ikinci 

adının baş harfi nokta 

2) İlk ad İkinci ad Soyad (virgül yok) 

Örnek 

Volckaert,Mariël veya Volckaert, M.G. veya Mariël Volckaert 

De Gelder,Mieke veya De Gelder,M. veya Mieke De Gelder 

Auwera,Van der Jozef 

 İsimleri doğru bir şekilde ve aynı formatta girmeye dikkat edin. 

 EndNote ilk ve ikinci adları kısaltabilir, bu nedenle maksimum esneklik için yazarlara ait 

tüm isimleri girin. 

 Yazar ve editör adlarını her zaman her bir satıra bir isim gelecek şekilde girin. 

Birden fazla yazar adını girerken yazar adlarını ayırmak için Enter tuşunu kullanın. 

 Eğer birden fazla yazar adı varsa, yayında gösterildiği sıraya uyun. 

 Kütüphanenizde bulunan yazar adlarının bulunduğu terimler listesinde bulunmayan yeni 

bir yazar adı girdiğinizde kelime kırmızı olarak görünecektir. Referans penceresini 

kapatıldığında yeni yazar adı yazar adlarının bulunduğu ‘Author Term List’e eklenecektir. 

Aynı yazar adı daha sonra kullanılmak istendiğinde artık kırmızı olarak görünmeyecek ve 

Ruben, Jan Antoon 

Jones, Tony 

Geist, Norbert Roger 
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Alanlar (Fields) Bilgi Alıştırmalar 

ilk birkaç harfi yazıldığında terimler listesi kayıtlarından otomatik olarak getirilecektir. 

Default olarak her bir EndNote kütüphanesinde Authors (Yazarlar), Journals (Dergiler) ve 

Keywords (Anahtar Kelimeler) için terimler listesi bulunmaktadır. Yazar adı girerken, ‘Auto 

Suggest’ (otomatik öneri) özelliğini kapatmak ve açmak için ‘Edit/Preferences/Term Lists’i 

kullanın. 

Firma adları yazar adından sonra virgül kullanılarak girilir. 

Örnek 

   Ministerie van Financiën, 

   DISC B.V., 

Year (Yıl)  ‘in press’ (basım) veya ‘in prepatation’ (hazırlanma) tarihine ait bilgiyi dört hane olarak 

girmelisiniz, örneğin; 2008. 
2003 

Title (Başlık)  Alan 64 KB ile sınırlıdır. 

 Başlık bilgisini girerken sonuna nokta veya başka herhangi bir noktalama işareti 

kullanmayın. 

 EndNote da başlık girerken Enter tuşunu kullanmayın; uzun başlıklarda cümle otomatik 

olarak alt satırdan devam edecektir. 

 EndNote stilleri, başlıkların yazım biçimini değiştirebilse de, başlığı dokümanınızda 

yazılmasını istediğiniz şekilde girebilirsiniz. 

Respiratory and 

reproductive 

paleophysiology of 

dinosaurs and early birds 

Journal (Dergi) 

(Term List) 

 ‘Journal’ alanı ‘Journals Term List’ ile doğrudan bağlantılı olarak çalışmaktadır. Bu, 

referanslarınıza yeni bir dergi adı girdiğinizde, ‘Journal List’in güncelleneceği anlamına 

gelir. EndNote, dergi alanına, dergi isimlerini girerken veri girişini kolaylaştırmak için 

terim listesini kullanacaktır. 

 ‘Journal’in tam adını girin veya girmek istediğiniz dergi adını EndNote otomatik olarak 

önerirse ‘Enter’ tuşuna basın. 

 Terim listesinde bulunmayan yeni bir dergi adı giriyorsanız metin, kırmızı olarak 

görüntülenecektir. 

 Dergi adları, ‘Journal Term List’ içerisine farklı formlarda (uzun olarak veya kısaltılmış 

olarak) girildiğinde, kullanılan stile bağlı olarak bibliyografyadaki dergi adları farklı 

biçimlerde görüntülenecektir.  ‘Tools/Open Term Lists/Journals Term List’ menüsünü 

 



 

4
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kullanarak terimler listesine yeni bir kayıt ekleyebilir, silebilir veya var olan bir kaydı 

düzenleyebilirsiniz. 

 EndNote medikal, kimya ve beşeri bilimler dergileri için önceden tanımlanmış terim 

listeleri içermektedir. 

 ‘Journal’ alanı 64 KB ile sınırlıdır. 

Publisher (Yayımcı)  Publisher adını girin. 

 ‘Publisher’ alanı 64 KB ile sınırlıdır. 
 

Volume (Cilt)  Derginin volume sayısını girin (parantez ve ek noktalama işareti olmadan). 

 ‘Volume’ alanı 64 KB ile sınırlıdır. 
76 

Issue (Baskı Sayısı)  Issue sayısını girin (köşeli parantez yok). 

 ‘Issue’  alanı 64 KB ile sınırlıdır. 
2 

Pages (Sayfa)  Sayfa aralığı tam olarak girilebilir, örnek 241-249 (ek noktalama işareti olmadan). 

 Sayfa aralığı kısaltılarak girilebilir, örnek: 241-9. 

 Stil, sayfa numaraları biçimini tam veya kısaltılmış olarak değiştirilebilir. 

141-164 

Date (Tarih) and Auto 

Date Stamp 

 Tarih bilgisini, referans listenizde nasıl görüntülenmesini istiyorsanız o şekilde girin. 

 EndNote tarihleri yeniden biçimlendirmez. 

 Daha sonra referans kayıtlarınızı tarih bilgisine göre sıralamak ve belirli bir tarih aralığı 

için arama yapabilmek için, tarih bilgisini numerik olarak girin (örneğin; 2016/12/15) 

 Her EndNote referans kaydının alt bölümünde iki Auto Date Stamp alanı 

görüntülenmektedir. ‘Added to Library’ ve ‘Last Updated’ tarihleri yeni bir referans 

kaydedildiğinde eklenmektedir. ‘Last Updated’ tarihi bir referans kaydına ait değişiklikler 

her kaydedildiğinde güncellenmektedir. 

 

ISBN/ISSN  Yayında belirtildiği şekilde numarayı girin (dergi veya kitap). 

 Bu alan ‘Report Number’ ve ‘Patent Number’ içinde kullanılmaktadır. 
 

DOI (Digital Object 

Identification) 

 Bu alan, bir dokümanın dijital versiyonunu PDF veya imaj şeklinde bulmak için kullanılır. 

Referans verilerini online kaynaklardan doğrudan import ederken etkin olarak 

kullanılmaktadır. 
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Reprint Edition  ‘Reprint Edition’ alanı, bir referans kaydı orjinal olarak farklı bir başlık altında 

yayınlandığında kullanılır. 

 Önceki baskının, yeniden yayınlandığını belirtmek için orjinal başlığı ve yılı girin. 

 Bu bilgileri, tam olarak biçimlendirilmiş referansınızda görünmesini istediğiniz şekilde girin 

(metin stilleri ve noktalama işaretleri dahil). 

 Bu alan, dosyadaki makalenin yeniden yazdırılıp yazdırılmadığını belirtmek için 

kullanılamaz. Bu amaçiçin, özel alanlardan birini kullanabilirsiniz. 

 

Custom 1 - 8  EndNote içerisinde default olarak tanımlı olmayan alanlar ve bilgiler için kullanılabilen 

alanlardır. 

 ‘Field Name’ (Alan Adı) ‘Edit/Preferences/Reference Types/Modify Reference Types’ 

kullanılarak düzenlenebilir. 

 

Call Number (Raf 

Numarası) 

 Bu alan ‘library call numbers’ (kütüphane raf numaralarını) saklamak için kullanılır. ‘Call 

Number’, kaynağın kütüphanede nerede (hangi rafta) bulunduğu bilgisi için kullanılır. 
 

Label (Etiket)  Bu alan, birçok amaç için kullanılabilmektedir, örneğin özel metin içi (in-text) atıflar veya 

yeni baskı numarası gibi. 

 EndNote kayıt numaraları kalıcı değildir. Değişebilir ve kalıcı tanımlayıcı olarak 

kullanılmamalıdırlar. EndNote kütüphanenizde makale takibi için kalıcı bir tanımlayıcıya 

sahip olmak isterseniz Label alanlarını kullanabilirsiniz. 

 

Keywords (Anahtar 

Kelimeler) 

(Term List) 

 ‘Keywords’ alanındaki kelimeler bir terimler listesinde saklanmaktadır. 

 Referans kaydınız ile ilgili anahtar kelimeleri girmek için kullanılan alandır. 

 Spesifik anahtar kelimelerinizi girin ya da EndNote tarafından önerilen anahtar kelimeleri 

girmek istediğinizde ‘Enter’ butonuna basın. 

 Noktalı virgül (;), ters slash (\) ve satır başı (Enter) ile anahtar kelime girişi 

yaparken kelimelerinizi birbirinden ayırabilirsiniz. 

 Kütüphanenizde, terimler listesinde bulunmayan yeni bir anahtar kelime girdiğinizde, 

kelime kırmızı olarak görüntülenecektir. 

Animals 

Fossils 

Paleontology 
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Alanlar (Fields) Bilgi Alıştırmalar 

Abstract (Öz)   Bu alan, çalışmanın içeriği hakkında kısa bir açıklama için kullanılır. 

 Alan limiti 64 KB’tır (16 sayfalık düz yazı). 
In terms of their 

diversity and longevity, 

dinosaurs and birds 

were/are surely among 

the most successful of 

terrestrial vertebrates. 

(...) 

Notes (Notlar) 

Research Notes 

(Araştırma Notları) 

 ‘Notes’ (Notlar) ve ‘Research Notes’ (Araştırma Notları) alanı kişisel hatırlatma bilgilerini 

saklamak için kullanılır. Örneğin; alıntı yapılan yer veya alıntının kendisi gibi. 

 Alan limiti 64 KB’tır (16 sayfalık düz yazı). 

Bu alan kitap bölümlerini girmek amacı ile kullanılmaz (girilebilecek bilgi sınırlıdır!!). 

 

URL (Uniform Resource 

Locator) 

 Bu alan, EndNote kütüphanenizdeki referans kaydına ait bilgilerin bulunduğu internet 

sayfasına ulaşmak için kullanılan, web adresinin girildiği alandır. 

Örnek 

     https://researchsoftware.com 

 Ayrıca, lokal bir dosyaya da link (bağlantı) oluşturabilirsiniz. Örneğin; Word, Excel dosyası 

veya PowerPoint sunumu. 

Yerel klasör ve dosya adlarındaki boşluğun '% 20' ile değiştirilmektedir. 

 Referans kaydına ait web adresini açmak için, ‘Open Link’  butonunu kullanın. 

 Referans kaydına birden fazla link (bağlantı) girmek isterseniz, Enter tuşunu kullanarak 

her bir satıra URL adresi girebilirsiniz. 

 EndNote, herhangi bir alanda http:// veya ftp:// kullanıldığında, bu bilgiyi URL olarak 

tanıyacaktır. Bu bilgi tanındığında tekst mavi, altı çizili ve tıklanabilecek web bağlantısı 

olarak görüntülenecektir. 

 

https://researchsoftware.com/
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Alanlar (Fields) Bilgi Alıştırmalar 

File Attachments (Ekli 

Dosyalar) 

 Bu alan, dosya eki yolunu saklamak için kullanılmaktadır (max. 45 kısayol). 

 Bir dosyayı, referansa bağladığınızda mutlak veya göreceli bir yol oluşturabilirsiniz. 

1. Menülerden ‘References/File Attachments/Attach File...’ veya 

Sağ tuş menüsünden ‘File Attachments/Attach File...’ menüsünü kullanın. 

2. ‘Select a file to link to the reference’ ekranında, ‘Copy this file to the default file 

attachment folder and create a relative link’ onay kutusu default olarak seçilidir. Bu 

onay kutusu seçildiğinde, eklenen dosyanın bir kopyası EndNote kütüphanesinin bir 

parçası olan DATA\PDF klasörüne eklenir ve referans kaydı ile bağlantısı oluşturulur. 

(EndNote kütüphanenizi taşımanız durumunda yalnızca .enl uzantılı kütüphane 

dosyanızı ve .DATA klasörünü taşımanız yeterlidir) 

Eğer onay kutusu seçili değilse, referans kaydı doğrudan eklenen dosya ile 

ilişkilendirilir. Bu durumda, orijinal klasörün yerini değiştirirseniz, referans 

kayıtlarınıza eklediğiniz dosyaları, referans kayıtlarınızla tekrar ilişkilendirmeniz 

gerekecektir. 

3. Eklenen dosyayı açmak için araç çubuğunda bulunan ‘Open File’  butonunu 

kullanabilirsiniz. 

 

Author Address (Yazar 

Adresi) 

 Yazar veya yayımcı adresini girin. Ruben JA, Oregon State 

Univ, Dept Zool, 

Corvallis, OR 97331 USA. 

rubenj@science.oregonst

ate.edu 
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Alanlar (Fields) Bilgi Alıştırmalar 

Figure (Şekil)  Referans kaydına şekil veya grafik eklemek için ‘Attach Figure ’ butonunu kullanın. 

 Figure alanına yalnızca, bir grafik veya şekil eklenebilir. Eğer, bu alana ikinci bir şekil 

eklemek isterseniz, bir önceki ile yer değiştirilecektir. 

 Eklenen şekil veya grafiğin bir kopyası, verilerin tutulduğu .DATA klasörüne kopyalanır ve 

bu kopya ile referans kaydı arasında bağlantı oluşturulur. 

 ‘Cite While You Write’ özelliği ile, word dokümanınıza resim ve resim yazısı otomatik 

olarak eklenebilir. 

 Eğer, şekil içeren bir kaydı, daha sonra Microsoft Word’e tablo olarak eklemek 

istiyorsanız, ‘Reference Type’ olarak ‘Chart or Table’ kullanın. 

 

Caption  Bu alan şekil veya dosyaya ait, kısa bir açıklama girmek için kullanılır. 

 Word dokümanında şekil listesi oluşturulduğunda, bu açıklama şeklin altında veya 

üstünde görüntülenecektir. (‘Output Style’a bağlı olarak). 

Lung structure and 

ventilation in Therapod 

dinosaurs and early birds 

Access Date 

Last Modified Date 

 Bu alanlar, sizin kayıt oluşturma bilginizi saklamak için kullanılır. 

 Tarih bilgisini numerik olarak girin. Bu sayede referans kayıtlarını bu tarih bilgisine göre 

sıralayabilir veya belirli bir tarih aralığı için arama yapabiliriz. 

 



ResearchSoftware.com 45 

EndNote X9 

4.1.4 Record Numbers (Kayıt numarası) Hakkında 

EndNote, kütüphanenize her referans eklediğinizde, o kayda eşsiz bir kayıt numarası 

atamaktadır. Kayıt numaraları, makale formatı belirlendiğinde, doğru referansın 

kullanılmasını sağlamak için geçici atıfda (Temporary Citations) görüntülenir: 

{Argus, 1991#14} 

Ayrıca bu bilgi, bir referans kaydına çift tıklanarak ulaşılan ‘Referans Penceresi’ başlık 

çubuğunda da görüntülenir. Kayıt numarası ile ilgili dikkat edilmesi gerekli hususlar: 

 EndNote, bir kütüphaneye referans kaydı eklediğinizde, her kayıt için otomatik 

olarak sıralı bir kayıt numarası atar. 

 Aynı referans kaydı farklı iki kütüphanede bulunuyorsa, büyük olasılıkla kayıt 

numaraları farklı olacaktır. 

 Kayıt numaraları bir kütüphanede, değiştirilemez, tekrar kullanılamaz veya 

atanamaz. Bir referans silindiğinde, ilgili kayıt numarası o kütüphanede tekrar 

kullanılmaz. 

 EndNote kayıt numaraları otomatik olarak atandığından, basılı arşivlerinizin 

dosyalanması ya da numaralandırılması ile ilgili bir kullanım için önerilmemektedir. 

Bunun yerine, Etiket (Label) alanını veya herhangi bir Kişisel (Custom) alanı 

kendi eşsiz numaralarınızın girişi için kullanabilirsiniz. 

4.1.5 Auto Date Stamp (Otomatik Tarih) Hakkında 

Yeni bir referans kaydettiğinizde, ‘Added to Library’ ve ‘Last Updated’ tarih bilgileri, her 

EndNote referansınının alt bilgisine eklenir. Referans kaydına ait değişiklikleri 

kaydettiğinizde son güncelleme tarihi sıfırlanır. 'Auto Date Stamp’ alanı varsayılan 

işletim sistemi ayarlarınızda tanımlanmıştır (Control Panel > Regional Settings, 

Windows). 

'Auto Date Stamp’ alanlarından herhangi birini düzenleyemez, print edemez veya 

export edemezsiniz. Bununla birlikte, bu alanları, herhangi bir EndNote alanında olduğu 

gibi görüntüleyebilir ve sıralayabilirsiniz. 

4.1.6 Special characters (Özel karakterler) Hakkında 

EndNote referansları, fonetik, yunan, matematiksel ve dizgiye ait özel karakterler 

içerebilir. Fonetik karakterler standart Windows yazı tiplerinin bir parçasıdır, ayrıca 

çoğu sembol ‘Symbol font’tan girilebilir. 

EndNote, verilerin platformlar, programlar ve diller arasında kolaylıkla çevrilebilmesi 

için özel karakterleri kodlarken Unicode kullanır. EndNote, işletim sisteminiz tarafından 

belirlenen varsayılan dil ayarını kullanmaktadır. EndNote'a, aşağıdaki metin giriş 

yöntemlerinden herhangi birini kullanarak özel karakterler girilebilir: 

 Klavyede karakteri yazabilirsiniz (eğer karakter, klavye tarafından desteklenen 

dilin bir parçasıysa). 

 Karakteri başka bir programdan kopyalayıp EndNote kütüphanenize 

yapıştırabilirsiniz. 

 Bu amaçla Windows ile birlikte verilen ‘Character Map’ programını kullanabilirsiniz. 

‘Start > All programs > Accessories > System Tools > Character Map’. 

 Belirli fonetik karakterleri ya da kelimeleri sık kullanıyorsanız, bir terim listesinde 

saklayabilir ve referansları girerken seçebilirsiniz. Bkz. 6.5 Term Lists (Terimler 

Listesi) 

 Not 

 Referans penceresinde  ikonuna bastığınızda ‘Hide Empty Fields’ (Boş Alanları 

Gizle) ve ‘Show Empty Fields’ (Boş Alanları Göster) işlemlerini 
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gerçekleştirebilirsiniz. Başlangıçta, EndNote referans kaydındaki tüm alanları 

görüntülemektedir. Sadece veri içeren bütün alanları görüntülemek için, ‘Hide 

Empty Fields’ (Boş Alanları Gizle) komutunu kullanın. 

 Kütüphanenizde bulunan çift referansları bulmak için, ‘References/Find Duplicates’ 

menüsünü kullanabilirsiniz. Bkz. 5.5.4 Duplicate (Çift) Referans Kayıtlarını Bulma 

 Bir referans kaydına şekil veya grafik eklediğinizde ‘Caption’ alanına bilgi girmeyi 

unutmayın. 

 ‘Figure’ alanında yalnızca bir imaj veya grafik saklanabilir. 

 EndNote, makalenizde bibliyografyayı oluşturduğunda, yazı tipi ve boyut olarak 

‘Plain Font’ ve ‘Plain Size’ kullanır. Eğer, kütüphanenize girilen default ayarlardan 

farklı herhangi bir yazı tipi, boyut ya da stil oluşturulmuşsa, bu değişiklik 

makalenizin yazı tipi ayarlarına bakılmaksızın bibliyografyada görüntülenecektir. 

 EndNote ‘Spell Check’i (yazım denetimi) başlatabilmek için, kontrolün 

gerçekleştirileceği referans kaydının açık olması gereklidir. Sözcük kontrolüne 

başlamak için ‘Tools/Spell Check’i seçin. 

4.2 ‘Online Search’ import işlemi 

Z39.50 protokolünü (Bkz. 1.2.12 Z39.50) destekleyen bir kütüphane kataloguna veya 

bibliyografik veri tabanına erişiminiz varsa, ‘EndNote Online Search’ komutunu 

kullanabilir ve referansları doğrudan bu veri tabanından EndNote'a akatarabilirsiniz. 

Bu, EndNote'a ek adımlar olmadan veri aktarmanın en kolay yoludur. 

EndNote, bu online kaynaklara bağlantı ve arama için gerekli bilgileri kişisel bağlantı 

dosyalarında saklamaktadır (Bkz. 5.5.5 Connection Files (Bağlantı Dosyaları)). 

4.2.1 Örnek 1 – Library of Congress 

Bu örneğimizde ‘Library of Congress’ veri tabanına bağlanılacak ve dinozorlar 

hakkındaki yayınları araştıracağız. 

4.2.1.1 Bağlantı Dosyası (Connectıon Fıle) Seçimi 

1. ‘Online Search’ grubunun altından ‘Library of Congress’i, ‘Tools/Online Search’ü 

ya da ‘Online Search’ grubunun altından ‘more…’u seçin. 

‘Choose A Connection’ ekranı açılacaktır. 

  

2. İstenilen veri tabanını seçin (Library of Congress). 

‘Choose’ butonuna basın. 

3. ‘Search’ tabı aktif hale gelecektir. 



ResearchSoftware.com 47 

EndNote X9 

4.2.1.2 Online Veri Tabanında Arama 

1. İlk alanı listeden ‘Any Field’ seçin. 

<Tab> a basıp listeden ‘Contains’ i seçin. 

<Tab> a basıp aramak istediğiniz metni (dinosaur) girin. 

<Tab> a basıp listeden ‘And’ parametresini girin. 

<Tab> a basıp listeden ‘Year’ ı seçin. 

<Tab> a basıp listeden ‘Contains’ i seçin. 

<Tab> a basıp arama yapılacak yılı (2003) girin. 

2. ‘Search’ tabı aşağıdaki gibi gözükecektir: 

    

3. ‘Search’ butonuna basın. 

4. ‘Confirm Online Search’  ekranı görüntülenecektir. 

Onaylamak için ‘OK’ butonuna basın. 

  

5. Uzak veri tabanından download edilen referanslar, geçici olarak ‘Library Congress’ 

grubu altında görüntülenecektir. Doğrudan ‘All References’ grubuna eklenen 

referanslar için, yeni bir ‘Custom Group’ ya da ‘Smart Group’ oluşturulabilir. 

  

4.2.1.3 Referansların Kütüphaneye Kaydedilmesi 

Download edilen referansları kütüphanenizdeki mevcut bir gruba ya da yeni bir gruba 

ekleyebilirsiniz. 
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1. Grup altına eklemek istediğiniz referansları seçmek için ‘Ctrl’ ya da ‘Shift’ tuşlarını, 

tüm kayıtları seçmek için ‘Ctrl+A’ tuş kombinasyonunu kullanabilirsiniz. 

2. Seçilen referans kayıtları ‘sağ tuş’ veya ‘References’ menüsünden ‘Add References 

to’ seçeneği kullanılarak eklenebilir. 

3. Mevcut olan gruplardan birine ya da yeni oluşturacağınız gruba eklediğiniz referans 

kayıtları aşağıda bulunan ekrandaki gibi görüntülenecektir. 

Sonuç 

  

4.2.2 Örnek – Pubmed 

İkinci örneğimizde ‘PubMed’ veri tabanına bağlanılacak ve ‘Bo, K.’ adlı yazarın 

yayınlarını araştıracağız. 

4.2.2.1 Bağlantı Dosyası (Connectıon Fıle) Seçimi 

‘Pubmed, National Library of Medicine'nın ‘MEDLINE’ veri tabanındaki online erişim 

versiyonudur. 

1. ‘Tools/Online Search’ü ya da ‘Online Search’ grubunun altından ‘more…’u seçin. 

‘Choose A Connection’ ekranı açılacaktır. 

2.  ‘PubMed (NLM)’i seçin. 

‘Choose’ butonuna basın. 

   

3. ‘Search’ tabı aktif hale gelecektir. 

Listeyi Kaydırın 
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4.2.2.2 Online Veri Tabanında Arama 

1. İlk alanı listeden ‘MeSH Terms’ seçin. 

<Tab> a basıp listeden ‘Contains’ i seçin. 

<Tab> a basıp aramak istediğiniz metni (electromyography) girin. 

<Tab> a basıp listeden ‘And’ parametresini girin. 

<Tab> a basıp listeden ‘Author’ u seçin. 

<Tab> a basıp listeden ‘Contains’ ı seçin. 

<Tab> a basıp yazar adını (Vacek, J) girin. 

2. ‘Search’ tabı aşağıdaki gibi gözükecektir: 

   

3. ‘Search’ butonuna basın. 

4. ‘Confirm Online Search’ ekranında ‘OK’ butonuna basın. 

  

Sonuç 

   

4.2.2.3 Referansların Kütüphaneye Kaydedilmesi 

Download edilen referansları kütüphanenizdeki mevcut bir gruba ya da yeni bir gruba 

ekleyebilirsiniz. 

1. Grup altına eklemek istediğiniz referansları belirlemek için, ‘Ctrl’ ya da ‘Shift’ 

tuşlarını, tüm kayıtları seçmek için ‘Ctrl+A’ tuş kombinasyonunu kullanabilirsiniz. 
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2. Seçilen referans kayıtları, ‘sağ tuş’ veya ‘References’ menüsünden ‘Add References 

to’ seçeneği kullanılarak eklenebilir. 

3. Mevcut olan gruplardan birine ya da yeni oluşturduğunuz gruba eklediğiniz 

referans kayıtları aşağıda bulunan ekrandaki gibi görüntülenecektir. 

Sonuç 

     

 Not 

 Bu arama işlemleri ‘Integrated Library&Online Search Mode’da gerçekleştirilmiştir. 

 Alınan referansları, geçici kütüphanede saklayarak, sadece istemiş olduğunuz 

referans kayıtlarınızı lokal kütüphanenize aktarmak istiyorsanız, Online Search 

Mode’u kullanabilirsiniz. 

     

PubMed örneğini ‘Online Search Mode’ kullanarak gerçekleştirdiğinizde sonuç 

aşağıdaki gibi görüntülenecektir. 

    

Online Search Mode 

(Temporary Library) 

Copy to Local Library 
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Referans kayıtlarını seçtikten sonra, ‘Copy to Local Library’ butonunu kullanarak 

arama sonuçlarını kütüphanenize kaydedebilirsiniz. Kopyalanan referanslar 

‘Integrated Library&Online Search Mode’ ve ‘Local Library Mode’ bölümünde geçici 

bir grup olan ‘Copied References’da görüntülenecektir. 

   

Mevcut olan gruplardan birine ya da yeni oluşturduğunuz gruba eklediğiniz 

referans kayıtları aşağıdaki gibi görüntülenecektir. 

  

4.3 Online Veri Tabanlarından Bibliyografik Veri 

Import İşlemi 

EndNote kütüphaneleri oluşturmanın birçok yolu vardır: 

 Bazı Web siteleri, arama sonuçlarınızı doğrudan EndNote’a aktarmak için bir 

download butonu içerir, bu buton kullanılarak import işlemi otomatik olarak 

gerçekleştirilir. Yapmanız gereken tek işlem, referans kayıtlarının hangi EndNote 

kütüphanenize import edilmesini istiyorsanız, onu seçmek olacaktır. Bu yönteme 

‘direct export’ veya ‘direct download’ yöntemi denilmektedir. Bu yöntemle, 

referansları metin dosyası olarak kaydetme ve uygun filtreyle import etme 

adımlarına gerek olmaksızın işlem gerçekleştirilir. Bilgi transferinin ne kadar iyi 

olduğu, bilgi sağlayıcının bibliyografik bilgi verilerini, ne kadar doğru etiketlediğine 

bağlıdır. Ayrıntılı bilgi için Bkz. 4.3.1 Direct Export. 

 Eğer, online bibliyografik veri tabanlarına ve üniversite kataloglarına erişiminiz 

varsa, bu kaynaklardan metin formatında kaydedilmiş veya download edilmiş 

referansları, EndNote kütüphanenize eklerken EndNote import filtrelerini 

kullanabilirsiniz. EndNote filtreleri, ihtiyacınız olan referans kayıtlarını aktarmanızı 

kolaylaştırırken, ihtiyacınız olmayanları ise elemenizde size yardımcı olacaktır. 
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Download edilen referans kayıtlarını EndNote kütüphanesine import ederken 

önemli olan iki unsur bulunmaktadır: 

 - Verilerin doğru çıktı formatında nasıl download edileceği. 

- EndNote’a veri aktarırken, doğru import filtresinin kullanılması. 

Verilerin doğru alanlara yerleştirilebilmesi için doğru import filtresinin seçimi son 

derece önemlidir (Bkz. 4.3.2 Bir Filtre Kullanarak Import İşlemi Gerçekleştirme ve 

4.4 Tekst Dosyası Import İşlemi) 

4.3.1 Direct Export 

Birçok bilgi sağlayıcının web sitesinde, referans kayıtlarını doğrudan EndNote 

kütüphanelerinize kopyalamanız için, direct export seçeneği mevcuttur. Direct export 

işleminde, bibliyografik bilgilerin aktarımı için, uygun EndNote import filtresi otomatik 

olarak belirlenmektedir. Yapmanız gereken tek işlem kayıtları aktarmak istediğiniz 

EndNote kütüphanesini belirlemek olacaktır. Bu yöntem, referansları metin dosyası 

olarak kaydetme ve uygun filtreyle import etme adımlarını ortadan kaldıracaktır. 

Direct export özelliği bulunan birçok bilgi sağlayıcı aşağıdaki listede yer almaktadır. 

Yeni eklenen bilgi sağlayıcılar ve güncellemeler için, lütfen aşağıdaki web sitesini 

ziyaret edin http://www.endnote.com! 

Bilgi Sağlayıcı  Veri/Erişim Türü  

ALEPH Various library Web sites 

American Psychological Association PsycInfo Online 

http://www.apa.org 

Üyelik gerekli 

Bibliotech.dk Library Management System 

http://bibliotech.dk.au 

Bibliotek.dk Union Catalog 

http://bibliotek.dk 

BioMedCentral All journals 

http://www.biomedcentral.com 

BioOne Biomedical 

http://www.bione.org 

Üyelik gerekli 

Blackwell Synergy All journals published by Blackwell that are online 

http://www.blackwell-synergy.com 

BMJ British Medical Journal 

Tobacco Control Database 

http://bmj.bmjjournals.com/cgi/citmgr 

Ücretsiz erişim 

Buffalo University Library catalog 

http://ublib.buffalo.edu/libraries/e-

resources/bison/off.html 

Access for Buffalo University students only 

CABI-Direct CABI Databases 

http://www.cabdirect.org  

Subscription required 

Canadian Journal of Communication http://www.cjc-online.ca 

CCLR Reference Sight Database provided by the University of 

Waterloo Centre for Contact Lens Research (formerly 

Bausch) 

http://www.endnote.com/
http://www.apa.org/
http://bibliotech.dk.au/
http://bibliotek.dk/
http://www.biomedcentral.com/
http://www.bione.org/
http://www.blackwell-synergy.com/
http://bmj.bmjjournals.com/cgi/citmgr
http://ublib.buffalo.edu/libraries/e-resources/bison/off.html
http://ublib.buffalo.edu/libraries/e-resources/bison/off.html
http://www.cabdirect.org/
http://www.cjc-online.ca/
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Bilgi Sağlayıcı  Veri/Erişim Türü  

http://www.referencesight.com 

Free subscription 

Delphion Patent data 

http://www.delphion.com 

EBSCO All EBSCO databases 

http://www.ebsco.com/ 

Ei Engineering Village Elsevier Engineering Information database 

http://www.ei.org 

Üyelik gerekli 

Elsevier Science Direct 

http://www.elsevier.com 

Üyelik gerekli 

EMBASE EMBASE database 

http://www.embase.com 

Üyelik gerekli 

ERIC ERIC database 

http://www.eric.ed.gov 

Ücretsiz erişim 

ESDS Government Economic and Social Data Service for the UK, 

Government Social Data Survey Information 

http://www.esds.ac.uk/government/search 

Free access 

Google Scholar Broad literature search 

http://scholar.google.com/ 

Ücretsiz erişim 

HAPI online Hispanic American Periodical Index (UCLA) 

http://hapi.ucla.edu/ 

Subscription required 

IEEE Institute of Electrical and Electronics Engineers, Inc.; All 

databases 

http://ieeexplore.ieee.org/Xplore/ 

guesthome.jsp 

JAMA and Archives Journal of the American Medical Association 

http://pubs.ama-assn.org/ 

Ücretsiz erişim 

JISC Joint Information Systems Committee Collections 

http://www.jisc-collections.ac.uk  

Subscription required 

JSTOR The Scholarly Journal Archive 

http://www.jsgtor.org/help/export_help.html  

Üyelik gerekli 

Karger Publishing Medical and scientific journals 

http://www.karger.com/ 

Ücretsiz erişim 

Los Alamos National Laboratory Library without walls 

http://www.lanl.gov/  

Ücretsiz erişim 

MicroPatent All articles 

http://www.micropat.org 

Üyelik gerekli 

http://www.referencesight.com/
http://www.delphion.com/
http://www.ebsco.com/
http://www.ei.org/
http://www.elsevier.com/
http://www.embase.com/
http://www.eric.ed.gov/
http://www.esds.ac.uk/government/search
http://scholar.google.com/
http://hapi.ucla.edu/
http://ieeexplore.ieee.org/Xplore/
http://pubs.ama-assn.org/
http://www.jisc-collections.ac.uk/
http://www.jsgtor.org/help/export_help.html
http://www.karger.com/
http://www.lanl.gov/
http://www.micropat.org/


ResearchSoftware.com 54 

EndNote X9 

Bilgi Sağlayıcı  Veri/Erişim Türü  

Nature Scientific data 

http://www.nature.com 

Üyelik gerekli 

Nerac All articles 

http://www.nerac.com 

Üyelik gerekli 

NISC All articles 

http://www.nisc.com 

Üyelik gerekli 

OCLC All databases 

http://www.oclc.com 

Üyelik gerekli 

OhioLink Multiple databases 

http://www.ohiolink.edu  

Üyelik gerekli 

OVID All databases 

http://www.ovid.com 

Üyelik gerekli 

Oxford Journals Journal articles 

http://www.oxfordjournals.org/ 

Ücretsiz erişim 

Pacific Northwest Labs Internal veri tabanları 

http://www.pnl.gov 

Yalnızca Internal (iç) kullanım mümkündür 

Patent Café Patent data 

http://www.patentcafe.com 

Üyelik gerekli 

PILOTS Medical PTS research 

http://www.ncptsd.va.gov/publications/pilots/ 

Yalnızca Internal (iç) kullanım mümkündür 

PNAS Online Online science journal search tool at Boston University 

http://cybele.bu.edu/biomass/ar/pnas/all.shtml.htm 

ProQuest All databases 

http://www.proquest.com 

Üyelik gerekli 

PubMed U.S. National Library of Medicine (NLM) 

http://www.ncbi.nlm.nih.gov/pubmed 

Free access 

ScienceDirect Full-text scientific database offering journal articles and 

book chapters from nearly 2,500 journals and 26,000 

books 

http://www.sciencedirect.com/  

Free access 

Science Magazine Journals 

http://www.sciencemag.org  

Üyelik gerekli 

Scopus Scopus 

http://www.scopus.com 

Üyelik gerekli 

St. John of God, Ireland Medical library 

http://www.library.sjog.ie 

Internal use only 

http://www.nature.com/
http://www.nerac.com/
http://www.nisc.com/
http://www.oclc.com/
http://www.ohiolink.edu/
http://www.ovid.com/
http://www.oxfordjournals.org/
http://www.pnl.gov/
http://www.patentcafe.com/
http://www.ncptsd.va.gov/publications/pilots/
http://cybele.bu.edu/biomass/ar/pnas/all.shtml.htm
http://www.proquest.com/
http://www.ncbi.nlm.nih.gov/pubmed
http://www.sciencedirect.com/
http://www.sciencemag.org/
http://www.scopus.com/
http://www.library.sjog.ie/
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Bilgi Sağlayıcı  Veri/Erişim Türü  

Stanford University’s HighWire Press HighWire Press 

http://highwire.stanford.edu/  

Ücretsiz erişim 

Thieme Journal publications 

http://www.fiz-karlsruhe.the 

Üyelik gerekli 

WebFeat Federated Search Engine 

http://www.webfeat.org 

Web of Science Clarivate Analytics  

Üyelik gerekli 

WilsonWeb General science and social science journals 

http://vnweb.hwwilsonweb.com/hww/login.jhtml 

Required login 

4.3.1.1 ScienceDirect’ten EndNote Kütüphanesine Referans Export İşlemi. 

Referansları ScienceDirect veri tabanından EndNote kütüphanesine export etmek için: 

1. http://www.sciencedirect.com  URL adresini açın. ‘ScienceDirect’ veri tabanı ana 

sayfası görüntülenecektir. 

2. ‘Quick Search’ (hızlı arama) sayfasında aramak istediğiniz kelimeleri girin. 

(Örneğin: ‘Keywords’de Variogram olan makaleleri aramak istiyoruz). ‘Search’ 

butonuna basın. 

    

3. Arama sonucu referans kayıtları listelenecektir. 

   

4. Arama sonuçlarını sınırlandırmak için farklı parametreler seçilebilir ya da 

girilebilirsiniz (Örneğin: ‘Refine by’ alanında ‘2018’ onay kutusunu işaretleyin). 

http://highwire.stanford.edu/
http://www.fiz-karlsruhe.de/
http://www.webfeat.org/
http://vnweb.hwwilsonweb.com/hww/login.jhtml
http://www.sciencedirect.com/
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5. Kütüphanenize export etmek istediğiniz referans kayıtlarını işaretleyin ve 

‘Export’ linkine tıklayın. 

6. Açılan ‘Export’ ekranında ‘Export citation to RIS’ linkine tıklayarak referans 

kayıtlarını download edin. 

7. Download ettiğiniz referans kayıtları, ‘Aç’ butonuna tıkladığınızda, açık olan 

EndNote kütüphanenize eklenerek, Imported References geçici grubunda 

görüntülenecektir. 

Sonuç 

    

4.3.1.2 WorldCat’ten EndNote Kütüphanesine Referans Export İşlemi 

EndNote kütüphanenize Worldcat’ten referans kayıtlarını export etmek için: 

1. www.worldcat.org adresine giriş yapın. 

2. WorldCat ana sayfasında: 

‘Advanced Search’e tıklayın. 

http://www.worldcat.org/
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3. Arama kriterinizi girin ve ‘Search’ butonuna tıklayın. 

  

4. Kullanacağınız referans kaydı linkine tıklayın. 
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5. Cite/Export linkine tıklayın. 

6. Export to EndNote / Reference Manager linkine tıklayın. 

  

8. RIS dosyasını download etmek için ‘Open’ butonuna tıklayın. Sonuç doğrudan 

EndNote kütüphanenize eklenecek ve Imported References geçici grubunda 

görüntülenecektir. 

Sonuç 

 

4.3.1.3 PubMed Veri Tabanından EndNote Kütüphanesine Referans Export İşlemi 

1. http://www.ncbi.nlm.nih.gov/PubMed/ URL adresini açın 

‘PubMed’ ana penceresi görüntülenecektir. 

2. Aramak istediğiniz kelimeyi girin. 

(Biz bu örnekte Joniau M. yazarına ait referans kayıtlarını aramak istiyoruz) 

Aramanızı detaylandırmak için ‘Advanced’ linkine tıklayabilirsiniz. 

‘Search’ butonuna basın. 

http://www.ncbi.nlm.nih.gov/PubMed/


ResearchSoftware.com 59 

EndNote X9 

  

3. Arama sonuçları liste halinde görüntülenecektir. 

EndNote kütüphanenize import etmek istediğiniz referans kayıtlarını işaretleyin. 

4. ‘Send to’ linkine tıklayın ve ‘Citation Manager’ radyo butonunu işaretleyin. 

   

5. ‘Create File’ butonuna bastığınızda seçtiğiniz referanslar açık olan EndNote 

kütüphanenize import edilecek ve Imported References geçici grubunda 

görüntülenecektir. 

Sonuç 
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 Not 

 Eğer herhangi bir kayıt seçmezseniz, ‘Number to send’ listesinde EndNote’a 

aktarmak istediğiniz referans kayıt sayısını belirleyerek, kayıtların import 

edilmesini sağlayabilirsiniz. 

 Import işlemi sırasında eğer, EndNote Online uygulaması da kullanılıyorsa açılan 

‘Choose Destination’ ekranında EndNote’u seçin ve ‘OK’ butonuna basın. Seçilen 

referanslar açık olan EndNote kütüphanenize import edilecektir. 

4.3.1.4 EndNote ve Google Scholar Kullanımı 

4.3.1.4.1 ENDNOTE ILE GOOGLE SCHOLAR KULLANIMI IÇIN GEREKLI AYARLAR 

Google Scholar’da gerçekleştirilen arama sonuçlarını, EndNote kütüphanelerine 

aktarmak için aşağıdaki işlem sırasını takip edebilirsiniz; 

1. http://scholar.google.com.tr/  URL adresini açın, 

‘Google Scholar’ arama sayfası görüntülenecektir. 

2. ‘Kaynakça Yöneticisi’ olarak EndNote’u belirlemek için, ‘Ayarlar’ butonuna tıklayın. 

   

3. Açılan ekranın alt bölümünde yer alan ‘Kaynakça Yöneticisi’ bölümdeki ‘Alıntıları 

EndNote konumuna aktarma bağlantılarını gösterin’ şeçeneğinde bulunan listeden 

EndNote’u seçin. 

   

4. Yapılan değişiklikleri kaydetmek için ‘Kaydet’ butonuna basın. Kayıt işlemi 

tamamlandığında arama ekranına tekrar dönülecektir. 

Yapılan bu ayarlar sonrasında Google Scholar’da yapılan arama işlemi sonucundaki 

referans kayıtları kolaylıkla EndNote kütüphanelerine eklenebilecektir. 

http://scholar.google.com.tr/
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4.3.1.4.2 GOOGLE SCHOLAR VERI TABANINDAN ENDNOTE KÜTÜPHANELERINE KAYIT AKTARMA 

EndNote ile Google Scholar kullanımı için, gerekli ayarlar yapıldıktan sonra arama ve 

EndNote kütüphanelerine kayıt aktarma işlemlerini, aşağıdaki işlem sırasını izleyerek 

gerçekleştirebilirsiniz; 

1. Basit veya gelişmiş arama ekranlarının herhangi birinde, aramak istediğiniz 

kriterleri gerekli alanlara girin ve ‘Arama’ butonuna basın. (Örneğin: Variogram 

olan makaleleri aramak istiyoruz). 

   

2. Arama sonucunda Variogram kelimesini içeren tüm kayıtlar listelenecektir. 

   

3. İstediğiniz referans kaydını EndNote kütüphanesine aktarmak için kaydın hemen 

altında bulunan ‘EndNote konumuna aktar’ linkine tıklayın. (Örneğin: ‘Fitting 

variogram models by weighted least squares’ kaydını aktaralım) 

4. İlgili linke tıkladığınızda açılan ekrandan referans kaydını EndNote kütüphanenize 

iki farklı yöntemle ekleyebilirsiniz; 

 ‘Dosya Yükleme’ (File Download) ekranında, ‘Aç’ (Open) butonuna bastığınızda, 

referans kaydınız açık olan EndNote kütüphanenize eklenecektir. 

   

 ‘Dosya Yükleme’ ekranında ‘Kaydet’ (Save) butonuna basarak, referans kaydınızı 

EndNote import dosyası olarak kaydedip, istediğiniz EndNote kütüphanenizi 

açtıktan sonra, kaydedilen dosyanın üzerine çift tıklayarak import işlemini 

gerçekleştirilebilirsiniz. 
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  Not 

 Referans kaydı dosya olarak (.enw) kaydedildiğinde import işlemi sırasında açık bir 

EndNote kütüphanesi yoksa ‘Select a Reference Library’ ekranından import 

yapılacak kütüphane seçilebilir. 

4.3.2 Bir Filtre Kullanarak Import İşlemi Gerçekleştirme 

Bir üniversite kataloğundan veya online bibliyografik veri tabanından referans 

kayıtlarını EndNote kütüphanenize eklemek veya metin dosyası olarak kaydetmek için 

EndNote import filtrelerini kullanabilirsiniz. Import filtreleri metin dosyalarını bir 

EndNote kütüphanesine import ederken kullanılan dosyalardır. Filtreler import 

aşamasında metnin nasıl biçimleneceği ve düzenleneceği konusunda bilgi verir.  

Pubmed veri tabanından referans kayıtlarını doğrudan EndNote kütüphanesine import 

ile ilgili ayrıntılı bilgi için Bkz. 4.3.1.3 PubMed Veri Tabanından EndNote Kütüphanesine 

Referans Export İşlemi. 

Aşağıdaki örnekte, PubMed veri tabanındaki verilerin sonucu, metin dosyası olarak 

kaydedilmektedir. 

1. http://www.ncbi.nlm.nih.gov/PubMed/ URL adresini açın 

‘PubMed’ ana penceresi görüntülenecektir. 

2. Aramak istediğiniz kelimeyi girin. 

(Biz bu örnekte Joniau M. yazarına ait referans kayıtlarını aramak istiyoruz) 

ve ‘Search’ butonuna basın. 

 

3. Arama sonuçları liste halinde görüntülenecektir. 

EndNote kütüphanenize import etmek istediğiniz referans kayıtlarını seçin. 

http://www.ncbi.nlm.nih.gov/PubMed/
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4. ‘Send to’ linkine tıklayın ve ‘Choose Destination’ alanında ‘File’ı seçin. 

5. ‘Format’ listesini açın ve listeden ‘MEDLINE’ı seçin. ‘Sort by’ listesinde sıralama 

kriterinizi belirleyin ve ‘Create File’ butonuna basın. 

 

6. ‘Dosya Yükleme’ penceresi görüntülenecektir. ‘Kaydet’ (Save) listesininde ‘Farklı 

Kaydet’i (Save as) seçin. 

 

7. Açılan ‘Farklı Kaydet’ ekranında ‘Dosya adı’ alanına dosya adını ‘pubmed_joniau.txt’ 

olarak girin. ‘Kayıt türü’ alanında ‘Metin Belgesi’ default olarak gelecektir. ‘Kaydet’ 

butonuna basın. 

   

EndNote kütüphanelerine bir metin dosyasının nasıl import edileceği konusunda 

ayrıntılı bilgi için; Bkz. 4.4 Tekst Dosyası Import İşlemi. 

4.4 Tekst Dosyası Import İşlemi 

Internet üzerinden online veri tabanı servislerinden metin formatında indirilen veya bir 

CD’de bulunan metin dosyalarındaki referans kayıtları, import modülü kullanılarak 

EndNote kütüphanelerine eklenebilir. Bu metodu kullanarak, manuel referans kaydı 

girişinden hem daha hızlı hem de daha kolay referans kaydı eklemek mümkündür. 
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Metin formatında kaydedilmiş referans kayıtlarını sorunsuz import edebilmeniz için, 

EndNote’un hazır import filtrelerini kullanabilir. ‘Edit/Import Filters/New Filter…’ 

menüsünden kendi import filtrenizi oluşturabilir veya ‘Edit/Import Filters/Open Filter 

Manager…’ menüsünden kurulum ile gelen import filtrelerine ulaşabilirsiniz. ‘Edit’ 

butonunu kullanarak açacağınız ekrandan import işlemi için kullanacağınız filtreler 

üzerinde değişiklik ve düzenleme işlemleri de gerçekleştirebilirsiniz. 

Kurulum ile gelen import filtreleri default olarak;  

‘C:\Program Files\EndNote X9\Filters’ 

‘C:\Program Files (x86)\EndNote X9\Filters (64-bit Windows versiyonları için)’  

klasöründe bulunmaktadır. Bunun dışında düzenlediğiniz ya da yeni oluşturduğunuz 

filtreler kendi kişisel klasörünüzde tutulacaktır (default olarak, 

C:\Users\UserName\Documents\EndNote\Filters). 

Referans import işlemini gerçekleştirmeden önce, metin dosyasındaki referans kayıtları 

formatının, kullanılacak import filtresinin okuyabileceği formatta olduğundan emin 

olun. Her bir alanda bulunan veriler, belirli bir düzende birbirinden ayrılmalıdır. Bu 

sayede import işlemini gerçekleştirirken veriler doğru bir şekilde okunacak, 

ayrıştırılacak ve ilgili alanlara doğru şekilde yerleştirilerek, EndNote kütüphanesine 

problemsiz bir şekilde import işlemi tamamlanacaktır. 

Dosyada bulunan kayıtlara ait veriler içinde hangi bilginin hangi alana ait olduğu, her 

bir bilginin başında yer alan farklı alan etiketleri (tag) ile karakterize edilir. Örneğin 

MEDLABS formatında her bir yazar adı farklı bir satırda, yazar adından önce ‘AU –’  ve 

başlık ‘TI –’ “etiketleri kullanılarak belirlenir. 

Örnek:  

TI  - Levels of asymmetric dimethylarginine, nitric oxide and lipid peroxidation markers 

in patients with end-stage renal disease having peritoneal dialysis treatment. 

AU  - Gocmen AY 

AU  - Sahin E 

AU  - Kocak H 

AU  - Tuncer M 

AU  - Gumuslu S 

Veri tabanlarındaki içerikler aynı olmasına rağmen, her servis kendi formatını 

kullanmaktadır. Örneğin; bazı servisler yazar adı ve soyadı arasında tire işareti 

kullanırken (Kocak-H) bir başkası virgül (Kocak,H) veya boşluk (Kocak H) 

kullanmaktadır. Bu nedenle referans import işlemi sırasında hangi veri tabanı ve hangi 

servisin kullanıldığını bilmek önemlidir. Her servis için import modülü özel çeviriciler 

içermektedir. Çeviriciler tekst dosyalarının import programı tarafından sorunsuz 

okunmasını sağlar. 

Bir veri tabanı servisinden referans import işlemi sırasında aşağıdaki adımlar önemlidir: 

 Hedef (= veri tabanından import işleminin gerçekleştirileceği) kütüphanenizi açın; 

 Menülerden ‘File>Import>File’ı seçin. 

 ‘Choose File’ (Dosya Seç) butonunu kullanarak ‘Import Data File’ kutusuna tekst 

dosyasını girin; 

 ‘Import Option’ listesinden filtreyi seçin; 

 ‘Text Translation’ listesinden Unicode (UTF-8) seçin. 

Son seçenek Türkçe gibi özel karakterler içeren dillerdeki kayıtların import işleminin 

sorunsuz gerçekleştirilebilmesi için önemlidir. 
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4.4.1 PubMed Filtresi ile Import İşlemi 

Bu örnekte bir önceki örnekteki tekst dosyasını (pubmed_joniau.txt) EndNote 

kütüphanemize import edeceğiz. 

1. EndNote’u açın. 

2. Menülerden ‘File/Import/File…’ seçeneğine veya araç çubuğundan  (Import) butonuna 

basın. ‘Import File’ ekranı görüntülenecektir.  

3. ‘Choose...’ butonuna basın ve kaynak metin dosyasını (pubmed_joniau.txt) seçin. 

  

4. ‘Aç’ butonuna basın. ‘Import File’ ekranına geri dönülecektir. 

5. ‘Import Option’ listesinden ‘Pubmed (NLM)’ import filtresini seçin. 

6. ‘Duplicates’ listesinden çift kayıt kriterini belirleyin. 

 Import All: Tüm referansları import etmek için kullanılır.  

 Discard Duplicates: Çift kayıtlar haricindeki tüm referansları import etmek için 

kullanılır. 

 Import into Duplicates Library: Çift kayıtlar için, ‘Kütüphane Adı-Dupl.enl’ 

olarak yeni bir kütüphane oluşturmak için kullanılır. 

7. ‘Text Translation’  listesinden ‘Unicode (UTF-8)’i seçin. 

8. ‘Import’ butonuna basın. 

  

Sonuç 

Import edilen kayıtlar, grup panelinde Imported References altında listelenecektir. 

Kütüphanenizdeki tüm referansları görüntülemek için All References’ı seçin. 
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4.4.2 RIS Filtresi ile Import İşlemi 

RIS filtresi Reference Manager, ProCite veya internet üzerindeki bir veri tabanından 

RIS formatında export edilmiş metin dosyalarını import etmek için kullanılır. Bu 

örnekte, ProCite veri tabanından RIS formatında export edilmiş metin dosyasındaki 

referans kayıtlarını, EndNote kütüphanemize import edeceğiz. Referans kayıtlarının 

sorunsuz import edildiğini kontrol amacı ile geçici olarak yeni bir EndNote 

kütüphanesine import etmeniz önerilir. 

1. EndNote’u açın.  

2. Menülerden ‘File/Import/File…’ seçeneğine veya araç çubuğundan  (Import) butonuna 

basın. ‘Import File’ ekranı görüntülenecektir. 

3. ‘Choose...’ butonuna basın ve ProCite tekst dosyasını seçin. 

4. ‘Aç’ butonuna basın. ‘Import File’ ekranına geri dönülecektir. 

5. ‘Import Option’ listesinden ‘Reference Manager (RIS)’ import filtresini seçin. 

6. ‘Duplicates’ listesinden çift kayıt kriterini belirleyin. 

 Import All: Tüm referansları import etmek için kullanılır.  

 Discard Duplicates: Çift kayıtlar haricindeki tüm referansları import etmek için 

kullanılır. 

 Import into Duplicates Library: Çift kayıtlar için, ‘Kütüphane Adı-Dupl.enl’ 

olarak yeni bir kütüphane oluşturmak için kullanılır. 

7. ‘Text Translation’ listesinden ‘Unicode (UTF-8)’i seçin. 

8. ‘Import’ butonuna basın. 

   

 Not 

 Bir metin dosyasındaki referans kayıtlarını import ederken, doğru import filtresini 

seçebilmek için metin dosyasının oluşturulduğu kaynak (provider veya service) 

bilgisi önemlidir. 

 Kayıtları import ederken, import işlemini geçici bir kütüphaneye gerçekleştirmenizi 

ve kullanmak istediğiniz kayıtları belirledikten sonra kalıcı kütüphanenize 

taşımanızı öneriyoruz. 

 Reference Manager, EndNote ve ProCite tarafından tanınan .RIS uzantılı bir 

dosyaya çift tıkladığınızda kayıtlar doğrudan EndNote veri tabanına import edilir. 

 EndNote Online sitesinden http://www.endnote.com veri import ile ilgili teknik 

desteğe, ipuçlarına ve EndNote’un en son versiyonuna ait faydalı bilgilere 

erişebilirsiniz. Ayrıca güncellenmiş stil, filtre ve bağlantı dosyalarını web sitesinde 

‘Downloads’ altında bulabilirsiniz. 

 EndNote, diğer kaynaklardan veri importu sırasında esnek birçok yol sunmasına 

rağmen tüm kaynaklardan import işlemi gerçekleştirilememektedir. Bazı 

durumlarda kendi import filtrenizi oluşturmanız ya da import etmeden önce kelime 

işlemcinizde veriyi düzenlemeniz gerekebilir. 

4.5 PDF Import 

EndNote, bir PDF dosyasından ya da bir klasördeki PDF dosyalarından, DOI’yi (Digital 

Object Identifiers) ayıklayarak doğrudan EndNote kütüphanesine import edilmesine 

http://www.endnote.com/
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olanak sağlamaktadır. Bu import işlemiyle PDF'lerdeki temel bibliyografik bilgileri 

kütüphanenize aktararak PDF dosyasının ilişkilendirildiği referans kayıtları oluşturabilir 

ve sonrasında PDF dosyalarının içeriğinde arama işlemleri gerçekleştirebilirsiniz. Bkz. 

8.9 PDF Handling 

4.5.1 PDF Manuel Import 

PDF manuel import işlemi ile daha önceden yapmış olduğunuz çalışmalarınızda kayıt 

altına aldığınız PDF dosyalarınızı tek tek ya da bir klasör altında bulunan PDF 

dosyalarınızın tümünü import ederek temel bibliyografik bilgileri EndNote 

kütüphanenize ekleyebilir ve yazacağınız makalelerde kullanabilirsiniz. 

4.5.1.1 Tek bir PDF dosyası import etmek için; 

1. PDF’i import etmek istediğiniz EndNote kütüphanenizi açın. 

2. ‘File/Import/File...’ menüsünü seçin. ‘Import File’ ekranı açılacaktır. 

3. ‘Choose...’ butonuna basın ve kütüphanenize import etmek istediğiniz PDF 

dosyasını seçin. 

  

4. ‘Aç’ (Open) butonuna basın. ‘Import File’ ekranına geri dönülecektir. 

5. ‘Import Option’ listesinde ‘PDF’i seçin. 

6. ‘Duplicates’ listesinden çift kayıt kriterini belirleyin. 

 Import All: Tüm referansları import etmek için kullanılır.  

 Discard Duplicates: Çift kayıtlar haricindeki tüm referansları import etmek için 

kullanılır. 

 Import into Duplicates Library: Çift kayıtlar için, ‘Kütüphane Adı-Dupl.enl’ 

olarak yeni bir kütüphane oluşturmak için kullanılır. 

7. ‘Text Translation’ listesinde ‘No Translation’ı seçin. 

 

8. ‘Import’ butonuna basın. PDF dosyanız temel bibliyografik bilgilerle kütüphanenize 

eklenecek ve ‘Grup Panel’inde ‘Imported References’ geçici grubunda 

görüntülenecektir.  
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4.5.1.2 PDF dosyalarınızın bulunduğu klasörleri import etmek için; 

1. PDF dosyalarınızı import etmek istediğiniz EndNote kütüphanenizi açın. 

2. ‘File/Import/Folder...’ menüsünü seçin. ‘Import Folder’ ekranı açılacaktır. 

3. ‘Choose...’ butonuna basın ve kütüphanenize import etmek istediğiniz PDF 

klasörünü seçin. 

  

4. ‘Tamam’ butonuna basın. ‘Import Folder’ ekranına geri dönülecektir. 

5. Seçmiş olduğunuz PDF klasörünüz alt klasörlere sahip ise ‘Include files in 

subfolders’ onay kutusunu seçmeniz gerekmektedir. 

6. ‘Import Option’ listesinde ‘PDF’i seçin. 

7. ‘Duplicates’ listesinden çift kayıt kriterini belirleyin. 

 Import All: Tüm referansları import etmek için kullanılır.  

 Discard Duplicates: Çift kayıtlar haricindeki tüm referansları import etmek için 

kullanılır. 

 Import into Duplicates Library: Çift kayıtlar için, ‘Kütüphane Adı-Dupl.enl’ 

olarak yeni bir kütüphane oluşturmak için kullanılır. 

 

8. ‘Import’ butonuna basın. PDF klasörünüzün içindeki dosyalarınız temel bibliyografik 

bilgilerle kütüphanenize eklenecek ve ‘Grup Panel’inde ‘Imported References’ geçici 

grubunda görüntülenecektir.  
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4.5.1.3 PDF dosyalarınızın bulunduğu klasörleri grup set ve gruplar halinde import 

etmek için; 

1. PDF dosyalarınızı import etmek istediğiniz EndNote kütüphanenizi açın. 

2. ‘File/Import/Folder...’ menüsünü seçin. ‘Import Folder’ ekranı açılacaktır. 

3. ‘Choose...’ butonuna basın ve kütüphanenize import etmek istediğiniz PDF 

klasörünü seçin. 

 

4. ‘Tamam’ butonuna basın. ‘Import Folder’ ekranına geri dönülecektir. 

5. Seçmiş olduğunuz PDF klasörünüz alt klasörlere sahip ise ‘Include files in 

subfolders’ onay kutusunu, grup set ve gruplar halinde import edilmesi için ‘Create 

a Group Set for this Import’ onay kutusunu işaretlemeniz gerekmektedir. 

6. ‘Import Option’ listesinde ‘PDF’i seçin. 

7. ‘Duplicates’ listesinden çift kayıt kriterini belirleyin. 

 Import All: Tüm referansları import etmek için kullanılır.  

 Discard Duplicates: Çift kayıtlar haricindeki tüm referansları import etmek için 

kullanılır. 

 Import into Duplicates Library: Çift kayıtlar için, ‘Kütüphane Adı-Dupl.enl’ 

olarak yeni bir kütüphane oluşturmak için kullanılır. 

 

8. ‘Import’ butonuna basın. PDF klasörünüzde bulunan, alt klasörlerin içindeki PDF 

dosyalarınız temel bibliyografik bilgilerle kütüphanenize eklenecektir. Eklenen 

kayıtlar ‘Grup Panel’inde ‘Imported References’ geçici grubunda ve bu klasör adı ile 

oluşturulan grup set altındaki gruplarda görüntülenecektir. 
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4.5.2 PDF Otomatik Import 

PDF dosyalarınızı otomatik olarak import etmek için; 

1. PDF dosyalarınızı import etmek istediğiniz EndNote kütüphanenizi açın. 

2. Bilgisayarınızda PDF’lerin otomatik olarak import edileceği bir klasör oluşturun. 

3. ‘Edit/Preferences/PDF Handling’ menüsünü seçin. 

 

4. ‘PDF Auto Import Folder’ alanında ‘Enable automatic importing’ onay kutusunu 

işaretleyin ve otomatik import için oluşturduğunuz klasörü seçin. 

 

5. ‘Preferences’ ekranı aşağıdaki gibi görüntülenecektir. 
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6. PDF klasörüne eklediğiniz PDF’ler, EndNote kütüphaneniz açık ise siz çalışmaya 

devam ederken, açık değil ise kütüphanenizi bir sonraki açtığınızda otomatik olarak 

import edilecek ve ‘Grup Panel’inde ‘Imported References’ geçici grubunda 

görüntülenecektir. 

 

7. PDF klasörünüze eklediğiniz PDF’ler çift kayıt oluşmaması için otomatik olarak 

oluşturulan ‘Imported’ klasörüne aktarılacaktır. 

 

 Not 

 Mevcut PDF dosyanızı, EndNote arama paneli üzerine sürükle-bırak ile 

kütüphanenize ekleyebilirsiniz. 

 Mevcut PDF dosyanızı, sağ tuş menü ‘Birlikte Aç’ seçeneğinde uygulama olarak 

EndNote’u seçerek kütüphanenize ekleyebilirsiniz.  

 Import işlemi gerçekleştirilirken, PDF dosyasının ilk iki sayfasında iki DOI 

bulunursa, EndNote veriyi almak için DOI alanına en az bir DOI koyacaktır. PDF 

sonra eklenir ve dosya adı başlık alanına girilir. 

 Import işlemi tamamlandığında, yeni kayıt Imported References grubunda 
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depolanır ve PDF dosyasından alınmış Digital Object Identifiers (DOI) için verilen 

bibliyografik bilgileri içerir (başlık, yazar, cilt, sayı, sayfa, yıl ve DOI gibi). 

 Imported References grubu, başka bir referans grubunu her import ettiğinizde 

değişen geçici bir gruptur. EndNote'tan çıktığınızda grup panel listesinden 

kaldırılacaktır. 

 Bazen download edilen PDF’lerin isimleri makale içeriğini gösterecek şekilde 

olmamaktadır (Numaralarla vb. gösterilmektedir). Bu gibi durumlarda 

‘Edit/Preferences/PDF Handling’ ekranında ‘PDF Auto Renaming Options’ alanında 

import edilecek PDF’lerinizi size sunulan seçenekler ya da ‘Custom’ seçeneğini 

kullanarak sizin belirleyeceğiniz alan sıralaması ile yeniden isimlendirebilirsiniz. Bu 

işlem için: 

1. ‘Edit/Preferences/PDF Handling’ menüsünde isimlendirme kriterinizi belirleyin. 

 

2. Import etmek istediğiniz PDF dosyanızı PDF klasörünüze ekleyin 

(belirleyeceğiniz isimlendirme kriteri tüm PDF import işlemlerinde geçerli 

olacaktır). 

 

3. EndNote’u başlattığınızda eklemiş olduğunuz PDF belirlediğiniz yeniden 

isimlendirme kriterine bağlı olarak güncellenecektir (Örnekte kriter olarak 

Author+Title seçilmiştir). 
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5 Bir Kütüphane ile Çalışma 

Bir EndNote kütüphanesinde kişisel referanslar ile çalışırken (örneğin; kopyalama, 

açma, export etme ve düzenleme işlemleri gerçekleştirirken), referans kayıtlarının 

seçimi, sıralaması ve kütüphane içerisinde nasıl gezinti yapılacağını bilmek önemlidir. 

Bkz. 1.7 Kısayol Tuş Komutları 

5.1 Kütüphane Penceresinde Referans Kaydı Seçimi  

Tek klik Tek bir referans kaydını seçmek için 

Aynı zamanda referans kaydına ait bir alanda 

bulunan bilginin birkaç harfini tuşlayarak o kaydı 

seçebilirsiniz. 

<Ctrl> + klik <Ctrl> tuşunu basılı tutup, referans kayıtlarının 

üzerine tıklayarak birden fazla kaydı seçebilirsiniz. 

<Shift> + klik Bir aralıktaki referans kaydını seçmek için  

1 İlk referans kaydına tıklayın 

2 <Shift> tuşunu basılı tutun 

3 Seçmek istediğiniz aralıktaki son referans kaydına 

tıklayın. 

<Ctrl+A> Tüm referans kayıtlarını seçmek için. 

Seçim ve seçimi tekrar iptal etmek için <Ctrl+A> 

tuşlarını kullanın 

<Home> Kütüphanedeki ilk referans kaydını seçmek için 

<End> Kütüphanedeki son referans kaydını seçmek için 

Yukarı yön tuşu  Bir önceki referans kaydını seçmek için 

Aşağı yön tuşu  Bir sonraki referans kaydını seçmek için 

5.2 Ekranlarda Gezinti (Navigating) 

5.2.1 Library (Kütüphane) Penceresinde Gezinti 

Dikey kaydırma 

çubuğu 

Referans listesini dikey olarak aşağı ve yukarı 

kaydırmak için kullanılır 

 Seçilen referans kaydından aşağı inmek için 

 Seçilen referans kaydından yukarı çıkmak için 

<Page Up> Bir ekran boyutu kadar yukarı çıkmak için 

<Page Down> Bir ekran boyutu kadar aşağı inmek için 

<Home> Kütüphanedeki ilk kayda gitmek için 

<End> Kütüphanedeki son kayda gitmek için 

Yukarı yön tuşu Seçili referans kaydından bir önceki kayda gitmek için 

Aşağı yön tuşu Seçili referans kaydından bir sonraki kayda gitmek için 
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5.2.2 Referans Penceresinde Gezinti 

 
Previous reference (Önceki referans) 

 
Next reference (Sonraki referans) 

<Tab> Next field (Sonraki alan) 

<Shift+Tab> Previous field (Önceki alan) 

<Ctrl + J>  veya 

References/Go to… 

Referanstaki spesifik bir metne erişmek için 

kullanılır 

5.2.3 Ekran Görüntü Seçeneklerinin Kullanılması 

‘Layout’ seçeneği ile EndNote kütüphane pencerenizin görüntü özelliklerinden 

faydalanabilirsiniz. 

 

Grup Panel 

 Left 

 Off  

 

 

Reference Panel 

 Right 

 Righth – Split 

 Bottom 

 Bottom – Split 

 Off 
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5.2.4 PDF Görüntü Seçeneklerinin Kullanılması 

Mevcut PDF’lerinizi, PDF araç çubuğu üzerindeki ‘Open PDF’ butonu ile kütüphane 

penceresinden ayrı görüntülenmesini sağlayabilirsiniz. 

 

5.3 Sıralama (Sorting) 

Sıralama işlemi birkaç farklı şekilde yapılabilir: 

 Kütüphane penceresinde kolon başlığına tıklayarak; 

 ‘Tools/Sort Library…’ menüsünü kullanarak; 

5.3.1 Mouse Kullanarak Sıralama 

Sıralama yapılmak istenilen alana ait kolon başlığına tıklayarak sıralama işlemi 

gerçekleştirilebilir. 

  

 Not 

 Ulaşmak istediğiniz kaydın, klavyeden ilk harflerine tıkladığınızda eşleşen ilk kayda 

yönlendirilirsiniz. Eşleme, kütüphane sıralamasına göre değişecektir. 

Yazar adına göre sıralamak için 

‘Author’ kolon başlığına tıklayın 
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5.3.2 ‘Sort Library’ Menüsünü Kullanarak Sıralama 

‘Sort Library’ komutu, tüm referans kayıtlarının görüntülendiği ‘Kütüphane 

Penceresi’nde referansları gözden geçirirken, export ederken, yazdırırken ya da 

kopyalarken aranan kayıtlara daha kolay ulaşabilmenizi ve düzenlemenizi sağlar. 

EndNote kütüphaneleri genel olarak ilk yazarın soyadına ve ilk adına göre, yıla göre ve 

kayıt numarasına göre sıralanır. 

1. ‘Tools/Sort Library…’ menüsünü seçin. 

2. ‘Sort Options’ ekranı görüntülenecektir. 

Ekranda bulunan listelerden bir veya birden 

fazla alan adını seçin. (öncelik sırasına göre 

alan adlarını belirleyin) 

3. Ekranın sağında bulunan sıralama  

butonunu kullanarak sıralama işlemini artan 

veya azalan şeklinde yapabilirsiniz. Sıralama 

kriterleri belirledikten sonra ‘OK’ butonuna 

tıklanarak sıralama işlemi gerçekleştirilebilir. 

5.4 Referans Görüntüleme/Gizleme 

EndNote kütüphanenizde referanslarla çalışırken, tüm referansları veya alt gruplardaki 

referansları görüntüleyebilirsiniz. Bu gruplar ‘Search Library’, ‘Import’, ‘Show Selected 

References’ ve ‘Hide Selected References’ komutlarının sonucunda oluşturulabilir. 

Bir EndNote kütüphanesinde, herhangi bir  arama işlemi yapıldığında kriterlere uyan 

kaç kayıt varsa referans listesinde, yalnızca bu kayıtlar listelenecektir. Örneğin; arama 

sonucunda 3 kayıt bu kriterlere uyuyorsa, ‘Search Results’ grubunun altındaki referans 

listesinde yalnızca bu 3 kayıt yer alacaktır. Ayrıca, arama sonucuna uyan kayıt sayısı, 

‘Groups Paneli’nde ‘Search Results’ grubunun sağında parantez içinde ve kütüphane 

penceresinin sol alt köşesinde ‘Showing 3 of x references’ bilgi metni içinde 

belirtilecektir. 

Birçok EndNote komutu, yalnızca ‘Kütüphane Penceresi’nde görüntülenen kayıtlar ile 

çalışmak için kullanılabilir (örneğin; Search Libary, Change and Move Field, Change 

Text, Sort, Print, ve Export). Aşağıda, bu komutlar ve kullanım şekilleri hakkında kısa 

bilgiye ulaşabilirsiniz: 

 Yalnızca görüntülenen referans kayıtlarında arama yapmak için ‘Tools/Search 

Library’ komutunu kullanabilirsiniz (‘All References’ grubu seçilerek tüm kayıtlarda 

veya bir grup seçilerek yalnızca seçilen grup içerisinde arama yapabilirsiniz). 

 ‘Change Text’ ve ‘Change Field and Move Field’ komutlarını kullanarak, yalnızca 

görüntülenen referans kayıtlarını düzenleyebilirsiniz. 

 Terim listelerinde, ‘Update List’ komutunu kullanılarak, yanlızca görüntülenen 

referans kayıtları için, terim listelerinizi güncelleyebilirsiniz. 

 Görüntülenen referans kayıtları için, ‘Tools/Subject Bibliography’ komutunu 

kullanarak, konu bibliyografyası oluşturabilirsiniz. 

 Yalnızca görüntülenen referansları, ‘Print’ veya ‘Export’ edebilirsiniz. 

5.4.1 Arama Sonuçlarını Görüntüleme 

Örnek kütüphanede, ‘Quick Search’ alanı kullanılarak yapılan arama işlemi 

(echolocation) sonucu, ‘Showing References’ grubu altında aşağıdaki şekilde 

listelenebilir. 
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Ekranın alt bölümünde yer alan durum çubuğunda, ‘Search Results’ grubunda 

görüntülenen referans sayısı ve tüm referans sayısına ait bilgi görüntülenecektir. 

5.4.2 Tüm Referansları Görüntüleme  (Show All References) 

‘Kütüphane Penceresi’nde bulunan tüm referans kayıtlarını görüntülemek için; 

 ‘References’ menüsünden bulunan ‘Show All References’ komutunu ya da ‘Ctrl+M’ 

tuş kombinasyonu 

  

veya    

 Kütüphane penceresinde sağ tuş menüsünden ‘Show All References’ komutu 

kullanılabilir. 

  

Kütüphanede bulunan tüm kayıtları 

görüntülemek için ‘Show All 

References’a  tıklayın 

Bu grupta  Quick Search (Hızlı Arama) 

sonuçları görüntülenir. 

Gösterilen kayıt bilgi metni 
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5.4.3 Seçilen Referansları Görüntüleme (Show Selected References) 

EndNote kütüphanesinde ‘Ctrl’ ya da ‘Shift’ tuşları kullanılarak seçtiğiniz referans 

kayıtlarını görüntülemek için; 

 ‘References’ menüsünden bulunan ‘Show Selected References’ komutunu 

      

veya 

 Kütüphane penceresinde sağ tuş menüsünden ‘Show Selected References’ komutu 

kullanılabilir. 

  

‘Show Selected References’ komutunu kullandığınızda, yalnızca seçtiğiniz referans 

kayıtlarını aşağıdaki gibi görüntüleyebilirsiniz. 

Kütüphanede bulunan seçili 

kayıtları görüntülemek için ‘Show 

Selected References’a  tıklayın 

6 referans seçilmiştir 

Seçilen bir referans 

üzerinde sağ tuş menü 

6 referans seçilmiştir 
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Benzer şekilde, aynı menülerden ‘Show All References’ komutunu kullanarak, EndNote 

kütüphanesinde bulunan tüm referans kayıtlarını görüntüleyebilirsiniz. 

5.4.4 Seçilen Referansları Gizle (Hide Selected References) 

‘Hide Selected References’ komutu, seçili referansların kütüphane penceresinde geçici 

olarak gizlenmesi dışında, ‘Show Selected References’ komutuna benzer şekilde 

kullanılmaktadır. Görüntülenen referans kayıtları ile çalışmanızı tamamladıktan sonra, 

gizlenen kayıtlar tekrar görüntülenmek istendiğinde ‘Show All References’ komutu ya 

da ‘Ctrl+M’ tuş kombinasyonu kullanılabilir. 

5.5 EndNote Kütüphanelerinde Arama 

EndNote kütüphanelerinde birkaç farklı arama seçeneği mevcuttur: 

 Bir kolon başlığına tıklayarak referans kayıtlarını hızlı bir şekilde sıralayabilir ve o 

alanda bulunan kelimelerin ilk veya ilk birkaç harfini yazarak aradığınız referans 

kaydına ulaşabilirsiniz. 

 ‘Quick Search’ (Hızlı Arama). 

 ‘Search Library’ (Ctrl+F) komutu ile, spesifik bir referans veya referans grubuna 

ulaşabilirsiniz. ‘Search Library’ panelinde, EndNote kütüphanelerinde arama yapar 

gibi, erişiminiz olan online veri tabanlarında da arama yapabilirsiniz. Bkz. 4.2 

‘Online Search’ import işlemi 

5.5.1 Kelimelerin İlk Harfini Yazarak Arama 

Bu arama şeklinde, referans listesinin hangi alana göre sıralandığı önemlidir. Çünkü 

arama işlemi bu belirlenen alanda yapılır. Buna göre hangi alanda arama yapmak 

isteniyorsa öncelikle referans kayıtları o alana göre sıralanmalıdır.  Örneğin; EndNote 

kurulumunda gelen ‘Sample_Library_X9’ kütüphanesinde referans kayıtları default 

olarak öncelikle yazar alanına sonrasında yıla göre sıralanmaktadır. 

Sample_Library_X9’ kütüphanesinde klavyeden ‘P’ harfine bastığınızda referans 

listesinde Author alanında ‘P’ harfi ile başlayan ilk kayıt olan ‘Pepperberg’ kaydına 

gidilecektir. Benzer şekilde farklı bir harfe bastığınızda ise o harfle başlayan ilk referans 

kaydına gidilecektir. Arda arda ‘per’ yazacak şekilde birkaç harfe bastığınızda ise, ard 

arda bu harfleri içeren ilk kayıt olan ‘Peron’ kaydına gidilecektir. 

 Not 

 EndNote kurulumunda gelen örnek “Sample_Library_X9” kütüphanesine default 

olarak; 

‘C:\Users\Public\Public Documents\EndNote\Examples’ 

ya da 

Kütüphanedeki görüntülenen ve tüm referansların sayısı 

Yalnızca seçilen 6 referans 

kaydı  görüntülenecektir 
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‘C:\Program Files\EndNote X9\Examples’ (32-bit Windows versiyonları için) 

‘C:\Program Files (x86)\EndNote X9\ Examples’ (64-bit Windows versiyonları için) 

klasörlerinden ulaşabilirsiniz. 

 Kütüphanenizde bulunan referans kayıtlarının hangi alana göre sıralanacağını alan 

adına tıklayarak belirleyebilirsiniz. Sıralama konusunda ayrıntılı bilgi için Bkz. 5.2.3 

Ekran Görüntü Seçeneklerinin Kullanılması 

‘Layout’ seçeneği ile EndNote kütüphane pencerenizin görüntü özelliklerinden 

faydalanabilirsiniz. 

 

Grup Panel 

 Left 

 Off  

 

 

Reference Panel 

 Right 

 Righth – Split 

 Bottom 

 Bottom – Split 

 Off 

5.5.2 PDF Görüntü Seçeneklerinin Kullanılması 

Mevcut PDF’lerinizi, PDF araç çubuğu üzerindeki ‘Open PDF’ butonu ile kütüphane 

penceresinden ayrı görüntülenmesini sağlayabilirsiniz. 

 

 Sıralama (Sorting) 

5.5.3 Hızlı Arama (Quick Search) 

Bir EndNote kütüphanesinde ‘Quick Search’ işlemi, ‘Library’ araç çubuğunda bulunan, 

‘Quick Search’ açılır metin kutusuna arama kriteri girildikten sonra, ‘Enter’ tuşuna 

basılarak gerçekleştirilebilir. Bu arama şeklinde, metin kutusuna girilen kelime, 

referans kayıtlarının tüm alanlarında gerçekleştirilir (PDF ve PDF notları dahil). 
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 Not 

 EndNote, ‘Quick Search’ alanına, iki veya daha fazla bitişik terim girildiğinde, AND 

Boolean operatörünü kullanmaktadır. Örn. African grey parrots girildiğinde African 

AND grey AND parrots ile aynı değerlendirilecektir. 

 ‘Quick Search’ metin kutusuna, yeni arama kiterleri girilebileceği gibi, son 

kullanılan arama kriterleri için açılır liste kullanılabilir. 

5.5.4 EndNote Kütüphanelerinde Arama (Searching EndNote libraries) 

EndNote arama paneli, lokal EndNote kütüphanelerinde ve online veri tabanlarında, 

temel arama işlemleri için en kolay çözümü sunmaktadır. Her iki arama şekli için de, 

aynı arama paneli kullanılmaktadır.  

EndNote, spesifik referans kayıtları ya da referans grupları oluşturmada, ‘Search 

Library’ özelliğiyle etkili bir arama sağlamaktadır. Örneğin, kütüphanenizin hepsinde 

genel bir tarama yapabilir ya da spesifik alanlarla (örneğin; Author veya Keywords) 

aramalarınızı sınırlandırabilirsiniz. Çeşitli operatörler (örneğin; And, Or, Not, Contains, 

Is, Is less than, Is less than or equal to, Is greater than, Is greater than or equal to, 

Field begins with, Field ends with and Word begins with) kullanarak, kompleks 

aramalar yapabilirsiniz. 

Aramayı başlatmanın farklı yolları bulunmaktadır : 

 Araç çubuğu menüsünde ‘Tools/Search Library’ komutunu kullanarak. 

 ‘Ctrl+F’ tuş kombinasyonunu kullanarak. 

 ‘Search’ tabını kullanarak. 

Arama kriterinizin önüne ve arkasına özel karakterler kullanarak, arama sonuçlarınızı 

genişletebilirsiniz. Yıldız işareti herhangi bir karakter grubunu temsil etmektedir. 

 Alanlar ve PDF dosyaları, yıldız özel karakteri kullanılarak aranabilir. 

 Minimum karakter uzunluğu bulunmamaktadır. 

5.5.4.1 ‘Any Field+PDF with Notes’ Arama 

EndNote, PDF arama özelliği sayesinde, kütüphanenizde bulunan PDF dosyalarının 

içinde ve bu PDF dosyalarına eklemiş olduğunuz notlarda geçen kelimelerde, arama 

yapma imkanı sağlamaktadır. 

Tüm alanlarda, PDF dosyalarının içinde ve PDF’lere eklediğiniz notlarda arama yapmak 

için; 

1. Arama yapacağınız EndNote kütüphanenizi açın. 

2. ‘Search’ tabında, arama yapmak istediğiniz alanı listeden ‘Any Field+PDF with 

Notes’ olarak seçin. 

3. ‘Contains’ listesinde arama kriterini belirleyin. 

4. Aramak istediğiniz kelimeyi arama alanına girin. 

Bir kelime veya cümle girin 

ve Enter tuşuna basın. 
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5. ‘Search’ butonuna basın. EndNote, tüm alanlarda ve PDF dosyalarının içinde geçen 

kelimeleri tarayarak girmiş olduğunuz arama kriterine uyan kayıtları, geçici bir 

grup olan ‘Search Results’ grubunun altında listeleyecektir. 

   

5.5.4.2 PDF Dosyalarında Arama 

Sadece PDF dosyaları içerisinde arama yapmak için; 

1. Arama yapacağınız EndNote kütüphanenizi açın. 

2. ‘Search’ tabında, arama yapmak istediğiniz alanı listeden ‘PDF’ olarak seçin. 

3. ‘Contains’ listesinde arama kriterini belirleyin. 

4. Aramak istediğiniz kelimeyi arama alanına girin. 

   

5. ‘Search’ butonuna basın. 

EndNote, PDF dosyalarının içinde geçen kelimeleri tarayarak girmiş olduğunuz arama 

kriterine uyan kayıtları, geçici bir grup olan ‘Search Results’ grubunun altında 

listeleyecektir. 
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5.5.4.3 ‘PDF Notes’ Arama 

Sadece PDF dosyalarına eklediğiniz notlar içinde arama yapmak için; 

1. Arama yapacağınız EndNote kütüphanenizi açın. 

2. ‘Search’ tabında, arama yapmak istediğiniz alanı listeden ‘PDF Notes’ olarak seçin. 

3. ‘Contains’ listesinde arama kriterini belirleyin. 

4. Aramak istediğiniz kelimeyi arama alanına girin. 

   

5. ‘Search’ butonuna basın. EndNote, PDF dosyalarına girilmiş olan notların içinde 

geçen kelimeleri tarayarak girmiş olduğunuz arama kriterine uyan kayıtları, geçici 

bir grup olan ‘Search Results’ grubunun altında listeleyecektir. 

 

5.5.4.4 Örnekler 

ÖRNEK 1 – Aşağıdaki örnekte  ‘Sample_Library_X9’ kütüphanesinde ‘Pepperberg’ nin 

‘1999’ da basılmış yayınını araştıracağız. 

1. ‘Sample_Library_X9’ kütüphanesini açın. 

2. ‘Tools/Search Library’ komutunu ya da ‘Ctrl+F’ tuş kombinasyonunu kullanın. 
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‘Search’ tabı 3 adet boş arama alanı ile aktif hale gelecektir (eğer gerekli ise yeni 

satır ekleyebilirsiniz). 

‘Options/Restore Default’ kullanılarak default ayarlara geri dönülebilir ve arama 

kriterleri silinebilir. 

3. Alanları aşağıda görüldüğü gibi girin. 

İlk alanı listeden ‘Author’ seçin. 

<Tab> a basıp listeden ‘Contains’i seçin. 

<Tab> a basıp aramak istediğiniz metni (Pepperberg) girin. 

<Tab> a basıp listeden ‘And’ operatörünü seçin. 

<Tab> a basıp listeden ‘Year’ı seçin. 

<Tab> a basıp listeden ‘Contains’i seçin. 

<Tab> a basıp arama yapılacak yılı (1999) girin. 

  

4. ‘Search’ butonuna basın. Arama sonucu Search Results grubunda 

görüntülenecektir. 

Sonuç 

   

ÖRNEK 2 – Bu örnekte, ‘Sample_Library_X9’ kütüphanesindeki ‘abstract’ alanı boş olan 

referansların araması yapılacaktır. 

1. ‘Tools/ Search Library’ komutunu ya da ‘Ctrl+F’ tuş kombinasyonunu kullanın. 

‘Search’ tabı 3 adet arama alanı ile aktif hale gelecektir. 

2. Alanları aşağıda görüldüğü gibi girin. 

İlk alanı listeden ‘Abstract’  seçin. 

<Tab> tuşuna basarak karşılaştırma operatörünü ‘Is’ girin. 

Arama alanını (kriterini) boş geçin. 
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3. ‘Search’ butonuna basın. EndNote seçilen boş alanlarla ilgili (abstract bilgisi 

içermeyen) referans kayıtlarını görüntüleyecektir. 

Sonuç 

  

ÖRNEK 3 – Bu örnekte ‘Sample_Library_X9’ kütüphanesindeki ‘abstract’ alanı veri içeren 

referansların araması yapılacaktır. 

1. ‘Tools/ Search Library’ komutunu ya da ‘Ctrl+F’ tuş kombinasyonunu kullanın.                      

‘Search’ tabı 3 adet arama alanı ile aktif hale gelecektir. 

2. Alanları aşağıda görüldüğü gibi girin. 

İlk alanı listeden ‘Abstract’ seçin. 

<Tab> a basıp listeden ‘Is greater than or equal to’ yu seçin. 

<Tab> a basıp ‘a’ girin. 

<Tab> a basıp listeden ‘or’ u seçin. 

<Tab> a basıp listeden ‘Abstract’ ı seçin. 

<Tab> a basıp listeden ‘Is greater than or equal to’ yu seçin. 

<Tab> a basıp ‘1’ girin. 

 

3. ‘Search’ butonuna basın. 
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Sonuç 

  

 Not 

 Bu arama işlemleri, ‘Integrated Library&Online Search Mode’da gerçekleştirilmiştir. 

 Bu arama işlemleri, herhangi bir veri tabanına bağlanma ihtiyacı duyulmadığından 

‘Local Library Mode’ kullanılarak da gerçekleştirilebilir. 

 

 Aynı anda tek bir kütüphanede arama yapabilirsiniz. 

 Default olarak, EndNote bir kütüphanede arama yaparken büyük harf kullanımını 

göz ardı etmektedir. Örneğin, university olarak arama yapıldığında University 

sonuçları da listelenecektir. 

 ‘Match Words’ seçeneği işaretlendiğinde, EndNote kısmi kelime eşlemeleri yerine 

arama terimi ile kesin eşleşmeleri bulur. Örneğin, state olarak arama yapıldığında 

‘statehood’ ya da ‘understated’ kelimelerini bulmayacaktır. 

 Sık kullandığınız aramayı, ‘Options > Save Search’ ile kaydedebilirsiniz. 

 Kaydettiğiniz aramayı, ‘Options > Load Search’ ile kullanabilirsiniz. 

5.5.5 Duplicate (Çift) Referans Kayıtlarını Bulma 

Çift kayıtlı referansları belirlemek amacıyla, EndNote ‘Find Duplicates' komutunu 

sunmaktadır. Bu komut, ‘Kütüphane Penceresi’nde görüntülenen referansları tarayarak 

çift kayıtları belirlemektedir (Çift kayıt kriterleri ‘Preferences’dan  belirlenmektedir. 

Bkz. 8.4 Duplicates (Çift) Kayıtlar). 

Kütüphanenizdeki tüm çift kayıtlı referansları bulmak için aşağıdaki işlem sırasını takip 

edin: 

1. Çift kayıtlı referansları bulmak istediğiniz kütüphaneyi açın. 

2. Tüm referans kayıtlarını görüntülemek için ‘References/Show All References’ı seçin. 

3. ‘References/Find Duplicates’i seçin. 

4. EndNote, açılan ‘Find Duplicates’ ekranında, kütüphanenizde bulunan çift kayıtları 

kolayca karşılaştırmanız için yan yana görüntüleyecek ve kayıtta, farklı verilerin 

Local Library Mode 
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bulunduğu alanları seçili olarak gösterecektir (İlk kayda alınan referans, ekranın sol 

kolonunda yer almaktadır).  

5. EndNote ‘Find Duplicates’ karşılaştırma ekranında, kayıt altında tutacağınız 

referans üzerinde bilgi girişi ya da mevcut veriler üzerinde değişiklik yapma imkanı 

sunmaktadır. Bilgi girişini tamamlayıp diğer kayda geçiş yaptığınızda yapmış 

olduğunuz değişiklikler otomatik olarak kaydedilecektir. 

  

6. Her çift kayıt için;  

 butonunu kullanarak, kayıt altına almak istediğiniz referans kaydını 

kütüphanenizde tutabilir, diğer kaydı ‘Trash’ grubuna gönderebilirsiniz (Bu 

komutu kullanmadan önce, silmek istediğiniz çift kayıtlı referansın kayıt 

numarasıyla, bu referansa ait makalenizde atıf yapılıp yapılmadığını kontrol 

edin). 

 butonunu kullanarak, çift kayıtlı referansın kütüphanenizde kalmasını 

sağlayabilirsiniz. Bu şekilde kütüphanede tutulan çift kayıtlı referanslar, geçici 

bir grup olan ‘Duplicate References’ grubunun altında görüntülenecektir. 

 butonunu kullanarak, çift kayıt referans karşılaştırma işlemini 

durdurabilirsiniz. Bu durumda tüm çift kayıtlı referanslar ‘Duplicate References’ 

grubunun altında görüntülenecektir. 

7. ‘Trash’ grubunda bulunan kayıtları silmek için ‘References/Delete Trash References 

(Ctrl+D)’ komutunu kullanın. Onaylamak için ‘Tamam’a basın. 

Çift kayıtların belirlenmesindeki kriterler, ‘EndNote Preferences’ ekranında ‘Duplicates’ 

ayarlarından değiştirilebilmektedir. Default olarak, aynı referans tipine (örneğin, dergi 

makalesi ya da kitap gibi) sahip olan, yazar, yıl ve başlık alanları eşleşen kayıtlar 

dikkate alınmaktadır. Çift kayıtları belirlemek için; 

1. ‘Edit/Preferences/Duplicates’i seçin. 

2. ‘EndNote Preferences’ ekranı görüntülenir: 

Çift kayıtlar bulunurken, EndNote’un karşılaştırma yapabilmesi için, alan adlarının 

solundaki onay kutularının seçili olması gerekmektedir. 
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3. Kriterlerinizi belirledikten sonra, ‘OK’ butonuna basın. 

 Not 

 Çift kayıtlı referanslarınız ‘Skip’ ya da ‘Cancel’ butonunu kullandığınızda seçili 

olarak görüntülenecektir. 

 

Kayıtlarınızı silmeden önce kontrol etmenizi öneriyoruz. Kayıtları inceleyip, 

istediğiniz kayıtlar olduğunu doğruladıktan sonra belirlenen referansları silmek için, 

‘References’ menüsünden ya da sağ tuş menüsünden ‘Show Selected References’ı 

seçebilir ve menülerden ‘References/Move References to Trash (Ctrl+D)’ 

seçeneğini ya da ‘Delete’ tuşunu kullanabilirsiniz. Kayıtlar ‘Trash’ grubunun altına 

atılacaktır. ‘Trash’ grubunda bulunan kayıtları silmek için menülerden  

‘References/Delete Trash References (Ctrl+D)’ seçeneğini ya da ‘Delete’ tuşunu 

kullanabilirsiniz. 

 Çift kayıtları silmeden önce, dokümanınıza atıfı gerçekleştirilen referansları 

silmediğinizden emin olmak için, kayıt numaralarını kontrol edin. ‘Kütüphane 

Penceresi’nde kayıt numaralarını görüntülemek için ‘Edit/Preferences/Display 

Fields’ ayarlarını kullanabilirsiniz. 

5.5.6 Connection Files (Bağlantı Dosyaları) 

Bağlantı dosyaları ile, sanki kendi bilgisayarınızdaki bir EndNote kütüphanesinde arama 

yapar gibi, online bibliyografik veri tabanlarında kolayca arama yapabilirsiniz. Ayrıca, 

arama sonuçlarınızı EndNote içindeki referanslarınız gibi görüntüleyebilir ve EndNote 

kütüphanenize ekleyebilirsiniz. 

EndNote, ‘Z39.50’ olarak adlandırılan bilgi erişim protokolünü kullanarak online veri 

tabanlarına erişim sağlayabilmektedir. Z39.50, tüm dünyada kütüphane kataloglarına 



ResearchSoftware.com 126 

EndNote X9 

ve referans veri tabanlarına erişim için, kütüphaneler ve bilgi sağlayıcılar tarafından 

yaygın şekilde kullanılan bir yöntemdir. 

EndNote, bu online kaynaklara bağlantı ve arama için gerekli bilgileri kişisel bağlantı 

dosyalarında (.enz uzantılı dosya) saklamaktadır. EndNote içerisinde, önceden 

oluşturulmuş bağlantı dosyalarıyla, bu veri tabanlarının (kişisel / üniversitenizin erişimi 

varsa veya ücretsiz ise) bir çoğuna erişim imkanı bulunmaktadır. 

Bazı online veri tabanı sağlayıcıları, verilerin kullanımı için ekstra ücret talep 

etmektedir. Ayrıca, bu veri tabanlarına erişim için bir kullanıcı hesabı gerekmektedir: 

 California Digital Library (Melvyl)  

 DIMDI 

 EBSCO 

 Mimas 

 OCLC FirstSearch 

 Ovid 

 Research Libraries Group 

 SilverPlatter 

 Stanford

Bunun yanında, birçok veri tabanı herhangi bir ücret ödemeden veya kullanıcı 

hesabınız olmadan erişiminize izin vermektedir. İki büyük veri tabanına bu şekilde 

erişim mümkündür. Bunlar ‘National Library of Medicine’dan PubMed ve Library of 

Congress veri tabanlarıdır. Ayrıca, birçok genel kütüphane kataloğuna (library 

catalogs) herhangi bir kısıtlama olmaksızın erişebilirsiniz. 

Online veri tabanlarından, referanslara erişmek için aşağıdaki temel adımları 

izleyebilirsiniz: 

 ‘Tools/Online Search’ü ya da ‘Online Search’ grubunun altından ‘more…’u seçin. 

 ‘Search’ tabında arama kriterini belirleyin. 

 ‘Search’ butonuna basın. 

 Arama sonucunda EndNote kütüphanenizde saklamak istediğiniz referansları 

mevcut bir gruba ya da yeni bir gruba ekleyebilirsiniz. 

Bağlantı dosyaları kullanılanılarak, online veri tabanlarında arama ile ilgili ayrıntılı bilgi 

için Bkz. 4.2 ‘Online Search’ import işlemi. 

 Not 

 ‘Integrated Library & Online Search Mode’ kullanılarak, referanslar doğrudan 

mevcut EndNote kütüphanesine import edilebilir. 

 Referanslarınızın anında kütüphane ‘All References’ grubuna eklenmesini 

istemiyorsanız, aramalarınızın ‘Online Search Mode’ kullanılarak gerçekleştirilmesi 

önerilmektedir. Bir arama stratejisi oluşturmak veya arama stratejinizi düzenlemek 

istediğinizde, geçici bir kütüphane kullanmak bu konuda size yardımcı olacaktır. 

Kalıcı kütüphanenizde değişiklik yapmadan, referansları download edebilir ve 

sadece seçeceğiniz referansları kalıcı kütüphanenize aktarabilirsiniz. 

5.6 Finding Full Text 

EndNote, referanslarınızda depolanan verileri kullanarak, Web'deki tam metin 

dosyalarını bulmaya çalışacaktır. EndNote dosyaları (PDF ve URL) bulduğunda, indirir 

ve referanslara ekler. Dosya ekleri, ‘File Attachments’ alanına göreceli bağlantı olarak 

kaydedilir. Dosyanın kendisi, geçerli kütüphanenin .DATA klasörüne depolanır. 

EndNote tam metin yayınları arama sırasında aşağıdaki yöntemleri kullanabilir: 

 Web of Science Core Collection Full Text Links 

 DOI (Digital Object Identifier) 

 PubMed LinkOut (U.S. National Library of Medicine) 

 OpenURL 
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EndNote, bibliyografik kayıtlarınızla ilişkili tam metin dosyaları bulma olasılığını 

optimize etmek için, bu yöntemlerin tümünü kullanmaya çalışacaktır. Bkz. 5.6.1 Tam 

metin arama ayarları 

5.6.1 Tam metin arama ayarları 

‘Find Full Text’ tercihleri, EndNote’un bir referans için tam metni bulmaya çalışırken 

hangi sitelerin, servislerin ve teknolojinin kullanılacağını kontrol etmenizi sağlar. ‘Find 

Full Text’ işlemini hızlandırmak için seçenekleri sınırlayabilirsiniz. 

1. ‘Edit > Preferences > Find Full Text’i seçin. 

2. ‘EndNote Preferences’ ekranındaki onay kutuları, EndNote referanslarınızdan hangi 

bilgilerin kullanılacağını belirlemektedir. Bunlar, tam referans eşleşmesini sağlamak 

için eşsiz tanımlayıcıları temsil etmektedir. 

 

3. Kurumunuz / Üniversiteniz, bir OpenURL sunucusuna erişim izni veriyorsa, bu 

paneli, EndNote'un site erişimine izin verecek şekilde yapılandırabilirsiniz. 

‘OpenURL Path’ onay kutusunu seçin ve online siteye yönlendirmek için OpenURL 

yolunu girin. 

4. Site erişim izni için kimlik doğrulaması gerekiyorsa, bir ‘Authentication URL’ 

girebilirsiniz. ‘Authentication URL’, sadece sitenin giriş sayfasına yönlendirmektedir. 

‘Find Full Text’ komutunu çalıştırdığınızda, doğrulama bilgilerini (genellikle bir 

kullanıcı kimliği ve şifre) girmek için o sayfaya yönlendirileceksiniz. 

5.6.2 Find Full Text 

‘Find Full Text’ komutu ‘Online Search Mode’ kütüphane seçeneğinde 

kullanılmamaktadır. Tam metinleri bulmak ve download etmek için: 

1. Tam metin eklemek istediğiniz referansı ya da referansları seçin. 

2. Opsiyonel: Seçilen kayıtların üzerinde sağ tuş menüsünden ‘Show Selected 

References’ı ya da menülerden ‘References/ Show Selected References’ı seçin. 

3. Kayıtlar seçili iken sağ tuş menüsünden ‘Find Full Text/Find Full Text’i ya da 

menülerden ‘References/Find Full Text/Find Full Text’i seçin. 

Opsiyonel: Find Full Text tercihlerindeki OpenURL adresi ve kimlik doğrulama 

URL’ini girdiyseniz, doğrudan kurumunuzun/üniversitenizin kütüphane giriş web 

sayfasına yönlendirilirsiniz. Giriş yapmak için uygun kullanıcı kimliği ve şifreyi 

girerek talimatları takip edin. Giriş yaptıktan sonra Continue butonuna basın. 
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4. EndNote, seçilen referanslar için tam metin arama ve download işlemine 

başlayacaktır. Diğer işlemlerin performansını etkileyebileceğinden, tam metin 

download arka planda gerçekleşecektir. 

5. Referanslar, ‘Find Full Text’ grup setinin altındaki gruplarda görüntülenecektir. 

‘Find Full Text’ arama sonuçları, mevcut kütüphaneyi kapatana kadar grup set 

altında görüntülenecektir. Grup set altındaki kategoriler: Searching, Found PDF, 

Found URL, Not found. 

 

 Not 

 Kütüphane oturumu sırasında, ‘Find Full Text’ işlemini birden fazla çalıştırdığınızda, 

yeni referanslar ‘Find Full Text’ gruplarındaki mevcut referanslara eklenir. 

‘Find Full Text’ işlemini istediğiniz zaman durdurabilir ya da iptal edebilirsiniz: 

1. ‘Find Full Text Searching’ grubunda iken sağ tuşa tıklayın. 

2. Açılan menüde ‘Pause finding full text’ ya da ‘Cancel finding full text’i 

seçebilirsiniz. 
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 Tam metin bulmak için, Internet Explorer’da çerezlerin açık olması gerekmektedir. 

 ‘Find Full Text’ komutu, bir kerede en fazla 250 kayıt için tam metin dokümanları 

bulmayı deneyebilir. 

 ‘Web of Science Core Collection’ ücretsiz dergi seti, tüm kullanıcılara denetimli 

olarak açıktır, aboneler IP tabanlı olarak tüm kaynaklara tam erişime sahip olabilir. 

Tam metin PDF dosyalarının bir abonelik gerektirdiği durumlarda, siz veya 

kurumunuz uygun erişime sahipse, EndNote uygun dosyaları doğrulamaya ve 

otomatik olarak indirmeye çalışacaktır. 

5.7 Finding Reference Updates (Otomatik Referans 

Güncelleme) 

‘Find Reference Updates’ seçeneği ile, referansları tek tek ya da çoklu seçebilir, Web of 

Science Core Collection ve PubMed gibi EndNote dışındaki kaynak veri tabanlarından 

bilgi alarak, ‘Review Available Updates’ ekranında güncelleyebilirsiniz. EndNote, seçilen 

referans kayıtlarına ait alanların güncel bilgilerini arayacak ve varsa bu bilgileri 

görüntüleyecektir.  

‘Find Reference Updates’ komutuna aşağıdaki seçenekler ile erişebilirsiniz: 

 EndNote sağ tuş menüsü ile, 

 EndNote referans kaydına çift tıkladıktan sonra açılan ‘Edit Reference’ 

penceresindeki ‘Find Reference Updates’  butonu ile, 

 EndNote References menüsü ile, 

 EndNote referans kaydı Word dokümanınıza atıf olarak ekli ise; 

1. EndNote X9 tabı / Citations grubu/  butonuna 

2. Sağ tuş menüsünden ‘Edit Citations>More...’ komutuna 

tıklandığında açılan ‘EndNote X9 Edit & Manage Citations’ ekranındaki ‘Edit 

Reference’ açılır listesi ile. 

EndNote, alan güncellemesi için aşağıdaki işlem sırasını izlemektedir: 

 EndNote, öncelikle seçilen kaydın DOI'si ile eşleşen DOI'yi (Digital Object 

Identifier) aramaktadır. Güvenilir bir eşleşme bulunursa, ‘Review Reference 

Updates’ ekranında alan güncellemeleri görüntülenir. 

 EndNote, eşleşen bir DOI numarası bulamazsa, seçilen kayda ait yazar adını, yayın 

yılını ve dergi adını arar. Güvenilir bir eşleşme bulunursa, ‘Review Reference 

Updates’ ekranında alan güncellemeleri görüntülenir. 

 Eşleşme bulunamazsa, seçili referans kayıtlarının güncel olduğu uyarı mesajı 

görüntülenecektir. 

Referans kaydını güncellemek için; 

1. Referans/referansları kütüphane penceresinden seçin. 
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2. ‘References’ menüsünden ‘Find Reference Updates...’ komutuna basın. 

3. EndNote seçmiş olduğunuz referans kaydına ait güncelleme varsa bu 

güncellemeleri ‘Rewiev Avaible Updates’ ekranında yan yana görüntüleyecektir. 

  

4. ‘Update All Fields’ butonu ile kütüphanenizde bulunan referans kaydındaki tüm 

alanları, ‘Update Empty Fields’ butonu ile de sadece boş alanları 

güncelleyebilirsiniz. 

 Not 

 Eğer gerekli ise, ‘Edit Reference’ butonu ile herhangi bir alanda düzenlemeyi 

manuel olarak gerçekleştirebilir, ‘Save and Continue’ butonu ile yapmış olduğunuz 

değişikliği kaydedip, seçili diğer referans kayıtları için güncel alan aramasına 

devam edebilirsiniz. 

5.8 Groups Paneli 

Gruplar, büyük kütüphaneleri düzenlemek ve yönetmek için kolaylık sağlamaktadır. 

Grup, bir kütüphanede bulunan referansların nerede yer aldıklarını basitçe işaret 

etmektedir. Referanslarınızı grup set içerisindeki birden fazla grupta depolayarak 

düzenleyebilirsiniz. 

5.8.1 Grup Tipleri 

Groups Paneli büyük EndNote kütüphanelerini alt gruplara ayırarak daha kolay 

yönetebilmenizi ve aradığınız kayıtlara daha kolay erişebilmenizi sağlayacaktır.  

Groups panelinde kalıcı ve geçici gruplar türleri bulunmaktadır. 

1. Permanent Groups (Kalıcı Gruplar) 
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- All References (Tüm Referanslar): Tüm referans kayıtlarının bulunduğu 

gruptur. 

- Configure Sync…/Sync Status… (Senkronizasyon Konfigürasyon): Online 

uygulamanın konfigürasyonunun yapıldığı gruptur. 

- Recently Added (Son eklenen): En son eklenen referans kayıtlarının 

(paylaşılmış/paylaşılmamış, senkronize edilmiş/edilmemiş) bulunduğu gruptur. Bu 

Grup, bir kütüphane tarafından yönetilir ve genel tercihlere dahil edilmediğinden, 

son 24 saat olarak bir kütüphanede, son 30 gün olacak şekilde de başka bir 

kütüphanede ayarlanabilir. 

- Unfiled (Dosyalanmamış): ‘Custom’ gruba (opsiyonel olarak Smart gruba) 

dahil edilmemiş tüm referansların görüntülendiği gruptur. ‘Unfiled’ grubunda sağ 

tuş yapıldığında ‘Exclude Smart Group/Include Smart Group’ seçeneği ile Smart 

grubu ‘Unfiled’ grubuna dahil edebilir ya da çıkartabilirsiniz. 

- Trash (Geri Dönüşüm): Referans kayıtları silindiğinde kütüphaneden tamamen 

silinmeden önce ‘Trash’ grubunun altına atılır. Yanlışlıkla silinen bir kayıt bu grup 

altından tekrar kurtarılabilir (Kütüphane kapatılırken bu grup altındaki referansların 

hepsi birden silinebilir veya saklanabilir). 

- Online Search (Online Arama) 

Online arama yapılan veri tabanları ve bu veri tabanlarında en son yapılan arama 

sonuçlarının listelendiği gruptur. 

2. Temporary Groups (Geçici Gruplar) 

Otomatik ve geçici olarak oluşturulur, kütüphane kapatıldığında bu gruplar 

kendiliğinden silinir ancak bu gruplarda görüntülenen referans kayıtları 

kütüphaneden silinmez. 

 

- Citation Report (Atıf Raporu): Dokümanınızın adı ile birlikte, bu doküman 

içerisine yapmış olduğunuz atıfların referans kayıtlarının listelendiği gruptur. 

- Copied References: Online arama modunda, arama sonucunda bulunan 

referans kayıtlarınızın lokal kütüphanenize aktarımı sırasında kullanılan gruptur. 

- Duplicate References (Çift Kayıt Referanslar): Kütüphanede bulunan çift 

referans kayıtlarının listelendiği gruptur. ‘References/Find Duplicates’ menüsü 

kullanılarak kütüphanedeki çift kayıtlar bu grup altında listelenebilir. 

- Imported References (Import Edilen Referanslar): Import edilen referans 

kayıtlarının listelendiği gruptur. 

- Search Results (Arama Sonuçları): En son yapılan arama sonuçlarının 

listelendiği gruptur. 

- Full Text (Tam Metin) Grubu: ‘Find Full Text’ komutu kullanıldığında sonuçlar 

‘Full Text’ grup setinin altında ‘Searching’, ‘Found PDF’, ‘Found URL’ ve ‘Not Found’ 

geçici grupları görüntülenmektedir. 
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3. Custom Groups (Kişisel Gruplar), Smart Groups (Akıllı Gruplar) ve 

Combination Groups (Kombinasyon Grupları) 

 Custom Groups : EndNote kütüphanenizde bulunan, referans kayıtlarınızı 

daha kolay yönetmek ve görüntülemek için kişisel gruplar oluşturabilir ve 

referanslarınızı sürükle bırak ile gruplara ekleyebilirsiniz. 

 Smart Groups : Belirleyeceğiniz kriterlere uyan referans kayıtlarını, dinamik 

olarak (EndNote, kütüphanenize yeni referans kayıtları eklendiğinde ‘Smart’ 

gruplar için belirlediğiniz kriterler, yeni eklenen referans kayıtları içinde 

otomatik olarak uygulanacaktır) bir grup altında toplamanızı sağlayan gruptur. 

 Combination Groups : Yeni grup kombinasyonları ile referanslarınızı daha 

etkin bir şekilde düzenleyebilirsiniz. ‘And, Or ve Not’ bağlaçları ile mevcut 

‘Custom’ ve ‘Smart’ gruplarınızda yer alan ortak, farklı veya tüm kayıtları tek 

bir grup altında toplayabilirsiniz.  

Groups panelinde yer alan grup türleri: 

    

 Not 

 Bir EndNote kütüphanesinde maximum 5000 ‘Custom Grup’ ve ‘Smart Grup’ 

oluşturabilirsiniz. 

 Bir referans kaydı birden fazla gruba eklenebilir. 

 Bir referans kaydı, bir grupta yalnızca bir kayıt olarak görüntülenebilir. Birden fazla 

görüntülenemez. 

 ‘Custom Grup’larda görüntülünen referans kayıtları aslında kütüphanede bulunan 

asıl kaydın bir kısa yoludur. Yani, bir kişisel grupta listelenen referans kaydı 

silindiğinde, yalnızca gruptan kısayolu silinmiş olur. Kütüphanedeki asıl referans 

kaydı silinmez. 

 Referans kaydı kütüphaneden silindiğinde, gruplardan da silinecektir. 

5.8.2 Groups Panelini Görüntüleme veya Gizleme 

5.8.2.1 Groups Panel 

‘Groups Paneli’ ‘Kütüphane Penceresi’nin sol tarafında yer almaktadır. Bu paneli 

gizlemek veya görüntülemek için, ‘Groups’ menüsünden ‘Hide/Show Groups’ 

seçeneğini kullanabilirsiniz. 

Tüm referanslar 

Akıllı Gruplar 

Geri Dönüşüm Grubu 

Geçici Gruplar 

Find Full Text Grubu 

Online Arama 

Dosyalanmamış 

Kişisel Gruplar 

Kombinasyon Gruplar 

Senkronizasyon 

Konfigürasyon 

Son Eklenen 
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5.8.2.2 Display Modes (Görüntüleme Seçenekleri) 

Local Library Mode, Integrated Library & Online Search Mode ya da Online Search 

Mode’da çalışabilirsiniz. 

 

 Local Library Mode: Online gruplar haricindeki otomatik gruplar, kişisel gruplar 

ve akıllı grupların görüntülendiği kütüphane modudur. Bu mod, online aramalar 

sırasında bulduğunuz referans kayıtlarını yanlışlıkla açık olan kütüphanenize 

eklemenize engel olur. Varsayılan kütüphane modudur. 

 Online Search Mode: Online veri tabanlarından referans kayıtları aranarak, 

download edilebilir. Bu modda sadece ‘Online Search’ grubu yer almaktadır. 

Referanslar geçici bir kütüphaneye download edilecektir. EndNote’u kapattığınızda 

ya da diğer kütüphane seçeneklerine geçiş yaptığınızda referanslar silinecektir. 

 Integrated Library & Online Search Mode: Tüm grup ve komutlar bu modda 

yer almaktadır. Online veri tabanından referansları download ettiğinizde, EndNote 

bu kayıtları ‘Online Search’ grup setinin altındaki gruba ve açık olan kütüphanenize 

kaydetmektedir. 

5.8.3 Grup/Grup Set Oluşturma 

5.8.3.1 Group Set Oluşturma, Yeniden Adlandırma ve Silme 

5.8.3.1.1 YENI BIR GRUP SET OLUŞTURMA 

Yeni bir grup set oluşturmak için iki farklı yol kullanılabilir: 

 Menülerden ‘Groups/Create Group Set’ seçeneği 

 ‘Groups Paneli’nde sağ tuş menüsünden ‘Create Group Set’ seçeneği 

Birinci metod için aşağıdaki işlem sırası takip edilmelidir: 

1. Menülerden ‘Groups/Create Group Set’ menüsünü seçin. 

  

Local Library Mode 

Online Search Mode Integrated Library 

&Online Search Mode 

Groups menüsünden ‘Hide Groups’ 

veya  ‘Show Groups’ u seçin 
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2. ‘ New Group Set’ sol tarafda bulunan ‘Groups Paneli’nde listelenecektir. 

Görüntülenen ‘New Group Set’ yerine bir grup set adı girin. ‘Enter’a bastığınızda 

işlem tamamlanacaktır. 

  

5.8.3.1.2 GRUP SET ADINI DEĞIŞTIRME (RENAME GROUP SET) 

Bir ‘Grup Set’i yeniden adlandırmanın üç farklı yolu vardır: 

 Adı değiştirilmek istenen grup set adının üzerinde, sağ tuş menüsünden ‘Rename 

Group Set’ kullanılarak; 

 ‘Groups Paneli’nden grup set seçildikten sonra, ‘Groups/Rename Group Set’ 

menüsü kullanılarak; 

 Adı değiştirilmek istenen grubun üzerine çift tıklanarak, grup adı seçili hale 

geldikten sonra yeni grup adı girilebilir. 

5.8.3.1.3 GRUP SET SILME 

‘Grup Set’ silme işlemi için aşağıdaki iki farklı yol izlenebilir: 

 ‘Grup Set’ adının üzerinde, sağ tuş menüsünden ‘Delete Group Set’ seçilebilir 

 ‘Groups Paneli’nden ‘Grup Set’ seçildikten sonra, ‘Groups/Delete Group Set’ 

menüsü kullanılabilir. 

 Not 

 Bir ‘Group Set’ oluşturulduktan sonra, bu grup setin altına yeni ‘Custom’, ‘Smart’ 

ve ‘Combination’ gruplar oluşturulabilir. 

 Grup set başlıklarında bulunan eksi (-) işaretine tıkladığınızda grup set altındaki 

grupları gizleyebilir, artı (+) işaretine tıkladığınızda grup set altındaki grupları 

görüntüleyebilirsiniz. 

5.8.3.2 Custom (Kişisel) Grup Oluşturma, Yeniden Adlandırma ve Silme 

5.8.3.2.1 CUSTOM GRUP OLUŞTURMA 

Yeni bir grup oluşturmak için iki farklı yol kullanılabilir: 

 Önce gruba eklenecek referanslar seçilir, daha sonra seçilen referanslar için yeni 

bir grup oluşturulur, 

 Önce yeni bir grup oluşturulur, sonrasında referanslar bu gruba eklenir. 

Birinci metod için aşağıdaki işlem sırası takip edilmelidir: 

1. Yeni gruba eklemek istediğiniz referansları seçin (‘Shift’ veya ‘Ctrl’ tuşlarını 

kullanarak). 

2. Seçilen referansların üzerinde sağ tuş menüsünü açın. 

3. Açılan menüden ‘Add References to’ ve ‘Create Custom Group...’u seçin. 

Yeni Grup Set adını girin 
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4. ‘New Group’ sol tarafda bulunan ‘Groups Paneli’nde listelenecektir. Görüntülenen 

‘New Group’ adını sağ tuş menüsünü kullanarak ‘Rename Group’ komutu ile 

değiştirebilirsiniz. ‘Enter’a bastığınızda ya da boş bir alana tıkladığınızda işlem 

tamamlanacaktır. 

   

İkinci metod için aşağıdaki 2 farklı işlemden birini tercih edebilirsiniz; 

Sağ tuş menüsü kullanılmak istenirse: 

1. ‘Groups’ alanında sağ tuş tıklayın. 

2. Açılan menüden ‘Create Group’u seçin. 

    

3. Yeni grup adını girin ve ‘Enter’a basın. 

Yeni grup solda bulunan ‘Groups’ alanında alfabetik olarak listelenecektir. 

Yeni grup adını girin 

Create Group’ u seçin 

Create Custom Group.. u seçin 
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Menü kullanılmak istenirse: 

1. ‘Groups/Create Group’ menüsünü seçin. 

   

2. Yeni grup adını girin ve ‘Enter’a basın. 

Yeni grup solda bulunan ‘Groups’ alanında alfabetik olarak listelenecektir. 

 Not 

 Seçilen referansları daha önceden oluşturulmuş bir gruba sürükle bırak ile de 

ekleyebilirsiniz. 

5.8.3.2.2 CUSTOM GRUP ADINI DEĞIŞTIRME 

Kişisel bir grubu yeniden adlandırmanın üç farklı yolu vardır: 

 Adı değiştirilmek istenen grup adının üzerinde, sağ tuş menüsünden, ‘Rename 

Group’ kullanılarak 

 ‘Groups Paneli’nden grup seçildikten sonra, ‘Groups/Rename Group’ menüsü 

kullanılarak 

 Adı değiştirilmek istenen grubun üzerine çift tıklanarak, grup adı seçili hale 

geldikten sonra yeni grup adı girilebilir. 

5.8.3.2.3 CUSTOM GRUP SILME 

Grup silme işlemi için aşağıdaki iki farklı yol izlenebilir: 

 Grup adının üzerine sağ tuş menüsünden, ‘Delete Group’ seçilebilir 

 ‘Groups Paneli’nden grup seçildikten sonra ‘Groups/Delete Group’ menüsü 

kullanılabilir. 

5.8.3.2.4 CUSTOM GRUPTAN REFERANS KAYDI SILME 

Bir referans grubundan, bir veya birden fazla referans kaydı aynı anda silinebilir. 

Referans kaydının üzerine tıklayarak tek bir referans kaydını ya da ‘Shift’ veya ‘Ctrl’ 

tuşları ile birden fazla referans kaydını seçebilirsiniz.  

Referans kayıt/kayıtları seçildikten sonra silmek için aşağıdaki yollar izlenebilir: 

 ‘Delete’ tuşu kullanılarak 

 ‘Ctrl+D’ tuş kombinasyonu kullanılarak 

 ‘Edit/Cut’ menüsü kullanılarak 

 ‘Ctrl+X’ tuş kombinasyonu kullanılarak 

 ‘Edit/Clear’ menüsü kullanılarak 

Yukarıdaki alternatifler ile bir ‘Custom Grup’tan silinen referans kaydı kütüphaneden 

tamamen silinmez (Custom gruplarda listelenen kayıtlar asıl referans kayıtlarının 

kısayoludur). 

Create Group u seçin 
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Bir ‘Custom Grup’taki referans kaydını hem kütüphaneden hem de gruptan silmek için 

referans kayıt veya kayıtları seçildikten sonra sağ tuş menüsünden ‘Move References 

to Trash’ seçeneği ya da ‘References/Move References to Trash’ menüsü kulanılabilir. 

5.8.3.3 Smart (Akıllı) Grup Oluşturma, Yeniden Adlandırma, Düzenleme ve Silme 

5.8.3.3.1 SMART GRUP OLUŞTURMA 

Yeni bir grup oluşturmak için üç farklı yol kullanılabilir: 

 Menüden ‘Groups/Create Smart Group’ seçeneği 

 ‘Groups Paneli’nden sağ tuş menüsünden ‘Create Smart Group’ seçeneği 

Birinci metod için aşağıdaki işlem sırası takip edilmelidir: 

1. Menülerden ‘Groups/Create Smart Group’ menüsünü seçin. 

  

2. Açılan ‘Smart Group’ ekranında, ‘Smart Group Name’ alanına grubunuzun adını 

girin ve grup altında toplamak istediğiniz referans kayıtları için gerekli kriterleri 

belirleyin. 

  

3. ‘Create’ butonuna bastığınızda, belirlenen kriterlere uyan referans kayıtlarını içeren 

‘Smart Grup’unuz oluşturulacaktır. 

  

Create Smart Group u seçin 
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5.8.3.3.2 SMART GRUP ADINI DEĞIŞTIRME (RENAME GROUP) 

Bir ‘Smart Grup’u yeniden adlandırmanın üç farklı yolu vardır: 

 Adı değiştirilmek istenen grup adının üzerinde, sağ tuş menüsünden ‘Rename 

Group’ kullanılarak; 

 ‘Groups Paneli’nden grup seçildikten sonra, ‘Groups/Rename Group’ menüsü 

kullanılarak; 

 Adı değiştirilmek istenen grubun üzerine çift tıklanarak, grup adı seçili hale 

geldikten sonra yeni grup adı girilebilir. 

5.8.3.3.3 SMART GRUBU YENIDEN DÜZENLEME (EDIT GROUP) 

Bir ‘Smart Grup’ iki farklı şekilde yeniden düzenlenebilir: 

 Düzenlenmek istenen grup adının üzerine sağ tuş ile tıklayarak açılan menüden 

‘Edit Group’ seçilir ve düzenleme işlemi gerçekleştirilebilir 

 ‘Groups Paneli’nden grup seçildikten sonra, ‘Groups/Edit Group’ menüsü 

kullanılabilir. 

‘Smart Group’ ekranında, ‘Smart Grup’ için belirlenen kriterlerde değişiklik yapılabilir, 

yeni kriterler eklenebilir veya var olan bir kriter kaldırılabilir. 

   

Bu ekranda daha önceden belirlenen bir kriter üzerinde doğrudan değişiklik yapabilir, 

 butonunu kullanarak yeni kriter satırları eklenebilir veya var olan bir kriteri 

kaldırmak için  butonu kullanılabilir. 

5.8.3.3.4 SMART GRUP SILME 

Grup silme işlemi için aşağıdaki iki farklı yol izlenebilir: 

 Grup adının üzerine sağ tuş ile tıklayarak açılan menüden ‘Delete Group’ seçilebilir 

 ‘Groups Paneli’nden grup seçildikten sonra ‘Groups/Delete Group’ menüsü 

kullanılabilir. 

5.8.3.3.5 SMART GRUPTAN REFERANS KAYDI SILME 

Bir referans grubundan, bir veya birden fazla referans kaydı aynı anda silinebilir. 

Referans kaydının üzerine tıklayarak tek bir referans kaydını ya da ‘Shift’ veya ‘Ctrl’ 

tuşları ile birden fazla referans kaydını seçebilirsiniz. 

Referans kayıt/kayıtları seçildikten sonra silmek için aşağıdaki yollar izlenebilir: 

 ‘Delete’ tuşu kullanılarak 

 ‘Ctrl+D’ tuş kombinasyonu kullanılarak 

 ‘Edit/Cut’ menüsü kullanılarak 

 ‘Ctrl+X’ tuş kombinasyonu kullanılarak 

 ‘Edit/Clear’ menüsü kullanılarak 

 Sağ tuş menüsünden ‘Move References to Trash’ seçeneği kullanılarak 

 ‘References/Move References to Trash’ menüsü kulanılarak 

 Not 

 Bir ‘Smart Grup’tan silinen referans kaydı ‘Custom Grup’tan farklı olarak 

kütüphaneden de silinecektir. 
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 Bir ‘Smart Grup’tan silinen referans kaydı ‘All References’ grubunda olduğu gibi 

‘Trash’ grubunun altına atılacaktır. 

 Önceden bir arama stratejisi oluşturduysanız ve kaydettiyseniz, kaydetmiş 

olduğunuz arama stratejisini, ‘Options> Convert to Smart Group’ komutu ile 

‘Smart Grup’a dönüştürebilirsiniz. Arama sonuçları otomatik olarak oluşturulan 

‘Converted Search’ grubunun altına eklenecektir. Oluşturulan grup ile ilgili, mevcut 

komutları kullanarak düzenleme işlemini gerçekleştirebilirsiniz. 

5.8.3.4 Combination (Kombinasyon) Grubu Oluşturma, Yeniden Adlandırma, 

Düzenleme ve Silme 

Grup kombinasyonları ile, referanslarınızı daha etkin bir şekilde düzenleyebilirsiniz. 

‘And, Or ve Not’ bağlaçları ile mevcut ‘Custom’ ve ‘Smart’ gruplarınızda yer alan ortak, 

farklı veya tüm kayıtları tek bir grup altında toplayabilirsiniz.  

5.8.3.4.1 COMBINATION GRUP OLUŞTURMA  

Yeni bir ‘Combination Grubu’ oluşturmak için iki farklı yol kullanılabilir: 

 Menülerden ‘Groups/Create from Groups...’ seçeneği 

 ‘Groups Paneli’nde sağ tuş menüsünden ‘Create from Groups...’ seçeneği 

Birinci metod için aşağıdaki işlem sırasını takip edebilirsiniz; 

1. ‘Sample_Library_X9.enl’  kütüphanesini açın.  

2. ‘Combination Grubu’nu hangi grup setinin altına oluşturacağınızı belirleyin. 

3. ‘Groups’ menüsününden ‘Create from Groups...’u seçin. 

     

4. ‘Create from Groups’ ekranı açılacaktır. 

  

5. ‘Grup Name’ alanına grup adını girin. ‘Include References in’ bölümünde yer alan 

listelerden, istediğiniz ‘Custom’ ya da ‘Smart’ grupları belirleyin. 
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6. ‘Create’ butonuna bastığınızda, belirlemiş olduğunuz grup setinin altında girdiğiniz 

kriterlere bağlı olarak grubunuz oluşturulacaktır. 

   

 Not 

 ‘Combination Grup’ oluşturulurken kullanılan bağlaçlar; 

- ‘And’ bağlacı kullanılan gruplarda aynı referans kayıtlarının grup altında 

toplanmasını, 

- ‘Or’ bağlacı kullanılan gruplarda tüm referans kayıtlarının grup altında 

toplanmasını (her iki grupta yer alan kayıtlardan yalnızca biri oluşturulan 

grupta görüntülenir), 

- ‘Not’ bağlacı kullanılan gruplarda bağlaçtan önce gelen gruplar için ortak 

kullanılan referans kayıtları haricinde kalan kayıtların grup altında toplanmasını 

sağlamaktadır. 

 ‘Combination Grup’ oluştururken, ‘Search (Arama)’ kriter satırlarındaki gibi  

butonu kullanılarak 10 tane kriter satırı eklenebilir veya var olan bir kriter satırını 

kaldırmak için  butonu kullanılabilir. 

5.8.3.4.2 COMBINATION GRUP ADINI DEĞIŞTIRME  

Bir ‘Combination Grubu’nu yeniden adlandırmanın üç farklı yolu vardır: 

 Adı değiştirilmek istenen grup adının üzerinde, sağ tuş menüsünden ‘Rename 

Group’ kullanılarak; 

 ‘Groups Paneli’nden grup seçildikten sonra, ‘Groups/Rename Group’ menüsü 

kullanılarak; 

 Adı değiştirilmek istenen grubun üzerine çift tıklanarak, grup adı seçili hale 

geldikten sonra yeni grup adı girilebilir. 

5.8.3.4.3 COMBINATION GRUBU YENIDEN DÜZENLEME  

Bir ‘Combination Grubu’ iki farklı şekilde yeniden düzenlenebilir: 
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 Düzenlenmek istenen grup adının üzerine sağ tuş ile tıklayarak açılan menüden 

‘Edit Group’ seçilir ve düzenleme işlemi gerçekleştirilebilir 

 ‘Groups Paneli’nden grup seçildikten sonra, ‘Groups/Edit Group’ menüsü 

kullanılabilir. 

‘Create from Groups’ ekranında, ‘Combination Grup’ için belirlenen kriterlerde 

değişiklik yapılabilir yeni kriterler eklenebilir veya var olan bir kriter kaldırılabilir. 

 

Bu ekranda daha önceden belirlenen bir kriter üzerinde doğrudan değişiklik yapabilir, 

 butonunu kullanarak yeni kriter satırları eklenebilir veya var olan bir kriteri 

kaldırmak için  butonu kullanılabilir. 

  

5.8.3.4.4 COMBINATION GRUP SILME 

Grup silme işlemi için aşağıdaki iki farklı yol izlenebilir: 

 Grup adının üzerine sağ tuş ile tıklayarak açılan menüden ‘Delete Group’ seçilebilir 

 ‘Groups Paneli’nden grup seçildikten sonra ‘Groups/Delete Group’ menüsü 

kullanılabilir. 

5.8.3.4.5 COMBINATION GRUPTAN REFERANS KAYDI SILME 

Bir referans grubundan, bir veya birden fazla referans kaydı aynı anda silinebilir. 

Referans kaydının üzerine tıklayarak tek bir referans kaydını ya da ‘Shift’ veya ‘Ctrl’ 

tuşları ile birden fazla referans kaydını seçilebilirsiniz. 

Referans kayıt/kayıtları seçildikten sonra silmek için aşağıdaki yollar izlenebilir: 

 ‘Delete’ tuşu kullanılarak 

 ‘Ctrl+D’ tuş kombinasyonu kullanılarak 

 ‘Edit/Cut’ menüsü kullanılarak 

 ‘Ctrl+X’ tuş kombinasyonu kullanılarak 

 ‘Edit/Clear’ menüsü kullanılarak 

 Sağ tuş menüsünden ‘Move References to Trash’ seçeneği kullanılarak 
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 ‘References/Move References to Trash’ menüsü kulanılarak 

‘Combination Grubu’ndan referans kayıtları silindiğinde bağlı olduğu gruplardaki 

referans kayıtları da silinerek ‘Smart’ (Akıllı) ve ‘All References’ grubunda olduğu gibi 

doğrudan ‘Trash’ (Geri Dönüşüm) grubunun altına atılacaktır. 

5.8.3.5 Sharing Groups 

EndNote X9, bir kütüphanenin tamamının paylaşılmasına ek olarak, kullanıcılarına bir 

referans grubunu 99 diğer EndNote Online kullanıcısı ile paylaşma seçeneği 

sunmaktadır. Bkz. 5.10.3 Lokal Grup Paylaşımı 

5.8.4 Manuscript Matcher 

Web of Science ve Journal Citation Reports'un karmaşık algoritmalarını ve verilerini 

kullanan Manuscript Matcher, makalenizi göndermek isteyebileceğiniz en uygun dergi 

önerisinde bulunmaktadır. ‘Manuscript Matcher'a erişmek için aşağıdaki yollardan birini 

kullanabilirsiniz: 

 EndNote içerisinden; 

Grubu seçili hale getirdikten sonra ve sağ tuş menüsü ya da ‘Groups’ menüsünden 

‘Manuscript Matcher’ı seçebilirsiniz. 

 

 Word içerisinden; 

EndNote tabında ‘Tools’ grubunda  butonunu kullanabilirsiniz. 

 EndNote Online içerisinden; 

Bkz. 12.4.5 Match Menüsü 

 Not 

 Desktop kütüphanenizdeki kişisel grupları, başka EndNote Online kullanıcıları ile 

paylaşabilirsiniz. 

 EndNote Online üzerinden sizinle paylaşılan grupların listesini, desktop 

kütüphanenizde görüntüleyebilir ve bu grupları EndNote Online kısa yolu olarak 

kullanabilirsiniz. 

 EndNote Desktop kütüphanenizde, ‘Online Search Mode’ seçiliyken EndNote Online 

kütüphanesi ile senkronize edemezsiniz. 

 EndNote Online kütüphaneleri bir sunucuda depolanmaktadır. Sunucu kapanırsa, 

EndNote Online kütüphanenize erişim sağlayamazsınız. Sunucu aşırı yüklenmişse 

uygulama yavaş çalışacaktır. 
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5.9 Syncing (Senkronizasyon) 

5.9.1 Genel Bakış 

EndNote (EndNote desktop ve EndNote online arasında) referans kayıtlarınızı 

senkronize etme imkanı sunmaktadır. 

 EndNote, bibliyografik kaynakça yönetim aracınızın desktop versiyonudur. 

 EndNote online, EndNote desktop’un online versiyonudur. 

Sync özelliği, EndNote desktop ve EndNote online ortamında tam bir eşleşme olması 

için, gruplar halinde her iki referans setini otomatik olarak senkronize etmektedir. 

Senkronizasyon işlemi her zaman EndNote’dan başlatılmaktadır. Senkronizasyonu 

çalıştırdığınızda, EndNote ve EndNote online’daki veriler her iki uygulamada da 

senkronize edilir. Senkronizasyon tamamlandığında, aynı grup ve referanslara sahip 

olursunuz. 

Senkronizasyon işlem içeriği: 

 senkronizasyon işlemi sırasında tüm referanslara ait (dosya ekleri dahil) tüm veri 

değişir, böylece her kütüphane diğeri ile eşleşir. Örneğin, EndNote’da veya 

EndNote online’da referans ve/veya PDF dosyası ekleyip sildiyseniz, bütün 

değişiklikler karşılıklı olarak güncellenecektir. 

 güncellemeler ve eklemeler tüm kütüphanelere uygulanır. Örneğin, yeni bir grup 

oluşturup referans kayıtları eklerseniz, bir sonraki ‘Sync’ komutunu çalıştırdığınızda 

bu grubu EndNote online’da görebilirsiniz. 

‘Sync’ işlemini başlatmak için aktif bir EndNote online hesabınızın olması ve kayıt 

olmanız gerekmektedir. Kayıt işlemi hızlı ve kolaydır. İki yıllık EndNote online 

hesabınızı aktif hale getirir. İşlem tamamlandığında senkronizasyon otomatik olarak 

başlar ve EndNote kütüphanenizdeki gruplar eşlenerek yeni EndNote online 

kütüphaneniz güncellenir. 

5.9.2 Preferences (Tercihler) 

Sync tercihlerini görüntülemek için: 

1. Edit > Preferences > Sync’i seçin. 

2. ‘Sync Preferences’ tercih ayarlarınızı gerçekleştirmenizi sağlayacaktır. 

 ‘Sync Preferences’ ekranında, e-mail adresinizi ve şifrenizi girmeniz 

gerekmektedir. Referanslarınızı EndNote desktop ve EndNote online arasında 

her zaman manuel senkronize etmenize gerek yoktur. 

 ‘Sync Automatically’ onay kutusunu işaretleyerek sekronizasyonun (arka 

planda) EndNote tarafından otomatik olarak her 15 dakikada bir 

gerçekleştirilmesini sağlayabilirsiniz. 

 Not 

 EndNote desktop satın alındığında, EndNote online için iki yıllık üyelik 

gerçekleştirilmektedir. Ücretsiz abonelik, kütüphanenizde sınırsız referans kaydı ve 

dosya eklerinde 5 GB'a (gigabayt) kadar veri içeren, bir EndNote online 

kütüphanesi oluşturmanıza olanak sağlar. 

 Senkronizasyon bir kütüphane ve bir EndNote online hesabı ile kullanılmaktadır 

(Edit > Preferences > Sync ekranında görüntülenmektedir). 

 ‘Tools/Sync’ ya da araç çubuğunda ‘Sync Library ’ butonuna bastığınızda, 

‘EndNote Online’ bilgileriniz girilmiş ise, kayıtlar otomatik olarak aktarılmaya 

başlayacaktır. Eğer bu bilgiler girilmemişse sizden bu bilgilerin girilmesi 

istenecektir. Eğer ‘EndNote Online’ için hesap oluşturmadıysanız yine bu aşamada 

online hesabınızı oluşturabilirsiniz. 
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 Transfer işlemini ilk kez gerçekleştiriyorsanız kütüphanenizin sıkıştırılmış bir 

yedeğinin alınması önerilmektedir.  

  

 Eğer farklı bir kütüphanenin senkronizasyonunu gerçekleştirmeye çalışırsanız bu 

kütüphanelerin birleştirileceği uyarısı alırsınız. Önerilen, tek bir kütüphane, grup 

set ve gruplar ile kütüphanenizi düzenleyerek çalışmak olacaktır. 

  

 Senkronizasyonda Group Set, Smart grup ve and Combination grup 

görüntülenmemektedir. Sadece Custom grup görüntülenmektedir.  

Bilgisayarlar arasında akıllı gruplar için, ‘EndNote plugin to Import or Export Smart 

Groups’ eklentisini kullanabilirsiniz. 

EndNote SSS 7 https://researchsoftware.com/tr/faq/endnote  

 Senkronizasyon işlemi tamamlandıktan sonra, grup paylaşımı etkin hale gelecek ve 

EndNote online’da paylaşılan her grup, paylaşım ikonu ile görüntülenecektir. 

Meslektaşlarınız ile paylaşılan gruplar ‘Groups Shared by Others’ bölümünde 

görüntülenecektir. 

 Grup set tanımlanamadığında gruplar Unfiled Groups set altında görüntülenecektir. 

Desktop kütüphanenizde grupları uygun grup set altına sürükleyebilirsiniz. 

5.10 Kütüphane ve Grup Paylaşımı (Sharing) 

EndNote kütüphanesi ve grupları paylaşmanın farklı yolları bulunmaktadır: 

 Network paylaşımı 

 Lokal kütüphane paylaşımı 

 Lokal Grup paylaşımı 

 Online Grup paylaşımı 

İşlemler aşağıda açıklanmaktadır. 

https://researchsoftware.com/tr/endnote-desktop-online-ve-ipadr-kutuphane-

paylasimi 

5.10.1 Kütüphane Network Paylaşımı 

EndNote çoklu okuyucu uygulamasıdır (çoklu okuma ve yazma uygulaması değildir). 

Bunun anlamı, aynı anda yazma modunda sadece bir kullanıcı tarafından açılabilir. 

Diğer kullanıcılar bu kütüphaneyi aynı anda açamazlar. Okuma modunda birçok 

kullanıcı kütüphaneyi açabilir. Okuma modunda, işlevlerin yaklaşık % 99'u kullanılabilir 

(referanslar yazma / girme, terim yöneticisi listelerini kaldırma ve değiştirme vb. 

hariç). 

Paylaşılan ağ erişimi için bir EndNote kitaplığı kurmanın en kolay yolu, kullanıcıların ve 

grupların izin verdiği erişim türünü kontrol etmek için ağın dosya izinleri sistemini 

kullanmaktır. Veri tabanını ekleyen kişi dışında, tüm kullanıcılara salt okunur erişim 

hakkı verin. Kütüphaneyi ayrı bir yerde tutmak ve güncellemek için bir kişiye tam 

https://researchsoftware.com/tr/faq/endnote
https://researchsoftware.com/tr/endnote-desktop-online-ve-ipadr-kutuphane-paylasimi
https://researchsoftware.com/tr/endnote-desktop-online-ve-ipadr-kutuphane-paylasimi
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erişim hakkı verilmelidir. Ardından, güncellenmiş kitaplığı diğer kullanıcıların ağına 

periyodik olarak salt okunur olarak gönderin. 

Paylaşılan Endnote kütüphaneleri için öneriler 

https://researchsoftware.com/tr/endnote-kutuphanelerini-paylasma 

https://researchsoftware.com/tr/faq/endnote#nid-285 

5.10.2 Lokal Kütüphane Paylaşımı 

Lokal kütüphane diğer EndNote kullanıcıları ile paylaşılabilir. 

 Nerede oldukları önemli olmaksızın, kütüphanenizi (kendiniz de dahil olmak üzere) 

100 EndNote kullanıcısıyla paylaşabilirsiniz. 

 Desktop ve online kütüphanenizi senkronize ettiğinizde, tüm kütüphanenizi okuma-

yazma ya da okuma erişim haklarıyla paylaşabilirsiniz. 

 Kütüphanenizin tamamına okuma-yazma erişim hakkı olanlar erişebilir. Yani 

referanslara, eklere, PDF ek açıklamalarına, grup set ve gruplarına ait düzenleme 

hakları bulunmaktadır. 

 Paylaşılan kütüphane boyutu sınırsızdır. 

 Kütüphane paylaşımı, tüm kullanıcıların EndNote X9, X8 ya da EndNote X7.2 ile 

ilişkili EndNote online hesaplarının bulunduğu anlamını taşımaktadır. 

 X9 versiyonununa sahip olmayan kullanıcı, EndNote online hesabı ile oturum 

açtığında paylaşılan gruba erişim sağlayabilir. 

 ‘Activity Feed’ butonu (sadece EndNote X8 ve X9’da kullanılmaktadır) ile paylaşılan 

kütüphane üzerinde yapılan değişiklikler görüntülenebilir (yeni işlemler üste yer 

alacak şekilde 500 satıra kadar görüntülenmektedir). 

Kütüphane paylaşımı işlemi: 

 Kütüphane paylaşımını gerçekleştiren davet gönderimi sağlar. 

 Alıcı kütüphane paylaşım davetini kabul eder. 

 Alıcı kütüphaneyi açar. 

5.10.2.1 Davet Gönderimi 

Kütüphanenizi paylaşmak için aşağıdaki adımları takip edebilirsiniz: 

1. Paylaşmak istediğiniz kütüphaneyi açın. 

Dikkat: paylaşmak istediğiniz kütüphane ile ‘Preferences > Edit > Sync’ ekranında 

görüntülenen kütüphane aynı olmalıdır. 

   

2. ‘File > Share’ komutunu ya da  ‘Share’ butonunu kullanın. 

3. Davet etmek istediğiniz kişinin e-mail adresini girin. 

4. Her davetli için ‘Read & Write’ ya da ‘Read Only’ erişim seviyesini belirleyin. 

5. ‘Invite’ butonuna tıklayın. 

https://researchsoftware.com/tr/endnote-kutuphanelerini-paylasma
https://researchsoftware.com/tr/faq/endnote#nid-285
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5.10.2.2 Davet Kabulü 

Dikkat: alıcının EndNote X9 desktop versiyonu ile ilişkili, EndNote online hesabının 

olması gerekmektedir. Alıcı, EndNote kütüphanesi paylaşım daveti içeren e-mail alır. 

Alıcı, daveti aşağıdaki gibi kabul eder: 

1. Alıcı ‘Accept the invitation’ butonuna tıklar. 

   

2. Web sayfası görüntülenir. Alıcı, EndNote online kullanıcı kimliği ve şifre ile giriş 

yapabilir. Alıcının EndNote hesabı bulunmuyorsa, aynı sayfada yeni bir hesap 

oluşturabilir. 
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3. Oturum açtıktan sonra, kütüphanenin paylaşıldığını ve EndNote X9'da 

açılabileceğini belirten bir mesaj görüntülenir. 

5.10.2.3 Paylaşılan Kütüphanenin Açılması 

‘File > Open Shared Library’ komutunu kullanarak paylaşılan kütüphaneyi açabilirsiniz. 

Referanslar, ekler, PDF açıklamaları, grup setler ve gruplardaki herhangi bir değişiklik 

senkronize edilecektir. 

Ayrıntılı bilgi için: 

https://researchsoftware.com/tr/software/bibliography/endnote/kutuphane-paylasimi 

 Not 

 Kütüphaneyi siz paylaştıysanız, bu kütüphaneye desktop, online ya da iPad 

üzerinden erişim sağlayabilirsiniz. 

 Eğer başka bir kullanıcının kütüphanesine davet edildiyseniz, bu kütüphaneye 

sadece desktop üzerinden erişim sağlayabilirsiniz. 

 ‘Activity Feed’  butonu ile çalışma arkadaşlarınızın gerçekleştirdiği değişiklikleri 

takip edebilirsiniz. X9 ile paylaştığınız her kütüphane ya da sizinle paylaşılan her 

kütüphane, ‘Activity Feed’ özelliğini içermektedir. ‘Activity Feed’ paylaşılan 

kütüphane penceresine eklenecektir. ‘Activity Feed’ ikonuna tıklayarak değişiklikleri 

görüntüleyebilir, güncellemeleri tarayabilirsiniz. ‘Activity Feed’ dışına tıkladığınızda, 

ekrana geri yönlendirilirsiniz. 

5.10.3 Lokal Grup Paylaşımı 

Grup paylaşımı ile, tüm meslektaşlarınızın bir EndNote grubuna, anında ve gerçek 

zamanlı erişimi sağlanmaktadır. Grup, bir EndNote kütüphanesinden seçilen referanslar 

kümesidir. Grup paylaşımı, kütüphane veya grubu paylaşılan bir sürücüye kaydetmeye 

veya sıkıştırılmış bir kopyasını, ortak çalışanlara e-postayla göndermeye alternatif 

olarak önerilir.  

Kişileri paylaşılan grubunuza davet etme:  

1. Senkronize edilmiş kütüphanenizi açın.  

2. Menüden ‘Group > Share Group’u seçin. EndNote online’a giriş yapmadıysanız, giriş 

yapmanız istenecektir.  

3. ‘Sharing Group’ ekranı açılacaktır:  

 Paylaşılan grubunuza davet etmek istediğiniz kişi/kişilerin e-mail adresini (ya da 

virgül ile ayrılmış adreslerini) girin. Her davetlinin erişim düzeyini ‘Read & Write’ ya 

da ‘Read Only’ olarak açılır listeden belirleyin. 

 Girdiğiniz e-mail adresine gönderilmek üzere, isteğinize bağlı olarak bir mesaj 

girin. 

 ‘Invite’ butonuna tıklayın. 

Bkz. 5.10.2 Lokal Kütüphane Paylaşımı  

 Not 

 X9 versiyonununa sahip olmayan kullanıcı, EndNote online hesabı ile oturum 

açtığında, paylaşılan gruba erişim sağlayabilir. 

 X9 kullanıcısı için, senkronize edilen kütüphanenin Grup panelinde, ‘Groups Shared 

by Others’ grup seti görüntülenecektir. Bu grup sete tıklandığında grup EndNote 

online’da açılacaktır. 

 ‘Share’ ekranı ile aşağıdaki işlemleri gerçekleştirebilirsiniz: 

 Kişileri paylaşılan grubunuza davet edin 

 Daveti tekrar (hatırlatma) gönderin. 

https://researchsoftware.com/tr/software/bibliography/endnote/kutuphane-paylasimi
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 Grubunuzu paylaşım için davet ettiğiniz meslektaşlarınızın erişim düzeyini 

değiştirin. 

 Paylaşılan gruptan meslektaşlarınızı çıkartın.  

5.10.4 Online Grup Paylaşımı 

Online kütüphanenizdeki grupları paylaşabilirsiniz. Bilinmesi gereken en önemli durum, 

eklentilerin paylaşımının gerçekleştirilmediğidir. Paylaşılan gruplar paylaşım ikonu ile 

görüntülenir. Grubu paylaşmak için; 

1. EndNote Online’a gidin ve giriş yapın. 

https://www.myendnoteweb.com 

2. ‘Organize’ tabına tıklayın. 

3. ‘Manage My Groups’ linkine tıklayın. 

 

4. Paylaşmak istediğiniz grubun ‘Share’ onay kutusunu işaretleyin. 

5. Paylaşmak istediğiniz grubun ‘Manage Sharing’ butonuna tıklayın. 

6. Pencerenin altındaki ‘Start sharing this group’ linkine tıklayın. 

 

7. Paylaşmak istediğiniz kişinin e-mail adresini girin. 

- ‘Read only’ ya da ‘Read & Write’ seçimini belirleyin. 

- ‘Apply’ butonuna tıklayın. 

- ‘Close window’ linkine tıklayın. 

 Not 

 Gruplarınızı herhangi bir kurum/şirket online kullanıcısı ile paylaşabilirsiniz. 

 Gruplarınızı EndNote online hesabı olmayan kullanıcılar ile paylaşabilirsiniz. 

Kullanıcılar kayıt olup giriş yaptıklarında, gruplar otomatik olarak 

görüntülenecektir. 

 Aynı grupta çalışma arkadaşlarınıza salt okunur ya da okuma-yazma erişim 

seçeneklerini belirleyebilirsiniz. 

 Okuma-Yazma erişimi, salt okunur erişim hakkları yanında, kullanıcıların 

gruptaki referansları ekleme, değiştirme veya silme imkanı bulunmaktadır. 

Ancak, paylaşılan kütüphaneden referansları silemezler. 

https://www.myendnoteweb.com/


ResearchSoftware.com 126 

EndNote X9 

 Salt okunur erişimi bulunan kullanıcıların, referansları görüntülemesine, Word 

belgelerinde kullanmasına veya kendi kütüphanesine kopyalamasına izin 

verilmektedir. 

 Birden fazla kişi aynı referansı aynı anda değiştirirse, son kayıt işlemini 

gerçekleştiren kişinin değişiklikleri kaydedilecektir. 

 Paylaşılan gruplardaki referanslar aranamamaktadır. 

 Paylaşılan gruplardaki referanslar ‘Quick List’e eklenememektedir. 

 Paylaşılan gruplar bibliyografya oluşturmak ve export işlemi için kullanılabilir. 

 Gruptaki dosya ekleri paylaşılamamaktadır. 

 Grup paylaşımları hakkında ayrıntılı bilgiye, EndNote Online Help’ten ulaşabilirsiniz 

http://www.myendnoteweb.com/help/en_us/ENW/help.htm 

5.11 Yazdırma (Printing) 

Referans listesini yazdırmak için birkaç farklı yöntem kullanabilirsiniz: 

 Referans listesini doğrudan ‘File’ menüsünden yazdırabilirsiniz. 

 ‘Subject Bibliography’ yazdırabilirsiniz. 

 Aşağıdaki yöntemlerden birini kullanarak Word dokümanındaki bibliyografyayı 

anında transfer edebilir ve yazdırabilirsiniz. 

 Kütüphanedeki referansları kopyalamak için ‘Edit/Copy Formatted’ı seçin ve 

Word dokümanına yapıştırın. Bkz. 5.11.3 Copy Formatted (Biçimlendirilmiş 

Kopya) Komutu ile Word’te Yazdırma. 

 Referans listesini doğrudan EndNote kütüphanesinden Word dokumanınıza 

sürükleyebilirsiniz.  

 Word dokümanınızda ‘Cite While You Write’ özelliğini kullanarak atıflardan 

oluşan bibliyografyalar oluşturabilirsiniz. Bkz. 10 Cite While You Write Özelliği 

Yazdırma sırasında önemli noktalar: 

 ‘Kütüphane Penceresi’ görüntülendiğinde, listede bulunan seçili referansları ya da 

tüm referansları yazdırabilirsiniz. 

 Eğer incelemek için tek bir referans açıksa, EndNote alan etiketleriyle ekranda 

görüntülenen spesifik referans kaydını print edecektir. 

 Referanslar seçilen ‘Output Style’ tarafından belirlenen düzene göre yazdırılacaktır. 

Eğer sıralama düzenini değiştirmek isterseniz, ‘Output Style’ı düzenlemeniz 

gerekmektedir. Eğer referansları geçerli kütüphane penceresinde listelenen sıraya 

bağlı olarak export etmek isterseniz, ‘Output Style’ sıralama düzen ayarını ‘Order 

of appearance’ olarak değiştirebilirsiniz. 

 Eğer yazı tipi (font) ‘True Type font’ ise print edilen referansların yazı tipi (font) ve 

boyut (size) ayarları ‘General Display Font’dan belirlenebilir, aksi halde yazı tipi 

değişikliği yapılacaktır. Eğer gerekli ise, yazı tipi ve boyut ayarlarını değiştirmek 

için 'Edit/Preferences/Display Fonts’ seçin. Yazı tipi adının solundaki çift ‘T’ ‘True 

Type font’ olduğunu belirtmektedir. 

 Seçilen referanslar sıralandıkları düzende print edilirler. ‘Sort References’ komutu 

seçili referanslarla birlikte seçili olmayanlara da uygulanır, bu yüzden gerekli ise, 

seçtiğiniz referansları bir arada görüntülemek için sıralamadan önce ‘Show 

Selected References’ komutunu kullanın. 

http://www.myendnoteweb.com/help/en_us/ENW/help.htm
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5.11.1 EndNote File Menüsünden Yazdırma 

Bağımsız bibliyografyada, doğrudan EndNote sonuçlarında listelenen referanslar 

yazdırılabilir. EndNote, makalede bulunan atıflara dayanarak bibliyografya 

oluşturmamaktadır, bunun yerine bibliyografya makaleden bağımsız olarak oluşturulur. 

Bu örnekte, ‘Echolocation' ‘keyword’ünü içeren referans kayıtlarının alfabetik olarak 

listesini yazdıracağız. 

1. Grup panelinden ‘All References’ı seçin 

2. ‘Tools/Search Library’ komutunu ya da ‘Ctrl+F’ tuş kombinasyonunu kullanın. 

3. ‘Search’ tabı aktif hale gelecektir. 

İlk alanı listeden ‘Keywords’ seçin. 

<Tab> a basıp listeden ‘Contains’ i seçin. 

Arama alanına ‘Echolocation’ girin. 

‘Search’ butonuna basın. 

    

4. Arama sonuçları aşağıdaki gibi görüntülenecektir. 

Araç çubuğundaki stil listesini kullanarak stili seçin. 

Referansları sıralamak için, ‘Tools/Sort Library’ komutunu ya da kolon başlıklarını 

kullanın. 

Yazdırmak istediğiniz referansları seçin. 

   

5. ‘File/Print’ komutunu ya da ‘Ctrl+P’ tuş kombinasyonunu kullanın. 

‘Yazdır’ (Print) ekranı görüntülenecektir. 

Seçenekleri belirleyin. 

6. ‘Tamam’a basın. 

Sonuç, seçili olan stile bağlı olarak aşağıdaki gibi görüntülenecektir. 
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Sonuç 

   

 Not 

 Bibliyografya dosya gibi kaydedilebilmektedir. 

‘Yazdır’ (Print) ekranında ‘Dosyaya yazdır’ (Print to File) onay kutusunu 

seçebilirsiniz. 

- ‘Dosyaya Yazdır’ (Print to File) ekranında dosyanın adını girin. 

- ‘Kaydet’ butonuna basın. 

 Her yazdırılan sayfa 1-inç kenar boşluğuna sahiptir, metin sola yanaşıktır, sol üst 

köşede kütüphanenin adının yer aldığı sayfa başlığı ve sağ üst köşede sayfa 

numarası yer alır. Yazıcı çıktısında, kenar boşluklarına, üst bilgi ve alt bilgi 

düzenlenmesine ait seçenek bulunmamaktadır. Yazılı çıktınızda görünüm ayarlarını 

değiştirmeniz gerekirse, bağımsız bibliyografyanızı oluşturmak için diğer 

seçeneklerden birini kullanabilirsiniz. 

5.11.2 Subject Bibliography (Konu Bibliyografyası) Yazdırılması 

‘General Bibliyography’ belirli düzende atıfların sürekli listelenmesidir. ‘Subject 

Bibliography’, her biri ayrı ve farklı başlık altında görünen daha küçük listelerden 

oluşan bağımsız bibliyografyadır. ‘Subject Bibliography’ herhangi bir alana veya 

alanların kombinasyonuna dayanabilir. 

Konu bibliyografyalarının farklı kullanımları bulunmaktadır: dergi özet listelerinin 

oluşturulması, kütüphanedeki yeni kazanımlar hakkında kullanıcıları bilgilendirmek için 

güncel farkındalık listelerinin oluşturulması, konu indeksleri ya da kategorilere göre 

kütüphanenin sahip olduğu tüm materyallerin listelerinin oluşturulması. Tipik konu 

bibliyografyası başlıkları ‘Author, Keyword, Journal Name vb. olmaktadır. 

5.11.2.1 Subject Bibliography (Konu Bibliyografyası) Oluşturma 

Bu örnekte, anahtar kelimelerin konu bibliyografyalarını yazdıracağız. Bunun için 

‘Sample_Library_X9.enl’ kütüphanesini kullanacağız. 

1. Mevcut kütüphane penceresinde, konu bibliyografyası oluşturmak istediğiniz 

referansları görüntüleyin. Bu işlemi gerçekleştirmenin birkaç yolu bulunmaktadır: 

 Listede sağ tuş yapın ve menüden ‘Show All References’ komutunu seçin. 

Referansları seçmek için ‘Ctrl+A’ tuş kombinasyonunu kullanın. 

 Sadece belirli bir gruptaki referansları görüntülemek için grup adına tıklayın. 

 ‘Tools > Search Library’ ile referans alt kümesi oluşturun. 

 Referans kayıtlarını seçili hale getirin ve bu referansları listelemek için ‘Show 

Selected References’ komutunu kullanın. 

2. ‘Tools/Subject Bibliography’ komutunu seçin. 

3. ‘Subject Fields’ ekranı görüntülenecektir. 

Konu başlıkları gibi kullanmak istediğiniz, ‘Keywords' alanını seçin. 

‘OK’ye basın. 
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4. ‘Subject Terms’ penceresi görüntülenecektir. Konu başlığı olarak eklemek istediğiniz 

terimleri seçin. 

‘OK’ye basın. 

  

5. Öncelikle konu bibliyografyanız istediğiniz gibi ayarlanmaktadır, listeyi 

görüntüleyebilir, yazdırabilir, kaydedebilir ya da vazgeçebilirsiniz. 

- Konu başlıkları özelliklerini değiştirmek isterseniz, ‘Layout’ butonuna basın. 

- Belirlediğiniz terim seçimlerini değiştirmek için, ‘Terms’ butonuna basın. 

- Bibliyografyanın biçimlendirilmiş sayfa görüntüsünü görmek için, ‘Print Preview’ 

butonuna basın. 

- Yazıcıdan çıktı almak için, ‘Print’  butonuna basın. 

- Text, RTF ya da HTML olarak kaydetmek için, ‘Save’ butonuna basın. 

   

Sonuç (Önizleme) 

Konu terimi 

Konu terim sayısı 
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5.11.2.2 Konu Bibliyografya Düzenlemesi (Subject Bibliography Layout) 

Konu başlıkları özelliklerini değiştirmek isterseniz, aşağıdaki yolu takip edin: 

1. ‘Print Preview’ ekranını kapatmak için, ‘Close’ butonuna basın. 

2. ‘Subject Bibliography’ ekranı tekrar görüntülenecektir. 

3. ‘Layout’ butonuna basın. 

4. ‘Subject Bibliography Setup’ penceresi görüntülenecektir. 

Seçenekleri belirleyin. 

       

5. ‘Tamam’ butonuna basın. 

6. Sonuç aşağıdaki gibi görüntülenecektir. 

Çıktı stilini seçin 

Başlığı girin 

Sıralama düzenini seçin 
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7. ‘Save’ butonuna bastığınızda, ‘Subject Bibliyography’i Text, RTF ya da HTML olarak 

kaydedebilirsiniz. 

Sonuç (Word’te .rtf dosyası olarak açıldıktan sonra) 

   

Konu terimi 

Konu terim sayısı 

Kayıt numarası listesi 
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5.11.3 Copy Formatted (Biçimlendirilmiş Kopya) Komutu ile Word’te 

Yazdırma 

‘Copy Formatted’ komutunu, bibliyografyayı kopyalayıp Word, WordPad ya da 

WordPerfect dokümanınıza yapıştırmak ve daha hızlı üretmek için kullanabilirsiniz. 

Referanslar seçilen stil kurallarına göre biçimlendirilir ve sıralanırlar. 

‘Copy Formatted’ komutu için kullanılan yazı tipi ve boyutu ‘Edit/Preferences/Display 

Fonts’ seçilerek, ‘General’ tabının altından belirlenebilir. Bibliyograftayı ‘RTF’ (Rich Text 

Format) olarak adlandırılan yazı dosyasına yapıştırırken, tüm metin stil bilgisi (örneğin; 

kalın ve italik gibi) korunmaktadır.  

1. EndNote kütüphanesini açın ve kopyalamak istediğiniz referansları seçin. 

2. Gerekli ise, ‘Styles’ listesinden stili belirleyin. 

3. Seçilen referansları kopyalamak için ‘Edit/Copy Formatted’ komutunu ya da 

‘Ctrl+K’ tuş kombinasyonunu kullanın. 

4. Word dokümanını açın ve imleci referansların görüntülenmesini istediğiniz yere 

koyun. 

5. ‘Edit/Paste’ komutunu ya da ‘Ctrl+V’ tuş kombinasyonunu kullanın. 

Sonuç  

Style: APA 6th 

   

Style: Numbered 

 



 

EndNote X9 

6 Referansları Düzenleme (Editing 

References) 

Referansları düzenleyeceğiniz zaman, bir referansı ya da birçok referansı düzenlemek 

arasındaki farkın bilinmesi gerekmektedir. 

6.1 Tek Bir Referansı Düzenleme 

Tek bir referans kaydını iki şekilde düzenleyebilirsiniz: 

 Referans kaydına çift tıkladığınızda açılan ekranda değişiklikleri yaparak 

 Tab panelinde ‘Reference’ tabını kullanarak 

6.1.1 Referans Kaydına Çift Tıklayarak Düzenleme 

EndNote ‘Kütüphane Penceresi’nde görüntülenen referans kaydı üzerinde değişiklik 

yapmak için: 

1. Düzenlenecek olan referansın üzerindeyken çift tıklayın ya da 

Referans listesinden referansı belirleyin ve ‘References/Edit References’ı seçin. 

2. ‘Edit Reference’ penceresi görüntülenir. Değişiklileri gerçekleştirin.  

3. ‘Previous Reference’  ve ‘Next Reference’  butonu ile referanslarınıza hızlı bir 

şekilde göz atabilir ve önceki ya da sonraki referansları da düzenleyebilirsiniz. 

4. ‘File/Close Reference (Ctrl+W)’ ya da ekranın sağ üst köşesindeki ekranı kapama 

butonuna basın. 

Yaptığınız değişiklikleri kaydetmek için, ekranı kapatmadan önce ‘File/Save 

(Ctrl+S)’ komutunu ya da ekranı kapatırken açılan, ‘EndNote’ uyarı ekranında ‘Yes’ 

butonuna basın. 

6.1.2 Tab Panelini Kullanarak Düzenleme 

Tab panelinde bulunan ‘Reference’ tabını kullanarak, EndNote ‘Kütüphane 

Penceresi’nden seçeceğiniz referans kaydınızı açmadan, anında değişiklikler yapabilir 

ve ‘PDF Viewer’ bölümünde bu kayda ait mevcut PDF eki varsa bu PDF’i görüntüleyerek 

üzerinde bazı düzenlemeler yapabilirsiniz (örn: belirli bir alanı vurgulamak, not 

eklemek vb.). 

Referans kaydınızda değişiklik yapmak için; 

1. ‘Sample_Library_X9.enl’ kütüphanesini açın. 

2. Kütüphane penceresinden değişiklik yapmak istediğiniz referans kaydını seçin.  

3. Tab panelinde ‘Reference’ tabını seçin. 
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4. ‘Reference’ penceresinde, referans kaydında değişiklik yapmak istediğiniz alanı 

bulun.  

5. Terimleri girerken, girdiğiniz kayıt terimler listesinde yer alıyorsa otomatik 

tamamlama özelliğini etkin olarak kullanabilirsiniz. Ayrıca ‘Reference’ penceresinde 

penceresinde sağ tuş menü özelliklerini kullanabilirsiniz. 

6. ‘PDF Viewer’ bölümünde, PDF’te vurgulamak istediğiniz yeri belirleyin ve PDF araç 

çubuğunda, ‘Highligth Text’ butonuna basın. 

7. Not eklemek için PDF araç çubuğunda, ‘Sticky Note’ butonuna basın ve notunuzu 

ekleyin. 

    

8. ‘Reference’ ya da ‘PDF Viewer’ pencereleri dışına tıkladığınızda biri referans ve 

diğeri PDF değişikliklerini kaydetmek isteyip istemediğinizi soran iki ayrı EndNote 

ekranı açılacaktır. 

      

9. İki ekranı onayladığınızda, referans kaydınızda ve ekli PDF dosyanızda yapmış 

olduğunuz değişiklikler kaydedilecektir. Eğer ‘EndNote’ ekranının, her kayıt 

değişikliğinde açılmasını istemiyorsanız ‘Do not display this message again’ onay 

kutusunu işaretleyebilirsiniz, ancak önerilen, bu onay kutusunun hatalı yapılan 

değişikliklerin kaydedilmesini önlemek için seçilmemesidir. 

 Not 

 ‘Reference’ penceresinde ‘Tab’ tuşunu bir sonraki alana geçmek için, ‘Shift+Tab’ 

tuş kombinasyonunu ise bir önceki alana geçmek için kullanabilirsiniz. 

6.2 Birden Fazla Referans Kaydı Düzenleme 

Genel düzenleme komutları, birden fazla referans kaydını aynı anda düzenlemenizi 

kolaylaştırır ve referans verilerinizin tutarlı, standart olmasını sağlar. İki komut sizin 

için bu işi yapmaktadır: ‘Find and Replace…’, ‘Change/Move/Copy Field…’. 

6.2.1 Find and Replace (Bul ve Değiştir) 

‘Find and Replace’ komutu ile, kütüphanenizde metin arama, metin silme ve 

belirteceğiniz metinle yer değiştirme işlemleri gerçekleştirilmektedir. 
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Referansınızdaki değişiklikler belli alanlarla sınırlandırılabilir; hatta ‘Match Case’ 

(büyük-küçük harfe duyarlı) ve ‘Match Words’ (kelime eşlemesi) kısıtlamalarını da 

kullanabilirsiniz. ‘Find and Replace’ komutu sadece kütüphane penceresinde 

görüntülenenen referanslar için uygulanır. 

Aşağıdaki örnekte, ‘Author Address’ alanında bulunan ‘Univ ’i ‘University ’ olarak 

değiştireceğiz. 

1. ‘Edit/ Find and Replace (Ctrl+R)’i seçin. 

2. ‘Find and Replace’ ekranı görüntülenecektir. Seçenekleri belirleyin: 

Arama yapılacak alanı ‘In’ listesinden seçin. 

Değiştirilecek metni ‘Find’ alanına girin. 

Eğer gerekliyse, ‘Match Case’ ya da ‘Match Words’ ayarlarını değiştirin. 

‘Replace with’ alanına, orjinal metinle yer değiştirecek metni girin. 

‘Insert Special’ butonunu, ‘Tab’ ya da ‘Carriage return’ için kullanabilisiniz. 

Belirlenen metni aramak için, ‘Change’ butonuna basın. 

    

3. Bilgiler doğru ise ‘Tamam’ (OK) butonuna basın ve yeni metinle yer değiştirin. 

4. EndNote metni değiştirecek ve değiştirilen kayıtların sayısı görüntülenecektir. 

           

 Not 

 ‘Find and Replace’ komutu sadece kütüphane penceresinde görüntülenen 

referanslar için uygulanır. 

 Eğer ‘Replace with’ alanı boş bırakılırsa arama terimi silinecektir. 

 ‘Undo’ komutu ‘Find and Replace’ komutu sonucunda kullanılamamaktadır. 

Değişiklik yapmadan önce yedek aldığınızdan emin olun. 

 ‘Find and Replace’i kullanırken, yeni metin değiştirilen metnin ilk karakterinin 

metin stilini benimsemektedir. Örneğin; değiştirilen kelime italik ise yeni metinde 

italik olacaktır. 

6.2.2 Change/Move/Copy Fields (Alanları 

Değiştirme/Taşıma/Kopyalama) 

6.2.2.1 Change Field (Alan Değişikliği) 

‘Change Fields’ komutu ile kütüphanenizde, girilen metin alanın başında veya sonunda 

olsa dahi düzenleme yapılabilir, alanın tüm içeriğini farklı bir metinle değiştirebilir ya 

da alanın içeriğini silebilirsiniz. 
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Aşağıdaki örnekte ‘Sample_Library_X9’ kütüphanesindeki kitapları araştıracağız ve 

‘Research Notes’ alanına veri girişi yapacağız. 

1. ‘Sample_Library_X9’ kütüphanesini açın. 

2. ‘Tools/ Search Library (Ctrl+F)’ komutunu ya da ‘Search’ tabını kullanın. 

3. Aşağıda gösterilen seçenekleri girin (Reference Type, Contains-Book). 

  

4. ‘Search’ butonuna basın. 

5. Arama sonuçları pencerede görüntülenecektir. 

  

6. Değişiklik yapmak için referans listesini seçin ve ‘Tools/Change/Move/Copy Fields’ 

komutunu kullanın. 

7. ‘Change/Move/Copy Fields’ ekranı açılacaktır. 

‘In’ listesinden ‘Research Notes’u seçin. 

‘Insert after field’s text’i seçin. 

Notu, yeni satıra eklemek için ‘Insert Special’ butonuna basın ve ‘Carriage return’e 

tıklayın ve metni girin. 

    

8. ‘Tamam’ (OK) butonuna basın. 

9. İşlemi doğrulamak için, açılan ekranda ‘Tamam’ (OK) butonuna basın. 
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10. EndNote işlemi gerçekleştirecek ve veri girişi yapılan kayıtların sayısı 

görüntülenecektir. 

          

İkinci örneğimizde ‘Abstract’ alanının içeriğini sileceğiz. 

1. ‘Sample_Library_X9’ kütüphanesini açın. 

2. Tüm referansları görüntülemek için ‘References/Show All References (Ctrl+M)’ 

komutunu kullanın. 

3. Değişiklik yapmak istediğiniz referans kayıtlarını seçin ve 

‘Tools/Change/Move/Copy Fields’ komutunu kullanın. 

4. ‘Change/Move/Copy Fields’ ekranı açılacaktır. 

5. ‘Change Fields’ tabı üzerindeyken aşağıdaki işlemleri takip edin: 

- ‘In’ listesinde ‘Abstract’ alanını seçin. 

- ‘Clear field’ı seçin. 

  

6. ‘Tamam’ (OK) butonuna basın. 

7. İşlemi doğrulamak için açılan ekranda ‘Tamam’ (OK) butonuna basın. 

8. EndNote işlemi gerçekleştirecek ve içeriği silinen kayıtların sayısı 

görüntülenecektir. 

       

6.2.2.2 Move/Copy Fields (Alanları Taşıma/Kopyalama) 

‘Move/Copy Fields’ sekmesini kullanarak referans içerisindeki bir alanın içeriğini başka 

bir alanla değiştirebilirsiniz. Bu komut kütüphane penceresinde görüntülenen tüm 

referanslara uygulanır. Aşağıdaki örnekte veriyi ‘Custom 3’ alanından ‘Custom 4’e 

taşıyacağız. 

1. ‘Sample_Library_X9’ kütüphanesini açın. 

2. Düzenlemek istediğiniz referansları belirleyin. Bu referansların kütüphane 

penceresinde bulunduğundan emin olun. 

3. ‘Tools/Change/Move/Copy Fields’ı seçin. 
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4. ‘Change/Move/Copy Fields’ ekranı açılacaktır. 

‘Move/Copy Fields’ tabını seçin. 

‘From’ listesinden veriyi taşımayı istediğiniz alanı seçin. 

‘To’ listesinden veriyi taşıyacağınız alanı girin. 

Üç seçenekten birini girin. 

  

5. ‘Tamam’ (OK) butonuna basın. 

6. Doğrulamak için ‘Tamam’ (OK) butonuna basın. 

7. EndNote işlemi gerçekleştirecek ve içeriği taşınan kayıtların sayısı 

görüntülenecektir. 

       

 Not 

 Hedef alanda, taşınacak metni verinin önüne veya arkasına ekleme seçeneğine 

sahip olduğunuz gibi, hedef alanın bütün içeriğini değiştirebilirsiniz. Ayrıca, boş 

alanları taşıyıp taşımayacağınıza dair ek bir seçeneğe de sahipsiniz. Eğer ‘Don’t 

move empty fields’ onay kutusunu işaretlemezseniz, boş kaynak alana sahip olan 

her referansta, hedef alanda karşılığı olan içerikler silinecektir (ve alan olduğu gibi 

boş yapılacaktır). Bu seçenek seçili olduğunda, kaynak alan boş ise hedef alanın 

içeriği silinmeyecektir. 

 Eğer ‘Custom’ alanları aklınızda canlandıramıyorsanız, bu alanları 

‘Edit/Preferences/Reference Types/Modify Reference Types’ı seçerek 

ekleyebilirsiniz. 

6.3 Referansları Silme 

Referans kayıt/kayıtları seçildikten sonra silmek için, aşağıdaki komutlardan biri 

kullanılabilir: 

 ‘Delete’ tuşu ya da ‘Ctrl+D’ tuş kombinasyonu kullanılarak 

 ‘Edit/Cut’ ya da ‘Ctrl+X’ tuş kombinasyonu kullanılarak 

 ‘Edit/Clear’ kullanılarak 

 Sağ tuş menüsünden ‘Move References to Trash’ seçeneği kullanılarak 

 ‘References/Move References to Trash’ menüsü kulanılarak 

 ‘Trash’ grubuna referans/referansları sürükle/bırak kullanılarak 
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 Not 

 ‘Custom’ gruptan bir referansı sildiğinizde, sadece bu grup içerisinden silinecektir, 

kütüphaneden silinmeyecektir. 

 Referans kaydını sildiğinizde, o kütüphanedeki kayda ait kayıt numarası da 

tamamen silinecektir. 

 ‘Empty Trash’ ya da yukarıdaki benzer komutlar kullanılarak, ‘Trash’ grubundan 

silinen kayıt(lar) geri alınamaz. Bu yüzden, EndNote uyarı mesajını kabul etmeden 

önce referans(ları) silmek istediğinizden emin olun. 

 Makalelerde kullanılmış olan referansları silmemenizi öneriyoruz, bu kayıtları daha 

sonra yeniden biçimlendirmek isteyebilirsiniz. 

 Referanslarınızda düzenleme yaparken kütüphanenizin yedeğini almanız önerilir. 

6.4 Kütüphaneleri Birleştirme 

Kütüphaneleri birleştirmenin üç yolu bulunmaktadır:  

Bir kütüphaneden diğerine; 

 Referans import (File > Import) 

 Referans kopyalama (Edit > Copy ve Edit > Paste) 

 Drag-and-drop (Sürükle – bırak) 

6.4.1 File/Import 

Bkz. 4.4 Tekst Dosyası Import İşlemi 

6.4.2 Edit/Paste 

Referans kayıtlarını kopyala ve yapıştır komutları ile transfer edebilirsiniz.  

1. Kopyalama işlemi gerçekleştireceğiniz kütüphaneyi açın (=kaynak kütüphane) 

2. Hedef veri tabanına kopyalamak istediğiniz referansları ‘Ctrl’ veya ‘Shift’ tuşları ile 

ya da tüm referans kayıtları için ‘Edit/Select All’ menüsünü veya ‘Ctrl+A’ tuş 

kombinasyonunu kullanarak seçin. 

3. Referansları kopyalamak için ‘Edit/Copy’ komutunu veya ‘Ctrl+C’ tuş 

kombinasyonunu kullanın. 

4. Referansları eklemek istediğiniz kütüphaneyi açın (= hedef kütüphane). 

5. Kütüphane penceresine referansları yapıştırmak için ‘Edit/Paste’ komutunu veya 

‘Ctrl+V’ tuş kombinasyonunu kullanın. 

6.4.3 Drag-and-drop (Sürükle – bırak) 

Bir kütüphaneden diğerine kopyalamak istediğiniz referans kayıtları için,  

1. Referans kayıtlarını seçin: 

- sıralı olmayan referans kayıtlarını seçmek için ‘Ctrl’ tuşunu kullanın   

- sıralı referans kayıtlarını seçmek için ‘Shift’ tuşunu kullanın  

2. Seçili kayıtları mouse kullanarak diğer kütüphaneye sürükleyin. Seçili referans 

kayıtları diğer kütüphaneye kopyalanacaktır. 

 Not 

 Kütüphaneye referans eklemek istediğinizde, yeni eklenen referanslar yeni kayıt 

numaralarıyla eklenecektir. 

 Kütüphaneleri birleştirmeden önce, referansları transfer ettiğiniz kütüphanenin 

yedeğini almanız önerilmektedir. 
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6.5 Term Lists (Terimler Listesi) 

6.5.1 Tanımlama 

EndNote terim listeleri ‘keywords, ‘author names ya da journal names’ gibi terimleri 

depolamak için kullanılmaktadır. Depolanmış terimler, referanslar girilirken 

kütüphanenizdeki tutarlılığı ve bilgi doğruluğunu sağlamak için kullanılmaktadır. 

EndNote, Journals term list’i (dergiler terim listesi) bibliografyada tam dergi isminin 

yerini alabilen kısaltılmış dergi isimlerini depolamak için kullanmaktadır. 

 Terim listeleri, kütüphane ile birlikte depolanmaktadır, bu yüzden sadece o 

kütüphaneye özgüdür.  

 Default olarak her EndNote kütüphanesi, alanlarla bağımlı üç ‘Term Lists’e sahiptir: 

Authors, Journals, Keywords. EndNote terim listelerini otomatik olarak 

güncellemektedir. Bu sayede, Authors Jornals ve Keywords listeleri, referanslara 

eklenen tüm yazar isimlerini, dergi isimlerini ve anahtar kelimeleri içermektedir. 

 Terim listesindeki terimlerin sayısında bir sınırlama bulunmamaktadır. 

 Bir terim 253 karakter uzunluğunda olabilir. 

 Terimler listesi belirli alanlarla bağlantılıdır, bu yüzden EndNote, doğru terim 

listesini düzenlediğiniz alanla ilişkilendirmektedir. 

 Terim listeleri, export veya import edilebilir. 

 Default olarak terim listeleri, referanslarınıza girilen terimlerle otomatik olarak 

güncellenmektedir. Referans penceresinde yeni terimler kırmızı metin olarak 

gözükecektir. Bu özellik, EndNote ‘Preferences’ kullanılarak kapatılabilmektedir. 

6.5.2 Terim Listelerini Kullanma 

6.5.2.1 Suggestion (Öneri) Özelliğini Kullanarak Terimleri Ekleme 

Eğer, terim listesi ile bağlantılı bir alana metin giriyorsanız, EndNote listedeki ilk uygun 

terimi bulacak ve girmek isteyebileceğiniz terimi önerecektir. Listeden önerilen metin, 

imleçten sonra seçili olarak gözükecektir. EndNote, doğru terimi önerene kadar 

yazmaya devam edin ve önerilen terimi kabul etmek için ‘Enter’ ya da ‘Tab’ tuşuna 

basın. 

EndNote bir terim önerdiğinde, klavyeden aşağı veya yukarı yön tuşlarını kullanarak 

terim listesinden önerilen metinden bir sonraki veya bir önceki muhtemel uygun 

metine geçiş yapabilirsiniz. 

Terim listesinde yer almayan bir terim girdiğinizde, terimin yeni olduğunu belirtmek 

için kırmızı renkte gözükecektir. Yeni terim, referans kaydını kapatığınızda veya 

kaydettiğinizde terim listesine eklenir ve artık kırmızı renkte görüntülenmez. 

Aşağıdaki örnekte ‘Author’ adı Brinklov olan yeni bir referans girelim. 

1. Yeni bir referans kaydı girmek için; 

Araç çubuğundan ‘New Reference’  butonunu, ‘References/New Reference’ 

komutunu ya da ‘Ctrl+N’ tuş kombinasyonunu kullanın. 

2. Klavyeden B harfine bastığınızda EndNote, ‘Bailey, S.’i önerecektir. 
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3. Klavyeden R harfine bastığınızda EndNote, ‘Bragg, R.’yi önerecektir. 

  

4. Klavyeden İ harne bastığınızda EndNote, ‘Brinklov, S.’yi önerecektir. 

  

5. Brinklov, S. ismi görüntülendiğinde, yeni yazar adını girmek için ‘Enter’a basın ya 

da ‘Tab’ tuşuna basıp sonraki alana geçin. Pencere aşağıdaki gibi 

görüntülenecektir: 

  

6.5.2.2 Suggest (Öneri) Özelliğini Kullanmadan Terimleri Ekleme 

Default olarak, ‘Suggest Terms as you type’ özelliği açıktır (Edit/Preferences/Term 

Lists). Eğer ‘Suggest Terms as you type’ seçeneğini kapatırsanız referanslarınızdaki 

terimleri manuel olarak girmeniz gerekmektedir. Terim listesi penceresinden terim 

girmek için: 

1. Araç çubuğundan ‘New Reference’  butonunu, 

‘References/New Reference’ komutunu, 

ya da 

‘Ctrl+N’ tuş kombinasyonunu kullanın. 

Terimi eklemek istediğiniz yerin konumunu belirtin. 

2. ‘Tools/Open Term Lists’i açın ve istenen listeyi seçin (Authors Term List (Ctrl+1), 

Journals Term List ya da Keywords Term List). 

‘DefineTerm Lists’ ekranını etkinleştirmek için ‘Tools/DefineTerm Lists’ komutunu 

ya da ‘Ctrl+4’ tuş kombinasyonunu kullanabilirsiniz. 

3. Terim eklemek için methodlardan birini seçin ve ‘Terms’ tabına basın; 
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 Terimi referansınıza doğrudan eklemek için çift tıklayın; 

 Bir ya da daha fazla terimi seçin ve ‘Insert Term’ butonuna basın, birden fazla 

terimi seçebilmek için ‘Shift’ ya da ‘Ctrl’ tuşlarını kullanabilirsiniz. 

4. Terimlerin her biri referansınızda alfebetik olarak listelenecektir. 

6.5.3 Terim Listelerini Düzenleme 

Bir terim listesindeki herhangi bir terim, kütüphanedeki referansları veya terim listeleri 

ile alanlar arasındaki bağlantıları etkilemeden düzenlenebilir ya da silinebilir.  

6.5.3.1 Author Term (Yazar Terim) Listesi Düzenleme 

Yazar terim listesindeki bir terimi düzenlemek için: 

1. ‘Tools/Open Term Lists’i açın ve düzeltme yapılacak terimi içeren listeyi seçin 

(Authors Term List) ya da ‘Ctrl+4’ tuş kombinasyonunu kullanarak ‘Lists’ tabını 

aktif hale getirin. 

2. ‘Term Lists’ ekranı görüntülenecektir. 

‘Terms’ tabında yazar isimleri alfebetik olarak listelenir. 

‘Lists’ tabında default olarak üç terim listesi bulunmaktadır (Authors, Journals, 

Keywords). 

   

Terms (Terimler) 

‘Terms’ tabında aşağıdaki seçenekler kullanılabilir: 

 New Term: Bu buton, listeye yeni terimler eklemek için kullanılır. 

 Edit Term: Bu buton, seçilen terimleri düzenlemek için kullanılır. 

 Delete Term: Bu buton, seçilen terimleri silmek için kullanılır. 

 Insert term: Bu buton, seçilen terimleri doğrudan açık olan referansa eklemek için 

kullanılr. 

Lists (Listeler) 

‘Lists’ tabında aşağıdaki seçenekler kullanılabilir: 

 Create List: Bu buton, yeni terim listesi oluşturmak için kullanılır. 

 Rename List: Bu buton, seçilen terim listesinin adını düzenlemek için kullanılır. 

Terim listeleri, referans alanlarındaki ya da terimlerdeki bağlantılarda değişiklik 

olmadan yeniden adlandırılabilir. 

 Delete List: Bu buton, seçilen terim listesini silmek için kullanılır. 

 Update List: Bu buton, seçilen terim listesini, kullanılan kütüphanede bağlı 

alanlarda bulunan terimlerle güncellemek için kullanılır. Terimler listenizde 

otomatik güncellemenin kapatılması halinde, terimler listesi olmadan iş 

arkadaşınızdan kütüphane aldığınızda ya da terim listesi silindiğinde tekrardan 

oluşturmak istediğinizde yararlı olacaktır. 

 Import List: Bu buton, tekst dosyasından seçilen listeye mevcut terimler listesini 

import etmek için kullanılır. 
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 Export List: Bu buton terimleri, seçilen listeden tekst dosyası olarak export etmek 

için kullanılır. Bu tekst dosyası diğer kütüphanelere import edilebilir ya da word 

dokümanı olarak açılabilir. 

 Link Lists: Bu buton, terim listesini bir ya da daha fazla alanla bağlamak için 

kullanılır. Bkz. 6.5.6 Terimler Listesi Bağlantısı 

Aşağıdaki örnekte ‘Binfield, Peter’i ‘Binfield, P.’ olarak değiştireceğiz: 

1. Eğer gerekli ise ‘Sample_Library_X9’ kütüphanesini açın. 

2. Kütüphanede sağ tuş yapın ve ‘Show All References’ı seçin. 

3. ‘Edit/Find and Replace’i seçin. 

4. ‘In’ listesinden ‘Author’u seçin. 

‘Find’ alanına Binfield, Peter yazın. 

‘Replace with’ alanına Binfield, P. yazın. 

  

5. ‘Change’ butonuna basın. 

6. Değişikliği onaylamak için ‘Tamam’ (OK) butonuna basın. EndNote işlemi 

gerçekleştirecek ve değişiklik yapılan kayıtların sayısı görüntülenecektir. 

      

7. Kütüphane listesinde isim doğru olarak gözükecektir. 

8. ‘Tools/Open Term Lists/Authors Term List’i seçin. 

9. ‘Terms’ tabında Bin yazın. 

Terim listesinde hala iki isim gözükecektir. 

Yanlış yazılan Binfield, Peter ismini seçin. 

‘Delete Term’ butonuna basın. 

İsim listeden kaldırılacaktır. 

    

10. ‘Close’ butonuna basın. 
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6.5.3.2 Journal Term (Dergi Terim) Listesi Düzenleme 

EndNote'un, bibliyografyalarınızda kısaltılmış dergi adlarını doğru bir şekilde kullanması 

için, bir dergi adının farklı biçimlerini girerken tutarlı olmak önemlidir. İlk sütun her 

zaman tam dergi adını listelemeli ve sonraki sütunlar tutarlı kısaltılmış adların 

biçimlerini saklamalıdır. 

Liste güncelleme tercihlerini kapatmadıysanız, dergi listeleri, Journal Article ve 

Electronic Article referans tiplerinden otomatik olarak güncellenir. Dergi listeleri 

güncellendiğinde, Journal alanı verisi listenin ilk sütununa (Full Journal) ve Alternative 

Journal alanına girilen veri listenin ikinci sütununa (Abbreviation 1) eklenecektir. Bu 

alanlara veri girerken tutarlı olun, böylece dergi terim listesi doğru şekilde 

güncellenecektir. Journal alanına girilen veri, dergi terim listesi sütunlarından birinde 

bulunuyorsa tekrar eklenmeyecektir. EndNote, dergi listesindeki çift girişlere engel 

olmaya çalışacaktır. 

Terim listeleri, otomatik güncelleme tercihini kapattıysanız, listeleri manuel olarak da 

güncelleyebilirsiniz. Dergi listelerini manuel olarak güncellerken, listedeki hangi 

sütunların hangi veri alanları için kullanılacağını seçebilirsiniz. 

‘Sample_Library_X9’ kütüphanesinde ‘Journal Term Listesi’ni inceleyelim: 

1. ‘Sample_Library_X9’ kütüphanesini açın. 

2. ‘Tools/Open Term Lists’i açın ve ‘Journals Term List’i seçin. 

3. ‘Terms’ tabında dergi adları alfebetik liste olarak görüntülenecektir. 

4. Listeden bir terim seçin. 

  

5. ‘Edit Term’ butonuna basın. 

‘Edit Journal’ ekranındaki kısaltma alanlarına, aynı dergi adının alternatiflerini 

girerek, bir terim altında kullanabilirsiniz. 
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 Not 

 Dergiler terim listesi, bibliyografya oluşturulurken kullanılabilecek dergi isimlerinin 

farklı biçimlerini saklamaktadır. Veri girişinde kullanmak için sağlanan dergi başlığı 

listelerinden birini yükleyebilirsiniz. Bu listeler ayrıca, alternatif çıktı stilleri için 

dergi isim kısaltmalarını içerir ve belirli dergi stilleri tarafından kullanılmaktadır. 

EndNote X9 terim listeleri dosyasında tutulan bu listeler: Anthropology.txt, 

Archaeology.txt, Astronomy and Astrophysics.txt, BioScience.txt, Chemical.txt, 

Economics.txt, Humanities.txt, Korean Medical Terms.txt, Law.txt, Medical.txt, 

Philosophy.txt, Physics.txt, Religion.txt and Zoological Records.txt.  

Bu listeler; 

‘C:\Program Files\EndNote X9\Terms Lists’ 

‘C:\Program Files (x86)\EndNote X9\Terms Lists (64-bit Windows versiyonları için)’  

klasöründe bulunmaktadır. 

 Dergiler terim listesinden bir dergi adını bir referansa eklediğinizde, dergi adı için 

yalnızca ilk terim girilecektir. Ancak, makaleyi biçimlendirmek için kullanılan stili 

düzenleyerek, terim listesindeki herhangi bir kısaltmanın kullanılacağı bir 

bibliyografya oluşturabilirsiniz. 

 Terim listesindeki bir terimin düzenlenmesi, o terimin kütüphanenizde önceden 

girilen verisini değiştirmez. Referanslarınızdaki eski terimi bulmak ve yenisiyle 

değiştirmek için ‘Edit / Find and Replace’ komutunu kullanabilirsiniz. 

6.5.4 Yeni Terim Listesi Oluşturma 

Referansları manuel olarak girerseniz, yayıncı ve yazar adresleri gibi alanlar için yeni 

terim listeleri (en fazla 31 terim listesi) oluşturmayı yararlı bulabilirsiniz. Aşağıdaki 

örnekte, biomedikal eşanlamlı terimleri (MeSH) import etmek için yeni bir liste 

oluşturacağız. 

1. Yeni liste oluşturmak istediğiniz kütüphaneyi açın. 

2. ‘Tools>Define Term Lists’i açın ve ‘Journals’i seçin. 

3. ‘Create List’ butonuna tıklayın. 

‘Term List  Name’ ekranında yeni listenin adını (MeSH) girin. ‘OK’ botununa basın. 

 

 Not 

 MeSH terimlerini https://researchsoftware.com/downloads/terms-lists adresinden 

download edebilirsiniz. Bkz. 6.5.5 Terimleri, Terim Listelerine Import Etme 

6.5.5 Terimleri, Terim Listelerine Import Etme 

Bu örnekte, bir önceki örnekte oluşturmuş olduğunuz MeSH terimler listesine 

biomedikal eşanlamlı terimleri import edeceğiz. 

1. Terim listesini import etmek istediğiniz kütüphaneyi açın. 

(Bu örneği test kütüphanesi ile yapmanızı öneriyoruz) 

2. ‘Tools>Define Term Lists’i açın 

3. Bir önceki örnekte oluşturduğunuz yeni terim listesini seçin. 

4. ‘Import List’ butonuna tıklayın. 

5. ‘Open’ ekranında import edeceğiniz MeSH_terms_2016_0.txt dosyasını seçin. 

‘Open’ butonuna tıklayın. 

https://researchsoftware.com/downloads/terms-lists
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6. ‘OK’ butonuna basın. 

7. ‘Terms’ tabına tıklayın. 

 

6.5.6 Terimler Listesi Bağlantısı 

Aşağıdaki örnekte, yeni MeSH terim listesini farklı alanlara bağlayacağız. 

1. Gerekli ise kütüphaneyi açın. 

2. ‘Tools>Link Term Lists’i seçin ya da ‘Ctrl+3’ tuş kombinasyonunu kullanın. 

3. ‘Keywords’ ve ‘Abstract’ alanlarına MeSH terim listesi bsğlantısını oluşturun. 

 

4. ‘OK’ butonuna tıklayın. 

5. ‘Close’ butonuna tıklayın. 

6.6 Referans Export İşlemi 

EndNote’dan bibliyografyaların export edilmesi kolay ve kullanışlıdır. Kütüphaneden 

export işlemi gerçekleştirilirken, EndNote seçilen stile göre referans kayıtlarını içeren 

bir dosya oluşturur. Export komutunu takip eden formatlardan herhangi biri için, 

serbest-kalıcı bibliyografya oluşturmak için kullanabilirsiniz: 

 RTF (Rich Text Format) 

Kelime işlemci kullanılarak düzenlenebildiğinden veya yazdırılabildiğinden, serbest-

kalıcı bibliyografya oluşturmada en ideal yol ‘RTF’ exporttur. Bu format, bütün 

popüler kelime işlemcilerde açılabilir, yazı tipi ve metin stili bilgileri korunur. 

 Text File 

‘Text File’ export seçeneği, taslak amacıyla ya da export edilen referansların, başka 

bir veri tabanına import edilmesinde kullanılması uygundur. 

 HTML 

Dokümanların HTML (HyperText Markup Language) olarak export edilmesi, ‘World 

Wide Web’e referans listeleri göndermenin en kolay yoludur. Web tarayıcınızda, 

export edilen dokümandaki genişletilmiş unicode karakterlerini uygun şekilde 

görüntülemek için, kodlama ‘Unicode-UTF 8’ olarak ayarlanmalıdır. 
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 XML 

XML seçeneği, tescilli EndNote ‘XML’ formatında export edilmektedir. 

‘Export’ komutu, yeni EndNote kütüphanesine referanslar import edildikten sonra, sıralı 

kayıt numaraları oluşturmanın en hızlı yoludur. 

6.6.1 İşlem Sırası (Export için) 

Bir sonraki örnekte, ‘Sample_Library_X9’ kütüphanesinden referansları RIS formatında 

export edeceğiz. Export edilen RIS dosyası, yeni bir kütüphaneye ya da Reference 

Manager veri tabanına import edilebilir. Sonuç olarak ‘Import’ işlemi, aşağıdaki gibi 

görünecektir. Bkz. 4.4 Tekst Dosyası Import İşlemi 

Örneğe başlamadan önce ‘EndNote’da ‘File/New…’ menüsünü kullanarak, boş bir 

kütüphane oluşturun ve ‘EndNote’da ‘Edit/Preferences’ menüsünü açın. ‘Preferences’ 

ekranında ‘Libraries’ bölümünde ‘When EndNote starts’ açılır listesinden ‘Promt to 

select a library’i ya da ‘Do nothing’i seçin. 

1. Export işlemini gerçekleştireceğiniz kütüphaneyi açın. 

2. Export edeceğiniz referansları belirleyin. 

3. Listede sağ tuşa basın ve ‘Show Selected References’ seçin. 

4. ‘Library’ araç çubuğu stil listesinden ‘RefMan (RIS) Export’ stilini seçin. 

Kolon başlığında sıralama için ‘Author’ alanına basın. 

  

5. ‘File/Export...’u seçin. 

6. ‘Export file name’ penceresi açılır. 

‘Dosya Adı’ (File Name) alanına dosyanın adını girin (.ris uzantısı ile birlikte). 

‘Kayıt Türü’ (Save as type) alanında ‘Text File’ (*.txt) seçili olsun. 

   

7. ‘Kaydet’ (Save) butonuna basın. 
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6.6.2 RIS Dosyası Import 

Bu örnekte, export edilen referans kayıtları (RIS dosyası) bir kütüphaneye import 

edilecektir. 

1. RIS dosya ikonuna  çift tıklayın. ‘Choose Destination’ ekranı açılacaktır. Bu 

ekranda, EndNote ya da Reference Manager’ı seçip, ‘OK’ butonuna basarak import 

işlemine devam edebilirsiniz. 

 

2. ‘Select a Reference Library’ ekranından export edilen referansları eklemek 

istediğiniz kütüphaneyi seçebilirsiniz (Default program ayarları kullanıldığında 

referans kayıtları aktif EndNote kütüphanesine / Reference Manager veri tabanına 

import edilecektir). 

   

3. ‘Aç’ (Open) butonuna basın. 

Veri doğrudan seçmiş olduğunuz kütüphaneye import edilecektir. 

Sonuç (Import Sonrası) Başka Bir EndNote Kütüphanesi 

 

Kütüphaneyi Seçin 

 

Kayıt numaraları aralıksızdır 
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Sonuç (Import Sonrası) Başka Bir Reference Manager Kütüphanesi 

 

 Not 

 Referansları export etmeden önce ‘Style’ ve ‘Sort Order’ özelliklerini belirleyin. 

 Export komutu sadece metinleri export etmektedir, imajları içermemektedir. 

Bununla birlikte; eğer EndNote kütüphanesine referansları geri import edecekseniz, 

orjinal kütüphanenin .DATA klasöründeki imaj dosyalarını, yeni kütüphanenin 

.DATA imaj klasörüne kopyalayın. 

 Eğer referansları HTML formatında export ederseniz, referans listeniz doğrudan 

Web sitenizde kullanılmaya hazır olacaktır. Web tarayıcınızda, genişletilmiş unicode 

karakterlerini uygun şekilde görüntülemek için, kodlama ‘Unicode-UTF 8’ olarak 

ayarlanmalıdır. 

 Eğer referansları RIS formatında export ederseniz, metin dosyasını RIS filtresi 

kullanarak Reference Manager, ProCite ya da EndNote veri tabanına import 

edebilirsiniz. Eğer dosyanın uzantısını .ris olarak değiştirdiyseniz ikon şu şekilde 

gözükecektir: . Bu dosyaya çift tıkladığınızda, dosyayı hangi veri tabanına import 

etmek istediğinizi belirleyeceğiniz, ‘Choose Destination’ ekranı açılacaktır.

Kayıt Numaraları aralıksızdır 
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7 Referans Tiplerinin Düzenlenmesi 

(Customizing Reference Types) 

EndNote kütüphaneniz farklı kaynakladan referanslar içerebilir (örneğin; ‘books’, 

‘journal articles’ ve ‘newspaper articles’). Bu farklı kaynaklar Reference Types olarak 

adlandırılmaktadır. EndNote bu ve diğer ortak referans tipleri için yerleşik formlar 

sağlamaktadır. 

Her şeyi kapsayan ‘Generic’ referans tipine ek olarak, EndNote: 

 53 önceden tanımlanmış referans tipleri: Aggregated Database (Birleştirilmiş Veri 

Tabanı), Antik Metin (Ancient Text), Sanat Çalışması (Artwork), Görsel İşitsel 

Materyal (Audiovisual Material), Tasarı (Bill), Blog, Kitap (Book), Kitap Bölümü 

(Book Section), Dava (Case), Katalog (Catalog), Grafik ya da Tablo (Chart or 

Table), Klasik Çalışma (Classical Work), Bilgisayar Programı (Computer Program), 

Konferans Makalesi (Conference Paper), Konferans Tutanağı (Conference 

Proceedings), Veri Kümesi (Dataset), Sözlük (Dictionary), Düzenlenmiş Kitap 

(Edited Book), Elektronik Makale (Electronic Article), Elektronik Kitap (Electronic 

Book), Elektronik Kitap Bölümü (Electronic Book Section), Ansiklopedi 

(Encyclopedia), Denklem (Equation), Şekil (Figure), Film ya da Tv/ Radyo Yayını 

(Film or Broadcast), Genel (Generic), Hükümet Dokümanı (Government 

Document), Ödül (Grant), Oturum (Hearing), Röportaj (Interview), Dergi Makalesi 

(Journal Article), Yasal Kural ya da Düzenleme (Legal Rule or Regulation), Magazin 

Makalesi (Magazine Article), Manuscript (Taslak), Harita (Map), Müzik (Music), 

Gazete Makalesi (Newspaper Article), Online Veri Tabanı (Online Database), Online 

Multimedya (Online Multimedia), Broşür (Pamphlet), Patent, Kişisel İletişim 

(Personal Communication), Podcast, Basın Bülteni (Press Release), Rapor (Report), 

Dizi (Serial), Standart (Standard), Kanun (Statute), Tezler (Thesis), 

Yayımlanmamış Çalışma (Unpublished Work) ve Web Sayfası (Web Page). 

 3 kullanılmayan referans tipi: Unused 1, Unused 2, Unused 3. 

Referans Tipleriyle İlgili Önemli Hususlar: 

 Kütüphanenize girilen her referans için özel referans tipi belirleyebilirsiniz. 

 Doğrudan EndNote ‘Preferences’tan erişilebilen ‘Reference Types’ tercihleri ile, her 

farklı referans tipi için hangi alanların kullanılacağı belirlenmektedir. 

 ‘Reference Types’ tercihleri 53 farklı referans tipine ve her biri en fazla 54 alanı 

(referans tipinin adını içeren) destekleyebilir. 

 ‘Generic’ tipi haricindeki 53 referans tipinin tümü düzenlenebilmektedir. 

 ‘Reference Types’ tercihlerini, alan eklemek, silmek veya yeniden adlandırmak için 

kullanabilirsiniz. Ayrıca, referans tipi ekleyebilir ya da tamamen gizleyebilirsiniz. 

 Referans tiplerini, düzenleyeceğiniz ya da oluşturacağınız zaman, Generic referans 

tipi kılavuz olarak kullanılmalıdır. Yazarlar için ayrılan satırlar sadece isimler 

için kullanılmalıdır. 

 ‘Referans Types’ tercihlerinde yapılan değişiklikler, her kullanıcı için ‘C:\ 

Users\User Name\ App Data\Roaming\EndNote’ klasöründe 

RefTypeTable.xml dosyasında saklanmaktadır. Bu değişiklikler geçerli kullanıcı 

hesabı altında açıldığında, bütün kütüphanelerde uygulanır. 

 Eğer kütüphanenizi farklı bir bilgisayara taşırsanız, referans tipi tablosunun 

kopyasını transfer etmedikçe, referanslarınız o bilgisayardaki geçerli kullanıcı 

hesabının ‘Referans Types’ tercihlerindeki düzeni takip edecektir. 
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 Referans verinizi ‘Referans Types’ tercihlerine girmeyin. Bu pencere sadece, 

referans alanlarının isimlerini depolamak için tasarlanmıştır. 

 Microsoft Word'de şekil eklemek için Cite While You Write kullandığınızda, Chart or 

Table referans tipine sahip şekil, tablo olarak eklenir. EndNote'ta herhangi bir 

referans tipinde bulunan şekil, Word'de şekil olarak biçimlendirilecektir. 

7.1 Default Referans Tip Ayarı 

Default olarak, yeni bir referans kaydı gireceğiniz zaman, referans tipi ‘Journal Article’ 

olarak görüntülenir. Yeni referansların otomatik olarak, kitap, patent veya başka bir 

referans tipi olarak görünmesini istiyorsanız, default ayarları değiştirebilirsiniz. Bunun 

için aşağıdaki işlemleri takip edin: 

1. ‘Edit/Preferences’ı seçin. 

2. ‘Reference Types’a basın. 

3. ‘Default Reference Type’ listesini açın ve uygun referans tiplerinden birini seçin. 

 

4. Değişiklikleri kaydetmek için, ‘Apply’ butonuna, ekranı kapatmak için ‘OK’ 

butonuna basın. 

7.2 Referans Tiplerini Gizleme 

İstenmeyen referans tipini gizleme: 

1. ‘Edit/Preferences’ı seçin. 

2. Tercihler listesinden ‘Reference Types’ı seçin. ‘Modify Reference Types’ butonuna 

bastığınızda, ‘Modify Reference Types’ ekranı görüntülenecektir.  

3. Gizlemek istediğiniz referans tipini listeyi kullanarak bulun. 

4. Kolon başında, referans tipi isminden önce nokta ekleyin. EndNote, bu öğeyi 

referans penceresindeki ‘Reference Type’ listesinden ve diğer yerlerden 

kaldıracaktır. Yinede, kalıcı bu durum sonrasında, gizlediğiniz referans tipini nokta 

işaretini kaldırarak görüntülenmesini sağlayabilirsiniz. 

Başka bir tip seçin 
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5. ‘Preferences>Reference Types’ ekranına, ‘OK’ butonuna basarak dönebilirsiniz. 

6. Değişiklikleri kaydetmek için ‘OK’ butonuna basın. 

7.3 Referans Tiplerini Düzenleme 

‘Generic’ haricindeki bütün referans tipleri ‘Reference Types’ tercihleri kullanılarak 

düzenlenebilmektedir. Referans tipinde değişiklik yapacağınız zaman, yeni ya da 

düzenlenmiş referans tiplerinin doğru formatta olduğundan emin olmak için stillerinizi 

de düzenlemelisiniz. 

Çeşitli referans tiplerini kişiselleştirmenin farklı yolları bulunmaktadır. Mevcut referans 

tipi ihtiyacınız olan tüm alanları içermiyorsa, yeni bir alan tanımlayabilir veya mevcut 

bir alanı yeniden adlandırabilirsiniz. Benzer şekilde, asla kullanmayacağınızı bildiğiniz 

bir alan varsa, onu referanslarınızda görünmeyecek şekilde referans tipinden 

silebilirsiniz. 

Aşağıdaki örnekte ‘Newspaper Article’ referans tipini kişiselleştireceğiz (Bkz. 4.1.1 

Farklı Bibliyografya Formatlarının Oluşturulabilmesi İçin Minimum Girilmesi Gerekli 

Alanlar). 

1. ‘Edit/Preferences’ seçin. 

‘EndNote Preferences’ ekranı görüntülenecektir. 

2. Tercihler listesinden Reference Types’ı seçin. 

Modify Reference Types butonuna basın. 

 

Reference Types Seçin 

Butona Basın 
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3. ‘Modify Reference Types’ ekranı görüntülenecektir. 

‘Reference Type’ listesinden Newspaper Article’ı seçin. 

 

4. Alanlar: Reporter, Year, Title, Newspaper, City, Pages, Edition ve Issue Date 

değiştirilmez. Diğer alan adları silinebilir. 

 

5. ‘OK’ butonuna basın. ‘Volume’ alanı referans penceresinden kaldırılacaktır. 

Sonuç 

 

‘Newspaper Article’ seçin 

Bu kolon Generic alan 

isimleri için ayrılmıştır 

Seçin ve Silin 
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7.4 Referans Tiplerini Export Etme 

‘Reference Type’ ayarları C:\Users\username\AppData\Roaming\EndNote altındaki 

RefTypeTable.xml dosyasına kaydedilmektedir.  

Referans tiplerinin yedeğini almak için: 

1. ‘Edit/Preferences’ seçin. 

2. Tercihler listesinden Reference Types’ı seçin. 

3. ‘Export’ butonuna tıklayın, açılan ekranda;  

 Dosya adını girin. 

 Dosyayı kaydetmek istediğiniz klasörü belirleyin. 

 ‘Save’ butonuna basın. EndNote, dosya adına .xml son eki ekleyecektir. 

Kişiselleştirilmiş referans tiplerini geri yüklemek için:  

1. ‘Edit/Preferences’ı seçin. 

2. Tercihler listesinden Reference Types’ı seçin. 

3. ‘Import’ butonuna tıklayın. 

4. Açılan ekranda, export ettiğiniz .xml dosyasını bulun ve açın.  

 Not 

 ‘Reference Type’ı düzenlediğinizde, çıktı stilini de (Output Style) düzenlemeyi 

unutmayın. 

 Eğer kütüphanenizi farklı bir bilgisayara taşırsanız, referans tipi tablosunun 

kopyasını transfer etmedikçe ya da RefTypeTable.xml dosyasını diğer kullanıcının 

‘C:\ Users\User Name\ App Data\Roaming\EndNote’ klasörüne 

kopyalamadıkça, referanslarınız o bilgisayardaki geçerli kullanıcı hesabının 

‘Referans Types’ tercihlerindeki düzeni takip edecektir.
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8 Preferences (Tercihler) 

EndNote’la çalışmaya başlamadan önce, program ayarlarını kişiselleştirmek yararlı 

olabilir. EndNote görüntü yapılandırması, biçimlendirme tercihleri ve diğer seçenekler 

EndNote programında ‘Preferences’ bölümünden yapılmaktadır. 

‘EndNote Preferences’a erişmek için: 

1. Menüden ‘Edit/Preferences’i seçin. 

2. ‘EndNote Preferences’ ekranında, pencerenin sol tarafında mevcut tercih panelleri 

bulunmaktadır. Listede panelin ismine tıkladığınızda, değiştirmek istediğiniz ayarlar 

görüntülenecektir. Tüm tercih panellerinde aşağıdaki seçenekler yer almaktadır: 

 EndNote Defaults: Geçerli panelde, orjinal EndNote ayarlarına dönmek için 

kullanılır. 

 Revert Panel: Geçerli panelde, son kaydedilme anına kadar, yapılan 

değişiklikleri kaldırmak için kullanılır. 

8.1 Change Case (Harf Değişikliği) 

EndNote stilleri, yazar isimlerinin ve başlıkların büyük/küçük harfe çevrilme 

değişikliğini yapılandırabilir. EndNote, başlıklar ya da yazarlar için harfin büyük/küçük 

olma durumunu değiştirirse, düzenleme yapılmaması gereken kelimeler listesi için 

‘Change Case’ özelliğini kullanın. ‘Change Case’ özelliği, büyük harf kullanılması 

tutarlılık gerektiren özel kısaltmalar, denklemler, özel isimler ya da bileşik isimler için 

kullanılabilir. 

Bu tercih, başlıklarda yalnızca ‘Headline style capitalization’ ya da ‘Sentence style 

capitalization’ (Leave titles as entered yerine) uygulanacak şekilde çıktı stili 

ayarlandığında kullanılır. 

 

8.2 Display Fields (Alanların Görüntülenmesi) 

Aşağıdaki değişiklikler için ‘Display Fields’ tercihlerini kullanın: 

 ‘Library Window’da kolonların sırası (default olarak: Read/Unread Status, File 

Attachments, Author, Year, Title, Rating, Journal/Secondary Title, Last 

Updated, Reference Type); 

 Kolonların sayısı maximum 10’dur. Alan adı yerine [Do not display] seçilirse on 

alandan azı gösterilebilir. 
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 ‘Field’ ve ‘Heading’ değerlerinin gösterimi. 

 Tüm yazar adlarının kütüphane penceresinde yazar başlığı altında görüntülenmesi 

için ‘Display all authors in the Author field’ onay kutusunu işaretleyin. 

Bu ayarlar bilgisayar açıldığında tüm kütüphanelere uygulanır. 

 

8.3 Display Fonts (Görüntülenen Yazı Tipleri) 

Default olarak, EndNote’da yazdığınız ya da düzenlediğiniz herhangi bir metinde, 

Windows sürümünüze bağlı olarak belirlenmiş, önerilen sistem yazı tipi kullanılır. 

EndNote tercihlerinde ‘General’ görüntüleme yazı tipi seçeneklerini kullanarak yazı tipi 

ve/veya boyutunu değiştirebilirsiniz. 

‘Display Fonts’ta yapılan değişiklikler bilgisayarda açık olan tüm EndNote 

kütüphanelerinde uygulanır; kelime işlemcinizde bibliyografyaları biçimlendirirken 

kullanılan yazı tiplerini etkilememektedir. Bunun için, dokümanın normal yazı tipi 

ayarları kullanılmaktadır. ‘General’ görüntüleme yazı tipinde gerçekleştirilen basit 

değişiklikleri EndNote, dokümanın ‘Plain Font’ ve ‘Plain Size’ ayarlarında 

kullanmaktadır. Referanslarınızda yapmayı tasarladığınız yazı tipi değişiklikleri ‘Display 

Font’ tarafından etkilenmemektedir. 

‘Display Fonts’ değişiklikleri için: 

1. ‘Edit/Preferences’ı seçin. 

2. ‘Display Fonts’ seçeneğini seçin. 

3. Ekran yazı tipi ayarını değiştirmek istediğiniz sekmeye tıklayın. Aşağıdaki ekran 

yazı tipi ayarlarını değiştirebilirsiniz: 

 Library: Kütüphane penceresinde listelenen referansların yazı tipi ve 

boyutlarının belirlendiği alandır. 

 General: EndNote’da yazılan birçok metnin (örneğin; Referans ya da Style 

penceresinde) görüntülenmesinde kullanılan yazı tipi ve boyut değişikliklerinin 

yapıldığı alandır. ‘General’ görüntüleme yazı tipi daha çok EndNote önizlemede 

ve bilgi panelinde kullanıldığı gibi bibliyografyalar doğrudan EndNote’dan print 

ve kopya edilebilir. 

 Fields: Referans penceresindeki alan etiketleri için kullanılan yazı tipi ve 

boyutların belirlendiği alandır. 

 Search: Arama penceresinde kullanıcının girdiği metne uygulanan yazı tipi ve 

boyutların belirlendiği alandır. 

4. Her sekmede ‘Change Font’ butonuna basın, farklı yazı tipi ve/veya boyutlarını 

listeden seçin. 

5. Yazı tipi ekranını kapatmak için ‘Tamam’ (OK) butonuna basın ve seçilen yazı tipi 

ve boyutunu örnek metinde görüntüleyin. 

Author alanında tüm yazar adların 

görüntülemek için kullanılır 
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6. ‘Uygula’ (Apply) butonuna basın ve açık olan EndNote penceresindeki değişiklikleri 

görüntüleyin. Bu değişiklikleri kaydetmek için ‘Tamam’ (OK) butonuna basın ve 

‘Preferences’ ekranını kapatın. 

   

   

8.4 Duplicates (Çift) Kayıtlar 

‘Duplicates’ tercihler panelinde, ‘References>Find Duplicates’ komutu için kriterler 

belirlenmektedir. Bkz. 5.5.5 Duplicate (Çift) Referans Kayıtlarını Bulma 

Default olarak, EndNote kütüphanesinde ‘Author, Year, Title ve Reference Type’ 

alanları ile eşleşen kayıtlar çift referans olarak kabul edilmektedir. EndNote’un çift 

referans kayıtlarını belirlemek için kullandığı kriterleri kişiselleştirmek için bu paneli 

kullanabilirsiniz. 

 

8.5 Find Full Text 

’Find Full Text’ tercihler paneli, EndNote’un bir referans için tam metni bulmaya 

çalışırken, hangi sitelerin, servislerin ve teknolojinin kullanılacağını kontrol etmenizi 

sağlar. ’Find Full Text’ işlemini hızlandırmak için seçenekleri sınırlayabilirsiniz. Onay 

kutuları, EndNote referanslarınızdan hangi bilgi parçalarının kullanılacağını 
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belirlemektedir. Bunlar, tam referans eşleşmelerini sağlamak için benzersiz 

tanımlayıcıları temsil etmektedir. 

Kurumunuz / Üniversiteniz, bir OpenURL sunucusuna erişim izni veriyorsa, bu paneli, 

EndNote'un site erişimine izin verecek şekilde yapılandırabilirsiniz. OpenURL onay 

kutusunu seçin ve online siteye yönlendirmek için OpenURL yolunu girin. Site erişim 

izni için kimlik doğrulaması gerekiyorsa, bir ‘Authentication URL’’ girebilirsiniz. 

‘Authentication URL’, sadece sitenin giriş sayfasına yönlendirmektedir. ‘Find Full Text’ 

komutunu çalıştırdığınızda, doğrulama bilgilerini (genellikle bir kullanıcı kimliği ve şifre) 

girmek için o sayfaya yönlendirileceksiniz. ‘Find Full Text’ işemi için, Bkz. 5.6.2 Find 

Full Text 

 

8.6 Folder Locations (Dosya Yerleri) 

‘Folder Locations’ tercihler panelinde, yeni veya değiştirilmiş ‘Styles, Import Filters ve 

Connection Files’ kişisel klasör yer ayarlarını gerçekleştirebilirsiniz. 

EndNote kurulumu ile default olarak; stiller, filtreler ve bağlantı dosyaları EndNote 

program klasöründe tutulmaktadır:  

C:\Program Files\EndNote X9 (32 bit) 

C:\Program Files(x86)\EndNote X9 (64 bit) 

Seçilen klasörlere kaydedilen tüm stil, filtre ya da bağlantı dosyaları ‘Style’,’ Filter’ ve 

‘Connection Managers’ yönetim ekranlarında görüntülenir. Bu yönetim ekranları, 

EndNote’la sık kullandığınız kişisel dosyaları seçmenize izin verir. 

 

8.7 Formatting (Biçimlendirme) 

‘Formatting’ tercih paneli, bir kelime işlemcideki bibliyografya girişlerinin 



ResearchSoftware.com 145 

EndNote X9 

biçimlendirmesini kontrol etmenize ve EndNote'un bibliyografyadaki çift referansları 

otomatik olarak dahil edip etmeyeceğini kontrol etmenizi sağlar. Bu ayarlar için 

‘Edit/Preferences’ı seçin ve listeden ‘Formatting’i tıklayın. 

‘Formatting’ tercih paneli aşağıdaki seçenekleri içermektedir: 

 Doküman tipi destekleniyorsa, EndNote’un Cite While You Write eklentisi ile 

biçimlendirme önermesi 

 Geçici atıfdan kaldırıldıysa, biçimlendirilmiş atıfta da yazar ve/veya yıl bilgisini 

kaldırma 

 Bibliyografyada çift kayıtların birleştirilmesi 

 

 Not 

 ‘Merge Duplicates in Bibliography’i seçtiğinizde, EndNote otomatik olarak 

kaynakçadaki referansları kontrol edecektir. Bir makalede, birden fazla EndNote 

kütüphanesinden atıf işlemi gerçekleştiriyorsanız, bu seçeneği kullanmanız 

önerilmektedir. Bu durumda, referans kaydı iki ayrı kütüphanede ve iki farklı kayıt 

numarasına sahip olacaktır. Bu özellik seçili değil ise, EndNote kayıtları kopya 

olarak tanımlayamayacaktır. 

8.8 Libraries (Kütüphaneler) 

EndNote başlatıldığında, default olarak hangi kütüphanelerin açılacağını ‘Libraries’ 

tercihler bölümünü kullanarak belirleyebilirsiniz. Aşağıdaki alternatifler için açılır listeyi 

kullanabilirsiniz: 

 Open the most recently used library 

 Open the specified libraries 

 Prompt to select a library 

 Do nothing 
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8.9 PDF Handling 

‘PDF Handling’ tercihler panelinde, mevcut PDF’leriniz ve yeni PDF’leriniz için 

oluşturacağınız bir dosya ile otomatik olarak PDF dosyalarınızı import edebilir ve 

yeniden adlandırabilirsiniz. Bu ayarlar, yalnızca göreceli ek bağlantıları olan PDF 

belgelerinin yeniden adlandırılması için geçerlidir. 

 

8.10 Okundu/Okunmadı (Read/Unread) 

Çalışmanızı takip etmek, okundu ya da okunmadı durum etiketini uygulamak için bu 

ayarları kullanabilirsiniz. Bu ayarlar için, ‘Edit’ menüsüne gidin, ‘Preferences’ı seçin ve 

listeden ‘Read/Unread’i tıklayın. 

‘Read/Unread’ tercih paneli aşağıdaki seçenekleri içermektedir: 

Referans kaydının okundu durumu seçenekleri; 

 Bağımsız referans penceresinde görüntüleme 

 Kütüphane penceresinde, ‘Referans, PDF ya da önizleme’ panelinde görüntüleme 

 ‘Rating’ değiştiğinde 

Kütüphane Penceresi; 

 Okunmamış referansları koyu metin olarak göster 

 

8.11 Reference Types (Referans Tipleri) 

‘Reference Types’ tercih panelini, EndNote’un kullandığı alanlar (örneğin, Author, Year 

ve Title) ve referans tipleri (örneğin, Journal Article ya da Book) ayarlarını 
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kişiselleştirmek için kullanabilirsiniz. Bu panelde yapılan değişiklikler, değişikliğin 

yapıldığı bilgisayardaki tüm kütüphanelere uygulanmaktadır. 

 Default Referans Type: EndNote kütüphanenizde, yeni bir referans oluştururken 

default olarak ‘Journal Article’ seçilidir. Eğer, yeni referansınızda otomatik olarak 

kitap, rapor ya da başka bir referans tipinin görüntülenmesini tercih ediyorsanız 

‘Default Reference Type’ ayarlarını değiştirmeniz gerekmektedir. 

 Modify Reference Types...: Herhangi bir EndNote alanını ya da referans tipini 

değiştirmeniz gerekiyorsa ‘Modify Reference Types’ butonuna basın. Açılan 

ekranda, EndNote referans tiplerini ve alanlarını, ekleyebilir, silebilir ve yeniden 

adlandırabilirsiniz. Referans tiplerini özelleştirmek hakkında bilgi için Bkz. 7 

Referans Tiplerinin Düzenlenmesi (Customizing Reference Types). 

 Reference Type Table: Geçerli referans tipleri tablosu, geçerli kullanıcı hesabı 

altında açılmış tüm kütüphanelerde uygulanır. Değişiklikler, ‘RefTypeTable.xml’ 

dosyasında tutulur. Eğer, dosyanızı paylaşmak isterseniz, ekrandaki ‘Export’ ve 

‘Import’ butonlarını kullanabilirsiniz. 

 

8.12 Sorting (Sıralama) 

EndNote ‘author names ve titles’ı sıralarken, kelimeleri ya da isimleri sıralama amacına 

göre yoksayabilirsiniz.  

 Author Field: ‘Author Fields’ listesi düzenlenirken, sıralama amacına göre yazar 

isim bölümleri ihmal edilebilir, bu yüzden yazar ismini parça parça girebilirsiniz. 

Örneğin; isimlerdeki edatlar mesela ‘von, van ve de’ soyadının bir parçası olabilir, 

fakat sıralama amacına göre ismin parçası dikkate alınmaz. ‘Author Field’ listesi 

büyük küçük harfe duyarlıdır. Eğer ‘von’ olarak giriş yaparsanız ‘von’ olarak 

uygulanır ‘Von’ olarak uygulanmaz. 

 Title Field: Terimler ‘Title Fields’ listesine eklendiğinde, sıralama yordamı bu 

terimleri başlığın başında gördüğünde yok saymaktadır. Bu kelimeler için 

büyük/küçük harf olması önemli değildir. Yani kelime ‘the’ girilebilir (küçük harf) ve 

‘The’ için de uygulanır. 

Kısaltmalar için kesme işareti kullanılmaz. Bu yüzden, ‘l'avenir’ terimini ‘avenir’ olarak 

sıralamak için listeye kesme işareti olmadan ‘L’ girilir. 
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8.13 Spell Check (Yazım Denetimi) 

‘Spell Check’ tercihler panelinde, ‘Options’la genel yazım denetimini ve ‘Dictionaries’le 

sözlük seçimini yapabilir veya düzenleyebilirsiniz. 

 

8.14 Sync 

‘Sync’ tercih paneli, EndNote kütüphanenizi, EndNote Online kütüphaneniz ile otomatik 

olarak senkronize etmek için gerekli kayıt bilgilerini ve senkronizasyon ayarlarını 

bulundurmaktadır. 

‘Sync’ tercih panelinde; 

 Email adresiniz ve parolanızı yalnızca bir kez girmeniz yeterlidir. EndNote desktop 

ve EndNote Online arasında referanslarınızı, manuel olarak her senkronize 

ettiğinizde giriş işlemi gerçekleştirmeniz gerekmez. 

 EndNote'un ‘Sync Automatically’ onay kutusunu işaretleyerek, her 15 dakikada bir 

(arka planda işlenen) otomatik olarak senkronizasyon işlemine başlamasını 

sağlayabilirsiniz. 

Senkronizasyon işlemini başlatmak için, aktif bir EndNote online hesabına sahip 

olmanız ve kayıt işlemini tamamlamanız gerekmektedir. Henüz EndNote Online 

kaydınızı oluşturmadıysanız, ‘Enable Sync/Sign up’ butonunu kullanın ve kaydınızı 

oluşturun. Kayıt işlemi hızlı ve kolaydır. Kayıt işlemini tamamladığınızda iki yıllık 

EndNote online hesabınız etkin hale gelecektir. EndNote, otomatik olarak 

senkronizasyon işlemine başlayacak ve yeni EndNote online kütüphaneniz, EndNote 

kütüphanenizdeki gruplarla eşleşecek şekilde güncellenecektir. 
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8.15 Temporary Citations (Geçici/Biçimlendirilmemiş 

Atıflar) 

Geçici atıf, anında biçimlendirme özelliğinin kapalı olduğu (Word> EndNote> 

Bibliography> Instant Formatting is Off) durumdaki biçimlendirilmemiş atıftır. Word 

EndNote tabında, ‘Citations’ grubunda ‘Insert Citation(s)’, ‘Insert Selected Citation(s)’ 

komutlarını kullandığınızda, doğrudan bir atıfı sürükle-bırak ya da kopyala-yapıştır 

yaptığınızda, EndNote bu atıfları kelime işlemci dokümanınıza geçici atıf (ya da 

biçimlendirilmemiş atıf) olarak ekleyecektir. Hatta, geçici atıfları dokümanınıza manuel 

olarak da girebilirsiniz. Geçici atıf, EndNote’un daha sonra biçimlendirilmiş atıfa 

çevirebileceği bir bilgi alanıdır (örneğin; ‘Smith et al., 2007’). 

Default olarak geçici atıf, ilk yazarın soyadı, yıl ve EndNote kayıt numarasını içermekte, 

kıvırcık parantezle de kapatılmaktadır: 

{Smith, 2007 #70} 

Eğer gerekli ise geçici atıfın ayraçlarını bu panel ayarlarını kullanarak değiştirebilirsiniz. 

 

8.16 Term Lists (Terim Listeleri) 

Default olarak her yeni EndNote kütüphanesi üç terimle ilişkilendirilmiştir : ‘Authors’, 

‘Journals’ ve ‘Keywords’. Kütüphanenize referansları girdikçe, terim listeleri otomatik 

olarak güncellenmektedir. Bu listedeki terimler, ‘Suggest Terms as You Type’ özelliği 

kullanılarak veri girişini kolaylaştırmak için de kullanılmaktadır. Bu özellik, terim 

listeleri ile ilişkili alanları doldururken terim önerilerinde bulunmaktadır. Terim 

listesinde olmayan yeni bir terim girdiğinizde, o terimin yeni olduğunu belirtmek için 

girilen metin kırmızı renkte görüntülenir. Bu sayede, kütüphanenizde sık kullandığınız 
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bir isim veya terim girmeye çalıştığınızda, yazım hatalarını ya da yanlış bir anahtar 

kelime kullanıldığını görebilirsiniz. 

 

8.17 URLs & Links (URLs & Bağlantılar) 

URLS & Links referans panelinde : ‘OpenURL’ ayarları ve ‘PDF’ dosyalarının eklenmesi 

için default ayarlar bulunmaktadır. Bu ayarları için ‘Edit/Preferences’e girin ve 

‘Preferences’ ekranında ‘URLs & Links’i seçin. 

Connection Log File (Bağlantı Log Dosyası) 

Online veri tabanına bağlanmak için ‘Online Search’ komutu kullanıldığında, EndNote 

alınan tüm referansların kopyasını aynı veri tabanında başka bir arama ya da EndNote 

kapatılana kadar ‘Connect.log’ dosyasında tutmaktadır. Bu özelliği, ‘Use Log File’ onay 

kutusundaki işareti kaldırarak kapatabilirsiniz. Erişilen referanslara tekrar ulaşmak 

istediğinizde, yeni bir arama veya download işlemi yapmadan, ‘Connect.log’ dosyasını 

kaydederek import etmeniz yeterli olacaktır. 

‘Connect.log’ dosyası default olarak: 

‘C:\Users\[UserName]\App Data\Roaming\EndNote’ 

ISI Base URL 

Referansları ‘Web of Science Core Collection’dan EndNote’a export ederken, EndNote 

her referansın ‘URL’ alanı için bir ‘Go to ISI’ bağlantısı oluşturmaktadır. Bu bağlantılar 

sizi, ilgili referansların times cited (verilen atıf) sayısının ve diğer bilgilerin bulunduğu 

kaynak kayıtlarına yönlendirir. Eğer, EndNote’u önceki versiyonlardan güncellediyseniz, 

‘ISI Base URL’ son güncel ayarları için ‘EndNote Defaults’ butonuna basmanız 

gerekmektedir. Kurumunuz ‘Web of Science Core Collection’un yerel olarak tutulan bir 

versiyonunu kullanıyorsa, bu sunucunun URL'si EndNote’un ‘ISI Base URL’ alanına 

girilmelidir. Aksi takdirde, ‘Web of Science Core Collection'dan indirilen referanslardaki 

bağlantılar, sizi erişemeyeceğiniz Web of Science ana sunucusuna yönlendirecektir. 

OpenURL Link Argument 

‘References’ menüsündeki ‘URL>OpenURL Link’ komutu default web tarayıcınızı 

başlatır, tam metin makaleyi (varsa) ve benzer makale linklerinin listesini görüntüler. 

Bu komut ile ‘OpenURL’ standart sunucusuna bağlanılır ve ‘OpenURL’ tecihlerini ilişkili 

online referansları bulmak için, EndNote kaydınızdaki veriler ile birlikte kullanır. 

Bu komut ile, ‘OpenURL’ standart sunucusuna bağlanılır ve ‘OpenURL’ tecihleri, 

EndNote kaydınızdaki veriler ile birlikte ilgili online referansları bulmak için kullanılır. 
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Attached Files 

Dosyanıza link eklemek için, ‘References’ menüsünden ‘File Attachments>Attach File’ı 

seçtiğinizde sizin için uygun iki seçenek bulunmaktadır:  

 Dosyayı göreceli link (relative link) olarak eklemek 

Bu durumda EndNote, orjinal PDF dosyasının kopyasını oluşturur ve bu kopya 

EndNote veri tabanınızın bir parçası olan DATA/ PDF klasöründe tutulur. EndNote, 

veri tabanınızı meslektaşınızla paylaştığınızda bile bu dosyaya her zaman 

erişebilecektir. Ancak, bilgisayarınızdaki orjinal dosyayı düzenlerseniz, bu 

değişiklikler EndNote’a yansıtılmayacaktır. Bu durumda, EndNote kütüphanenizdeki 

referans kaydınızdan PDF dosyasını silip yeniden eklemeniz gerekecektir. 

 Dosyayı salt (absolute path) olarak eklemek 

Bu durumda EndNote, eklenen dosya için daima orjinal klasöre gidecektir. Orjinal 

PDF dosyasını düzenlemeyi planladığınızda ve tüm değişikliklerin EndNote’a 

yansıtılmasını istediğinizde, bu alternatif size yardımcı olacaktır. Bununla birlikte, 

dosyanın ya da orjinal klasörün yerini değiştirirseniz, EndNote referansınızdan PDF 

dosyasını silip yeniden eklemedikçe, EndNote dosyaya erişemeyecektir. Veri 

tabanınızı meslektaşınıza gönderdiğinizde PDF dosyası kullanılamayacaktır. 

Default olarak, ‘Copy new file attachment to the default file attachment folder and 

create a relative link’ onay kutusu seçilidir, bu yüzden EndNote, ilişkili PDF dosyasını 

DATA/ PDF klasörüne kopyalayacaktır. Dosyayı salt olarak kaydetmek için, bu kutudaki 

onayı kaldırabilirsiniz. Bu default ayarları, dosyayı eklerken de geçersiz kılabilirsiniz. 
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9 Output Styles (Çıktı Stilleri) 

Output Style (ya da sadece ‘style’) terimi, çalışmanızı biçimlendirmenin özel 

yöntemini belirlemek için kullanılır. Her bir stil, metin içi atıflarınızı (in-text citations), 

dipnot atıflarınızı (footnote citations) ve bibliyografyalarınızı (bibliographies) 

biçimlendirmek ve sıralamak için eksiksiz bir çözüm olarak tasarlanmıştır. 

EndNote, 7.000’den fazla bibliyografik stil içermektedir. Bu stillerin her biri, EndNote 

klasörünüzde ‘Styles’ klasörü içinde saklanmaktadır. Stilin adı, bibliyografik formatı 

tanımlayan dergi ya da yayımcı adını belirtir. Örneğin; ‘Nature’ stili, ‘Nature’ dergisi 

tarafından gerekli olan biçimlendirmeye dayanmaktadır ve ‘Chicago’ stili ‘Chicago 

Manual of Style’dan sonra adlandırılmıştır. 

‘EndNote Style Manager’ ile stiller düzenlenebilir ve yeni stiller oluşturulabilir. 

Default olarak, ‘Output Styles’ menünüzde EndNote’un dört standart bibliyografik stili 

bulunmaktadır. 

 Annotated: Özet ile, ‘Author-Date’ stil bibliyografyasını oluşturmaktadır. 

 Author-Date: Yazar adına göre alfabetik bibliyografya ve yazar - yıl bilgisiyle metin 

içi atıflar düzenlemektedir. 

 Numbered: Numaralandırılmış metin içi atıflarıyla uyan, numaralandırılmış 

bibliyografya oluşturmaktadır. 

 Show All: Tüm alanları ve alanların isimlerini içeren referans listesini 

oluşturmaktadır. 

Örneğin; ‘Harvard’ ya da ‘Nature’ stili ile biçimlendirilmiş bir referans aşağıdaki gibi 

görünecektir: 

Harvard 

 

Nature 

 

 Not 

 Export sınıfındaki stiller (örneğin ‘RIS’), bibliyografik stil değildir, EndNote verisinin 

başka veri tabanlarına transferi sırasında yardımcı olmak için tasarlanmıştır. 

 ‘Edit’ menüsünün altındaki ‘Output Styles’ listesinden (ya da araç çubuğu stil 

listesinden) seçilen stil, ‘Format Bibliography, Format, Print, Export, ve Copy 

Formatted’ komutları kullanımının yanısıra, seçilen referans kayıtlarının kütüphane 

penceresindeki ‘Preview’ (Önizleme) tabında nasıl biçimlendirileceğinin 

görüntülenmesini de sağlamaktadır. 

 EndNote’un eski bir sürümünde hazırlanan stiller, EndNote’un güncel versiyonunda 

düzenlenebilir ve kullanılabilir. 

9.1 Output Style’ları Açma 

Stilin nasıl çalıştığını anlamanın en iyi yolu bir tanesini açıp incelemektir. 

1. ‘Edit/Output Styles/Open Style Manager’ı seçin. 

‘EndNote Styles’ penceresi görüntülenecektir. 
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2. Bir stil seçin.       

3. ‘Edit’ butonuna basın.        

‘Edit Style’ penceresi görüntülenecektir. 

Stili düzenlek için, bütün seçenekler stil penceresinin sol tarafında listelenecektedir: 

 İlk altı öğe (About this Style, Puntuation, Anonymous Works, Page Numbers, 

Journal Names ve Sections) genel seçeneklerdir. Atıflar, bibliyografyalar ve dipnot 

atıflarına uygulanır. 

 Stil penceresindeki diğer seçenekler, dört başlık altında gruplandırılır: Citations, 

Bibliography, Footnotes ve Figures & Tables.  

9.1.1 General Options (Genel Seçenekler) 

İlk altı öğe Citations, Bibliographies ve Footnote Citations alanlarına uygulanmaktadır: 

 About this Style: Bir stili tanımlarken kategorilere ayırabilirsiniz. Mevcut EndNote 

kategorileri kullanabilir ya da yeni bir tane oluşturulabilir. 

 

 Punctuation: Kullanılan dile bağlı olarak, çok parçalı noktalama işaretlerinden 

önceki boşluklarla ilgili bilginin yer aldığı paneldir. 

Find by butonu ile 

kategorinizi seçin 

 ‘Style Info’ ve ‘Style Preview’ 

arasında seçim yapın 

‘Less Info’ ve  ‘More info’ yu kullanarak 

seçilen stille ilgili ek bilgiyi görüntüleyebilir 

ya da gizleyebilirsiniz 

Sık kullanılanlar listenizi 

oluşturun 
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 Anonymous Works (Anonim Eserler): ‘Author’ alanının boş olduğu referanslar, 

EndNote tarafından ‘Anonymous Works’ olarak tanımlanmaktadır. ‘Anonymous 

Works’ panelindeki ayarlar stilin bütün bölümlerinde uygulanır (Citations, 

Bibliography ve Footnotes). 

 

 Page Numbers: Bu pencerede, referans sayfa numaralarının nasıl 

biçimlendirileceğini belirleyebilirsiniz.  

 

 Journal Names: Bu pencerede, dergi isimlerinin nasıl biçimlendirileceğini 

belirleyebilirsiniz. Dergiler terim listesine veri girilmemişse veya özel bir dergiler 

terim listesi yoksa, ‘Journal Names’ seçeneği, her zaman varsayılan ‘Don’t Replace’  

olarak belirlenir ve EndNote, dergi adını tam olarak orijinal referansta göründüğü 

gibi kullanır.  
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 Sections: Bu özel seçenekler, yalnızca Microsoft Word’de çalışıyorsanız 

uygulanabilir. Dokümanda oluşturulacak bibliyografyanın, bölümün, dokümanın ya 

da her ikisinin sonunda oluşturulması ayarlarını belirleyebilirsiniz. 

 

9.1.2 Citations (Atıflar) 

Atıf ya da metin içi atıf, metin yapınızda, bibliyografyadaki tam referansa karşılık gelen 

kısa bibliyografik bilgidir. En sık kullanılan biçimleri: (Author, Year), [Numbered] ve 

Author (Year). 

9.1.2.1 Templates (Şablonlar) 

Şablonlar, makalenizdeki metin atıflarını EndNote’un nasıl biçimlendireceğini belirtir. 

Örneğin; ‘Numbered’ stili metin içi atıflarda bibliyografya numaralarında parantez 

kullanılmaktadır. Atıf şablonunda ‘yazar-yıl’ stil tipinde muhtemel görünüm (Author, 

Year) olacaktır. 

Şablonda, bir metni, istenmeyen alan adlarını ve noktalama işaretlerini silebilir ya da 

istediğiniz noktalama işaretlerini yazabilir, ‘Insert Field’ butonunu kullanarak yeni 

alanlar ekleyebilirsiniz. 
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9.1.2.2 Ambiguous Citations (Belirsiz Atıflar) 

Referanslar, aynı yazar tarafından yazılmışsa ya da yazarlar aynı soyadına sahipse, 

kayıtlar benzer metin içi atıflara sahip olabilir. Bu atıflarda, belirsizliğe neden olmakta 

ve makalenizde okuyucu tarafından hangi referansdan bahsedildiğini anlamasını 

zorlaştırmaktadır. EndNote, atıflarınızda bu belirsizliği önlemek için çeşitli yollar 

sunmaktadır. Bu ayarlarda yazarın, metin içi atıflarda kullanıldığının varsayıldığını 

unutmayın. Metin içi atıflarda bibliyografya numaraları kullanılan stillerde, atıflar eşşiz 

olarak numaralandırıldığından belirsiz atıflar yapılması mümkün değildir. 

  

9.1.2.3 Author Lists (Yazar Listeleri) 

‘Author Lists’ paneli, yazarların biçimlendirilmiş metin içi atıflarda nasıl 

görüntüleneceklerini tam olarak belirtmenizi sağlar. Atıflarınız numaralı ise bu tercih 

panelini kullanmanız gerekmemektedir. 
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9.1.2.4 Author Name (Yazar Adı) 

İsim biçimlendirme bölümü, yazar adlarının nasıl görünmesi gerektiğini, adın mı yoksa 

soyadın mı önce kullanılacağı ve soyadından sonra virgül olup olmayacağını 

belirlemenize olanak sağlar. 

  

9.1.2.5 Numbering (Numaralama) 

Atıflar için ‘Numbering’ panel ayarları, sadece ‘Citation Template’ panelinde 

‘Bibliography Number’ kullanıldığında uygulanmaktadır. Bu ayarlar, makale metninde 

eşşiz numaralandırılmış atıflar oluşturulmasını sağlar ve numaralar, bibliyografya 

girdileri ile uyumludur. 

  

9.1.2.6 Sort Order (Sıralama Düzeni) 

‘Citations’ başlığının altındaki ‘Sort Order’ paneli, birden fazla metin içi atıf 

yapıldığında, stilin kullanacağı sıralama düzen ayarının yapılmasına olanak sağlar. 
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9.1.3 Bibliography (Bibliyografya) 

‘Bibliography’ başlığı altında listelenen öğeler, bir makaleyi biçimlendirirken EndNote’un 

oluşturacağı referans listesine uygulanır. Bu ayarlar ayrıca, Export, Print, Copy 

Formatted ve Preview seçenekleriyle de kullanılır. 

9.1.3.1 Templates (Şablonlar) 

‘Generic’ şablona ve diğer referans tipleri için spesifik şablonlara sahip, bibliyografya 

şablonları, bibliyografyada birçok referans tipini biçimlendirmede kullanılmaktadır. 

‘Generic’ şablonu, ‘Generic’ referans tipini kullanan ya da stilde kendi referans tipine ait 

şablonu olmayan referansları biçimlendirmek için kullanılmaktadır. Stildeki şablonların 

geri kalanı, EndNote’a, belirli referans tiplerinin (dergiler, kitaplar ve kitap bölümleri 

gibi) nasıl biçimlendirileceğini göstermektedir. 

 

9.1.3.2 Field Substitutions (Alan Değişiklikleri) 

‘Bibliography’ başlığı altındaki ‘Field Substitutions’ paneli, bibliyografyada referansın 

boş olan ya da düzenlenmesi gereken alanların (DOI, PMCID, Volume and Pages ve 

editor and translator are the same individual) yerine, uygun alanların kullanılmasına 

olanak sağlar.  

   

9.1.3.3 Layout (Düzen) 

‘Bibliography’ başlığının altındaki ‘Layout’ panelinde, bibliyografyada her referanstan 

önce ya da sonra metin girilmesini, bununla birlikte satırbaşı boşluğu bırakılmasını 

sağlayan seçenekler bulunmaktadır. 
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9.1.3.4 Sort Order (Sıralama Düzeni) 

‘Bibliography’ başlığının altındaki ‘Sort Order’ paneli, bibliyografyada stilin kullanacağı, 

referans sıralama düzen ayarının yapılmasına olanak sağlar. 

 

9.1.3.5 Categories 

‘Categories’ paneli, Microsoft Word dokümanlarınıza belirli referans tipleriyle ilişkili 

konu kategorileri eklemenize olanak sağlar. EndNote ile bibliyografya 

oluşturduğunuzda, atıflarınız kategori ve ilgili referans tipine göre düzenlenecektir. 

  

9.1.3.6 Author Lists (Yazar Listeleri) 

‘Author Lists’ paneli, yazarların biçimlendirilmiş bibliyografyada nasıl 

görüntüleneceklerini tam olarak belirtmenizi sağlar. 
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9.1.3.7 Author Name (Yazar Adı) 

İsim biçimlendirme bölümü, yazar adlarının nasıl görünmesi gerektiğini, adın mı yoksa 

soyadın mı önce kullanılacağı ve soyadından sonra virgül olup olmayacağını 

belirlemenize olanak sağlar. 

   

9.1.3.8 Editor Lists (Editör Listeleri) 

‘Editor Lists’ paneli, editörlerin biçimlendirilmiş bibliyografyada nasıl 

görüntüleneceklerini tam olarak belirtmenizi sağlar. 

   

9.1.3.9 Editor Name (Editör Adı) 

‘Editor Name’ paneli, editör adlarının nasıl görünmesi gerektiğini, adın mı yoksa 

soyadın mı önce kullanılacağı ve soyadından sonra virgül olup olmayacağını 

belirlemenize olanak sağlar. 
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9.1.3.10 Title Capitalization (Başlığı Büyük Harfle Yazma) 

‘Title Capitalization’ paneli, bibliyografyada referanslarınızın başlık yazımlarının 

biçimlendirmesine olanak sağlar. 

    

9.1.4 Footnotes (Dipnotlar) 

‘Footnotes’ başlığı altında listelene öğeler, bir kelime işlemci belgesinde dipnotlara ya 

da son notlara eklenen atıflara uygulanmaktadır (Öncelikle, kelime işlemcinizde 

dipnotlar oluşturmalı ve sonra EndNote atıflarını eklemelisiniz). 

9.1.4.1 Templates (Şablonlar) 

Şablonlar, dipnotlardaki atıfların, seçilen stile ve referans tipine bağlı olarak nasıl 

görüntüleneceklerini belirlemektedir. Dipnot ‘Templates’ paneli, farklı biçimlendirme 

seçenekleri sunmaktadır: 

 Same as bibliography: Dipnot atıflarınızın, bibliyografyanızdaki referans kayıtlarınız 

gibi biçimlendirilmesini istiyorsanız, bu alternatifi seçin;  

 Same as citations: Dipnotlar için özel bir şablon olusturmadan, metin içi atıflarınız 

gibi biçimlendirilmesini istiyorsanız, bu alternatifi seçin;  

 Using footnote format: Kişisel şablonunuzu oluşturmak istiyorsanız, bu alternatifi 

seçin. 
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9.1.4.2 Field Substitutions (Alan Değişiklikleri) 

‘Footnote’ başlığı altındaki ‘Field Substitutions’ paneli, dipnot veya bibliyografyada 

referansın boş olan ya da düzenlenmesi gereken alanların (DOI, PMCID, Volume and 

Pages ve editor and translator are the same individual) yerine, uygun alanların 

kullanılmasına olanak sağlar. 

   

9.1.4.3 Repeated Citations (Tekrarlanan Atıflar) 

Dipnotlardaki, birçok kompleks biçimlendirme yalnızca beşeri bilimlerdeki stiller ile 

ilgilidir. Bir makalenin dipnotlarında alıntı yapılan referanslar için, çeşitli 

biçimlendirmeler bulunmaktadır. Bu seçenekler, ‘Footnote’ başlığı altındaki ‘Repeated 

Citations’ panelinde sunulmaktadır. 

   

9.1.4.4 Author Lists (Yazar Listeleri) 

‘Author Lists’ paneli, yazarların biçimlendirilmiş dipnot atıflarda nasıl 

görüntüleneceklerini tam olarak belirtmenizi sağlar. 
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9.1.4.5 Author Name (Yazar Adı) 

İsim biçimlendirme bölümü, yazar adlarının nasıl görünmesi gerektiğini, adın mı yoksa 

soyadın mı önce kullanılacağı ve soyadından sonra virgül olup olmayacağını 

belirlemenize olanak sağlar. 

   

9.1.4.6 Editor Lists (Editör Listeleri) 

‘Editor Lists’ paneli, editörlerin biçimlendirilmiş dipnotta nasıl görüntüleneceklerini tam 

olarak belirtmenizi sağlar. 

   

9.1.4.7 Editor Name (Editör Adı) 

‘Editor Name’ paneli, editör adlarının nasıl görünmesi gerektiğini, adın mı yoksa 

soyadın mı önce kullanılacağı ve soyadından sonra virgül olup olmayacağını 

belirlemenize olanak sağlar. 

   

9.1.4.8 Title Capitalization (Başlığı Büyük Harfle Yazma) 

‘Title Capitalization’ paneli, dipnotta referanslarınızın başlık yazımlarının 

biçimlendirmesine olanak sağlar. 
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9.1.5 Figures & Tables (Şekiller & Tablolar) 

‘Figures & Tables’ başlığının altında, çıktı stil editorünün sol kolonunda ‘Figures’ ya da 

‘Tables’ı seçin. ‘Figures & Tables’ ayarları, EndNote’tan bir Word dokümanına eklenecek 

imajlar için geçerlidir. Eklenecek imajlar, bir dokümanda atıfın yapıldığı yere ya da 

dokümanın sonuna eklenebilir. Ayrıca, etiket ve resim yazılarının biçimlendirilmesini ya 

da yerleşim yerini belirleyebilirsiniz. 

9.1.5.1 Figures (Şekiller) 

Şekiller, herhangi bir ya da ‘Figure’ referans tipine sahip EndNote kaydına ait ‘Figures’ 

alanından eklenen görüntülerdir. 

Placement (Yerleştirme): 

 Şekilleri metin içine eklerken şeklin referansa yakın olması (şekil yazılan satırın 

altına eklenir) 

 Şekillerin dokümanın sonuna liste olarak eklenmesi 

Captions (Şekil Yazısı): 

 Şekil yazısının şeklin üzerine yerleştirilmesi 

 Şekil yazısının şeklin altına yerleştirilmesi 

 Etiket ve şekil yazısının çizgilerle ayrılması 

   

9.1.5.2 Tables (Tablolar) 

Tablolar, ‘Chart or Table’ referans tipindeki ‘Figures’ alanından eklenen görüntülerdir. 

Placement (Yerleştirme): 

 Tabloları metin içine eklerken tablonun referansa yakın olması (tablo yazılan satırın 

altına eklenir) 

 Tabloların dokümanın sonuna liste olarak eklenmesi  

Captions (Şekil Yazısı): 

 Şekil yazısının tablonun üzerine yerleştirilmesi 

 Şekil yazısının tablonun altına yerleştirilmesi 

 Etiket ve şekil yazısının çizgilerle ayrılması 
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9.1.5.3 Separation & Punctuation (Ayraç & Noktalama İşareti) 

‘Separation & Punctuation’ panelindeki ‘Image Separation’ bölümünde, dokümanda 

metin içine eklenen ve dokümanın sonunda listelenen imajlar için separatör 

belirleyebilirsiniz. Bu paneldeki ayarlar, şekiller ve tabloların her ikisinde de uygulanır. 

   

9.2 Output Styles (Çıktı Stilleri) Oluşturma 

‘Output Style’ oluşturmanın iki farklı yolu bulunmaktadır: 

 Yeni bir ‘Output Style’ oluşturmak; 

 Varolan bir ‘Output Style’ı düzenlemek.  

İhtiyacınız olan bir ‘Output Style’ için, yeni bir stil oluşturmak yerine varolan bir 

bibliyografik stil üzerinde düzenleme yapmak çok daha kolay olacaktır. 

Bir bibliyografik stilin hazırlanmasında, metin içi atıfların ve bibliyografik referansların 

makalenizde istediğiniz gibi görüntülenmesini sağlamak için, referans tipi şablonları 

oluşturulmalıdır. Yazarlar, başlıklar, sayfalar ve diğer alanlara ait çeşitli düzenlemeleri 

gereksinimlerinize göre ayarlamanız gerekmektedir. 

9.2.1 Stil Şablonlarıyla Çalışma Kuralları 

Bir stil şablonu oluşturulurken, alan adlarının, metinlerin ve boşlukların birbirleriyle 

nasıl ilişkilendirileceği dört temel kurala dayanmaktadır: 

 Kural 1: Temel Bağımlılık 

Alan isminden boşlukla ayrılmayan herhangi bir metin ya da noktalama işareti 

bitişik alana bağımlıdır. Bu bağlamda, ‘bağımlı’ anlamı, eğer bitişik alan veri 

içeriyorsa, metin ya da noktalama işareti bir alana bitişikse bibliyografyanızda 

görüntülenecektir. Örneğin: 

Volume (Issue) (Cilt (Basım)) 

Eğer, referans için basım numarası varsa, ‘Basım’ etrafındaki parantezler sadece 

biçimlendirilmiş referansda gözükecektir. 



ResearchSoftware.com 166 

EndNote X9 

 Kural 2: Önde olan alanın takip eden alandan önce gelmesi 

Boşluklar olmadan iki alan arasında noktalama işareti varsa, bu önceki alanla 

bağımlılığı gösterir. 

Bu örnekte; 

Volume:Issue (Cilt (Basım)) 

İki nokta üst üste cilt alanına bağımlıdır. Bunun anlamı, eğer referansta cilt yoksa 

iki nokta üst üste gözükmeyecektir. Eğer cilt varsa iki nokta üst üste gözükecektir. 

 Kural 3: Alandan sonra gelen ilk boşluk bu alana bağımlıdır. İlave 

boşluklar bağımsızdır. 

Alanı takip eden ilk boşluk daima bu alanla bağımlıdır. Sonraki ardışık boşluklar 

bağımsızdır ve biçimlendirilmiş referanslarda görüntülenecektir. 

Örneğin; eğer EndNote bir şablon kullanarak anonim bir kitabı biçimlendiriyorsa 

yazar alanını takip eden bir boşluk ve başlık alanı: 

Author._Title (Yazar._Başlık) 

Son biçimlendirilmiş referansta başlık boşluktan önce gelmeyecektir, çünkü boşluk 

nokta gibi yazar alanına bağımlıdır. Bununla birlikte, yazar ve başlık arasında iki 

boşluk varsa: 

Author. _ _Title (Yazar._Başlık) 

Bütün anonim referanslar için başlıktan önce bir boşluk gelecektir. İlk boşluk yazar 

alanına bağımlıdır, yazar yoksa gözükmeyecektir. Ancak, ikinci boşluk herhangi bir 

alana bağımlı değildir, bundan dolayı biçimlendirilmiş referansta görüntülenecektir. 

 Kural 4: Bağımsız metin daima bibliyografyada görüntülenir 

Alan adıyla bağımlı olmayan herhangi bir metin ya da noktalama işareti daima 

biçimlendirilmiş referansta görüntülenecektir. Örneğin, 

Edition ed. (Yayın ed.) 

Stilde, bir kitap şablonuna ‘Edition’ alanından sonra boşluk kullanılarak ‘ed.’ metni 

girildiğinde, ‘Edition’ alanında veri olup olmadığına bakılmaksızın tüm kitap 

referansları için bibliyografyada ‘ed.’ metni görüntülenecektir. 

9.2.2 Special Formatting Characters (Özel Biçimlendirme Karakterleri) 

EndNote, stil şablonlarındaki noktalama işaretleri ve alanların gruplandırılmasına, 

esneklik ve doğruluk kazandıran özel biçimlendirme karakterlerine sahiptir. Özel 

biçimlendirme karakterlerini eklemek için ‘Insert Field’ butonunu kullanabilirsiniz. 

 Link Adjacent Text (Bitişik Metin Bağlama) (‘Ctrl+Alt+Space’ = bölünemez 

boşluk kullanarak). Bir alandaki veriye, herhangi bir noktalama işareti veya metin 

eklenerek, tek bir veri gibi davranması istenirse ‘Link Adjacent Text’ karakteri () 

kullanılır. Eğer alan veri içermiyorsa, bu eklenen noktalama işareti veya metin 

bibliyografik künyede yer almayacaktır.       

‘Templates’ panelinde, ‘Insert Field’ listesinden ‘Link Adjacent Text’i seçerek ya da 

‘Ctrl+Alt+Space’ tuşlarına basarak bölünemez boşluk girebilirsiniz. Ekranda küçük 

bir elmas şeklinde görüntülenecektir. 

Örnek: volVolume (vol=metin ve Volume=alan adı) 

 

 Forced Separation (Zorla Ayırma) (Dikey Çubuk Kullanımı). Bir noktalama 

işareti ya da metin, önceki ya da sonraki alana bağımlı olmaksızın, bibliyografik 

künyede görüntülenmek istenirse, ‘Forced Separation’ (|) karakteri kullanılılır. 

Bölünemez Boşluk 
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Örnek: (Year)|. (dikey çubuktan sonra gelen nokta işareti, ‘(Year)’ alanından 

bağımsızdır ve alanın veri içerip içermediğine bakılmaksızın her zaman 

görüntülenecektir). 

 

 Field Names in Bibliographies (Bibliyografya Alan Adları) (metinden önce ve 

sonra ‘accent grave’ (`) kullanımı). Bibiliyografik künye içerisinde, EndNote’da alan 

adı olarak kullanılan metni, alan adı kısaltmasını ya da herhangi bir metni, alanın 

içerdiği veri ile kullanmak gerektiğinde, ‘accent grave’ (`) karakteri kullanılır. Bu 

sayede, bibliyografik künyede alanın içerdiği veri ile alan adı metni birlikte 

görüntülenecektir. Alan adı ile alanın içerdiği veriyi birbirine bağlamak için ‘Link 

Adjacent Text’ karakteri () kullanılmalıdır. 

Örnek: `Version` Version (`Version`=text and Version=fieldname). 

 

 Singular/Plural (Tekil/Çoğul) (Düzeltme (Şapka) işareti (^) kullanımı). 

Bibliyografik künyedeki biçimlendirilmiş bir referansta, editörler ve sayfalara ait 

terimleri ayırmak için, düzeltme işareti kullanılarak, tekil ve çoğul etiket biçim 

metni belirlenebilir. Stil şablonunda, ‘Insert Field’ listesinden ‘Singular/Plural’ 

seçerek ya da ‘Shift+3+Space’ tuşlarına basarak düzeltme işareti girebilirsiniz. 

Düzeltme işaretinin öncesi, verinin tek olduğu durum için, sonrası ise çoğul olduğu 

durumlar için kullanılır. 

Örnek: editor.^(editors.) 

 

9.2.3 Output Style Düzenleme 

İhtiyacınız olan bir ‘Output Style’ için, yeni bir stil oluşturmak yerine varolan bir 

bibliyografik stil üzerinde düzenleme yapmak çok daha kolay olacaktır. 

Aşağıdaki örnekte, mevcut bir stildeki, metin içi atıf şablonu düzenlecek ve 

bibliyografyada ‘Newspaper Article’ referans tipi için yeni bir şablon oluşturacağız. 

Bunun için ‘Adv Agronomy’ stilini düzenleyeceğiz. 

Stil şablonunu oluşturmak için: 

1. ‘Edit/Output Styles/Open Style Manager’ı seçin. 

2. ‘EndNote Styles’ ekranında düzenlemek istediğiniz (Adv Agronomy) stili seçin. 

  

Accent grave 

Singular/Plural 

Forced separation 
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3. ‘Edit’ butonuna basın. 

4. Stil penceresinde ‘About this Style’ kategorisi görüntülenecektir. 

‘Based On’ alanına orjinal stil adını girin. 

‘Category’ alanına bir kategori girebilirsiniz. 

‘Comments and Limitations’ alanına yorum ve bilgi girebilirsiniz. 

5. Kişisel ‘Styles’ klasörünüze stili kopyalamak için File>Save as’i seçin. Dosya 

konumunu ‘Edit>Preferences>Folder Locations’ ekranında bulabilirsiniz. 

9.2.3.1 Citations (Atıflar) 

Atıf ya da metin içi atıf, metin yapınızda bibliyografyadaki tüm referansa karşılık gelen 

kısa bibliyografik bilgidir. En sık kullanılan biçimleri: (Author, Year), [Numbered] ve 

Author (Year). 

Metin içi atıf biçimlendirmesi için; 

1. ‘Citations’ başlığı altındaki ‘Templates’e tıklayın. 

2. ‘Year’ alanının sonuna virgül koyun ve bir boşluk bırakın. 

3. ‘Insert Field’ butonuna tıklayın ve ‘Cited Pages’ı seçin. 

4. Şablon aşağıdaki gibi görüntülenecektir. 

  

9.2.3.2 Bibliyography (Bibliyografya) 

‘Bibliography’ başlığı altında listelenen öğeler, bir makaleyi biçimlendirirken EndNote’un 

oluşturacağı referans listesine uygulanır. 

Adım 1 – Şablon oluşturma 

Stili tanımlamak için, ‘Insert Field’ butonunu, stili biçimlendirmek için ‘Format’ araç 

çubuğunu kullanın. Aşağıdaki örnekte, stile ‘Newspaper Article’ referans tipi için 

biçimlendirme yapılacaktır. 

1. ‘Bibliography’ başlığının altındaki ‘Templates’e tıklayın. ‘Reference Types’ butonuna 

basın ve ‘Newspaper Article’ı seçin. 
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2. ‘Insert Field’ butonuna basın. 

‘Reporter’ı seçin. 

Nokta koyun. 

Boşluk bırakın. 

Tırnak açın. 

3. ‘Insert Field’ butonuna basın. 

‘Title’ı seçin. 

Nokta koyun. 

Boşluk bırakın. 

Tırnağı kapatın. 

Boşluk bırakın. 

4. ‘Insert Field’ butonuna basın. 

‘Newspaper’ı seçin. 

Seçmek için ‘Newspaper’ alanına iki kez tıklayın. 

İtalik yapmak için ‘Italics’ butonuna basın. 

Alandan sonra italiği kapatın. 

5. ‘Insert Field butonuna basın. 

‘Forced Separation’ı seçin. 

Virgül koyun. 

6. ‘Insert Field’ butonuna basın. 

‘Link Adjacent Text’i seçin. 

7. ‘Insert Field’ butonuna basın. 

‘Issue Date’i seçin. 

8. ‘Insert Field’ butonuna basın.       

 ‘Forced Separation’ı seçin. 

9. ‘Insert Field’ butonuna basın. 

‘Link Adjacent Text’i seçin. 

10. Insert Field butonuna basın. 

‘Year’ ı seçin. 

11. ‘Insert Field’ butonuna basın. 

‘Forced Separation’ı seçin. 

Virgül koyun. 

12. ‘Insert Field’ butonuna basın. 

‘Link Adjacent Text’i seçin. 

13. ‘Insert Field’ butonuna basın. 

‘Pages’ı seçin. 

14. ‘Insert Field’ butonuna basın. 

‘Forced Separation’ı seçin. 

Nokta koyun. 

Sonuç 

 

Adım 2 – Alan tercihleri 

Bu adımda, yazar alanı verisinin büyük harfle yazılmasını ve isim baş harflerinin de 

önce gösterilmesi için işlemleri gerçekleştireceğiz. 

1. ‘Bibliography’ başlığının altındaki ‘Author Name’i seçin. 

2. ‘First author’ ve ‘Other authors’ açılır listelerinden yazar adı ve soyadı olacak 

şekilde seçimi gerçekleştirin. 

‘Capitalization’ açılır listesinden ‘All Uppercase’i seçin. 

Initials açılır listesinden ‘A.B.’ seçeneğini belirleyin. 

3. Ekran aşağıdaki gibi görüntülenecektir. 

Italic 

Forced Separation 
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4. Pencereyi kapatmak için ‘Close’ butonuna basın. 

5. Değişiklikleri kaydetmek için ‘Evet’ (Yes) butonuna basın, stilinizi isterseniz yeni bir 

isimle de kaydedebilirsiniz. 

 

9.2.4 Footnotes (Dipnotlar) İçin Stil Şablonunu Düzenleme 

Stillerde, dipnot atıfların nasıl biçimlendirileceğine dair çeşitli alternatifler 

bulunmaktadır. Bu alternatiflerle ilgili olarak ‘Dipnot’ (Footnote) bölümünün en üstünde 

yer alan ‘Templates’ paneli farklı seçenekler sunmaktadır. 

Bazı stillerde dipnot atıfları, metin içi (makalenin ana metni içinde yer alan) atıflar gibi 

biçimlendirilmektedir. Bu durumda, dipnotlar için özel şablonlar oluşturulması 

gerekmemektedir. Basitçe dipnot biçim seçeneklerinde ‘Same as citations’ı 

kullanabilirsiniz. 

Benzer şekilde, bazı makalelerde dipnot atıfları, referans listesinde görüntülendiği gibi 

tüm bibliyografik bilgileri içerecek şekilde biçimlendirilmektedir. Bu stiller için, dipnot 

biçim seçeneklerini ‘Same as bibliography’ olarak ayarlayabilirsiniz. 

Ancak, makalenizi göndereceğiniz dergi, kendi özel dipnot biçimini kullanmanızı isterse 

(beşeri bilimler için çoğu stil bunu gerektirmektedir), ‘Using footnote format’ 

seçeneğini kullanarak özel bir dipnot formatı oluşturabilirsiniz. Bu seçenekte, dipnottaki 

atıfların nasıl biçimlendirileceğini şablonlarla belirlemelisiniz. 

Takip eden örnekte ‘Vancouver’ stilini düzenleyeceğiz. 

1. ‘Edit/Output Styles/Open Style Manager’ı seçin. 

2. ‘EndNote Styles’ penceresi görüntülenecektir. 

‘Vancouver’ı seçin.  

‘Edit’ butonuna basın. 
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3. ‘File/Save as’i seçin.  

Stilinizi yeni bir isimle, ‘Styles’ klasörüne kaydetmek için ‘Save’ butonuna basın. 

 

4. ‘Footnotes’ başlığının altında yer alan ‘Templates’e tıklayın. 

‘Format citations in footnotes’ listesinden formatınızı seçin. 

Eğer metninizin sonunda bibliyografyada görünmesini istemiyorsanız, ‘Include 

citations in bibliography’ kutusunu boş bırakın. 

 

5. ‘Bibliography’ başlığının altından ‘Layout’u seçin. 

‘Bibliography Number’ı kaldırın. Sekme ( ) kalacaktır. 

 

6. ‘Styles’ penceresini kapatmak için ‘Close’ butonuna basın ve değişiklikleri kaydedin. 

7. ‘Style Manager’ penceresini kapatmak için ‘Close’ butonuna basın. 

 Not 

 ‘10.3.4 Dipnotlarda ya da Sonnotlarda Atıf Yapma’ bölümünde dipnotlara nasıl atıf 

yapılacağı gösterilmektedir.

‘Format citations in footnotes’ 

listesinden formatınızı seçin 

Tekstin sonunda bibliyografyanın 

görünmesini istemiyorsanız bu 

kutucuğu boş bırakın 

 ‘Bibliography Number’ı silin 
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10 Cite While You Write Özelliği 

‘Cite While You Write’ (CWYW) özelliği ile, Microsoft Word’te kolay, hızlı ve hatasız 

olarak, şekilerinizi-tablolarınızı da içeren, atıf ve bibliyografya işlemlerinizi otomatik 

olarak gerçekleştirebilirsiniz. ‘Cite While You Write’ biçimlendirme komutlarına ve 

EndNote referanslarına erişmek için Word’deki ‘EndNote X9’ tabını kullanabilirsiniz. 

EndNote’u yüklediğinizde bu eklenti otomatik olarak yüklenecektir. 

Atıf ya da metin içi atıf, metin yapınızda bibliyografyadaki tüm referansa karşılık gelen 

kısa bibliyografik bilgidir. Atıf, parantez içinde bibliyografya numarası ya da yazar adı 

ve yılı şeklinde bilgiler içermektedir. Atıflar bir dokümanda, biçimlendirilmiş ya da 

biçimlendirilmemiş olarak görüntülenebilir. EndNote’un ‘Cite While You Write’ özelliği, 

siz Word’de makalenizi yazarken, belirleyeceğiniz biçimlerde atıflar yapma ve referans 

listeleri oluşturma gibi birçok özellik içermektedir. Ayrıca, bütün bu EndNote 

özelliklerini Word’ün bir parçası gibi kullanmanıza olanak sağlamaktadır. 

‘Cite While You Write’ biçimlendirilmiş atıfları oluştururken Word alan kodlarını 

kullanmaktadır. Bu alan kodları, Word’de atıf ve referans listelerini EndNote ile 

biçimlendirme, biçimlendirmeyi kaldırma ya da yeniden biçimlendirmeyi sağlamaktadır. 

Bu alan kodları atıf yapılan referanslara ait bir ‘Traveling Library’ içermektedir. Bkz. 0 

 Not 

Word dokümanınızda ‘Cite While You Write’ geçici atıf özelliğini kullanırken, kayıt 

numarası yerine ‘Label’ alanını kullanabilirsiniz.  

1. EndNote menüden ‘Edit > Preferences’ı seçin. 

2. ‘Temporary citations’ı seçin. 

3. ‘Use field instead of record number’ onay kutusunu işaretleyin. 

 

 Ortak çalışmalar yürüttüğünüz bir grubunuz varsa bu ayarın ortak çalışma 

arkadaşlarınız tarafından da değiştirilmesi gerekmektedir. 

Traveling Library (Gezici Kütüphane) Özelliği. Referans verisi, notlar ve özet dışındaki 

tüm alanlarla birlikte veri tabanı ismi ve yer bilgisini saklamaktadır. Bu size, 

dokümanınıza ait veri tabanınızın herhangi bir kopyası bulunmayan bir bilgisayarda 

kullanmanıza olanak sağlar. Ayrıca, makalenizi aynı EndNote kütüphanesine sahip 

olmadan diğer yazarlar ile kullanarak, çalışmalar yürütebilirsiniz. 

mk:@MSITStore:C:/Program%20Files/EndNote%20X/EndNote.chm::/10Word/Basic_Instructions.htm
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10.1 Öncelikli Ayarlar 

10.1.1 EndNote Ayarları 

EndNote, uygulamayı açtığınızda otomatik olarak güncellemeleri kontrol eder. Ayrıca, 

program güncellemelerini manuel olarak da gerçekleştirebilirsiniz. Güncellemeler için 

EndNote’u açtıktan sonra menülerden ‘Help > Check for Updates’ komutunu 

kullanabilirsiniz. 

10.1.2 Microsoft Word Ayarları 

Büyük belgeler ile çalışırken Word’ün yanıt verme süresi uzarsa, gecikmeye neden olan 

ayarları kapatmanızı öneriyoruz.  

10.1.2.1 Dil Ayarları 

Aşağıdaki ayarları uygulamadan önce dokümanınızın bir yedeğini almanızı öneriyoruz. 

1. Tüm dokümanı seçmek için ‘Ctrl+A’ tuş kombinasyonunu kullanın. 

2. ‘Review’ tabını seçin.  

‘Proofing’ grubunda ‘Set Language’ butonuna tıklayın. 

3. Dili seçin. 

4. ‘Detect Language automatically’ onay işaretini kaldırın 

5. ‘OK’ye basın. 

10.1.2.2 Word Seçenekleri 

Aşağıdaki ayarlar büyük belgelerde Word performansını etkilediğinden kapatabilirsiniz: 

 Check spelling as you type 

‘File > Options > Proofing’i seçin. 

‘Check spelling as you type’ onay işaretini kaldırın. 

 Track changes 

‘Review > Track Changes’i seçin. 

(Eğer işlev aktif ise buton portakal renginde olacaktır, işlevi kapatmak için butona 

tıklayın). 

 Show picture place holders 

‘File > Options > Advanced’ 

‘Show document content’ kategorisinde ‘Picture place holders’ onay kutusunu 

işaretleyin. 

Sonuç olarak şekillerin yerine boş çerçeveler gösterilir. Bu işlem doküman 

içerisinde daha hızlı hareket etmenize imkan sağlar. 

Çalışma dokümanındaki okunabilirliği artırmak için aşağıdaki özelliklerin Word 

dokümanında uygulanması önerilir. 

 Field codes 

‘File > Options > Advanced > Document content’ 

‘Show Field Codes’ onay işaretini kaldırın. 

 Field Shading 

‘File > Options > Advanced > Document content’ 

‘Field Shading>When selected’ 

10.1.2.3 Şekiller ve Resimler 

Çalıştığınız doküman çok sayıda resim içeriyorsa, resimleri sıkıştırmak yararlı olabilir. 

1. Resmi seçin. 

2. ‘Format’ tabına tıklayın. 

3. ‘Compress’ butonuna basın. 



ResearchSoftware.com 175 

EndNote X9 

10.1.2.4 Instant Formatting (Anında Biçimlendirme) 

Default olarak, ‘Instant Formatting’ özelliği ilk atıf eklerken ya da bibliyografyayı 

biçimlendirirken etkindir. Bu işlemler ‘Instant Formatting’ özelliği ile ilgilidir. ‘Instant 

Formatting’ özelliğini etkinleştirmek ya da devre dışı bırakmak için: 

1. Word’ü açın 

2. ‘EndNote X9’ tabına tıklayın. 

3. ‘Bibliography’ grubunda ‘Instant Formatting On’ ya da ‘Instant Formatting Off’ 

butonunu kullanın. 

 

 Not 

 ‘Instant Formatting’ devre dışı bırakıldığında, ‘Bibliography’ grubundaki ‘Update 

Citations and Bibliography’ butonu ile manuel olarak atıfları biçimlendirebilirsiniz. 

10.1.2.5 Troubleshooting Cite While You Write (Cite While You Write Sorun 

Giderme) 

EndNote’un kurulması sürecinde ‘Cite While You Write’ dosyaları otomatik olarak ‘Word 

startup folder’ına atılır. Bütün ‘CWYW’ komutları ‘EndNote’ araç çubuğunda, Word’de 

EndNote tabı olarak görüntülenir.  

Microsoft Word 2007’de ‘EndNote’ tabı görüntülenmezse aşağıdaki işlem sırasını 

takip edin: 

1. Word’ün sol üst köşesindeki ‘Office’ butonuna basın. 

2. Açılan ekranın altında ‘Word Seçenekleri’ (Word Options) butonuna basın. 

3. ‘Word Seçenekleri’ penceresinin solundaki listeden ‘Eklentiler’ (Add-ins) butonuna 

basın. ‘Cite While You Write’ eklentisini ‘Etkin Olmayan Uygulama Eklentileri’ 

(Disabled Aplication Add-ins) listesinde görebilirsiniz. Alt kısımdaki ‘Yönet’ 

(Manage) açılır listesinden ‘COM Eklentileri’ (COM Add-ins) yerine ‘Devre Dışı 

Öğeler’ (Disabled Items) seçin ve ‘Git’ (Go) butonuna basın. 

4. Açılan ekranda ‘EndNote cwyw.dll’ seçin ve ‘Etkinleştir’ (Enable) butonuna basın. 

5. Word 2007’yi kapatıp açtığınızda EndNote X9 tabı eklenmiş olacaktır. 

Eğer hala EndNote tabınızı görmüyorsanız, EndNote kurulum paketini çalıştırarak ya da 

‘Başlat/Denetim Masası/Program Ekle veya Kaldır’ (Start/Control 

Panel/Programs/Uninstall a program) EndNote X9’u seçtikten sonra ‘Değiştir’ (Change) 

butonuna basarak kurulum aşamasında ‘Repair’ veya ‘Modify’ seçeneklerinden birini 

tercih etmeniz gerekecektir. 

Microsoft Word 2010’da ‘EndNote’ tabı görüntülenmezse aşağıdaki işlem sırasını 

takip edin: 

1. Word’te ‘Dosya’ (File) tabına basın. 

2. Açılan listeden ‘Seçenekler’ (Options) butonuna basın. 

3. ‘Word Seçenekleri’ penceresinin solundaki listeden ‘Eklentiler’ (Add-ins) butonuna 

basın. ‘Cite While You Write’ eklentisini ‘Etkin Olmayan Uygulama Eklentileri’ 

(Disabled Aplication Add-ins) listesinde görebilirsiniz. Alt kısımdaki ‘Yönet’ 

(Manage) açılır listesinden ‘COM Eklentileri’ (COM Add-ins) yerine ‘Devre Dışı 

Öğeler’ (Disabled Items) seçin ve ‘Git’ (Go) butonuna basın. 

4. Açılan ekranda ‘EndNote cwyw.dll’ seçin ve ‘Etkinleştir’ (Enable) butonuna basın. 

5. Word 2010’u kapatıp açtığınızda EndNote X9 tabı eklenmiş olacaktır. 
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Eğer hala EndNote tabınızı görmüyorsanız, EndNote kurulum paketini çalıştırarak ya da 

‘Başlat/Denetim Masası/Program Ekle veya Kaldır’ (Start/Control 

Panel/Programs/Uninstall a program) EndNote X9’u seçtikten sonra ‘Değiştir’ (Change) 

butonuna basarak kurulum aşamasında ‘Repair’ veya ‘Modify’ seçeneklerinden birini 

tercih etmeniz gerekecektir. 

Microsoft Word 2013’de ‘EndNote’ tabı görüntülenmezse aşağıdaki işlem sırasını 

takip edin: 

1. Word’te ‘Dosya’ (File) tabına basın. 

2. Açılan listeden ‘Seçenekler’ (Options) butonuna basın. 

3. ‘Word Seçenekleri’ penceresinin solundaki listeden ‘Eklentiler’ (Add-ins) butonuna 

basın. ‘Cite While You Write’ eklentisini ‘Etkin Olmayan Uygulama Eklentileri’ 

(Disabled Aplication Add-ins) listesinde görebilirsiniz. Alt kısımdaki ‘Yönet’ 

(Manage) açılır listesinden ‘COM Eklentileri’ (COM Add-ins) yerine ‘Devre Dışı 

Öğeler’ (Disabled Items) seçin ve ‘Git’ (Go) butonuna basın. 

4. Açılan ekranda ‘EndNote cwyw.dll’ seçin ve ‘Etkinleştir’ (Enable) butonuna basın. 

5. Word 2013’ü kapatıp açtığınızda EndNote X9 tabı eklenmiş olacaktır. 

Eğer hala EndNote tabınızı görmüyorsanız, EndNote kurulum paketini çalıştırarak ya da 

‘Başlat/Denetim Masası/Program Ekle veya Kaldır’ (Start/Control 

Panel/Programs/Uninstall a program) EndNote X9’u seçtikten sonra ‘Değiştir’ (Change) 

butonuna basarak kurulum aşamasında ‘Repair’ veya ‘Modify’ seçeneklerinden birini 

tercih etmeniz gerekecektir. 

Microsoft Word 2016’da ‘EndNote’ tabı görüntülenmezse aşağıdaki linkte yer alan 

işlem sırasını takip edin: 

https://researchsoftware.com/tr/faq/endnote#nid-4176 

10.2 EndNote Hazır Makale Şablonlarının (Manuscript 

Templates) Kullanımı 

EndNote, makalelerinizi yayımcılara elektronik olarak sunmanızı kolaylaştıran daha 

önceden tanımlanmış birçok Microsoft Word manuscript (makale) şablonları 

içermektedir. Bu şablonlardan birini kullanarak makalenizi yazmaya başladığınızda 

makalenizin birçok biçimsel ayarları, örneğin kenar boşlukları, başlıklar, 

numaralandırma, satır aralığı, başlık sayfası, özet sayfası, grafiklerin yerleşimi, yazı tipi 

ve boyutu gibi ayarlar hedef yayınınıza uygun şekilde önceden ayarlanacaktır. Bütün 

bu ayarlardan sonra, atıflarınızı makalenize ekleyebilir ve daha önceden tanımlı olan 

binlerce bibliyografik stili kullanarak veya kendi bibliyografik stilinizi oluşturarak atıf ve 

referanslarınızı düzenleyebilirsiniz. Bibliyografya stillerinin bulunduğu listeden, uygun 

bibliyografya stilini seçerek makalenizi yazarken kolay, hatasız bir şekilde atıflarınızı 

yapabilir ve otomatik olarak referans listenizi oluşturabilirsiniz. Hatta EndNote 

kütüphanenizde bulunan şekil ve tablolarınızı ekleyebilirsiniz. 

EndNote içerisinden veya doğrudan Word'den, önceden tanımlanmış şablonları temel 

alarak, yeni bir Microsoft Word dokümanını başlatabilirsiniz. Ayrıca, önceden 

tanımlanmış şablonlardan birini kopyalayabilir ve düzenleyebilirsiniz. 

10.2.1 EndNote İçerisinden Kullanımı 

EndNote’un hazır Microsoft Word manuscript şablonları ile bir makale hazırlamak için 

aşağıdaki işlem sırasını izleyin: 

1. EndNote’u açın. 

2. Menülerinden Tools/Manuscript Templates...’i seçin. 

3. Tüm şablonların bulunduğu ‘Manuscript Templates’ ekranı görüntülenecektir. 

https://researchsoftware.com/tr/faq/endnote#nid-4176
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4. Makalenizi göndereceğiniz dergiye ait şablonu (örneğin APA 6th.dotm) seçin. 

5. Yeni bir Microsoft Word dokumanı açılacaktır. İlk defa manuscript özelliğini 

kullanıyorsanız office uygulamanız makro güvenliği ile ilgili bir uyarı verebilir. Bu 

durumda makroların çalıştırılmasına izin verin. 

6. ‘EndNote Manuscript Wizard’ ekranı görüntülenecektir. Makalenizde bulunması 

gereken genel bilgilerin girişini kolaylaştıran ‘EndNote Manuscript Wizard’ın ilk 

ekranını ‘İleri’ (Next) butonu ile geçin. 

  

7. Diğer ekranlar seçtiğiniz şablona bağlı olarak dokümanınızda kullanılacak bazı 

bilgilerin (full title, short title...) girilmesi ile ilgilidir. Makale başlığınızı girdikten 

sonra ‘Next’ butonuna basın. 

 

8. ‘Authors’ ekranında bulunan ‘Add Author' butonu ile daha önce bilgilerini 

girdiğiniz yazarları seçebilir veya yeni yazarlara ait bilgileri girebilirsiniz. 
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9. Daha önce bilgilerini girdiğiniz yazarları listeden seçmek ve listeye yeni yazar 

eklemek için ‘Add Author’ butonuna tıklayın. 

10. Yeni bir yazar eklemek için ‘New’ butonuna tıklayın. 

 

11. Açılan ‘Add Author’ ekranından yazar bilgilerini girin ve ‘OK’ butonuna tıklayın . 

 

12. Girilen kayıt listede görüntülenecektir. Listeden yazarı seçebilir veya yeni bir yazar 

kaydı girmek için, ‘New’ butonunu tekrar kullanabilirsiniz. Yazar kayıtları Microsoft 

Office Outlook’ta yer alıyorsa ‘Import from Outlook’ butonunu kullanabilirsiniz.  

13. Yazarları tek tek seçebileceğiniz gibi ‘Ctrl’ ve ‘Shift’ tuşları yardımıyla birden çok 

yazarı aynı anda seçebilirsiniz. 
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14. Yazarları seçtikten sonra ‘OK’ butonuna tıklayarak ‘Authors’ ekrana geri dönün. 

15. Makalenizde bulunması gereken yazar seçimi ve sıralamasını belirleyin. ‘İleri’ 

(Next) butonuna tıklayın. 

 

16. Açılan ‘Sections’ ekranından makalenizde bulunacak bölümleri seçin ve ‘İleri’ (Next) 

butonuna tıklayın. 

 

17. Açılan ‘Keywords’ ekranında, anahtar kelimelerinizi girin ve ‘İleri’ (Next) butonuna 

tıklayın. 
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18. Gerekli bilgilerin girişini tamamladığınızda ‘Son’ (Finish) butonuna tıklayın. 

  

Girilen tüm bilgiler ilgili bölümlere veya alanlara yerleştirilecek ve makalenizi 

yazmanız için tüm biçimsel ayarlar yapılacaktır. 

    

Bundan sonra yapmanız gereken, makalenizin ilgili bölümlerini şablon üzerinde 

doldurmak olacaktır. Ayrıca, EndNote ile yapacağınız atıflar ve referans listesi 

seçtiğiniz dergi şablonuna uygun olarak biçimlendirilecektir. 
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10.2.2 Word İçerisinden Kullanımı 

Hazır şablonları Word içerisinden kullanmak için: 

1. Microsoft Word’ü başlatın. 

2. ‘File > New’ komutuna tıklayın. 

3. ‘Templates’ listesinde, ‘My Templates’i seçin. 

4. ‘New’ ekranı görüntülenecektir. 

EndNote tabına tıklayın ve şablonu seçin. 

‘OK’ butonuna tıklayın. 

10.3 Atıflar & Şekiller Ekleme 

Atıf ya da metin içi atıf, metin yapınızda bibliyografyadaki tüm referansa karşılık gelen 

kısa bibliyografik bilgidir. En sık kullanılan biçimler: (Author, Year), [Numbered] ve 

Author (Year). 

Default olarak ‘Instant Formatting’ özelliği açıktır. Bunun anlamı her atıf eklediğinizde 

dokümanınız anında biçimlendirilecek ve dokümanınızın sonunda bulunan referans 

listeniz otomatik olarak güncellenmektedir. 

Atıflarınızı Word dokümanınıza, duruma bağlı olarak biçimlendirilmiş ya da 

biçimlendirilmemiş şekilde eklemenin farklı yolları bulunmaktadır: 

 EndNote X9 tabındaki ‘Insert Citation(s)’  butonunu veya ‘Insert Citation’ 

listesinden ‘Insert Citation...’  komutunu kullanın (Bkz. 10.3.1 'Insert Citation(s)' 

Özelliğinin Kullanımı). 

 EndNote X9 tabında ‘Insert Citation’ listesinden ‘Insert Selected Citation(s)’ 

komutunu veya EndNote içerisinden ‘Insert Citation’  butonunu kullanın (Bkz. 

10.3.2 ‘Insert Selected Citation(s)’ Özelliğinin Kullanımı) 
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 Kesin kurallara göre manuel olarak ‘temporary citations’ (geçici atıf) girin (Bkz. 

10.3.5 Manuel Olarak Atıf Yapma). 

 Kopyala-yapıştır ya da sürükle-bırak (Bkz. 10.3.5 Manuel Olarak Atıf Yapma). 

10.3.1 'Insert Citation(s)' Özelliğinin Kullanımı 

Makalenizi yazarken Word dokümanınızdan ayrılmadan, atıf işlemi yapacağınız EndNote 

referans kayıtlarınızı bulabilir ve dokümanınıza ekleyebilirsiniz. 

1. Atıf yapmak istediğiniz referansları içeren kütüphane ya da kütüphaneleri açın. 

2. Microsoft Word’ü başlatın ve yazdığınız dokümanı açın. 

3. İmleç, metinde atıfı koymak istediğiniz yerde olmalıdır. 

4. ‘Insert Citation(s)’  butonunu veya ‘Insert Citation’ listesinden ‘Insert Citation...’ 

 komutunu kullanın. 

Önceki arama sonuçlarının bulunduğu 'EndNote X9 Find & Insert My References' 

ekranı görüntülenecektir. 

5. ‘Find' kutusuna arama metnini girin (Echolocation) ve ‘Search’ butonuna basın. 

EndNote uygun referansları getirecektir. 

6. EndNote, arama metnini referanslarınızda karşılaştıracak ve eşleşenleri 

listeleyecektir. Eklemek istediğiniz referansı belirleyin ve 'Insert' butonuna basın. 

   

7. Yeni bir atıf yapmak için, 4, 5 ve 6’ıncı adımları tekrarlayın. 
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Sonuç 

   

 Not 

 EndNote kütüphaneniz içerisinde aradığınız metin, arama sonucunda ulaşılan 

referans kayıtlarında bir yazarın soyadı, makalenin yılı, bir anahtar kelime, kayıt 

numarası ya da terimlerin diğer kombinasyonlarından herhangi biri olabilir. 

 Word ile çalışırken ‘Citations’ grubunda  butonuna basarak EndNote’u 

çalıştırabilir veya EndNote ekranına geçiş yapabilirsiniz. 

 Eğer atıflarınız otomatik olarak biçimlendirilmiyorsa ve bibliyografyanız her atıf 

eklendiğinde otomatik olarak güncellenmiyorsa ‘Bibliyography’ grubunda 

 butonuna basın. 

 Atıflarınızın ve bibliyografyalarınızın stilinde düzenleme ya da değişiklik yapmak 

için ‘Bibliyography’ grubunda ‘Configure Bibliyography’  butonunu 

kullanabilirsiniz. 

 Referanslarınızı ekledikten sonra o referans üzerinde bazı değişiklikler 

yapabileceğiniz gibi, ‘Insert Citation(s)’ komutuyla referansı dokümanınıza eklerken 

‘Insert’ butonunun yanındaki açılır listedeki komutlar ile de kullanacağınız stile 

bağlı olarak bazı değişiklikleri gerçekleştirebilirsiniz. Burada kullanacağınız 

komutlar sadece eklenecek olan referans ve/veya referans kayıtlarına uygulanır 

tüm dokümana uygulanmaz. 

  

Insert: Atıf ve/veya atıfları dokümana eklemek için kullanılır. 

Insert & Display as: Author (Year): Atıf ve/veya atıflarınızda yazar adını 

parantez dışında görüntülemek için kullanılan komuttur. 

Insert & Exclude Author: Atıf ve/veya atıflarınızda yazar adının 

görüntülenmemesi için kullanılan komuttur. 
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Insert & Exclude Year: Atıf ve/veya atıflarınızda yıl bilgisinin 

görüntülenmemesi için kullanılan komuttur. 

Insert in Bibliography Only: Atıf ve/veya atıfların görüntülenmeden doğrudan 

referans listesine eklenmesi için kullanılan komuttur. 

10.3.2 ‘Insert Selected Citation(s)’ Özelliğinin Kullanımı 

EndNote kütüphane listesinden istediğiniz sayıda referans kaydını belirledikten sonra, 

bu kayıtları Word ile hazırladığınız makalenizde istediğiniz yere ekleyebilirsiniz. Seçilen 

atıflar EndNote ya da Word’den eklenebilmektedir. 

 EndNote’da ‘Library’ araç çubuğundan ‘Insert Citation’  (Alt+2 tuş 

kombinasyonu) butonuna basın. 

ya da 

 Microsoft Word’de EndNote tabında ‘Insert Citation’ listesinden ‘Insert Selected 

Citation(s)’  butonuna basın. 

Aşağıdakileri işlem sırasını takip edin: 

1. Eğer Microsoft Word’ le çalışıyorsanız,  butonuna basın. 

 EndNote kütüphanenizdeki istediğiniz kayıtlarını seçin. 

2. EndNote kütüphane araç çubuğunda ‘Insert Citation’  (Alt+2 tuş kombinasyonu) 

butonuna basın. 

Word dokümanınızda imlecin yerinden emin değilseniz, EndNote kütüphanenizde 

‘Go to Word Processor’  (Alt+1 tuş kombinasyonu) butonuna basın. Ardından, 

Word’de ‘Insert Selected Citation(s)’  butonuna basın. 

EndNote sonuçları Word’de görüntüleyecektir. 

10.3.3  ‘Insert Figure…’ Özelliğinin Kullanımı 

EndNote kütüphanelerinizde referansları arayarak, referansa ait imaj alanında yer alan, 

resim veya grafik dosyalarını Word dokümanınıza ekleyebilirsiniz. ‘Caption’ (Resim 

Yazısı) alanı resim dosyalarınızı ararken size kolaylık sağlayacaktır. Bu alan, resim ya 

da dosyanın kısa bir açıklaması için kullanılmaktadır. 

Word dokümanına, ‘Cite While You Write’ özelliği ile EndNote’dan bir resim dosyası 

eklediğinizde, makalenizde resmin üstünde ya da altında resim yazısı otomatik olarak 

görüntülenecektir (eklenen resim yazılarının resmin altında mı yoksa üstünde mi yer 

alacağı seçilen ‘Output Style’a göre belirlenmektedir). EndNote referansında bulunan 

bir grafik ya da dosyayı eklemek için: 

1. Eklemek istediğiniz şeklin bulunduğu kütüphaneyi açın. 

2. Microsoft Word dokümanını açın ve şekil atıfının görüntülenmesini istediğiniz yeri 

imleç ile belirleyin. 

3. ‘Citations’ grubunda ‘Insert Citation’ listesinden ‘Insert Figure...’ butonuna basın. 

'EndNote X9 Find Figure(s)' ekranı görüntülenecektir. 

4. ‘Find' metin kutusuna, resmin bulunduğu referans kaydını seçmek için metni girin. 

‘Find’ butonuna basın. 

5. EndNote ‘Author, Year, Title ve Caption’ alanları ile eşleşen referans kaydını 

görüntüleyecektir. 

Uygun şekli listeden belirleyin ve 'Insert' butonuna basın. 
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EndNote, metin içi şekil atıfını, şekli ve şekil yazısını ekleyecektir. 

Sonuç 
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 Not 

 Bibliyografyalara uygulanan ‘Instant Formatting’ şekillere uygulanmaz. Metin içi 

şekil atıfları, şekil dokümana eklendiğinde biçimlendirilir, ancak metin içerisinden 

şekil atıfını siler ya da taşırsanız, dokümanızdaki şekil atıfları ve 

numaralandırmasını güncellemek için, Word’te ‘Update Citations and Bibliography’ 

butonunu kullanmanız gerekmektedir. 

 EndNote, imajları resim yazısı ile birlikte paragraftan hemen sonra otomatik olarak 

eklemektedir. Tabloların ve şekillerin dokümana yerleştirilmesi, resim yazısı ile ilgili 

düzenlemeler, ‘Output Style’da ‘Figures & Tables’ panelinden gerçekleştirilebilir. 

 ‘Chart or Table’ referans tipindeki şekiller Word’e tablo olarak eklenecektir. Tablo 

olarak eklenen şekiller, tablo olarak etiketlenir ve numaralandırılır. Tablo eklemek 

için şekil ekleme işlem sırası takip edilebilir. 

10.3.4 Dipnotlarda ya da Sonnotlarda Atıf Yapma 

Word’te dipnot ya da sonnot oluşturduktan sonra, metin içi atıf işlemindeki gibi dipnot 

ya da sonnot atıflarınızı gerçekleştirebilirsiniz. 

Dipnotta (ya da sonnotta) referans atıf işlemi için: 

1. ‘Başvurular’ (References) tabında, ‘Dipnotlar’ (Footnotes) grubunda ‘Dipnot Ekle’ 

(Insert Footnotes) butonuna basın.  

2. ‘Dipnot ve Sonnot’ ile ilgili biçim değişiklileri için iletişim penceresini açmak 

isterseniz ‘Dipnotlar’ grubunda ‘Dipnot ve Sonnot’ (Footnote and Endnote)  

butonuna basın.  

 

3. ‘Dipnot ve Sonnot’ta atıflarınızı gerçekleştirirken imleç, atıf yapmak istediğiniz 

yerde bulunmalıdır. 

4. Standart atıf ekleme işlemlerini kullanarak ‘Dipnot ve Sonnot’ atıflarınızı 

ekleyebilirsiniz. 

Dipnot ve sonnottaki atıfların nasıl biçimlendirileceği seçilen stil’e göre 

belirlenmektedir. EndNote bu atıfları, metin içi atıflar gibi ya da referans listesinde 

görüntülendiği şekliyle biçimlendirebilir.  

Dipnot ya da sonnot atıflarda, referans kayıtları birden fazla atıf edildiğinde, Ibid ya da 

referans kayıtlarının kısaltılmış formları gibi, spesifik biçimlendirmeler oluşturulabilir 

(output style tanımlamaları için Bkz. 9.2.4 Footnotes (Dipnotlar) İçin Stil Şablonunu 

Düzenleme). 

Sonuç 
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10.3.5 Manuel Olarak Atıf Yapma 

10.3.5.1 Kesin Kurallara Göre Eklemek (Inserting according strict rules) 

Word dokümanınızda atıflar biçimlendirilmiş ya da biçimlendirilmemiş olarak 

görüntülenebilir. Biçimlendirilmemiş atıf geçici bir bilgi alanıdır ve son çıktıyı 

yansıtmaz. Aşağıdaki işlemler sırasını takip ederek, bu atıflarınızı uygun olan formatta 

biçimlendirebilirsiniz: 

 Atıf(ları) bulun ve ekleyin (Insert Citation(s) komutu) 

 Seçili atıf(ları) ekleyin (Insert Selected Citation(s) komutu) 

 Atıfları EndNote’ tan Word’e sürükleyip bırakın ya da kopyalayın ve yapıştırın. 

 Atıflarınızı formatsız olarak ekleyin (Unformatted Citation(s)) ya da 

biçimlendirilmemiş atıfları manuel olarak girin. 

EndNote, bibliyografyada hangi referansların yer alacağını belirlemek için geçici atıfları 

kullanmaktadır. 

 Metni tanımlarken ‘delimiters’ (ayraçlar) kullanılmaktadır. Örneğin {kıvırcık 

parantezler} ya da [köşeli parantezler]. Edit>Preferences>Temporary Citations 

ekranında ayarları değiştirebilirsiniz. 

 Her biçimlendirilmemiş atıf, açık olan kütüphanedeki EndNote referansına karşılık 

gelen eşsiz bilgi içermektedir. 

 Biçimlendirilmemiş atıf metni tanımlamak için tipik olarak; atıf ayraçlarıyla ilk 

yazarın soyadı, yıl ve EndNote kayıt numarasını içermektedir: 

Örneğin: {Volckaert, 2008 #13} 

ya da  

{Volckaert, 2008 #13; Tuzgöl, 2006 #8}. 

 Tanımlanan metin önek ya da sonek içerebilmektedir. 

Örneğin: {See \Volckaert, 2008 #13} 

Örneğin: {Volckaert, 2008 #8 p.120} 

Aşağıdaki örnekte ‘Instant Formatting’ özelliği kapatılmıştır (Bibliography grubunda> 

Instant Formatting is On/Off’). 

1. ‘Geçici Atıfları’ ları girin. 

{Allen, 2004 #80}, {Binfield, 2008 #79}, {Brinklov, 2009 #65} 
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2. EndNote X9 tabında ‘Bibliyography’ grubunda ‘Configure Bibliyography’  

butonuna basın. Açılan ‘EndNote X9 Configure Bibliography’ ekranında ‘Output 

Style’ı belirleyin ve ‘Tamam’ (OK) butonuna basın. 

 

3. Bütün geçici atıflar biçimlendirilmiş atıflara çevrilecektir. Bu işlemi ‘Bibliyography’ 

grubunda  butonuna basarak da gerçekleştirebilirsiniz. 

 Not 

 Eğer ‘Instant Formatting’ özelliği açıksa biçimlendirilmemiş atıfları 

göremeyebilirsiniz. ‘Instant Formatting’ default olarak açıktır. Kapatmak için 

EndNote X9 tabında ‘Bibliyography’ grubunda ‘Instant Formatting is Off/On’ 

butonuna basın. 

 Kullanmak istediğiniz stil ‘With output style’ listesinde bulunmuyorsa, ‘Browse...’ 

butonuna bastığınızda açılan ‘EndNote X9 Styles’ ekranında kullanacağınız stili 

belirleyebilirsiniz. 

 Atıflarınızı biçimlendirdikten sonra, herhangi bir stil değişikliği gerçekleştirecekseniz 

‘Bibliyography’ grubunda ‘Style’ listesinden kullanmak istediğiniz stili 

belirleyebilirsiniz. Kullanmak istediğiniz stil, ‘Style’ listesinde bulunmuyorsa ‘Select 

Another Style...’ seçeneğini kullanarak açılan ‘EndNote X9 Styles’ ekranında 

kullanacağınız stili belirleyebilirsiniz. 

Sonuç 

Style: APA 6th 

mk:@MSITStore:C:/Program%20Files/EndNote%20X/EndNote.chm::/10Word/Instant_Formatting.htm
mk:@MSITStore:C:/Program%20Files/EndNote%20X/EndNote.chm::/10Word/Instant_Formatting.htm
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Style: Numbered 

 

10.3.5.2 Kopyalama ve Yapıştırma 

Aşağıdaki işlem sırasını izleyerek ‘biçimlendirilmemiş’ ya da ‘geçici atıf’lar 

gerçekleştirebilirsiniz: 

1. EndNote’dan eklemek istediğiniz referansları seçin ve ‘Ctrl + C’ tuş kombinasyonu 

ile referansları kopyalayın. 

2. Word’e gidin ve ‘Ctrl + V’ tuş kombinasyonunu kullanarak referansları yapıştırın. 

Referanslar ‘biçimlendirilmemiş’ ya da ‘geçici atıf’ formunda dokümanınızda yer 

alacaktır. 

EndNote’dan Word’e referansların sürüklenip bırakılması da referansların ‘geçici atıf’ 

biçiminde dokümanınızda yer almasını sağlayacaktır. 

10.3.6 Referanslar Listesine Not Ekleme 

Bazı dergi stillerinde (örneğin; bilim dergiler), dokümanın sonunda referans listesiyle 

birlikte not girilmesi gerekebilir. Böyle bir durumda notlar, atıflar gibi 

numaralandırılmaktadır ve bibliyografik referanslarla birlikte referans listesine sırasıyla 

eklenmektedir. 
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Makaleniz not içeriyorsa numaralı bir stille makalenizi biçimlendirmeniz daha mantıklı 

olacaktır. 

Referans listesine, numaralanmış not olarak metin eklemek için: 

1. ‘Bibliyography’ grubunda, ‘Style’ açılır listesinden ‘Numbered’ stilini seçin. 

2. İmlecin metninizdeki yeri, numaralandırmak istediğiniz notu belirtmektedir. 

3. ‘Insert Citation’ listesinden ‘Insert Note…’  butonuna basın. 

4. ‘EndNote X9 Insert Note’ ekranı görüntülenir. 

Metin kutusuna notunuzu yazın (metnin uzunluğu ile ilgili sınırlama yoktur). 

 

5. ‘OK’ butonuna basın. 

Sonuç 

    

 Not 

 Bu özelliği anlamlı bir şekilde kullanabilmek için, ‘Output Style’ olarak numaralı bir 

stil seçilmelidir; aksi halde not sayfanızda metin olarak görüntülenecektir. 

 Yalnızca metni girin. Grafikler, eşitlikler ya da semboller girmeyin. 

 Geçici atıf ayraçları (varsayılan olarak kıvırcık parantez {}), not metninin bir 

parçası olarak kullanılmamalıdır. Kayıt numarası işareti (#), ön ek işareti ve çoklu 

atıf ayırıcı gibi diğer işaretleyiciler kullanılabilir. 

 Düzenli bibliyografik atıflarla, aynı ayraç (parantez ya da köşeli parantez gibi) 

grubu içindeki notlar birleştirilemez. Her biri kendi ayraç grubu içinde ayrı olarak 

belirtilmelidir. 

10.4 Tek Dokümanda Çoklu Bibliyografya 

Default olarak, EndNote, Word dokümanınızda tek bir bibliyografya oluşturmaktadır. 

Bunun yanında dokümanınızda her bölüm için ayrı bibliyografya oluşturmak 

isteyebilirsiniz. EndNote her bölüm için biçimlendirme yapabilir: 

 Bölümler için Word dokümanınıza kesme koyun. 

 Gerekli ise çıktı stilini düzenleyin. 

10.4.1 Bölümler için Microsoft Word Dokümanınızda Kesme İşlemi 

Microsoft Word dokümanınıza kesme koymak için, aşağıdaki işlemleri takip edin:  

1. Word’de ‘Layout’ tabını açın. 

2. ‘Breaks’ buttonuna tıklayın. 



ResearchSoftware.com 191 

EndNote X9 

3. Seçeneklerden birini belirleyin: Next Page, Even Page, Odd Page. 

10.4.2 Output Style Düzenleme 

İşlemleri takip edin:  

1. ‘Edit > Output Styles > Open 

Style manager’ı seçin. 

2. ‘Sections’ paneli açın. 

Üç seçenekten birini seçin. 

3. Değişiklikleri kaydedin ve 

‘Output Style’ı kapatın.  

 

 Not 

 Eğer, bölümler için önceden tanımlı biçimlendirilmiş bir stil kullanmak isterseniz, 

APA 5th (sections) ya da Chicago 15th B (sections) stillerini kullanabilirsiniz. Bu 

stillerde her bölüm için bibliyografya biçimlendirilmesi gerçekleştirilmiştir ve 

değişiklik gerekmemektedir. 

 EndNote, her bölümün son metni ile o bölüm için oluşturulan referans listesi 

arasına her zaman boş bir satır ekleyecektir. 

 Her bölümün sonunda referans listesini biçimlendirdiğinizde, bibliyografya başlığı, 

‘Configure Bibliography’  ekranında ‘Layout’ tabından girilebilir. Eğer her bölümde 

başlık olmasını istemiyorsanız ‘Layout’ tabında ‘Bibliography Title’ metin kutusunun 

boş olduğundan emin olun. 

 Stilde, ‘Create a bibliography for each section and a complete bibliography at the 

end of the document’ seçeneği seçili ve sadece tek bir bölüme sahipseniz, tüm 

bibliyografya iki kez görüntülenecektir. Biri bölümün sonunda, diğeri dokümanın 

sonunda olacaktır. 

10.5 Atıfları ve Referansları Düzenleme 

10.5.1 Atıfları Düzenleme 

Makalenizde yer alan biçimlendirilmiş atıflarınızda düzenleme yapmak istediğinizde, 

manuel olarak kayıt üzerinde değişiklik gerçekleştirmemelisiniz. Çünkü, yaptığınız 

manuel değişiklikler bir sonraki EndNote biçimlendirmesinde silinecektir. 

Makalenizdeki bir atıfı düzenlemek için, ‘Edit Citation’ özelliğinde yer alan tanımlı 

düzenleme seçeneklerini (Prefix, Suffix,… vb) kullanarak, yapmak istediğiniz 

değişiklikleri gerçekleştirebilirsiniz. Bu düzenleme işlemi için aşağıdaki işlem sırasını 

takip edin (örnekte uygulanan stil APA 6th’dır): 

1. Düzenlemek istediğiniz atıfın üzerine tıklayın. 
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2. EndNote X9 tabında ‘Citations’ grubunda  butonuna ya da sağ 

tuş menüsünden ‘Edit Citations>More...’a basın. Dokümanda bütün alıntı yapılmış 

referanslar açılan ekranda listelenecektir. Ekrandaki listeden, düzenleme yapmak 

istediğiniz atıfı seçin ve takip eden değişiklikleri gerçekleştirin: 

Prefix: Bkz. (boşluk ve noktalama işaretleri önemlidir) 

Suffix: : 15-20 (boşluk ve noktalama işaretleri önemlidir)  

   

3. ‘OK’ butonuna basın. 

Sonuç 

   

 Not 

 ‘Edit Reference’ açılır liste komutları: 

Edit Reference : Referansınızı seçtikten sonra, bu komut ile doğrudan ‘Referans 

Penceresi’ni açabilir ve referans bilgilerinde gerekli ise değişiklikler yapabilirsiniz. 

Edit Library Reference: Referansınızı seçtikten sonra, bu komut ile doğrudan 

‘Referans Penceresi’ni açabilir ve referans bilgilerinde gerekli ise değişiklikler 

yapabilirsiniz. 

Find Reference Updates...: Referansınızı seçtikten sonra, bu komut ile kaynak 

veri tabanlarından referansla ilgili varsa güncellemeleri alabilirsiniz. 

Remove Citation: Referansınızı seçtikten sonra, bu komut ile o referansı 

dokümanınızdan silebilirsiniz. 

Insert Citation: Bu komut ile, açılan ‘EndNote X9 Find & Insert My References’ 

ekranında, aynı set içine yeni referans kayıtları ekleyebilirsiniz. 

Update from My Library...: Bu komut ile, açılan ‘EndNote X9 Find & Insert My 

References’ ekranında başka bir kütüphaneden eklemiş olduğunuz referansları aktif 

kullandığınız kütüphanedeki referansla değiştirebilirsiniz. 
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 Edit Citation Tab: Biçimlendirilecek atıf üzerinde yapılacak değişikliklerin 

gerçekleştirileceği ekrandır. 

Prefix: Biçimlendirilen atıfa ön ek eklemek için kullanılır. 

Suffix: Biçimlendirilen atıfa son ek eklemek için kullanılır. 

Pages: Biçimlendirilen atıfa sayfa numarası eklemek için kullanılır. Spesifik sayfa 

numarası eklemek için, ‘Cited Pages’ alanının, çıktı stili atıf şablonunda tanımlı 

olması gerekmektedir. 

Formatting açılır liste komutları: 

Default: Biçimlendirilen atıfın default ayarlar ile kullanılması için kullanılır. 

Display as: Author (Year): Biçimlendirilen atıfta yazar adının parantez dışında 

görüntülenmesi için kullanılır. 

Exclude author: Biçimlendirilen atıfta yazar adının görüntülenmemesi için kullanılır. 

Exclude year: Biçimlendirilen atıfta tarihin görüntülenmemesi için kullanılır. 

Show Only in Bibliography: Biçimlendirilen atıfın sadece bibliyografyada 

görüntülenmesi için kullanılır. 

 

 Reference Tab: Referans tabını kullanarak listede seçili olan referansla ilgili 

ayrıntılı bilgiyi görüntüleyebilirsiniz. 
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 ‘Tools’ açılır liste komutları: 

Update Citations and Bibliyography: Bu komut ile EndNote, bibliyografya ve 

atıf biçiminde seçilmiş stili kullanır. 

Format Bibliyography: Bu komut, çıktı stilleri, atıf ayraçları ve anında 

biçimlendirme özelliklerinde değişiklik için kullanılır. 

Export Traveling Library: Bu komut ile, dokümanda kullanılan referans kayıtları 

mevcut ya da yeni bir kütüphaneye aktarılabilir. Referanslar, mevcut bir 

kütüphaneye aktarılırken, default olarak çift kayıtlar kütüphaneye 

aktarılmayacaktır. 

  

10.5.2 Kütüphane Referanslarını Düzenleme 

Word dokümanınızdaki bibliyografik metin içi atıflarınızdan, ilgili EndNote 

referanslarınıza hızlı bir şekilde geçebilir ve bazı düzenlemeler yapabilirsiniz (çıktı 

stilinde APA 6th kullanılmıştır): 

1. EndNote kütüphanesinin açık olduğundan emin olun. 

2. Word dokümanınızdaki atıfı seçili hale getirin. 
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3. EndNote X9 tabı, ‘Citations’ grubunda  butonuna basın. 

4. EndNote düzenleme için ilgili referans penceresini görüntüleyecektir. Bazı 

değişiklikler yapın:  

Year: 2006, 2007 haline getirin. 

Journal: ‘Series B’ ,‘Series C’ haline getirin ve değişiklikleri kaydedin. 

 

5. Word dokümanını etkinleştirin. 

6. EndNote X9 tabında ‘Bibliyography’ grubunda  butonuna 

basın. 

Sonuç 

 

2007 

Series C 
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10.6 Atıf ve Bibliyografyaları Biçimlendirme 

10.6.1 Bibliyografyayı Biçimlendirme 

Makalenizin yazma işlemini tamamen bitirmiş ya da atıf ekleme işleminin bir kısmını 

tamamlamış olabilirsiniz. ‘Instant Formatting’ özelliğini etkin olarak veya bu özelliği 

devre dışı bırakarak atıflarınızı manuel olarak ekleyebilirsiniz. Hangi seçeneği 

kullandığınız önemli değildir. Atıflarınızı girdiğiniz sürece, dokümanınızı istediğiniz 

zaman biçimlendirebilirsiniz. Birçok atıf ekledikten, stil ya da düzenleme ayarlarını 

değiştirdikten sonra bile biçimlendirme yapabilirsiniz. 

Öncelikle bir atıfı biçimlendirmek için, ilgili EndNote kütüphanesi açık olmalıdır. 

Sonrasında, EndNote referans bilgisi için ‘Traveling Library’yi kullanabilirsiniz. 

Atıfları biçimlendirmek ve bibliyografya oluşturmak için: 

1. EndNote X9 tabında ‘Bibliyography’ grubunda ‘Configure Bibliyography’  butonuna 

basın. 

2. 'EndNote X9 Configure Bibliography' ekranı görüntülenecektir. 

Farklı sekmelerden ayarları değiştirebilir veya var olan ayarları kullanabilirsiniz. 

3. ‘Tamam’ (OK) butonuna bastığınızda yapılan değişiklikler dokümanınıza 

uygulanacaktır. 

      

10.6.2 Remove Field Codes (Alan Kodlarını Kaldırmak) 

Dokümanınızı yayımcı ya da iş arkadaşlarınızla paylaşmak için ‘Cite While You Write’ 

alan kodlarını kaldırmanız gerekebilir. 

 Alan kodları kaldırıldığında, Word’deki ‘Cite While You Write’ alan kodları silinerek, 

biçimlendirilmiş atıflar ve bibliyografyalar metin olarak kaydedilir. Bu işlemle, 

yalnızca Cite While You Write alan kodları kaldırılır, makalenizde bulunan diğer 

Word alan kodları etkilenmez. 

 Alan kodları kaldırıldığında, metin içi şekil atıfları artık EndNote referansına ya da 

şekil listesine bağlı değildir. Metin içi şekil atıfları düz metin haline gelir. Şekil 

listesindeki resimler sanki dokümana kopyalanıp yapıştırılmış gibi GIF dosyaları 

haline gelir. 

 Alan kodları kaldırıldığında, EndNote ya da ‘Cite While You Write’ özelliği artık 

makalenizi biçimlendiremeyecektir. Çünkü bu işlem makalenizin kodsuz bir 

kopyasını oluşturur. 

Alan kodlarını kaldırmak, biçimlendirilmiş atıfları ve bibliyografyayı metin olarak 

kaydetmek için: 

1. Biçimlendirilmiş Word dokümanınızı açın. 
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2. ‘Bibliyography’ grubunda  butonuna basıp, açılan listeden 

‘Convert to Unformatted Citations’ komutuna tıklayın. 

Dokümanın alan kodları olmayan kopyası, yeni doküman penceresinde açılacaktır.  

3. File>Save ile dokümanı kaydedin. 

Word dokümanınız, biçimlendirme kodları olmadan kaydedilecektir. Makalenizi 

yayıncıya gönderebilir ya da son halini farklı kelime işlemci programları kullanan 

meslektaşlarınız ile paylaşabilirsiniz. 

10.7 Cite While You Write Preferences 

Cite While You Write tercihlerine farklı yollarla erişebilirsiniz: 

 Word içinden: 

EndNote tabını açın ve  butonuna tıklayın. 

 EndNote içinden: 

‘Tools > Cite While You Write’ menüsünü açın. 

‘CWYW Preferences’ı seçin. 

10.7.1 General Tabı 

‘General’ tabı, EndNote kütüphaneniz ile Word’ü 

birlikte kullanırken gerçekleştireceğiniz ayarları 

içermektedir. 

 Open EndNote When Starting Word 

Word başlatıldığında, EndNote’un da başlatılması 

için kullanılmaktadır. 

 Close EndNote When Leaving Word 

Word kapatıldığında, EndNote’un da kapatılması 

için kullanılmaktadır. Word başlatılmadan önce 

EndNote açık ise, bu özellik kullanılmayacaktır. 

 Return to Document After Inserting Citations 

EndNote'un ‘Insert Selected Citation(s)’ komutuyla atıflar ekledikten sonra, 

belgenizi etkin pencere haline getirmek için bu komut kullanılmaktadır. Bu tercih 

kapatıldığında belge arka planda kalırsa, belge etkin pencere haline gelene kadar 

belgeye eklenen alıntı görünmeyecektir. 

 Enable Instant Formatting on new Word documents 

Bu seçenek, yeni Word belgeleri için anında biçimlendirme özelliğini açar veya 

kapatır. Anında biçimlendirme özelliğini etkinleştirdiğiniz zaman, EndNote'un geçici 

atıflar için tarama sıklığını ve mevcut atıflardaki değişikliklerini kontrol edip 

etmediğini de görebilirsiniz. 

 Scan for temporary citations komutu, geçici atıf taramasını etkinleştirmektedir. 

Manuel olarak girişini gerçekleştirdiğiniz geçici atıflar da dahil olmak üzere, 

tüm atıfları bularak biçimlendirilecektir. EndNote’un hangi sıklıkta dokümanınızı 

taramasını istediğinizi belirleyebilirsiniz. 

 Check for citation changes komutu, atıf değişikliklerinin arka planda kontrolünü 

sağlamaktadır. 

 Turn off Word’s “Show field codes instead of their values” option when opening or 

updating documents that include citations: 

EndNote, atıfları tanımlamak ve biçimlendirmek için kapsamlı Word alan kodlarını 

kullanır. Alan kodları görüntülendiğinde, belgeniz karışık görünebilir! 
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10.7.2 Keyboard Tabı 

EndNote'un Cite While You Write komutları için 

klavye kısayolları Word'de bulunmaktadır. Klavye 

kısayolu eklemek veya değiştirmek için:   

1. Word>EndNote tabını açın ve ‘Preferences’ı seçin. 

2. ‘Keyboard’ tabını seçin. 

3. Komut listesinden kısayol eklemek (değiştirmek) 

istediğiniz komutu seçin. 

4. ‘Press new shortcut key’ alanına kısayol tuş 

kombinasyonunu klavyeden girin. 

5. Yeni kısayolu atamak için ‘Assign’ butonuna 

tıklayın. 

Atanmış bir kısayolu kaldırmak için, aynı adımları takip ettikten sonra ‘Assign’ butonu 

yerine ‘Remove’ butonuna tıklayın. Kişisel kısayol atamalarını kaldırmak için, ‘Reset All’ 

butonunu kullanabilirsiniz.  

10.7.3 Figures and Tables Tabı 

Microsoft Word'deki şekil ve tablo ayarları geçerli 

çıktı stili ayarlarını geçersiz kılmaktadır. Çıktı 

stiliniz şekil ve tabloları belgenin sonundaki bir 

listede yazdırılacak şekilde ayarlandıysa, bu 

sekmedeki ayarlar yok sayılır. Bununla birlikte, 

çıktı stili şekil ve tabloları metin içerisine eklemek 

üzere ayarlanmışsa, belgenizdeki şekilleri taşımak 

veya yerleşimini korumak istediğinizde bu 

sekmeyi kullanarak ayarları geçersiz kılabilirsiniz. 

Word’de, EndNote şekil ve tablo metin içi 

yerleşimini kişiselleştirmek için: 

1. Word>EndNote tabını açın ve ‘Preferences’ı seçin. 

2. ‘Figures and Tables’ tabını seçin. 

3. Aşağıdaki işlemler için uygun radyo butonunu seçin: 

 Her şekli veya tabloyu ilk referansın yapıldığı yere doğrudan yerleştirin 

ya da 

 Şekilleri yeniden düzenlerken, her şekil veya tabloyu mevcut konumunda 

tutun. Bu, ‘Generate Figure List’ komutunu tekrar kullanmanız durumunda 

belgenizdeki şekilleri taşımanıza veya aynı yerde kalmalarını sağlar.  

10.7.4 Application Tabı 

‘Cite While You Write'ı kullanırken EndNote'un hangi 

sürümünü kullanacağınızı belirlemek için Word'deki 

‘Application’ tabını kullanabilirsiniz.  

EndNote, EndNote’un masaüstü sürümü  

veya 

EndNote online, EndNote'un online sürümü 
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 Not 

 Word dokümanınızda ‘Cite While You Write’ geçici atıf özelliğini kullanırken, kayıt 

numarası yerine ‘Label’ alanını kullanabilirsiniz.  

4. EndNote menüden ‘Edit > Preferences’ı seçin. 

5. ‘Temporary citations’ı seçin. 

6. ‘Use field instead of record number’ onay kutusunu işaretleyin. 

 

 Ortak çalışmalar yürüttüğünüz bir grubunuz varsa bu ayarın ortak çalışma 

arkadaşlarınız tarafından da değiştirilmesi gerekmektedir. 

10.8 Traveling Library (Gezici Kütüphane) Özelliği 

EndNote ile Word dokümanına eklenen her atıf, bibliyografik verileri gömülü alan 

kodları biçiminde depolayan bir işlevi temsil etmektedir. Bir atıf ilk kez 

biçimlendirilirken, ilgili EndNote kütüphanesi açık olmalıdır. Daha sonra, bu referans 

kaydı için yeniden biçimlendirme yapmak isterseniz, EndNote yine atıfın 

gerçekleştirildiği kütüphanede arama yapmaya çalışacaktır. Kütüphane açık değilse 

otomatik olarak kütüphaneyi açacaktır. Ancak kütüphaneye erişilemiyorsa, 

bibliyografik veri bilgisi için EndNote’un ‘Traveling Library’ özelliğini kullanacaktır. 

10.8.1 Export Traveling Library 

Word dokümanında kullanılan tüm referans kayıtlarının, mevcut ya da yeni bir EndNote 

kütüphanesine kopyalanması gerekebilir. Meslektaşınızdan biçimlendirilmiş bir Word 

dokümanı almış ve daha sonra kullanılmak üzere, EndNote referans kayıtlarını 

oluşturmak isteyebilirsiniz.   

Alan koduna sahip Word dokümanından, EndNote kütüphanesine referansları export 

etmek için aşağıdaki işlem sırasını takip edin:  

1. Word dokümanını açın. 

2. EndNote X9 tabındaki, ‘Tools’ grubunda  butonuna bastığınızda 

açılan listeden ‘Export Traveling Library’ komutunu kullanın. 
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3. ‘Export Traveling Library’ ekranında kullanmış olduğunuz referansları; 

- ‘An existing EndNote Library’ seçeneği ile, ‘Browse’ butonuna bastığınızda mevcut 

bir kütüphaneye export işlemini gerçekleştirebilirsiniz. 

- ‘A new EndNote library’ seçeneği ile, yeni bir EndNote kütüphanesine export 

işlemini gerçekleştirebilirsiniz.  

 Not 

 Export işleminin yeni bir kütüphaneye yapılması önerilmektedir. Böylece, mevcut 

kütüphaneye ekleme yapmadan önce, kayıtları gözden geçirme şansınız olacaktır. 

 ‘Export Traveling Library’ komutunu kullandığınızda, export edilen referanslar 

tekrar numaralandırılır ve kendi orjinal referans numaralarını alamazlar. 

 Her atıf yapıldığında, referans verisine ait, notlar, özet, şekil ve resim yazısı 

haricindeki tüm alanlar kaydedilmektedir. 

 EndNote X9 tabındaki, ‘Tools’ grubunda  butonuna bastığınızda, 

açılan listeden ‘Export Word Citations’ komutuyla Word özellikleri ile oluşturulmuş 

atıfları export edebilirsiniz. 

 EndNote X9 tabındaki, ‘Tools’ grubunda  butonuna bastığınızda, 

açılan listeden ‘Export Word Master List’ Word özellikleri ile oluşturulmuş atıfları 

‘Master List’ olarak export edebilirsiniz. 

10.8.2 Word Doküman Paylaşımı 

Bazen dokümanınızı, düzeltme ya da yorum için çalışma arkadaşlarınıza göndermeniz 

gerekebilir. Kullanılacak en iyi format, meslektaşların birlikte nasıl çalıştığına, ayrıca 

kullanılan EndNote ve Word’ün versiyonlarına bağlıdır. Güvenilir bilgi paylaşımı için en 

iyi yol, tüm tarafların her iki yazılımda aynı sürümü kullanmalarıdır. 

Alıcı EndNote kullanıyor, ancak gönderenle aynı EndNote kütüphanesini kullanmıyorsa, 

biçimlendirilmemiş Word dokümanını göndermek ve ‘Traveling Library’nin sadeliğinden 

faydalanmak oldukça güvenlidir. 

Alıcı EndNote kullanmıyorsa, göndericinin metindeki biçimlendirilmiş atıfları, 

biçimlendirilmemiş atıflara (Convert to Unformatted Citations komutu ile) 

dönüştürmesi daha uygun olacaktır. 

10.9 Hyperlink ve Atıf Raporu Özelliği 

Metin içi atıflar ile, EndNote X9 ve Microsoft Word içerisindeki bibliyografyalar arasında 

bağlantılar oluşturabileceğiniz ‘auto-hyperlink’ özelliğini kullanarak daha fazla zaman 

kazanabilirsiniz. 

1. Yeni bir Word dokümanı ve ‘Sample_Library_X9.enl’ kütüphanesini açın.  

2. Dokümanınıza istediğiniz referans kayıtlarını ekleyin. 

3. Default olarak, aktif olan ‘auto-hyperlink’ özelliği sayesinde, metin içi atıflarınızın 

üzerine gelip, ‘Ctrl’ tuşuna basılıyken mouse sol tuş kombinasyonunu 

kullandığınızda, üzerinde bulunduğunuz metin içi atıfın, referans listesinde yer alan 

ilgili kaydına yönlendirileceksiniz. 
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4.  Bu özelliği, metin içi atıflarda altı çizili olarak da kullanabilirsiniz. Word’te EndNote 

sekmesinde ‘Bibliyography’ grubunun sağ alt köşesinde bulunan ‘Configure 

Bibliyography’  butonuna basın. 

5. Açılan ‘EndNote X9 Format Bibliyography’ ekranında ‘Underline linked in-text 

citation’ onay kutusunu işaretleyin.  

  

6. ‘Tamam’ (OK) butonuna basın. Dokümanınız aşağıdaki gibi görüntülenecektir: 
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7. Oluşturmuş olduğunuz dokümanda bulunan referanslara ait atıf raporunu, EndNote 

grup panelinde, otomatik olarak dokümanın adı ile oluşturulan, geçici grupta 

görüntüleyebilirsiniz. 

   

 Not 

 Makalenizde birden fazla referans listesi varsa (örneğin; biri bölüm sonunda ve 

diğeri dokümanın sonunda), metin içi atıflar ile bölüm sonunda bulunan referans 

kayıtları arasında bağlantı oluşturabilirsiniz.  

 Grup atıflarında, her bir yazar - yıl ve numaralandırılmış atıfın bağlantısı, ilgili 

referans kaydına oluşturulur.  

 Hyperlink özelliğini kapatmak için, Word’de ‘EndNote X9 Format Bibliyography’ 

ekranındaki ‘Link in-text citations to references in the bibliyography’ onay 

seçeneğini kaldırmanız yeterli olacaktır. 
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10.10 Categorize References (CWYW Kategori 

Bibliyografyası) 

‘Categorize References’ özelliği ile, Microsoft Word dokümanınıza yapmış olduğunuz 

atıflar için, referans tipleri, konu başlıkları vb. konular bazında kategorilere ayırarak 

bibliyografyalar oluşturabilirsiniz. 

1. Yeni bir Word dokümanı ve ‘Sample_Library_X9.enl’ kütüphanesini açın.  

2. Dokümanınıza istediğiniz referans kayıtlarını ekleyin. 

  

3. ‘Bibliyography’ grubunda ‘Categorize References’ listesinden ‘Configure 

Categories...’ komutuna tıklayın. ‘EndNote X9 Configure Categories’ ekranı 

açılacaktır. 

  

4. ‘EndNote X9 Configure Categories’ ekranında ‘Category Headings’  butonuna ya 

da ekranın sol bölümünde ‘Category Headings’ alanında sağ tuş menüsününden 

‘Add Category Heading’ komutunu kullanarak kategori başlıklarınızı girin. 

5. Sürükle-bırak ile referanslarınızı olması gereken kategorilere taşıyın. 
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6. ‘Tamam’ (OK) butonuna basın. Dokümanınız aşağıdaki gibi görüntülenecektir: 

   

 Not 

 Kategorilerinizin üzerine gelip sağ tuş menüsünü kullandığınızda ‘Delete’ komutu 

ile kategorinizi silebilir, ‘Rename’ komutu ile yeniden adlandırabilirsiniz. 

 Kullandığınız stili düzenleyerek, referans tiplerinizi bibliyografyada otomatik olarak 

kategorize edebilirsiniz (‘EndNote>Edit>Output Styes>Open Style Manager’ açılan 

ekranda kullanacağınız stili seçtikten sonra, ‘Edit>Bibliography>Categories’ 

bölümünde, kategori başlığı olarak kullanacağınız metinleri girin. ‘Insert Reference 

Type’ listesinden referans tiplerini belirleyip stili kaydedin. Word dokümanınızda 

düzenlemesini gerçekleştirdiğiniz stili seçtiğinizde, bibliyografyanızda kategoriniz 

oluşturulacaktır).  
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11 PowerPoint Atıf Özelliği 

EndNote kurulumunu gerçekleştirdikten sonra, EndNote tabı PowerPoint’e eklenecektir. 

EndNote eklentisini kullanarak, atıfları ya da bibliyografya kayıtlarını kolay ve hızlı bir 

şekilde, PowerPoint slaytlarınıza ekleyebilirsiniz. EndNote, eklenen atıfları ve referans 

kayıtlarını seçili stilde tanımlanmış kurallara göre biçimlendirecektir. 

 

 Insert Citation  

Atıflarınızı aramak ve dokümanınıza eklemek için, bu butonu kullanabilirsiniz. Bu 

seçeneği kullandığınızda, ‘Find & Insert My Citations’ ekranı açılacaktır. 

 Insert Selected Citation(s)  

Açık olan EndNote kütüphanenizde seçili olan atıfları eklemek için, bu butonu 

kullanabilirsiniz. EndNote’u açtıktan sonra, kütüphane referans listesinden 

kullanacağınız referansları seçin. PowerPoint sunumunuzu açın ve bu butona 

tıklayın. EndNote, seçili olan kayıtlar için imlecin bulunduğu yere atıf ekleme 

işlemini gerçekleştirecektir. 

 Insert Reference 

Referanslarınızı aramak ve dokümanınıza eklemek için, bu butonu kullanabilirsiniz. 

Bu seçeneği kullandığınızda, ‘Find & Insert My References’ ekranı açılacaktır. 

 Insert Selected Reference(s) 

Açık olan EndNote kütüphanenizdeki seçili olan referansları eklemek için, bu 

butonu kullanabilirsiniz. EndNote’u açtıktan sonra kütüphane referans listesinden 

kullanacağınız referansları seçin. PowerPoint sunumunuzu açın ve bu butona 

tıklayın. EndNote, seçili olan kayıtlar için imlecin bulunduğu yere referans ekleme 

işlemini gerçekleştirecektir. 

 Output Styles Menu 

Atıfları ve referansları eklemeden önce,çıktı stilini seçmek için, ‘Style’ açılır listesini 

kullanabilirsiniz. 

 Go to EndNote Command 

Açık değil ise EndNote’u açmak için bu seçeneği kullanabilirsiniz. EndNote açıksa 

bu seçenek ile ekranı aktif hale getirebilirsiniz. 

PowerPoint dokümanınıza atıf ve referans kaydı eklemek için; 

1. PowerPoint dokümanını ve ‘Sample_Library_X9.enl’ kütüphanesini açın. 

2. Atıfı yapacağınız yere imleci koyun. EndNote tabında ‘Insert Citation’ butonuna 

basın. Önceki arama sonuçlarının bulunduğu 'EndNote Find & Insert My Citations' 

ekranı görüntülenecektir. 

3. ‘Find' kutusuna arama metnini girin (Echolocation) ve ‘Search’ butonuna basın. 

EndNote, metni referans kayıtlarınızla karşılaştıracak ve eşleşenleri listeleyecektir. 
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4. Eklemek istediğiniz referansı/referansları belirleyin ve 'Insert' butonuna basın. 

Sonuç, aşağıdaki gibi görüntülenecektir.  

 

5. Referans listenizi oluşturacağınız yere imleci koyun. EndNote tabında ‘Insert 

Reference’ butonuna basın. 

Önceki arama sonuçlarının bulunduğu 'EndNote Find & Insert My References' 

ekranı görüntülenecektir. 

6. ‘Find' kutusuna arama metnini girin (Echolocation) ve ‘Search’ butonuna basın. 

EndNote, metni referans kayıtlarınızla karşılaştıracak ve eşleşenleri listeleyecektir. 
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7. Eklemek istediğiniz referansı/referansları belirleyin ve 'Insert' butonuna basın. 

Sonuç aşağıdaki gibi görüntülenecektir. 

  

 Not 

 PowerPoint ‘Cite While You Write’, atıf ekleme ve referans listesi oluşturma 

sırasında, Microsoft Word’teki gibi kapsamlı özelliklere ve seçeneklere sahip 

değildir. Eklenen atıflar için anında referans listesi oluşturulmayacaktır. 

Bibliyografya verisinin ayrıca eklenmesi gerekmektedir.  

 Atıf ekleme ve referans listesini oluşturmadan önce ‘Styles’ listesinden kullanacak 

stilin seçilmesi gerekmektedir. Çünkü, yeni bir çıktı stili seçildiğinde, dokümana 

önceden eklenen atıf ve referans listesi verisi güncellenmeyecektir. 

 Bu özellik, Microsoft PowerPoint 2007, 2010, 2013 ve 2016 versiyonları ile 

uyumludur. 

 EndNote içerisinden atıf ve referans kaydı eklemek için; 

1. PowerPoint EndNote tabında ‘Go to EndNote’ butonuna basın.  

2. Atıf işlemi gerçekleştireceğiniz referans ya da referansları belirleyin ve 

PowerPoint’i açın. 

3. ‘Insert Selected Citation(s)’ butonuna basın. 

4. Referans listesi için ‘Insert Selected References’ butonunu kullanabilirsiniz. 
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12 EndNote Online 

12.1 Giriş 

EndNote Online, web tabanlı referans arama ve makale yazımını kolaylaştıran bir 

bibliyografya aracıdır. EndNote Online ‘Safari’ dahil bütün popüler tarayıcılar ile birlikte 

kullanılabilmektedir. Özellikle EndNote’da bulunan kapsamlı özelliklere ve esnekliğe 

ihtiyaç duymayan ancak profesyonel rapor, makale ve tez hazırlayan üniversite 

öğrencileri için tavsiye edilmektedir. Ayrıca EndNote ile entegre bir şekilde 

kullanılabilen EndNote Online, EndNote kullanan profesyonel araştırmacılar ve 

akademisyenler için EndNote’u tamamlayan birçok özelliğe sahiptir. 

EndNote Online ile; 

 ‘PubMed, ISI Web of Knowledge’ gibi farklı online kaynaklarda referans kaydı 

arayabilir ve doğrudan veya metin dosyası olarak kaydederek EndNote Online 

kütüphanenize aktarabilrsiniz. 

 Referanslarınızı gruplar oluşturarak düzenleyebilirsiniz. 

 Ortak çalışmalarınızda oluşturduğunuz grupları çalışma arkadaşlarınızla kolaylıkla 

paylaşabilirsiniz. 

 Microsoft Word’de makalenizi hazırlarken ‘Cite While You Write’ özelliği ile atıf 

yapabilir ve referans listenizi oluşturabilirsiniz. 

 Kullanıcı adı ve şifrenizle internet erişimi olan her yerden kayıtlarınıza 

ulaşabilirsiniz. 

Ayrıca EndNote X9’a sahipseniz; 

 EndNote Online hesabınızda sınırsız referans kaydını saklayabilir ve sınırsız dosya 

eki depolama alanına sahip olabilirsiniz. 

 EndNote online hesabınızı oluşturup, etkinleştirdiğinizde iki yıllık full erişim 

limiti sağlanmaktadır (EndNote lisansınız bulunmuyorsa EndNote Online temel 

özelliklerinden faydalanabilirsiniz). 

 EndNote ve EndNote Online kütüphanelerinizde bulunan referans kayıtlarınızı ve 

dosya eklerini iki uygulama arasında kolaylıkla senkronize edebilirsiniz. 

 Aynı dokümanda, hem EndNote hem de EndNote Online kütüphanelerinizden 

makalelerinize atıf işlemleri gerçekleştirebilirsiniz. 

 Not 

 Filtreler, bağlantı dosyaları ve çıktı stilleri EndNote Online ile 

kişiselleştirilememektedir. 

 Senkronizasyon işlemi, yalnızca bir kütüphane (Edit>Preferences>Sync ekranında 

görüntülenen kütüphane ile ) ve bir EndNote online hesabı ile 

gerçekleştirilmektedir. Bkz. 5.8.3.5 Sharing Groups 

 EndNote X9, tüm kütüphane paylaşımının yanında bir referans grubunu 99 

EndNote online kullanıcısı ile paylaşma olanağı sunmaktadır. Bkz. 5.10.3 Lokal 

Grup Paylaşımı 

12.1.1 Manuscript Matcher 

Bkz. 5.8.4 Manuscript Matcher 

Bkz. 12.4.5 Match Menüsü 
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12.2 Uyumluluk ve Gereksinimler 

12.2.1 Web Uygulaması* İçin Tarayıcı Desteği 

 Microsoft Internet Explorer® 8.x (32-bit) veya daha üstü 

 Firefox® 27 veya daha üstü 

 Safari® 5.0 veya daha üstü 

 Chrome® 31 veya daha üstü 

12.2.2 Web Capture** İçin Tarayıcı Desteği 

 Eklentiler* 

 Microsoft Internet Explorer 8.x (32-bit) veya daha üstü 

 Firefox® 27 veya daha üstü 

 Bookmarklet* 

 Microsoft Internet Explorer 8.x veya daha üstü 

 Firefox® 27 veya daha üstü 

 Safari 5.0 veya daha üstü 

 Chrome 31 veya daha üstü 

 Not 

* Internet Explorer haricinde, Macintosh ve Windows tarayıcıları için geçerlidir  

** Çerezler ve JavaScript etkin olmalıdır. 

12.3 EndNote Online Kayıt 

EndNote Online ile çalışmak istiyorsanız, EndNote online hesabı oluşturmanız 

gerekmektedir. Kayıt işlemi hızlı ve kolaydır, iki yıllık EndNote online hesabınızı 

etkinleştirmektedir. Kayıt için kullanılan versiyona bağlı olarak (desktop, Web of 

Science, online) aşağıdaki işlemlerden birini uygulayın: 

12.3.1 EndNote desktop 

EndNote Online’nın, EndNote X9 ile gelen özelliklerini kullanabilmek ve referans 

kayıtlarını senkronize etmek için;  

1.  ‘Edit/Preferences/Sync’i açın. 

 

2. ‘Enable Sync’ butonuna basın. 

3.  ‘Sign Up’ butonuna basın. 
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4. E-mail adresinizi girin ve  butonuna basın. 

  

5. Açılan ekranda yer alan zorunlu alanları (*) doldurduktan sonra  

butonuna basarak kayıt işleminizi gerçekleştirebilirsiniz. 

  

 Not 

 EndNote Online hesabı oluşturmak ya da mevcut hesap girişi için, araç çubuğundan 

‘Sync Library’  butonunu veya menülerden ‘Tools>Sync’ komutunu da 

kullanabilirsiniz. 
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12.3.2 Web of Science 

‘Web of Science’a kayıt olduktan sonra EndNote Online’ı kullanabilirsiniz: 

1. www.webofknowledge.com sayfasını açın ve giriş yapın. 

2. EndNote kütüphanenizi açmak için ekranın üst bölümündeki ‘EndNote’ linkine 

tıklayın. 

  

 Not 

 Web of Science erişiminiz bulunuyorsa, 

 EndNote kütüphanenizden, Web of Science kaynak ve ilgili kayıtlara erişebilir 

ya da atıf raporu (citation report) oluşturabilirsiniz. 

 EndNote kütüphanenizdeki, bir gruba ait referans kayıtları için Web of Science 

atıf raporu oluşturabilirsiniz. 

Ayrıntılı bilgi: http://clarivate.libguides.com/home 

12.3.3 EndNote online 

EndNote desktop kullanmıyor ya da Web of Science erişiminiz bulunmuyorsa, EndNote 

online'da temel kullanıcı olarak çalışabilirsiniz: 

1. www.myendnoteweb.com sayfasına gidin. 

2. Ücretsiz hesap oluşturmak için ‘Register’ butonuna tıklayın. Açılan ekrandaki formu 

doldurun ve ‘Register’ butonuna basarak kayıt işleminizi tamamlayın. 

 

12.4 EndNote Online Menüleri 

EndNote Online’a, www.myendnoteweb.com adresinde kullanıcı adı ve şifrenizle giriş 

yaptıktan sonra, tüm özelliklerine 7 ana menüden erişebilirsiniz: 

 My References 

 Collect 

 Organize 

 Format 

 Match 

 Options 

 Downloads 

http://www.webofknowledge.com/
http://clarivate.libguides.com/home
http://www.myendnoteweb.com/
http://www.myendnoteweb.com/
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12.4.1 My References Menüsü 

‘My References’ menüsü, sizin tüm referans kayıtlarınızın ve gruplarınızın bulunduğu 

ekrandır. Bu ekranda; 

 Tüm referans kayıtlarınızda ya da herhangi bir grubun altında, ‘Quick Search’ 

alanından hızlı bir arama yapabilirsiniz. 

 Gruplara ayırdığınız referansları görüntüleyebilirsiniz. 

 Referans kaydına ait ‘Title’ linkine tıkladığınızda, o referans kaydı ile ilgili detay 

bilgilere erişebileceğiniz ve düzenlemeleri yapabileceğiniz bir ekrana 

yönlendirilirsiniz. 

 Eğer, referans kaydınızı ‘Web of Knowledge’ veri tabanından aktardıysanız, ‘Source 

Record’ linkine tıklayarak kaynak kayda, ‘Related Sources’ ile benzer kayıtlara 

ulaşabilirsiniz. ‘Times Cited’ bölümünde o referansa ait olan atıf sayısını 

görebilirsiniz. 

 Ekranın sağında bulunan ‘Show/Hide Panel’ butonuna bastığınızda, ‘Quick Search’ 

ve grupların listelendiği panelin gizlenmesini veya görüntülenmesini 

sağlayabilirsiniz. 

 Tam metni bulunan kayıtları, ‘Full Text’ butonuna basarak görüntüleyebilirsiniz. 

 ‘Author, Year, Title’ linklerine tıklayarak referanslarınızı sıralayabilirsiniz. 

 Dosya butonu, referansın hangi grupta bulunduğunu görüntülemek için 

kullanılmaktadır. 

 Ataş butonu, referansa ait dosya eklentisini görüntülemek veya yeni bir dosya 

eklemek için kullanılmaktadır. 

 Şekil butonu, referansa ait şekil eklentisini görüntülemek veya yeni bir şekil 

eklemek için kullanılmaktadır. 

 

12.4.2  Collect Menüsü 

‘Collect’ menüsü, online veri tabanlarında arama işlemi, yeni referans kaydı girişi ve 

referans import işlemi için kullanılan ekranlara ulaşmak için kullanılan ana menüdür. 

 

‘Collect’ menüsü ‘Online Search’, ‘New Reference’ ve ‘Import References’ olmak üzere 

3 alt menü içermektedir. 



ResearchSoftware.com 213 

EndNote X9 

 Online Search: Online veri tabanları ve kütüphane kataloglarında arama yapmak 

için kullanılan ekrandır. 

 New Reference: Manuel olarak referans kaydı girmek için kullanılan ekrandır. 

 Import References: Farklı kaynaklardan export edilmiş referans kayıtlarının, 

import filtreleri yardımıyla EndNote Online kütüphanesine aktarmak için kullanılan 

ekrandır. 

12.4.3 Organize Menüsü 

‘Organize’ menüsü, EndNote Online içerisinde oluşturduğunuz gruplarınızın yönetimini 

(paylaşım, yeniden adlandırma ve silme) gerçekleştirebileceğiniz, sizinle paylaşılan 

referans kayıtlarının ve kütüphanenizde bulunan çift kayıtların listelerine 

erişebileceğiniz bir ana menüdür. 

 

‘Organize’ menüsü, ‘Manage My Groups’, ‘Others’ Groups’, ‘Find Duplicates’ ve ‘Manage 

Attachments’ olmak üzere 4 alt menü içermektedir. 

 Manage My Groups: EndNote Online içerisinde oluşturulan grupların yönetimi 

(paylaşım, yeniden adlandırma ve silme) için kullanılan ekrandır. 

 Others’ Groups: Diğer EndNote Online kullanıcılarının sizinle paylaştığı grupları 

görüntülemek için kullanılan ekrandır. 

 Find Duplicates: EndNote Online kütüphanenizde yer alan çift referans kayıtlarını 

listelemek, düzenlemek ve silmek için kullanılan ekrandır. 

 Manage Attachments: EndNote Online kütüphanenizde bulunan dosya eklerini 

düzenlemek için kullanılan ekrandır. 

12.4.4 Format Menüsü 

EndNote Online kütüphanenizde bulunan referans kayıtlarını farklı bibliyografik 

formatlarda düzenlemek ve export etmek için kullanılan alt menülere erişebileceğiniz 

ana menüdür. 

 

‘Format’ menüsü ‘Bibliography’, ‘CiteWhile You Write Plug-In’, ‘Fortmat Paper’ ve 

‘Export References’ olmak üzere 4 alt menü içermektedir. 

 Bibliography: EndNote Online kütüphanenizde bulunan grupları, belirleyeceğiniz 

bibliyografik stilde ve farklı dosya formatlarında (html, txt, rtf) kaydetmenize, 

email olarak gondermenize veya yazdırmanıza olanak sağlayan ekrandır. 
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 CiteWhile You Write Plug-In: Makalenizde Cite While You Write özelliklerini 

kullanmanız için gerekli olan araç çubuğunu indirebileceğiniz ekrandır. 

 Fortmat Paper: rtf (Rich Text Format) dosya formatında oluşturulmuş, 

biçimlendirilmemiş atıflar içeren makalenizdeki atıfları, belirleyeceğiniz bibliyografik 

stile göre biçimlendirip referans listenizi oluşturabileceğiniz ekrandır. 

 Export References: EndNote Online kütüphanenizde yer alan referansları export 

etmek için kullanılan ekrandır. 

12.4.5 Match Menüsü 

Makalenizi gönderebileceğiniz, en iyi potansiyel dergiler hakkında, daha bilinçli bir 

karar vermek için ‘Manuscript Matcher’ özelliğini kullanın. Alternatifleri 

değerlendirmenize ve makalenizi göndermenize yardımcı olacak, JCR verilerine, 

anahtar dergi bilgilerine ve yayıncı ayrıntılarına, başlık, özet ve referans gibi temel 

bilgileri girerek sahip olabilirsiniz. ‘Manuscript Matcher'ı kullanmak için aşağıdaki 

adımları takip edin: 

1. EndNote Online hesabınız ile giriş yapın. 

2. ‘Match’ tabına tıklayın. 

3. Makalenizin başlık ve özet bilgisini girin. 

4. Referans kayıtlarınızın bulunduğu EndNote grubunu belirleyin (isteğe bağlı) 

5. ‘Find Journals’ butonuna tıklayın. 

 

Aşağıdaki sonuçların listelendiği EndNote ekranı açılacaktır: 

 Match Score 

 JCR Impact Factor 

 Journal 

 JCR Category 

 Rank in Category 

 Quartile in Category 

 Link to journal’s website 

 Publisher 

Makalenizi konu ve referans kaydı eşleşmesine bağlı olarak önerilen dergilerden birine 

gönderin. 
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Ayrıntılı bilgi için: 

https://researchsoftware.com/tr/software/bibliography/endnote/manuscript-matcher 

 Not 

 Manuscript Matcher özelliğini aşağıdaki kombinasyonlar ile de kullanabilirsiniz: 

 EndNote’de, Grup seçili iken sağ tuş menüsü ya da Group menüsünden 

 Word’de, Tools>Manuscript Matcher butonu ile 

12.4.6 Options Menüsü 

EndNote Online hesabınız ile ilgili, kişisel bilgi, parola ve EndNote Online ayarlarınızı 

değiştirebileceğiniz ana menüdür. 

 

12.4.7 Downloads Menüsü 

Dokümanınıza atıf işlemi gerçekleştirmek için EndNote online Cite While You Write 

özelliğini kullanabilirsiziniz. Ayrıca, birçok bilgi sağlayıcıdan direct export yardımcı 

uygulaması ile referansları import edebilirsiniz. Bu nedenle iki eklenti kurmanız 

gerekir: 

 Internet Explorer veya Firefox Capture eklentisi  

‘Capture Reference Tool’, direct export özelliği bulunmayan online kaynaklardan 

referans kayıtlarının import edilmesini sağlamaktadır. 

 Cite While You Write Microsoft Word eklentisi 

‘Cite While You Write’ eklentisi ile EndNote yüklü olmasa bile Microsoft Word 

dokümanınıza referans kayıtlarınızı ekleyebilirsiniz. Eklentiyi yüklediğinizde, 

EndNote online tabı Word’e eklenecektir. 

https://researchsoftware.com/tr/software/bibliography/endnote/manuscript-matcher
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 Not 

 EndNote kullanıyorsanız ‘Cite While You Write’ eklentisini kurmanız 

gerekmemektedir. 

 EndNote Online ve Desktop eklenti geçişlerini, ‘Word>EndNote tab>Tools 

grubu>Preferences>Application tab’da yer alan ‘Application’ açılır listesinden 

gerçekleştirebilirsiniz. 

12.5 EndNote Arama Özelliği 

EndNote Online, ‘Quick Search’ ve ‘Online Search’ olarak iki farklı arama özelliği 

içermektedir. 

12.5.1 EndNote Online, Quick Search Özelliği 

Tüm referans kayıtlarınızda ya da herhangi bir grubunuzda arama yapmak için ‘Quick 

Search’ alanını kullanabilirsiniz: 

1. ‘My References’a tıklayın. 

2. ‘Search for’ alanına arama yapmak istediğiniz kelimeyi girin (Chiu). 

3. ‘in’ alanında arama yapmak istediğiniz grubu belirleyin (All My References). 

4. ‘Search’ butonuna basın. 

Girmiş olduğunuz kriterlere bağlı olarak arama sonuçlarınız aşagıdaki gibi 

görüntülenecektir.  

 

 Not 

 Örnek, Sample_Library_X9.enl kütüphanesinin EndNote Online senkronizasyonu 

sonucunda aktarılan veriler üzerinde yapılmıştır. 

 Arama sonuçlarındaki kayıtlara daha hızlı ulaşabilmek için istediğiniz kayıtları 

seçerek, ‘Copy to Quick List’ butonuna basın. Seçmiş olduğunuz kayıtlar ‘Quick List’ 

grubuna eklenecektir 
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 Kayıtlarınızda yazar adının bulunduğu linke tıkladığınızda, bulunduğunuz grupta, o 

yazara ait tüm referans kayıtlarına ulaşabilirsiniz. 

12.5.2 EndNote Online, Online Search Özelliği 

‘Collect’ menüsünün altında yer alan ‘Online Search’ özelliğini kullanarak ‘ISI Web of 

Knowledge, PubMed’ gibi birçok veri tabanında ve kütüphane kataloglarında online 

arama yapabilir, arama sonuçlarınızı EndNote Online kütüphanenizde saklayabilirsiniz. 

Online arama için aşağıdaki işlem sırasını takip edin; 

1. ‘Collect’ menüsünden ‘Online Search’ linkine tıklayın. 

2. Bağlanmak istediğiniz veri tabanını seçin (PubMed(NLM)). 

   

3.  butonuna basın. 

4. İlk alana yazarın adını girin (Joniau) ve ‘in’ alanından ‘Author (Smith AB)’yi seçin.  

5. İkinci alana yılı girin (2001) ve ‘in’ alanından ‘Year’ı seçin. Ekran aşağıdaki gibi 

görüntülenecektir. 

  

6. Bu ekranda ‘retrieve all records’ seçeneği ile tüm kayıtları ekleyebileceğiniz gibi 

‘select a range of records to retrieve’ seçeneği ile arama sonuçlarında belirli bir 

kayıt aralığı belirlemeniz mümkündür.  butonuna basın. 

  

7. Kayıtları görmek için  butonuna basın. 

8. Kayıtları aktarmak için ‘Add to group…’ listesinde yer alan daha önceden 

oluşturduğunuz bir gruba ya da ‘New group’ seçeneğini kullanarak yeni bir gruba 

ekleyebilirsiniz. 
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 Not 

 ‘Select Favorites’ linkine tıkladığınızda, ‘All’ alanında bulunan veri tabanlarından en 

sık kullandığınız veri tabanlarını seçip, ‘Copy to Favorites’ butonu ile ‘My Favorites’ 

alanına ekleyerek veri tabanı sık kullanılanlar listenizi oluşturabilirsiniz. 
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13 Yardım & Destek 

 Help 

Choose Help > Contents or  

Press the F1 key on your keyboard. 

 Comparison EndNote/EndNote Online 

https://researchsoftware.com/software/bibliography/endnote/compare-endnote-

versions 

 EndNote X9 

 Homepage 

https://researchsoftware.com/software/bibliography/endnote 

https://www.endnote.com/ 

 EndNote Downloads: Output Styles, Import Filters, Connection Files, Writing 

Templates  

https://endnote.com/downloads/ 

 EndNote Practical Guide 

https://researchsoftware.com/endnote-practical-guide 

 Useful links 

https://researchsoftware.com/software/bibliography/endnote 

 EndNote X9 Video’s & tutorials 

http://clarivate.libguides.com/endnote_training/users/enx9 

 The Little EndNote How-To Book 

http://clarivate.libguides.com/ld.php?content_id=42104347 

 EndNote Menus Reference Guide 

http://clarivate.libguides.com/ld.php?content_id=42141672 

 EndNote Quick Reference Guide 

http://clarivate.libguides.com/ld.php?content_id=44898510 

 EndNote Guided Tour 

http://clarivate.libguides.com/ld.php?content_id=42326715 

 EndNote Community 

http://endnote.com/community 

 EndNote Online 

 Homepage 

https://www.myendnoteweb.com 

 Quick Reference Guide 

http://endnote.com/sites/en/files/m/pdf/en-online-qrc.pdf 

 Table of Contents 

http://www.myendnoteweb.com/help/en_us/ENW/help.htm 

 EndNote Guided Tour 

http://clarivate.libguides.com/ld.php?content_id=42326715 

 EndNote Community 

http://endnote.com/community 

 Licensed distributor Benelux and Turkey: DISC 

www.researchsoftware.com/ 

info@researchsoftware.com 
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